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FOREWORD

The Government of India has set an ambitious target of imparting skills to 30 crores people, one out of every

four Indians, by 2020 to help them secure jobs as part of the National Skills Development Policy. Industrial

Training Institutes (ITIs) play a vital role in this process especially in terms of providing skilled manpower.

Keeping this in mind, and for providing the current industry relevant skill training to Trainees, ITI syllabus

has been recently updated with the help of  Media Development Committee members of various stakeholders

viz. Industries, Entrepreneurs, Academicians and representatives from ITIs.

The National Instructional Media Institute (NIMI), Chennai, has now come up with instructional

material to suit the revised curriculum for Tool & Die Maker (Dies & Moulds) - Trade Theory - 1st Year

(Revised 2022) in Capital Goods & Manufacturing Sector under Yearly Pattern. The NSQF Level - 4

(Revised 2022) Trade Practical will help the trainees to get an international equivalency standard where their

skill proficiency and competency will be duly recognized across the globe and this will also increase the

scope of recognition of prior learning. NSQF Level - 4 (Revised 2022) trainees will also get the opportunities

to promote life long learning and skill development. I have no doubt that with NSQF Level - 4(Revised 2022)

the trainers and trainees of ITIs, and all stakeholders will derive maximum benefits from these Instructional

Media Packages IMPs and that NIMI's effort will go a long way in improving the quality of Vocational training

in the country.

The Executive Director & Staff of NIMI and members of Media Development Committee deserve appreciation

for their contribution in bringing out this publication.

Jai Hind

Addl.Secretary / Director General (Training)
Ministry of Skill Development & Entrepreneurship,

Government of India.

         New Delhi - 110 001
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PREFACE

The National Instructional Media Institute (NIMI) was established in 1986 at Chennai by then Directorate

General of Employment and Training (D.G.E & T), Ministry of Labour and Employment, (now under Directorate

General of Training, Ministry of Skill Development and Entrepreneurship) Government of India, with technical

assistance from the Govt. of Federal Republic of Germany. The prime objective of this Institute is to develop

and provide instructional materials for various trades as per the prescribed syllabi under the Craftsman and

Apprenticeship Training Schemes.

The instructional materials are created keeping in mind, the main objective of Vocational Training under

NCVT/NAC in India, which is to help an individual to master skills to do a job. The instructional materials are

generated in the form of Instructional Media Packages (IMPs). An IMP consists of Theory book, Practical

book, Test and Assignment book, Instructor Guide, Audio Visual Aid (Wall charts and Transparencies) and

other support materials.

The trade practical book consists of series of exercises to be completed by the trainees in the workshop.

These exercises are designed to ensure that all the skills in the prescribed syllabus are covered. The trade

theory book provides related theoretical knowledge required to enable the trainee to do a job. The test and

assignments will enable the instructor to give assignments for the evaluation of the performance of a trainee.

The wall charts and transparencies are unique, as they not only help the instructor to effectively present a

topic but also help him to assess the trainee's understanding. The instructor guide enables the instructor to

plan his schedule of instruction, plan the raw material requirements, day to day lessons and demonstrations.

IMPs also deals with the complex skills required to be developed for effective team work. Necessary care

has also been taken to include important skill areas of allied trades as prescribed in the syllabus.

The availability of a complete Instructional Media Package in an institute helps both the trainer and

management to impart effective training.

The IMPs are the outcome of collective efforts of the staff members of NIMI and the members of the Media

Development Committees specially drawn from Public and Private sector industries, various training institutes

under the Directorate General of Training (DGT), Government and Private ITIs.

NIMI would like to take this opportunity to convey sincere thanks to the Directors of Employment & Training

of various State Governments, Training Departments of Industries both in the Public and Private sectors,

Officers of DGT and DGT field institutes, proof readers, individual media developers and coordinators, but for

whose active support NIMI would not have been able to bring out this materials.

Chennai - 600 032      EXECUTIVE DIRECTOR
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INTRODUCTION

TRADE  PRACTICAL

The trade practical manual is intented to be used in workshop . It consists of a series of practical exercises

to be completed by the trainees during the one year course  of the  Tool & Die Maker (Dies & Moulds) Trade

supplemented and supported by instructions/ informations to assist in performing the exercises. These

exercises are designed to ensure that all the skills in compliance with NSQF LEVEL - 5

The manual is divided into SIX modules.

Module 1 - Safety

Module 2 - Fitting

Module 3 - Turning

Module 4 - Milling

Module 5 - Grinding

Module 6  - AutoCad & Pro - E

The skill training in the shop floor is planned through a series of practical exercises centred  around ome
practical project. However, there are few instances where the individual exercise does not form a part of
project.

While developing the practical manual a sincere effort was made to prepare each exercise which will be easy
to understand and carry out even by below average trainee. However the development team accept that there
is a scope for further improvement.  NIMI, looks forward  to the suggestions from the experienced training
faculty for improving the manual.

TRADE  THEORY

The manual of trade theory consists of  theoretical information for the one year course of the Tool & Die Maker
Trade. The contents are sequenced according to the practical exercise contained in the manual on Trade
practical.  Attempt has been made to relate the theoretical aspects with the skill  covered in each exercise
to the extent possible. This co-relation is maintained to help the trainees to develop the perceptional
capabilities for performing the skills.

The Trade theory has to be taught and learnt along with the corresponding exercise contained in the manual
on trade practical. The indicating about the corresponding practical exercise are given in every sheet of this
manual.

It will be preferable to teach/learn the trade theory connected to each exercise atleast one class before
performing the related skills in the shop floor. The trade theory is to be treated as an integrated part of each
exercise.

The material is not the purpose of self learning and should be considered as supplementary to class room
instruction.
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(ix)

1 Plan and organize the work to make job as per specification 1.1.01 - 1.2.27
applying different types of basic fitting operation and check
for dimensional accuracy following safety precautions. [Basic
fitting operation – Filing, Marking, Hack sawing, Drilling,
Taping, chipping and Grinding etc. Accuracy: ± 0.1mm]

2 Make different fit of components for assembling as per 1.2.28 - 1.3.30
required tolerance observing principle of interchangeability
and check for functionality. [Different Fit –Open, Angular, &
Square Fit; Required tolerance: ±0.05 mm, angular tolerance:
1 degree.]

3 Set different shaped jobs on different chuck and demonstrate 1.2.31 - 1.3.33
conventional lathe machine operation observing standard
operation practice. [Different chucks:3 jaws & 4 jaws, different
shaped jobs: round, square, hexagonal]

4 Prepare different cutting tool to produce jobs to appropriate 1.3.34 - 1.3.43
accuracy by performing different turning operations. Different
cutting tool – V tool, side cutting, parting, thread cutting (both
LH & RH),Appropriate accuracy: ±0.06mm, Different turning
operation – Plain, facing, drilling, boring (counter & stepped),
grooving, Parallel Turning, Step Turning, parting, chamfering,
U -cut, Reaming, internal recess, knurling.

5 Set the different machining parameters to produce threaded 1.3.44 - 1.3.45
components applying method/ technique and test for
proper assembly of the components with an accuracy of
± 0.05 mm. [Different threads viz., metric/ BSW/ Square]

6 Set the different machining parameters and cutters to prepare 1.3.46 - 1.4.62
job by performing different milling operation and indexing.
[Different machining parameters – feed, speed and depth of
cut. Different milling operations – plain, stepped, angular,
dovetail, T-slot, contour, gear milling]

7 Produce components of high accuracy by surface grinding 1.4.63 - 1.5.72
operation. [Accuracy of +/- 0.02 mm]

8 Produce components of high accuracy by cylindrical grinding 1.5.73 - 1.5.77
operations. [Accuracy of +/- 0.02mm.]

9 Sharpen different cutter or multipoint cutting tool. [Different 1.5.78
cutters – end mill cutter, side & face milling cutter, single angle
cutter, Reamer]

10 Develop isometric drawing and solid modelling of mould using 1.5.79 - 1.6.83
CAD & Pro-E.

LEARNING / ASSESSABLE OUTCOME

On completion of this book you shall be able to

SI.No. Learning /Outcome Refer Ex:No
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(x)

SYLLABUS

Duration Reference
Learning outcome

Professional Skills
(Trade Practical)

With Indicative Hours

Professional Knowledge
(Trade Theory)

Professional
Skill 138
Hrs.;

Professional
Knowledge
40 Hrs.

Plan and organize the
work to make  job as per
specification applying
different types of basic
fitting operation and
check for  dimensional
accuracy following  safety
precautions.  [Basic
fitting  operation – Filing,
Marking, Hack  sawing,
Drilling,  Taping, chipping
and Grinding etc.
Accuracy: ±  0.1mm].
NOS:CSC/N0308

1. Introduction of trade skill and work
application. (02hrs.)

2. Safety attitude development of the
trainee by educating them to use
Personal Protective Equipment
(PPE). (02hrs.)

3. First Aid Method and basic training.
(02hrs.)

4. Safe disposal of waste materials
like cotton waste, metal chips/
burrs etc. (01hrs.)

5. Hazard identification and
avoidance. (02hrs.)

6. Identification of safety signs for
Danger, Warning, caution &
personal safety message. (01 hr.)

7. Preventive measures for electrical
accidents & steps to be taken in
such accidents. (02hrs.)

8. Use of Fire extinguishers. (05hrs.)

9. Practice and understand
precautions to be followed while
working in fitting jobs. (02 hrs.)

10. Importance of trade training, List
of tools & Machinery used in the
trade. (01 hr.)

11. Safe use of tools and equipments
used in the trade. (01 hr.)

12.Knowing games and memory
training. (10 hrs.)

13.Motivational talk by experts.
(02hrs.)

14. 5S training. (02 hrs.)

15. Identification of tools
&equipments as per desired
specifications for fi l ing and
marking, visual inspection of raw
material for rusting, scaling,
corrosion etc. (03 hrs.)

16. Familiarisation of bench vice.
(01hr.)

17. Filing- files different sector and
measure with steel rule. (25 hrs.)

18. Mark with scriber and steel rule.
(01 hr)

19. Measuring practice with steel
rule, outside & inside callipers.
(06 hrs.)

All necessary guidance to be provided
to the newcomers to become familiar
with the working of Industrial Training
Institute system including store’s
procedures. Safe working practices.
Soft Skills, its importance and Job
area after completion of
training.Importance of safety and
general precautions observed in the
industryshop floor. Introduction of
First aid. Operation of electrical
mains and electrical safety.
Introduction of PPEs. Response to
emergencies e.g. power failure, fire,
and system failure.mportance of
housekeeping & good shop floor
practices. Introduction to 5S
concept& its
application.Occupational Safety
&Health:Health, Safety and
Environment guidelines, legislations
& regulations as applicable. (08 hrs)

Bench work – Metal working hand
tools and devices –Work bench –
vices – files – hacksaw –hammer –
spanners – screw  drivers.

Linear measurements- its units, steel
rule dividers, Punch – types and uses.
Description use and care of marking
table. (05 Hrs.)
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(xi)

20.Dot punching and letter and
number punching. (05 hrs.)

Vernier calliper – its parts, principles,
reading, uses and care.
Outside micrometer – its parts, principles,
reading, uses and care, vernier height gauge.
Marking tools – scriber.Marking out –
Coordinates system, Rectangular – Polar
–Rules for marking.
Bevel protractor, combination set- their
components, uses and cares.
Pedestal grinder, star wheel dresser, safety
precautions, care and maintenance. (12
Hrs.)

21.Grinding, centre punch, dot
punch, flat chisel and scriber.
(10hrs.)

22. Drill grinding practice. (10hrs.)

Marking media, special application.
Surface plate and auxiliary marking
equipment, ‘V’ block, angle plates,parallel
block, description, types, uses, accuracy,
care and maintenance.Drill, Tap, Die-types
& application. Determination of tap drill size.
Reamer- material, types (Hand and
machine reamer), parts and their uses,
determining hole size for reaming, Reaming
procedure. Drilling machines-types and
their application, construction of Pillar &
Radial drilling machine.
Countersunk, counter bore and spotfacing
tools and nomenclature.Cutting Speed,
feed, depth of cut and Drilling time
calculations. (05Hrs.)

23.Drill Plate filing to an accuracy of
±0.05mm. (10 hrs.)

24.Marking for centre punching,
drilling, reaming, tapping, counter
boring, counter sinking. (02 hrs.)

25.Centre punching, drilling, reaming,
tapping, counter boring, counter
sinking on drill plate. (12hrs.)

26.Die pass on standard material
(M8). (08 hrs.)

27. Cutting tool filing and grinding on
standard material. (10 hrs.)

Dial test indicator-its parts, types,
construction and uses.Interchangeability:
Necessityin Engineering. field,
LimitˆDefinition, types,terminology of limits
and fits-basic size, actualsize, deviation,
high and low limit, zero-line, tolerance zone,
allowances. Different standard systems of
fits and limits. Geometrical tolerance.
British standard system, BIS system.
(10Hrs.)

Professional
Skill 110
Hrs.;

Professional
Knowledge
20 Hrs.

Marking different of
components for
assembling as per
required tolerance
observing principle
of interchange
ability and check  for
functionality.
[Different Fit – Open,
Angular, &  Square
Fit;
Required tolerance:
±0.05 mm, angular
tolerance: 1
degree.]
NOS:CSC/N0309

28.Make Male & Female ‘Open’ fitting
with accuracy ±0.05 mm. (25 hrs.)

Introduction about metals, difference
between Metal and Non-Metal, properties
of metal, Classification of metals and its
applications, pig – iron, cast iron, wrought
iron, steel-plain carbon steel (Low carbon
steel, medium and high carbon steels, high
speed steel, stainless steel, carbides, etc.)
(04 Hrs.)

29.Make male & female for square
fit with accuracy ± 0.05 mm.
(30hrs.)

Heat treatment of metals, process- such
as annealing, nit riding, hardening,
tempering, case hardening,
carburizing,cyaniding, flame hardening,
Induction hardening, purposes and its
effects on the properties of steel. (08 Hrs.)
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(xii)

30.Angular fitting with male &
female. (30 hrs.)

Assembly fit with male & female
by dowelling and screwing. (25
hrs.)

31. Identify & function of different
parts of lathe. Practice on
operation of lathe (dry/idle run).
(10 hrs.)

32. Setting lathe on different speed
and feed. (02 hrs.)

33. Profile turning using hand tools-
radius external and internal.
(20hrs.)

34.Grinding of R.H. and L.H. tools,
parting tool, Round nose tool.
(05hrs.)

35.Checking of angles with angle
gauge / bevel protractor. (02 hrs.)

36. Grinding of “V” tools for
threading of Metric/ British
threads. (04hrs.)

37. Plain turning (holding in 4 –jaw
chuck), step turning and forming
shoulder, chamfering in between
centres as per dimensions.
(28hrs.)

38. Pillar turning between centres
(07 hrs.)

Introduction to lathe. Centre lathe
construction, detail function of parts,
specification. Safety points to be
observed while working on a lathe. (07
Hrs.)

Different types of Lathe operations -
facing, turning, parting-off, grooving,
chamfering, boring etc.Lathe cutting
tool-different types, shapes and
different angles (clearance, rake etc.),
specification of lathe tools.
Types of chips, chip breaker.Tool life,
factors affecting tool life. (10 Hrs.)

39. Bush turning, drilling and boring/
reaming. (14 hrs.)

40.Turning and die passing in a
standard material. (03 hrs.)

41. Pin punch turning and knurling
(05 hrs.)

42. Using 4 – jaw chuck; face both
side of a plate thickness as per
drawing. (02 hrs.)

Driving mechanism, speed and feed
mechanism of Lathe Concept of
Orthogonal and Oblique Cutting.
Chucks & different types of job holding
devices on lathe and advantages of
each type.
Mounting and dismounting of
chucks.Knurling-types, grade & its
necessity.Vernier Bevel Protractor –
parts, reading and uses. (04 Hrs.)

Getting to know the lathe with its main
components, lever positions and
various lubrication points as well.
Definition of machine & machine tool
and its classification. (08 Hrs.)

Set different  shaped
jobs on  different chuck
and demonstrate
conventional lathe
machine operation
observing standard
operation practice.
[Different chucks:3  jaws
& 4 jaws,  different
shaped  jobs: round,
square,  hexagonal]
NOS:CSC/N0316

Professional
Skill 32 Hrs.;

Professional
Knowledge
07 Hrs.

Professional
Skill 95 Hrs.;

Professional
Knowledge
21 Hrs.

Prepare different cutting
tool to produce jobs to
appropriate accuracy by
performing different
turning operations.
[Different cutting tool – V
tool, side cutting,
parting, thread cutting
(both LH & RH),
Appropriate accuracy:
±0.06mm, Different
turning operation –Plain,
facing, drilling, boring
(counter & stepped),
grooving, Parallel Turning
Step Turning, parting,
chamfering, U -cut,
Reaming, internal
recess, knurling.]
NOS:CSC/N0316

43. Taper turning male and female
work pieces and assembly.
(25hrs.)

Various material for single point
cutting tools, tip tools- their brazing
and grinding process. (07 Hrs.)

Professional
Skill 25 Hrs.;

Professional
Knowledge
05Hrs.

Set the different
machining  parameters to
produce threaded
components  applying
method/  technique and
test  for proper
assembly of the
components with  an
accuracy of ±  0.05 mm.
[Different  threads viz.,
metric/  BSW/ Square]
NOS:CSC/N0316

44. External thread cutting on step
turned work piece. (Metric,
BSW & Square Thread) (15hrs.)

45. Turn job for Internal thread and
 cut internal thread (10 hrs.).

Calculations of taper turning by off-
setting tail stock.
Sine Bar – description & uses
Slip gauge –description and uses. (05
Hrs.)
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(xiii)

46. Identification of milling machine. (02
hrs.)

47. Demonstrate working principle of
Milling Machine. (02 hrs.)

48. Set vice & job on the table of  Milling
Machine. (03 hrs.)

49. Set arbor on the spindle of milling
machine. (04 hrs.)

50. Set the cutter on arbor. (02hrs.)

51. Safety points to be observed while
working on a milling machine. (02 hrs.)

Milling Machine: importance,  types,
construction and  specification.
Driving and feed mechanism of
Milling Machine

Different milling cutter angles,
Milling cutter materials (05 Hrs.)

52. Demonstrate Up Milling and down
Milling Process. (04 hrs.)

53. Perform sequence of milling for six
faces of a solid block 2 numbers. (13
hrs.)

54. Check the accuracy with the help of
tri-square and vernier height gauge. (02
hrs.)

55. Perform Step milling using side and
face cutter checking with depth
micrometer. (05 hrs.)

Job holding devices-vice, clamps,  V-
block, parallel block etc.

Milling cutter holding devices,
milling process – Up milling and
Down milling. (02 Hrs.)

61.Concave and Convex milling. (16hrs.)

(Professional
Skill 128
Hrs.;

Professional
Knowledge
18 Hrs.)

Introduction to coolant &  lubricant-
difference between them, types and
uses of each. (03 Hrs.)

Set the different
m a c h i n i n g
parameters and
cutters to prepare
job by performing
different mill ing
operation and
indexing. [Different
m a c h i n i n g
parameters – feed,
speed and depth of
cut. Different milling
operations –plain,
stepped, angular,
dovetail, T-slot,
contour,
gear mill ing]
NOS:CSC/N0316

56. Milling blank piece (plain milling).\ (10
hrs.)

57. Slot milling with side and face  cutter
(08 hrs.)

58. 90° angular milling with equal  angle
cutter. (08 hrs.)

59. Dove tail milling. (09 hrs.)

60. Tee slot milling. (08 hrs.)

Calculation of cutting speed,  feed,
machining time for milling  machine.
Milling machine  operations.

Milling machine attachments –
vertical milling attachment, (03 Hrs.)

62. Simple indexing practice (30hrs.) Dividing head – Introduction,
construction, types. Simple and
universal dividing head. Indexing
methods – direct  indexing, simple
indexing,  angular indexing, its
calculations. (05 Hrs.)

63. Identification of different types of
grinding machine. (02 hrs.)

64. Wheel balancing & truing. (06hrs.)

65.Dressing of grinding wheel. (02hrs.)

66.Grinding of block (six sides) in  surface
grinding machine with an accuracy of
±0.01 mm. (15 hrs.)

67.Grinding of step block in surface
grinding machine with an accuracy of
± 0.01 mm. (15 hrs.)

Grinding machine introduction,
types, Surface & Cylindrical  grinding
Machine- their parts, functions,
specification, and uses. Safety
points to be  observed while working
on a  Grinding machine. (05 Hrs.)

P r o d u c e
components of
high accuracy by
surface grinding
o p e r a t i o n .
[Accuracy of +/-
0.02 mm]
NOS:CSC/N0316

Professional
Skill 108 Hrs.;
Professional
Knowledge
09 Hrs.

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



(xiv)

68.Grinding of slot block in surface
grinding machine with an accuracy
of ± 0.01 mm. (15 hrs.)

69. Set and perform angular grinding
using sine plate to stranded angle.
(18 hrs.)

70. Make slide fit (male/female) (12hrs.)

71. Perform form grinding. (08 hrs.)

72. Taper angle grinding fitting. (15hrs.)

Grinding wheel shapes and sizes.
Standard marking system. Selection of
grinding wheel.  (04 Hrs.)

Procedure for mounting of grinding
wheels, balancing of grinding wheels.
Dressing, types of dresser. Glazing and
Loading of wheels – its Causes and
remedies.  Roughness values and their
symbols. Explain the importance and
necessity of quality. (04 Hrs).

Abrasives - its types, Bond, Grade, Grit,
structure. (04 Hrs.)

79.Prepare simple mould design
drawings with basics of AutoCAD viz.,
Basic and advanced 2D drafting, draw
commands, Constraints, Modify
commands, Layers, Line types
block, Texts, Attribute, Table,
Dimensioning, Isometric, Solid
modelling, View port. (58 hrs.)

80.Prepare solid modelling of simple
mould with Pro-E [Sketch, Part
(solid, surface, free style, flexible
modelling, sheet metal.), Assembly,
Creo direct, Creo simulate]. (25 hrs.)

81.Creating (NC assembly and mould
cavity) drawing. (10 hrs.)

82.Part drawing of the universal coupling
assembled all the parts and solid
modelling and denoted by coloured
combination. (15hrs.)

AutoCAD: Introduction to AutoCAD,
creating first drawing, learning the tools
trade, organizing the work, drawing the
first mould. (14 Hrs.))

Professional
Skill 66 Hrs.;

Professional
Knowledge
08 Hrs

P r o d u c e
components of
high accuracy by
cylindrical grinding
o p e r a t i o n s .
[Accuracy of +
0.02mm.]
NOS:CSC/N0316

Cylindrical grinding:

73.External Parallel grinding
(Bothholding in chuck/ collet and  in
between centres. (17 hrs.)

74. Plunge grinding. (04 hrs.)

Professional
Skill 30 Hrs.;

Professional
Knowledge 04
Hrs.

Sharpen different
cutter or multipoint
cutting tool.
[Different cutters –
end mill cutter, side
& face mill ing
cutter, single angle
cutter, Reamer]
NOS:CSC/N0316

Develop isometric
drawing and solid
modelling of mould
using CAD & Pro-E.
NOS:CSC/N9492

Cylindrical grinding:

75.Internal Parallel grinding (Both
holding in chuck/collet). (20 hrs.)

76.Grinding of step in Cylindrical
grinding machine with an accuracy
of ±0.01 mm (15 hrs.)

77.Grinding of external taper in
Cylindrical grinding machine with an
accuracy of ± 0.01 mm. (10hrs.)

Tool & cutter grinderˆconstruction, use
and specification. (04 Hrs.)

Professional
Skill 108 Hrs.;
Professional
Knowledge  28
Hrs.

78.Demonstrate and practice of grinding
of end mill cutter of different sizes
by using tool & cutter grinding
machine. (30 hrs.)

Pro-E: Familiarization of
interface/ Windows, Sketching,
basic modeling, advanced
modeling, assembling, drawing,
surface modeling, manufacturing
– mould design awareness. (14Hrs.)
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C G & M Related Theory for Exercise 1.1.01
Tool & Die Maker (Dies & Moulds) - Safety

Guide lines to work with national skill training institute system including
store’s procedures
Objectives: At the end of this lesson you shall be able to
• state what is ITI and brief the objectives of ITI
• describe the organizational chart
• list out the infrastructure available in ITI
• explain the job opportunities and carrier development after completion of courses
• brief the examination pattern and soft skills.

Introduction to ITI

Industrial Training Institutes (ITI) and Industrial Training
Centers (ITC) comes under Craftsman training Scheme
(CTS) to provide Vocational training in various trades
functioning under Directorate General of Training (DGT),
Ministry of Skill Development and Entrepreneurship,
Government of India.

ITIs and ITCs are one and the same; ITIs are governed by
the state/union government, whereas, the ITCs are self-
financing institutions to provide same training courses as
ITI's. Trade test for ITI and ITC trainees are common and the
National Trade Certificate issued by the National Council
for Vocational Training (NCVT) is of the same standard.

The objectives of an ITI

 The objective of  an ITI is to ensuring a steady flow of skilled
workers and to reduce unemployment among the educated

youth by training & equipping for suitable industrial
employment and as well as for self employment.

The institute imparts training in engineering and non
engineering  two years/ one year trade courses approved
by the Government of India in consultation with the National
Council for Vocational Training, New Delhi.

Structure of ITI

The structure of industrial training institute is shown in the
following chart 1. It may vary state to state It explain the
information /order flow from higher superior officials to the
ground level officials. The working hours may differ state to
state. The trade master is the overall in-charge for the
particular trade .the trainee has to report to trade master.

In every ITI there is a store and the incharge of the store is
storekeeper for inward and outward movement of tools,
equipment and consumables. The instructor will  indent the
training requirement for the training purposes.

Government Industrial Training Institute

Vice Principal

Training Officer / Placement officer

HSS/PET

Asst Training Officer

Junior Training Officer

Workshop Asst

Administrative Officer

Office Manager

Assistant / Account / Store Keeper

Junior Assistant / Typist Record Clerk

Office Asst. / Watchman / Sweeper

<

<

<
<

<
<

<

<
<

<
<

Deputy Director / Principal
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2

Infrastructure available in ITI's

To provide 100% practical training to the trainees, tools,
equipments, machineries and classroom facilities are
available in ITI's. Continuous learning process/ programs
are conducted in regular intervals as per the instructions
given by the DGT.

The following facilities are available in ITI's

- Hostel facilities

- Libraries

- Soft skills lab/ computer labs

- High end classrooms /smart class.

- Stores

- Sports

- Wifi  enabled campus.

- Industrial visit's/ Industrialist guest lecture

- Internship training on the job training

- Apprentice programs

- Campus interview etc

CTS Admission Process

Online counseling is conducted Statewide selection is
made on merit basis duly following rules of reservation.
The candidates exercise the option of choosing the ITI
and trade of their choice.

Students between the age of 14 - 40 are admitted in
Industrial Training Institutes. Admission is made during
the month of August every year.

Craftsman Training Scheme Exam System

Final Trade Test is conducted on All India basis and the
question papers are issued to all Trade Testing Centres
on the same day by the NCVT. Passed-out candidates
are issued with National Trade Certificate (NTC) under
the seal and authority of NCVT by DGT, New Delhi

Job area after completion of  training

This highlights the employability aspect on completion
of training. The trainee should be aware of various
prospects available in present market scenario along
with scope for self-employment. For example a trainee
with NTC engineering trade may opt for various jobs
available in different industries in india and abroad.

After successful completion of training in any one of the
engineering trade one can seek appointment in
engineering workshop /Factories (Public Sector, Private
Sector and Government Industries) in India and abroad
as technician / Skilled worker.

Self employment

One can start is own factory / ancillary unit or design
products manufacture  and  become an entrepreneur.

Further learning scope

- Apprentice training in designated trade.

- Craft Instructor certificate course.

- Diploma in relevant Engineering.

Skill competition

All India Skill Competition for Craftsmen scheme at
national level was introduced to foster a healthy
competition among the trainees of ITIs / ITCs

India skill competition is organized by National Skill
Development Corporation., India skill competition the
country's biggest skill competition is designed to
demonstrate the  highest standards of skilling and offers
a platform to young people to show their talent at
national level and international levels.

The competition is now held every year in 15 trades viz.
Instrument Mechanic, Electronic Mechanic, Welder,
Fitter, Turner, Machinist, Mechanic Motor Vehicle,
Foundry man, Electrician, Cutting & Sewing, Computer
Operator & Programming Assistant, Draughtsman (Civil),
Draughtsman (Mechanical), Mechanic Diesel and
Mechanic Refrigeration & Air- Conditioning.

The best trainee of each of the above trades at the State
level competition competes at the All India Skill
Competition.

Awards

The best Craftsmen in each of the above 15 trades at the
All India level are awarded merit certificates and a cash
prize of Rs. 50,000/- each. ITIs whose trainee stands
first in the competition at the All India Skill Competition
is awarded a merit certificate and is declared as the
best ITI.

Approach on soft skills

Soft skills - refer to the cluster of personality traits,
social graces, facility with language, personal habits,
friendliness, and optimize that make people to varying
degrees. The same can also be defined as-ability to
interact communicates positively and productively with
others. Sometimes called "character skills".

More and more business are considering soft skills as
an important job criteria. Soft skills are used in personal
and professional life. Hard skills / technical skills do not
matter without soft skills.

CG& M: TDM (Dies & Moulds) (NSQF - Revised 2022) - R.Theory for Ex. 1.1.01
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C G & M Related Theory for Exercise 1.1.02
Tool & Die Maker (Dies & Moulds) - Safety

Safety and general precautions in industry/shop floor
Objectives: At the end of this lesson you shall be able to
• state the importance of safety
• list out the safety precautions to be observed in a industry/shop floor
• list out the personal safety precautions to be observed in machine shop
• list out the safety precautions to be observed while working on the machines.

Use the appropriate tools for the job.

Keep the tools at their proper place.

Wipe out split oil immediately.

Replace worn out or damaged tools immediately.

Never direct compressed air at yourself or at your
co-worker.

Ensure adequate light in the workshop.

Clean the machine only when it is not in motion.

Sweep away the metal cuttings.

Know everything about the machine before you start it.

Personal safety

Wear a one piece overall or boiler suit.

Keep the overall buttons fastened.

Don't use ties and scarves.

Roll up the sleeves tightly above the elbow.

Wear safety shoes or boots

Cut the hair short.

Don't wear a ring, watch or chain.

Never lean on the machine.

Don't clean hands in the coolant fluid.

Don't remove guards when the machine is in motion.

Don't use cracked or chipped tools.

Don't start the machine until

− the workpiece is securely mounted

− the feed of machinery is in the neutral

− the work area is clear & neat.

Don't adjust clamps or holding devices while the machine
is in motion.

Never touch the electrical equipment with wet hands.

Don't use any faulty electrical equipment.

Ensure that electrical connections are made by an
authorised electrician only.

Concentrate on your work. Have a calm attitude.

Safety in a workshop can be broadly classified into 3
categories.

- General safety

- Personal safety

- Machine safety

General safety

Keep the floor and gangways clean and clear.

Move with care in the workshop, do not run.

Don't leave the machine which is in motion.

Don't touch or handle any equipment/ machine unless
authorised to do so.

Don't walk under suspended loads.

Don't crack practical jokes while on work.

Generally accidents do not happen; they are caused. Most
accidents are avoidable. A good craftsman, having a
knowledge of various safety precautions, can avoid
accidents to himself and to his fellow workers and protect
the equipment from any damage. To achieve this, it is
essential that every person should follow safety procedure.
(Fig 1)
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Do things in a methodological way.

Don't engage yourself in conversation with others while
concentrating on your job.

Don't distract the attention of others.

Don't try to stop a running machine with hands.

Machine safety

Switch off the machine immediately, if something goes
wrong.

Keep the machine clean.

Replace any worn out or damaged accessories, holding
devices, nuts, bolts etc as soon as possible.

Do not attempt operating the machine until you know how
to operate it properly.

Do not adjust tool or the workpiece unless the power is
off.

Stop the machine before changing the speed.

Disengage the automatic feeds before switching off.

Check the oil level before starting the machine.

Never start a machine unless all the safety guards are in
position.

Take measurements only after stopping the machine.

Use wooden planks over the bed while loading and
unloading heavy jobs.

Safety is a concept, understand it. Safety is a
habit, cultivate it.

Approach on soft skills
Objectives : At the end of this lesson you shall be to
• state the concept of soft skill
• list the important common soft skills
• brief the employability aspect of training
• brief the further learning scope.

Concept: Soft skills - refer to the cluster of personality
traits, social graces, facility with language, personal habits,
friendliness, and optimism that make people to varying
degrees.  The same can also be defined as an ability to
interact communicate positively & productively with others.
Sometimes called “character skills”.

More and more business are considering soft skills as
important job criteria.  Soft skills are used in personal and
professional life.  Hard skills/technical skills do not matter
without soft skills.

Common Soft Skills

- Strong work ethic

- Positive attitude

- Good communication skills

- Interpersonal skills

- Time management abilities

- Problem-solving skills

- Team work

- Initiative, Motivation

- Self-confidence

- Loyalty

- Ability to accept and learn from criticism

- Flexibility, Adaptability

- Working well under pressure

Job area completion of training: This highlights the
employability aspect on completion of training.  The trainee
should be aware of various prospects available in present
market scenario along with scope for self-employment.
For example a trainee with NTC engineering trade may
opt for:

Various job available in different industries in
India and Abroad.

After successful completion of ITI training in any one of
the engineering trade one can see appointment in
engineering workshop/Factories (Public Sector, Private
Sector and Government Industries) in India and Abroad as
technician/Skilled worker.

Self employment

One can start is own factory/ancillary unit or design
products manufacture and became an entrepreneur.

Further learning scope

- Apprentice training in designated trade.

- Craft Instructor certificate course.

- Diploma in relevant Engineering.

CG& M: TDM (Dies & Moulds) (NSQF - Revised 2022) - R.Theory for Ex. 1.1.02

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



5

Personal Protective Equipment (PPE)
Objectives: At the end of this lesson you shall be able to
• state what is personal protective equipment and its purpose
• name the two categories of personal protective equipment
• list the most common type of personal protective equipment
• list the conditions for selection of personal protective equipment.

Personal protective equipment

Personal protective equipment, commonly referred to as
"PPE", is equipment worn to minimize exposure to hazards
that cause serious workplace injuries and illnesses. These
injuries and illnesses may result from contact with
chemical, radiological, physical, electrical, mechanical,
or other workplace hazards. Personal protective equipment
may include items such as gloves, safety glasses and
shoes, earplugs or muffs, hard hats, respirators, or
coveralls, vests and full body suits.

Categories of PPE-Small's'

Depending upon the nature of hazard, the PPE is broadly
divided into the following two categories.

Non- respiratory : Those used for protection against injury
from outside the body, i.e. for protecting the head, eye,
face, hand, arm, foot, leg and other body parts

Respiratory: Those used for protection from harm due to
inhalation of contaminated air.

They are to meet the applicable BIS (Bureau of Indian
Standards) standards for different types of PPE.

The guidelines on 'Personal Protective Equipment' is
issued to facilitate the plant management in maintaining
an effective program with respect to protection of persons
against hazards, which cannot be eliminated or controlled
by engineering methods listed in table 1.

Table 1

No Title

PPE1 Helmet

PPE2 Safety footwear

PPE3 Respiratory protective equipment

PPE4 Arms and hands protection

PPE5 Eyes and face protection

PPE6 Protective clothing and coverall

PPE7 Ears protection

PPE8 Safety belt harness

Types of protection Hazards PPE to be used

Head protection (Fig 1) 1 Falling objects Helmets
2 Striking against objects
3 Spatter

Personal protective equipment and their uses and hazards are listed in Table 2

Foot protection (Fig 2) 1 Hot spatter Leather leg guards
2 Falling objects Safety shoes
3 Working wet area Gum boots

CG& M: TDM (Dies & Moulds) (NSQF - Revised 2022) - R.Theory for Ex. 1.1.02
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6

Hand Protecion (Fig 4) 1 Heat burn due to direct contact Hand gloves
2 Blows spark moderate heat
3 Electric shock

      Nose (Fig 3) 1 Dust particles Nose mask
2 Fumes/gases/ vapours

Types of protection Hazards PPE to be used

Eye protection (Fig 5 & Fig6) 1 Flying dust particles Goggles
2 UV rays, IR rays heat and Face shield
     High amount of visible radiation

Hand shield
Head shield

CG& M: TDM (Dies & Moulds) (NSQF - Revised 2022) - R.Theory for Ex. 1.1.02
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Types of protection Hazards PPE to be used

Face protection (Fig 6 &Fig 7) 1 Spark generated during Face shield
     Welding, grinding Head shield with or
2 Welding spatter striking without ear muff
3 Face protection from Helmets with welders
    UV rays Screen for welders

Ear protection (Fig 8s) 1 High noise level Ear plug
Ear muff

 Body protection (Fig 8, & Fig 9) 1 Hot particles Leather aprons

CG& M: TDM (Dies & Moulds) (NSQF - Revised 2022) - R.Theory for Ex. 1.1.02
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Quality of PPE's

PPE must meet the following criteria with regard to its
quality-provide absolute full protection against possible
hazard and PPE's be so designed and manufactured out
of materials that it can withstand the hazards against which
it is intended to be used.

Selection of PPE's requires certain conditions

- Nature and severity of the hazard

- Type of contaminant, its concentration and location of
contaminated area with respect to the source of
reparable air

- Expected activity of workman and duration of work,
comfort of workman when using PPE

- Operating characteristics and limitation of PPE

- Easy of maintenance and cleaning

- Conformity to Indian / International standards and
availability of test certificate.

Proper use of PPEs

Having selected the proper type of PPE, it is essential
that the workman wears it. Often the workman avoids using
PPE. The following factors influence the solution to this
problem.

- The extent to which the workman understands the
necessity of using PPE

- The ease and comfort with which PPE can be worn
with least interference in normal work procedures

- The available economic, social and disciplinary
sanctions which can be used to influence the attitude
of the workman

- The best solution to this problem is to make wearing of
PPE' mandatory for every employee.

- In other places, education and supervision need to be
intensified. When a group of workmen are issued PPE
for the first time.

CG& M: TDM (Dies & Moulds) (NSQF - Revised 2022) - R.Theory for Ex. 1.1.02
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CG & M Related Theory for Exercise 1.1.03
Tool & Die Maker (Dies & Moulds) - Safety

First-aid
Objectives: At the end of this lesson you shall be able to
• state what is first aid
• list the important guide lines for the first aid
• explain the ABC of the first aid
• brief how to give first-aid for a victim who need first aid.

Basic first aid: Basic first aid refers to the initial process
of assessing and addressing the needs of someone who
has been injured or is in physiological distress due to
choking, a heart attack, allergic reactions, drugs or other
medical emergencies. Basic first aid allows one to quickly
determine a person's physical condition and the correct
course of treatment.

Golden hours: India have best of technology made
available in hospitals to treat devastating medical problem
viz. head injury, multiple trauma, heart attack, strokes etc,
but patients often do poorly because they don't gain access
to that technology in time. The risk of dying from these
conditions, is greatest in the first 30 minutes, often instantly.
This period is referred to as Golden period. By the time
the patient reach hospitals, they would have passed that
critical period. First aid care come handy to save lives. It
helps to get to the nearest emergency room as quickly as
possible through safe handling and transportation. The
shorter that time, the more likely the best treatment
applied.

Important guideline for first aiders

Evaluate the situation: Are there things that might put
the first aider at risk. When faced with accidents like fire,
toxic smoke, gasses, an unstable building, live electrical
wires or other dangerous scenario, the first aider should
be very careful not to rush into a situation, which may
prove to be fatal.

Remember A-B-Cs

The ABCs of first aid refer to the three critical things the
first aiders need to look for.

- Airway - Does the person have an unobstructed airway?

- Breathing - Is the person breathing?

- Circulation - Does the person show a pulse at major
pulse points (wrist, carotid artery, groin)

Avoid moving the victim: Avoid moving the victim unless
they are in immediate danger. Moving a victim will often
make injuries worse, especially in the case of spinal cord
injuries.

Call emergency services: Call for help or tell someone
else to call for help as soon as possible. If alone in at the
accident scene, try to establish breathing before calling
for help, and do not leave the victim alone unattended.

Determine responsiveness: If a person is unconscious,
try to rouse them by gently shaking and speaking to them.

If the person remains unresponsive, carefully
roll them on the side (recovery position) and
open his airway.

- Keep head and neck aligned.

- Carefully roll them onto their back while holding his
head.

- Open the airway by lifting the chin. (Fig 1)

Look, listen and feel for signs of breathing

Look for the victim's chest to raise and fall, listen for sounds
of breathing.

If the victim is not breathing, see the section below

- If the victim is breathing, but unconscious, roll them
onto their side, keeping the head and neck aligned
with the body. This will help drain the mouth and prevent
the tongue or vomit from blocking the airway.

Check the victim's circulation: Look at the victim's colour
and check their pulse (the carotid artery is a good option;
it is located on either side of the neck, below the jaw
bone). If the victim does not have a pulse, start CPR.- If
you are trained.

Treat bleeding, shock and other problems as needed

After establishing that the victim is breathing and has a
pulse, next priority should be to control any bleeding.
Particularly in the case of trauma, preventing shock is the
priority.
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- Poisoning (Gas, Pesticides, Bites)

- Epileptic fits (Fits)

- Hysteria (Emotional, Psychological)

The following symptoms may occur after a person has
been unconscious:

- Confusion

- Drowsiness

- Headache

- Inability to speak or move parts of his or her body (see
stroke symptoms)

- Light headedness

- Loss of bowel or bladder control (incontinence)

- Rapid heartbeat (palpitation)

- Stupor

First aid

- Call EMERGENCY number.

- Check the person's airway, breathing, and pulse
frequently. If necessary, begin rescue breathing and
CPR.

- If the person is breathing and lying on the back and
after ruling out spinal injury, carefully roll the person
onto the side, preferably left side. Bend the top leg so
both hip and knee are at right angles. Gently tilt the
head back to keep the airway open. If breathing or pulse
stops at any time, roll the person on to his back and
begin CPR.

- If there is a spinal injury, the victims position may have
to be carefully assessed. If the person vomits, roll the
entire body at one time to the side. Support the neck
and back to keep the head and body in the same
position while you roll.

- Keep the person warm until medical help arrives.

- If you see a person fainting, try to prevent a fall. Lay
the person flat on the floor and raise the level of feet
above and support.

- If fainting is likely due to low blood sugar, give the person
something sweet to eat or drink when they become
conscious.

DO NOT

- Do not give an unconscious person any food or drink.

- Do not leave the person alone.

- Do not place a pillow under the head of an unconscious
person.

- Do not slap an unconscious person's face or splash
water on the face to try to revive him.

- Stop bleeding: Control of bleeding is one of the most
important things to save a trauma victim. Use direct
pressure on a wound before trying any other method of
managing bleeding.

- Treat shock: Shock, a loss of blood flow from the body,
frequently follows physical and occasionally
psychological trauma. A person in shock will frequently
have ice cold skin, be agitated or have an altered mental
status, and have pale colour to the skin around the
face and lips. Untreated, shock can be fatal. Anyone
who has suffered a severe injury or life-threatening
situation is at risk for shock.

- Choking victim: Choking can cause death or
permanent brain damage within minutes.

- Treat a burn: Treat first and second degree burns by
immersing or flushing with cool water. Don't use creams,
butter or other ointments, and do not pop blisters. Third
degree burns should be covered with a damp cloth.
Remove clothing and jeweler from the burn, but do not
try to remove charred clothing that is stuck to burns.

- Treat a concussion: If the victim has suffered a blow
to the head, look for signs of concussion. Common
symptoms are: loss of consciousness following the
injury, disorientation or memory impairment, vertigo,
nausea, and lethargy.

- Treat a spinal injury victim: If a spinal injury is
suspected, it is especially critical, not move the victim's
head, neck or back unless they are in immediate
danger.

Stay with the victim until help arrives: Try to be a
calming presence for the victim until assistance can arrive.

Unconsciousness (COMA): Unconscious also referred as
Coma, is a serious life threatening condition, when a person
lie totally senseless and do not respond to calls, external
stimulus. But the basic heart, breathing, blood circulation
may be still intact, or they may also be failing. If unattended
it may lead to death.

The condition arises due to interruption of normal brain
activity. The causes are too many.

- Shock (Cardiogenic, Neurogenic)

- Head injury (Concussion, Compression)

- Asphyxia (obstruction to air passage)

- Extreme of body temperature (Heat, Cold)

- Cardiac arrest (Heart attack)

- Stroke (Cerebra-vascular accident)

- Blood loss (Hemorrhage)

- Dehydration (Diarrhea & vomiting)

- Diabetes (Low or high sugar)

- Blood pressure (Very low or very high)

- Over dose of alcohol, drugs

CG& M: TDM (Dies & Moulds) (NSQF - Revised 2022) - R.Theory for Ex. 1.1.03
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Loss of consciousness may threaten life if the
person is on his back and the tongue has
dropped to the back of the throat, blocking the
airway. Make certain that the person is
breathing before looking for the cause of
unconsciousness. If the injuries permit, place
the casualty in the recovery position with the
neck extended. Never give anything by mouth
to an unconscious casualty.

- Think insulin: might the person be suffering from
insulin shock (see 'How to diagnose and treat insulin
shock")?

- Think about drugs: was there an overdose? Or might
the person have under dosed - that is not taken enough
of a prescribed medication?

- Consider trauma: is the person physically injured?

- Look for signs of infection: redness and/ or red streaks
around a wound.

- Look around for signs of Poison: an empty bottle of
pills or a snakebite wound.

- Consider the possibility of psychological trauma:
might the person have a psychological disorder of some
sort?

- Consider stroke, particularly for elderly people.

- Treat according to what you diagnose.

Shock: A severe loss of body fluid will lead to a drop in
blood pressure. Eventually the blood's circulation will
deteriorate and the remaining blood flow will be directed to
the vital organs such as the brain. Blood will therefore be
directed away from the outer area of the body, so the victim
will appear pale and the skin will feel ice cold.

How to diagnose an unconscious injured person

- Consider alcohol: look for signs of drinking, like empty
bottles or the smell of alcohol.

- Consider epilepsy: are there signs of a violent seizure,
such as saliva around the mouth or a generally
disheveled scene?

CG& M: TDM (Dies & Moulds) (NSQF - Revised 2022) - R.Theory for Ex. 1.1.03
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C G & M Related Theory for Exercise 1.1.04
Tool & Die Maker (Dies & Moulds) - Safety

Disposal of waste material
Objectives: At the end of this lesson you shall be able to
• state what is waste material
• list the waste materials in a work shop
• explain the methods of disposal of waste material.
• state advantage of disposal of waste material.
• state colour code for bins for waste segregation.

Waste material: industrial waste is the waste produced
by industrial activity such as that of factories, mills and
mines.

List of waste material (Fig 1)

- Cotton waste

- Metal chips of different material.

- Oily waste such as lubricating oil, coolant etc.

- Other waste such electrical, glass etc.

Methods of waste disposal (Fig 2)

Recycling: Recycling is one of the most well known
method of managing waste. It is not expensive and can be
easily done by you. If you carry out recycling. you will save
a lot of energy, resources and thereby reduce pollution.

Composting: This is a natural process that is completely
free of any hazardous by-products. This process involves
breaking down the materials into organic compounds that
can be used as manure.

Landfills: Waste management through the use of landfills
involves the use of a large area. This place is dug open and
filled with the waste.

Burning the waste material: If you cannot recycle or if
there are no proper places for setting up landfills, you can
burn the waste matter generated in your household.
Controlled burning of waste at high temperatures to produce
steam and ash is a preferred waste disposal technique.

Advantage of  waste disposal:

- Ensures workshop neat & tidy

- Reduces adverse impact on health

- Improves economic efficiency

- Reduce adverse impact on environment

Incineration (Fig 3)
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It is the process of controlled combustion of garbage to
reduce it to incombustible matter, ash, waste gas and
heat. It is treated and released into the environment
(Fig 3). This reduced 90% volume of waste, some time
the heat generated used to produce electric power.

Waste compaction: The waste materials such as cans
and plastic bottles compact into blocks and send for
recycling. This process space need, thus making
transportation and positioning easy.

Colour code for bins for waste segregation given in
Table 1

Table 1

Sl.No. Waste Material Color code

1 Paper Blue

2 Plastic Yellow

3 Metal Red

4 Glass Green

5 Food Black

6 Others Sky blue

CG& M: TDM (Dies & Moulds) (NSQF - Revised 2022) - R.Theory for Ex. 1.1.04
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CG & M     Related Theory for Exercise 1.1.05
Tool & Die Maker (Dies & Moulds) - Safety

Occupational safety and health
Objectives: At the end of this lesson you shall be able to
• describe occupational safety and its importance at work place to prevent unsafe act and conditions in work-

related activities
• brief the Environmental guidelines, legislations & regulations in India, framed to protect workplace health

and safety.
• list the Occupational safety and health Tips.

Occupational safety, and health

Occupational safety, and health means actions or working
conditions which are safe from any cause resulting in
danger to life, physique, mentality or health arising out of
or related to working environment. OSH includes the laws,
standards and programs that are aimed at making the
workplace better for workers, along with co-workers, family
members, customers, and other stakeholders.

The goal of Occupational safety and health

The goal of Occupational safety and health program is to
foster a safe and healthy occupational environment. OSH
also protects all the general public who may be affected
by the occupational environment.

Environmental safety

Environmental safety is defined by the guidance, policies,
and practices enforced in order to ensure that the
surrounding environment is free from hazards that will
warrant the safety and well-being of workers and
employees, residents near industrial operations, as well
as the prevention of accidental environmental damage

The surrounding areas include industrial facilities, work
areas, and laboratories. Environmental safety is a crucial
issue for any industrial activity as negligence and non-
compliance heighten the risk resulting in injuries, illnesses,
and accidental environmental releases.

Environmental safety is usually divided into three
subcategories: (fig1) Occupational safety and Health
Programs, Environmental Control, and Chemical Safety.
(Fig 1)

In order to protect the workers against work related
sickness, disease and injury. The International labour
organization(ILO) came up with an official order on OSH.

Similarly government of India is enacted the following acts

- The legislation for labour welfare, known as the Factories
Act 1948, was enacted with the prime objective of
protecting workmen employed in factories against
industrial and occupational hazards. There are number
of Acts enacted by the government of India and
amended from time to time; among them the following
are the most important ones in this regard:

- Factories Act, 1948,

- Mines Act, 1952,

- Dock workers (Safety, Health and welfare) Act, 1986,

- Building and other Construction workers (Regulation
of Employment and conditions of service) Act, 1996,

- Plantation Labour Act, 1951,

- Contract Labour (Regulation and Abolition) Act, 1970

- The Child labour (Prohibition and Regulation) Act, 1986,
etc.

Constitutional provisions form the basis of workplace safety
and health laws in India by imposing a duty on the State
governments to implement policies that promote the safety
and health of workers at workplaces. In addition, safety
and health statutes for regulating occupational safety and
health (OSH) of persons at work exist in different sectors,
namely manufacturing, mining, ports, and construction
sector.

The health and safety at work Act,1974 states employers
are responsible for protecting the safety of their employees
at work by preventing potential dangers in the workplace.
It places general duties on employers to ensure the health,
safety and welfare of all persons while at work.

Legislation is a directive proposed by a legislative body
while a regulation is a specific requirement within
legislation. Legislation is broader and more general while
regulation is specific and details how legislation is enforced.

The difference between legislation and regulation is that
legislation is the act of process of making certain laws
while regulation is maintaining the law or set of rules that
govern the people. It is a government-driven or ministerial
order having the force of law.
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The ILO's primary goal is to promote opportunities for
women and men to obtain decent and productive work in
conditions of freedom, equity, security and human dignity.
In 2003 the ILO adopted a global strategy to improve
preventive standards on occupational safety and health to
provide essential tools for governments, employers, and
workers to establish safe practices and health culture for
providing maximum safety at work.

The four important aims of health and safety legislation is
to

i secure the safety, health and welfare of employees and
other people at work;

ii protect the public from the safety and health risks of
business activities;

iii amend statutes relating to safety aspects of
substances, equipment and environment;

iv eliminate workplace risks at the source.

Occupational safety and health Tips:

- Be aware of your surroundings.

- Maintain a correct posture.

- Take break regularly.

- Use Equipment properly.

- Locate Emergency Exits.

- Report Unsafe conditions.

- Practice Effective Housekeeping.

- Make use of mechanical aids.

- Wear the correct Safety equipment.

- Reduce workplace stress.

CG& M: TDM (Dies & Moulds) (NSQF - Revised 2022) - R.Theory for Ex. 1.1.05
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C G & M Related Theory for Exercise 1.1.06
Tool & Die Maker (Dies & Moulds) - Safety

Safety signs
Objective : At the end of this lesson you shall be to
• state the safety attitude and list the four basic categories of safety signs.

Safety signs: As you go about your work on a construction
site you will see a variety of signs and notices. Some of
these will be familiar to you - a 'no smoking' sign for
example; others you may not have seen before. It is up to
you to learn what they mean - and to take notice of them.
They warn of the possible danger, and must not be ignored.

Safety signs fall into four separate categories. These can
be recognised by their shape and colour. Sometimes they
may be just a symbol; other signs may include letters or
figures and provide extra information such as the clearance
height of an obstacle or the safe working load of a crane.

The four basic categories of signs are as follows:

- prohibition signs (Fig 1 & Fig 5)

- mandatory signs (Fig 2 & Fig 6)

- warning signs (Fig 3 & Fig 7)

- information signs (Fig 4)

Mandatory signs
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Warning signs Question about your safety

Do you know the general safety rules that cover your place
of work?

Are you familiar with the safety laws that govern you
particular job?

Do you know how to do your work without causing danger
to yourself, your workmates and the general public?

Are the plant, machinery and tools that you use really
safe? Do you know how to use them safely and keep
them in a safe condition?

Do you wear all the right protective clothing, and have you
been provided with all the necessary safety equipment?

Have you been given all the necessary safety information
about the materials used?

Have you been given training and instruction to enable
you to do your job safely?

Do you know who is responsible for safety at your place of
work?

Do you know who are the appointed 'Safety
Representatives'?

CG& M: TDM (Dies & Moulds) (NSQF - Revised 2022) - R.Theory for Ex. 1.1.06
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C G & M Related Theory for Exercise 1.1.07
Tool & Die Maker (Dies & Moulds) - Safety

Response to emergencies
Objectives: At the end of this lesson you shall be able to
• respond incase of power failure, system failure and fire
• report an emergency.

Power failure, System failure & Fire

1 If there is a power failure, start the emergency generator.
This provides power to close the shutter, which is the
first priority.  The generator will also keep the UPSs
and the cryogenic compressors running,

- Get a flash light.

- Look out for power transfer switch and switch over
to normal power to emergency power by pressing
the latch.

- Check the fuel valves open or not - Open the valves.

- Check to see that the main breaker switch ON the
generator is in OFF position.

- Move the starter switch of the generator to run
position.  The engine will start at once.

- Allow few minutes to warm up the engine.

- Check all the gauges, pressure, temperature,
voltage and frequency.

- Check the "AC line" and "Ready" green light on the
front panel.

2 System failure

- If the bug or virus, invades the system.  The system
failure happens.

- Several varieties of bugs are there

1 Assasin bug

2 Lightening bug

3 Brain bug

For more details refer instruction manual for "System
failure".

3 Fire

When fire alarm sounds in your buildings

- Evacuate to outside immediately.

- Never go back

- Make way for fire fighters and their trucks to come

- Never use an elevator

- Do not panic

Report an emergency

Reporting an emergency is one of those things that seems
simple enough, until actually when put to use in emergency
situations. A sense of shock prevail at the accident sites.
Large crowd gather around only with inquisitive nature,
but not to extend helping hands to the victims. This is
common in road side injuries. No passer by would like to
get involved to assist the victims. Hence first aid
managements is often very difficult to attend to the injured
persons. The first aiders need to adapt multitask strategy
to control the crowd around, communicate to the rescue
team, call ambulance etc, all to be done simultaneously.
The mobile phones helps to a greater deal for such
emergencies. Few guidelines are given below to approach
the problems.

Assess the urgency of the situation. Before you report an
emergency, make sure that the situation is genuinely
urgent. Call for emergency services if you believe that a
situation is life-threatening or otherwise extermely
disruptive.

- A fire - If you're reporting a fire, describe how the fire
started and where exactly it is located. If someone
has already been injured, missing, report that as well.

- A life - threatening medical emergency, explain how
the incident occurred and what symptoms the person
currently displays.

Call emergency service

The emergency number varies - 100 for Police & Fire, 108
for Ambulance.

Report your location

The first thing the emergency dispatcher will ask where
you are located, so the emergency services can get there
as quickly as possible. Give the exact street address, if
you're not sure of the exact address, give approximate
information.
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C G & M Related Theory for Exercise 1.1.08
Tool & Die Maker (Dies & Moulds) - Safety

Importance of house keeping
Objectives: At the end of this lesson you shall be able to
• list the steps involves in house keeping
• state good shop floor practices followed in industry

Housekeeping

The following activities to be performed for better up keep
of working environment:

- Cleaning of shop floor: Keep clean and free from
accumulation of dirt and scrap daily

- Cleaning of Machines : Reduce accidents to keep
machines cleaned well

- Prevention of Leakage and spillage: Use splash
guards in machines and collecting tray

- Disposal of Scrap- Empty scrap, wastage, sward from
respective containers regularly

- Tools Storage- Use special racks, holders for
respective tools

- Storage Spaces: Identify storage areas for respective
items. Do not leave any material in gangway

- Piling Methods- Do not overload platform, floor and
keep material at safe height.

- Material handling: Use forklifts, conveyors and hoist
according to the volume and weight of the package.

Good shop floor practices followed in industry

Good Shop floor practices are motivating action plans for
improvement of the manufacturing process.

- All workers are communicated with daily target on
manufacturing, activities.

- Informative charts are used to post production, quality
and safety results compared to achievements.

- Workers are trained on written product quality
standards.

- Manufactured parts are inspected to ensure adherence
to quality standards.

- Production processes are planned by engineering to
minimize product variation.

- 5s methods are used to organize the shop floor and
production lines.

- Workers are trained on plant safety practices in
accordance with Occupational Safety Health (OSH)
standards.

- Workers are trained on "root cause" analysis for
determining the causes of not following.

- A written preventive maintenance plan for upkeep of
plant, machinery & equipment

- Management meets with plant employees regularly to
get input on process improvements.

- Process Improvement Teams are employed to
implement "best practices"

Introduction to 5S concept and its application
Objectives: - At the end of this lesson you shall be able to
• stat what is 5S
• state the general benefits of implementing 5S
• explain the terms in 5S and its concept of implementation.

Introduction

5S is a philosophy and a way of organizing and managing
the workspace and work flow with the intent to improve
efficiency by eliminating waste, improving flow and reducing
process unreasonableness. There are five steps in the
system, each starting with the letter S:

1 Sort 2  Set in order 3 Shine
4 Standardize 5  Sustain

The Steps of 5S (Fig 1)

5S was created in Japan, and the original "S" terms were
in Japanese, so English translations for each of the five
steps may vary. The basic ideas and the connections
between them are easy to understand, though.
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Step Name Japanese term Explanation

1 Sort Seri (tidiness) Remove unnecessary items from each area

2 Set In Order Seiton (orderliness) Organize and identify storage for efficient use

3 Shine Seiko (cleanliness) Clean and inspect each area regularly

4 Standardize Seiketsu (standardization) Incorporate 5S into standard
operating procedures

5 Sustain Shinseki (discipline) Assign responsibility, track progress, and continue the cycle

Step 1 Sort

The first step in the 5S process is Sort, or "seiri," which
translates to "tidiness." The goal of the Sort step is to
eliminate clutter and clear up space by removing things
that don't belong in the area. (Fig 2)

Step 4: Standardize

The fourth step is Standardize, or "seiketsu," which simply
means standardization. By writing down what is being done,
where, and by whom, you can incorporate the new
practices into normal work procedure. This paves the way
for long-term change.(Fig 5)

Step 2: Set In Order

The second step, Set in Order, was originally called
"seiton," which translates to "orderliness." A variety of
names have been used in English: "Systematic
Organization," "Straightening Out," and "Simplify," for
example. No matter what it's called, the goal of this step
is to organize the work area. Each item should be easy to
find, use, and return: a place for everything, and everything
in its place. (Fig 3)

Implementation steps of Set in order

- Draw up a map, and then implement it

- Physically arrange the workplace first, and then map it
out

- Map as you go, testing ideas and writing down what
works well

Step 3: Shine

The third step of 5S is Shine, or "seiso," which means
"cleanliness." While the first and second steps cleared
up space and arranged the area for efficiency, this step
attacks the dirt and grime that inevitably builds up
underneath the clutter, and works to keep it from coming
back.(Fig 4)

Tools for Standardizing
- 5S checklists
- Job cycle charts
- Procedure labels and signs

Step 5: Sustain

The fifth step of a 5S program is Sustain, or "shitsuke,"
which literally means "discipline." The idea here is
continuing commitment. It's important to follow through
on the decisions that you've made and continually return
to the earlier steps of 5S, in an ongoing cycle. (Fig 6)

Sustaining a 5S program can mean different things in
different work places, but there are some elements that
are common in successful programs.
- Management support
- Department tours
- Updated training
- Progress audits
- Performance evaluations

CG& M: TDM (Dies & Moulds) (NSQF - Revised 2022) - R.Theory for Ex. 1.1.08

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



21

C G & M Related Theory for Exercise 1.1.9-11
Tool & Die Maker (Dies & Moulds) - Safety

Operation of electrical mains
Objectives : At the end of this lesson you shall be able to
• explain the term 'emergency'
• explain the need to switch off the circuit during emergency
• explain the method of locating the area sub-main and switches in the shop floor
• explain the position of handle with respect to ON & OFF in case of iron clad

switches, MCB and ordinary house hold stitches.

An emergency is an unexpected occurrence and requires
immediate action.  In a place like a workshop such a
situation can arise when a person gets a shock due to
electrical current or a person gets injured by the rotating
part of a machine.

In such situations, switching off the supply will be the first
and best solution to avoid further damage to the victim.
For this, every person involved in the workshop should
know which switch controls the area where the victim of
shock remains.

Normally the total wiring in a workshop is controlled by a
main switch and the different areas within the workshop
may have two or more sub-main switches as shown in
Fig.1.

To ascertain the area of the sub-main control, switch off
one of the sub-main switches and try to switch 'on' the
lights, fans and power points in that suspected area. If
they do not work, then the area covered by the fan, light
and power points are controlled by the sub-main switch.
One after another, switch off the sub-main switches and
locate their area of control. Mark the area of control of the
switch in the plan of the wireman's section.

In a well organised workshop, the main switch, the sub
main switches and distribution ways will have clear marking
to show their area of control. (Fig 1) If this is not found, do
this now. However, If you are not sure about the area of
control the sub-main of the switches it is always better to
switch 'off' the main switch itself.

The emergency situations could happen even at home
Hence, identify the area of control of the switch and mark
them in the main/sub-main/ distribution bound of your house
switch board as a safety measure. Educate the intimates
of the house how to switch off the circuit in case of any
emergency.

The handle of iron clad switches and the knob of MCB
should be pushed down to switch 'off ' the circuits as shown
in Fig 2. whereas in the ordinary switches, the switch off
the circuit should be done by pushing the switch to upward
position. (Fig 3)
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Electrical safety
Objectives : At the end of this lesson you shall be able to
• explain the necessary of adopting the safety rules
• list the safety rules and follow them.

Safety rules

Necessity of safety rules: Safety consciousness is one
of the essential attitudes required for any job. A skilled
electrician always should strive to form safe working
habits. Safe working habits always save men, money and
material. Unsafe working habits always end up in loss of
production and profits, personal injury and even death. The
safety hints given below should be followed by Electrician
to avoid accidents and electrical shocks as his job involves
a lot of occupational hazards.

The listed safety rules should be learnt, remembered and
practised by every electrician. Here a electrician should
remember the famous proverb, "Electricity is a good
servant but a bad master".

Safety rules

- Only qualified persons should do electrical work

- Keep the workshop floor clean, and tools in good
condition.

- Do not work on live circuits, if unavoidable, use rubber
gloves rubber mats, etc.

- Use wooden or PVC insulated handle screwdrivers
when working on electrical circuits.

- Do not touch bare conductors.

- When soldering, place the hot soldering irons in their
stand. Never lay switched 'ON' or heated soldering iron
on a bench or table as it may cause a fire to break out.

- Use only correct capacity fuses in the circuit. If the
capacity is less it will blow out when the load is
connected. If the capacity is large, it gives no protection
and allows excess current to flow and endangers men
and machines, resulting in loss of money.

- Replace or remove fuses only after switching off the
circuit switches.

- Use extension cords with lamp guards to protect lamps
against breakage and to avoid combustible material
coming in contact with hot bulbs.

- Use accessories like sockets, plugs and switches and
appliances only when they are in good condition and
be sure they have the mark of BIS (ISI). (Necessity
using BIS (ISI) marked accessories is explained under
standardisation.

- Never extend electrical circuits by using temporary
wiring.

- Stand on a wooden stool, or an insulated ladder while
repairing live electrical circuits/appliances or replacing
fused bulbs. In all the cases, it is always good to open
the main switch and make the circuit dead.

- Stand on rubber mats while working/ operating switch
panels, control gears etc.

- Position the ladder, on firm ground.

- While using a ladder, ask the helper to hold the ladder
against any possible slipping.

- Always use safety belts while working on poles or high
rise points.

- Never place your hands on any moving part of rotating
machine and never work around moving shafts or
pulleys of motor or generator with loose shirt sleeves
or dangling neck ties.

- Only after identifying the procedure of operation, operate
any machine or apparatus.

- Run cables or cords through wooden partitions or floor
after inserting insulating porcelain tubes.

- Connections in the electrical apparatus should be tight.
Loosely connected cables will heat up and end in fire
hazards.

- Use always earth connection for all electrical appliances
along with 3-pin sockets and plugs.

- While working on dead circuits remove the fuse grips;
keep them under safe custody and also display 'Men
on line' board on the switchboard.

- Do not meddle with inter locks of machines/switch gears

- Do not connect earthing to the water pipe lines.

- Do not use water on electrical equipment.

- Discharge static voltage in HV lines/equipment and
capacitors before working on them.

CG& M: TDM (Dies & Moulds) (NSQF - Revised 2022) - R.Theory for Ex. 1.1.09-11
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CG & M Related Theory for Exercise 1.1.12
Tool & Die Maker (Dies & Moulds) - Safety

Games to improve your memory
Objectives : At the end of this lesson you shall be able to
• list the benefit of playing memory games
• describe what is a crossword pussle
• brief what is sudoku game
• highlights the importance of chess game.

As an organic storage device, the brain compares pretty
favourably to digital drives. It's believed to be able to retain
up to 2.5 pet bytes of information-that's akin to nearly three
million hours of television. Being able to retrieve all of that
knowledge, however, is a different matter. To help the
process along, we've compiled a list of games that can help
sharpen both your long- and short-term memory.

Do a Crossword-Just Not Too Often

Crossword puzzles remain the go-to cognitive exercise,
with studies showing a strong correlation between the habit
and delayed onset of dementia. But the problem with
crosswords as a memory and overall brain booster is that
you can get too good at them: If you're able to put your pen
down in record time, you're probably not giving yourself
enough of a challenge. Try alternating crosswords with
other word-search games to keep your brain engaged.

Sudoku

This number game has been a staple of newspapers for
years, and for good reason. By having to keep a series of
numbers in your head while mentally "rehearsing" their
placement in the nine-space grids, you're relying heavily on
working memory. But bear in mind, Sudoku is believed to
be most effective early on, before your brain has gotten
used to organizing the numbers. If it gets easier, it's time
to try something new.

Chess

Chess is one of the most intellectually challenging games
around, though newer players often rely on short-term
memory in order to analyze the board and plot their next
move on the spot. More experienced players have
committed strategies to their long-term memory, shifting
the exercise to retaining information for the long haul.
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CG & M Related Theory for Exercise 1.1.13-14
Tool & Die Maker (Dies & Moulds) - Safety

Motivation
Objectives : At the end of this lesson you shall be able to
• define the concept of motivation
• list the types of motivation in teaching and training
• analyse the result of reinforcement in learning motivation
• explain the motivational functions of instructor in modifying the behaviour of learners.

The terms ‘motivation’ is derived from the word “motive”
which may be defined as needs, wants, drives or impulses
within an individual.

Motivation is the hidden force within us which impels us to
behave in a particular way. The inducement to the people
to contribute effectively and efficiently as possible is called
motivation.

Human motives are based on needs, desire, wishes, drives,
interests inclination, purpose etc. Thus, motivation is an
act of energising and activating the people to satisfy their
needs.

Motivation is the important factor in the learning process.
It is important for an instructor to know the general
principles of motivation.

In the field of teaching and training two fundamentally
different types of motives may be distinguished.

“Intrinsic” motives which drives for knowledge and activity
without the consideration of the result or consequence.

“Extrinsic” motives which are directed towards the
achievement of goal such as learning a skill in order to
earn money.

Trainer have a tendency to value intrinsic motivation more
highly than extrinsic motivation. Extrinsic motivation,
however, cannot be fully neglected and should not be looked
separately.

Reinforcement

Reinforcement plays an important role in influencing the
learning process. Reinforcement occurs when the learner
can see that his efforts have led to success. A person who
has such a pleasant experience of success will
understandably have a tendency to repeat the activity again
and again. In this way successful learning can lead to a
continuous renewed willingness to learn. A person whose
efforts have met with failure for long duration and frequently
will have an expectation of failure before every new learning
situation. This negative reinforcement acts as a barrier to
learning. (Fig 1)

Behaviour modification

The behaviour modification techniques that a teacher or
instructor can adopt includes.

- Extinction : Ignoring failures to reinforce “undesirable
forms of behaviour or mistakes” by not noticing them.

- Counter conditioning : “Undesirable form of behaviour
or mistakes” leads to an unpleasant experience for the
learner. (Punishment, scolding, reprimands, marking
mistakes with thick red pencils / pen, condemnation
etc.)

- Learning by imitation : The teacher or instructor is
himself a model or provides a behavioural model in
some other way.

Motivational function of the trainer / instructor

From the available theory and data of the educational
psychology, the teacher should perform four functions to
motivate the learners, which are as follows:

Arousal function

It is to arouse and maintain learner’s interest. It involves
the initial responsibility of winning the learner’s attention
(readiness to receive the lesson) and the continuing
responsibility of regulating the level of arousal to avoid
both sleep and emotional eruption. To meet this, the trainer
should make the lesson interesting to the learners by
bringing them within the learner’s intellectual range and
helping them to understand that it is worth and valuable.
Changing the position, tone of voice, mood of the trainer,
teaching valuable from one technique to another etc, all
leads to increased motivation of learner.

Expectance function

It is to maintain or modify the learner’s expectation of
success or failure in reaching the instructional objectives.
It requires the trainer to describe concretely the learners
what they will be able to do after the lesson.
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Incentive function

It is to encourage learner in his further effort in the pursuit
of instructional objectives. Feedback of test results, spoken
or written praise or blame, grading, competition and co-
operation are some of the established methods as
successful incentives for learners which increase learner’s
vigour in learning. However, care must be taken that these
incentives do not come as discouragement to other groups
of learners.

Disciplinary function

It is to control the deviant behaviour of the learners through
the use of reward and punishment (Fig 2). A punishment
procedure which involves both the suppression of undesired
response (or behaviour) and the provision of an alternative
reward for desired response (or behaviour) may be a most
effective procedure. This artful combination of punishment
and reward as a disciplinary technique is called “restitution”.
This technique should be adopted by the trainer in a non-
threatening manner.

d Provoking learners by taking an extreme point of
view

e Arousing doubts, setting conflicting requirements

- Stimulation of independent learning by extending the
periods of independent activity during learning process.
Appropriate methods include goup discussion,
individual and group work, projects, role-playing etc.

- Feed back concerning learning success which
encourages positive reinforcement of learning.

Learning starts with what learner knows, and not what the
instructor / teacher knows or starts.

“Learning is change in behaviour”

- What learning means.

- Focal area in psychology of learning.

- Needs of learner.

- Learning materials.

- Learning methods.

- Readiness to learn.

- Methods of Instruction.

- Learning by interaction.

- Environment.

- Psychological factors.

- Types of learning.

- Factors affecting learning process.

What learning means

Learning is a process by which an individual acquires various
habits, knowledge, skill and attitude that are required for
meeting certain objectives. Learning changes the behaviour
of individuals.

For simple job initial learning is fast and the learning curve
shows steep rise (Fig 3). The curve becomes flat as learning
slow down. For simple tasks, steep initial rise in
performance and study of flattening of performance is the
main objective  for complex skill, there may be number of
flattening which refers to hold up or fatigue in the process.

Learning situation

Learning situation that provides necessary atmosphere
required for the acquisition of knowledge, attitudes and
skills. If any one of these is not satisfactory it affects the
effective learning. The learning situation provides
opportunity for learning. The learning situation determines
the quality and speed to provide good learning situation to
the learner.

Techniques of motivation

In order to create effective motivation, the trainer or
instructor should avoid the precipitous path of negative
reinforcement. In general attention should be paid to the
consistent use of reinforcement to promote positive types
of behaviour and achievement through encouragement. In
appropriate behaviour and errors should be largely ignored.
In addition, the following steps may be taken to create
effective motivation:

- Unambiguous objectives and a clear view of the subject
as a whole makes the learner’s motivation increased.

- Connection with the learner’s own interests and
elucidation of ways in which the results of his learning
can be put to practical use.

- Setting of tasks with a moderate degree of difficulty
and a flexible range of difficulty. This results in a
challenge to make an effort as well as the experience
of success in learning.

- Interesting and challenging formulation of questions:

a Creating surprise

b Producing uncertainty

c Raising objectives,
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Needs of learner

Learning can take place in response to the needs of the
learner. When the learner knows the needs of learning,
the learning will be more effective. The instructor should
display their needs, then only they can make them to
start learning.

Learning materials (content)

It is the content to be learnt by the learner. It should be
according to the mental level of the trainees. The content
should be presented in a language that could be understood
by the learner. If the content is in their own mother tongue
/ Regional language the learning will be more effective.

The learning methods

Comprehensive (understanding) learning is better that
cursory (Hasty) learning. Whole learning is better than
part learning. Self evaluation, periodical revision, repetition
of learning and altering modes (manner) of learning are
much important. Learning by trial and error needs good
amount of energy. The method of learning also depends
on the age maturity.

Readiness for learning

For learning readiness is the most important factor.
Learning is based on physical, social, intellectual and
emotional growth. It is very important that the learners
readiness should be ascertained before starting learning
process. The instructor should know the maturity back
ground of the learners for certain kind of learnings. In mass
education teaching, this is not possible to achieve.
Readiness of all trainees may vary from each other as
such some may be ready and some may not be and this
kind of individual differences can’t be avoided.

Method of instruction

The instructional methods affects the learning process. If
the instructional method is not related to the requirements
of learner, the learning will be ineffective. The method of
instruction should be in cognizance (knowledgeable) to
the instructional objectives. The method of teaching should
not be mechanical. The active participation of the trainees
in the teaching, accelerates the absorption of what trainees
learnt. For effective and faster learning teaching and training
aids may be used. Training aids help the learner to retain
better from what the trainees have learnt. Remedial
instructions helps the backward trainers.

Learning by interaction

When a learner feels the needs of the objectives to be
learn and to achieve the goal set for themself they learn
by interacting in their learning situation. This process of
responding to the situation enables them feeling
satisfaction for what they have learnt.

Environment

Physical, residential and social environment is very
important. Outside the institute the trainee must have
facility to apply the knowledge and skill. It is necessary
for instructor and the institute administration to develop
and create healthy and congenial environment which can
bring about good qualities and character in the trainees.
The environment helps the trainees in future to become
good craftsman and better citizens.

Psychological factors

Learning is a process involving communication between
the trainee and instructor. Cordial relationship provide
security and trainees attention. Psychological factor helps
improving self-expression, self ascertain and satisfaction.
Personality requirements are quite important for efficient
learning. Discipline, attitude of instructor, ability of
administrators and involvement of all these connections
are equally important for providing better learning
conditions.
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CG & M Related Theory for Exercise 1.2.15
Tool & Die Maker (Dies & Moulds) - Fitting

Bench vice
Objectives: At the end of this lesson you shall be able to
• state the uses of vice clamps
• explain the size of the bench vice
• state the parts of the bench vice
• explain the care and maintenance of vices.

Vice

Vices are used for holding workpieces. They are available
in different types. The vice used for bench work is the
bench vice. (Engineer’s vice)

A bench vice is made of cast iron or cast steel and it is
used to hold work for filing, sawing, threading and other
hand operations. (Fig 1)

The size of the vice is stated by the width of the jaws.

Parts of a bench vice (Fig 2)

The following are the parts of a vice.

Fixed jaw, movable jaw, hard jaws, spindle, handle, box
nut and spring.

The box nut and the spring are the internal parts.

Vice clamps or soft jaws (Fig 3)

To hold a finished work use soft jaws (vice clamps) made
of aluminium over the regular hard jaws. This will protect
the work surface from damage.

Do not over-tighten the vice as, otherwise, the
spindle may be damaged.

Care and maintenance of vices

• Always keep all threaded and moving parts clean by
wiping the vice with a cloth after each use.

• Make sure to oil and lubricate the joints and sliding
parts.

• To oil the sliding section, open the jaws completely
and apply a layer of grease to the screen.

• Remove the rust if appears on the vice using rust remover
chemical.

• When the vice is not in use bring the jaws lightly gap
together and place the handle in a vertical position.

• Avoid striking the handle of the vice by a hammer for
tightening fully, otherwise the handle will become bend
or damaged.

Positioning of bench vice

Vices are mounted rigidly on a work bench with the fixed
jaw in line with the bench edge to permit a long work to be
clamped in a vertical position (Fig 4).

For the convenience of working, the vice should be held at
a correct height i.e. when the fist is pressed against the
chin the elbow should touch the top of the vice. For further
height adjustments, wooden platforms can be used.

The correct height of a bench vice is shown in Fig 5.
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Precautions

Clamp the work as low as possible on the vice.
Do not give extra leverage while tightening
the work.

Lubricate the spindle and the box-nut
periodically. Do not tighten the jaws of he vices
without any work in between

Do not hammer on the vices for levelling metal

Types of vices
Objectives: At the end of this lesson you shall be able to
• state the different types of vices
• state the uses of  quick relasing vice, pipe vice, hand vice, pin vice and leg vice.

There are different types of vices used for holding work-
pieces. They are quick releasing vice, pipe vice, hand vice,
pin vice and toolmaker’s vice.

Quick releasing vice (Fig 1): A quick releasing vice is
similar to an ordinary bench vice but the opening of the
movable jaw is done by using a trigger (lever).  If the trigger
at the front of the movable jaw is pressed, the nut
disengages the screw and the movable jaw can be set in
any desired place quickly.

Pipe vice (Fig 2): A pipe vice is used for holding round
sections of metal, tubes and pipes.  In the vice, the screw
is vertical and movable. The jaw works vertically.

The pipe vice grips the work at four points on its surface.
The parts of a pipe vice are shown in Fig 2.

Hand vice (Fig 3): Hand vices are used for gripping screws,
rivets, keys, small drills and other similar objects which
are too small to be conveniently held in the bench vice. A
hand vice is made in various shapes and sizes.  The length
varies from 125 to 150 mm and the jaw width from 40 to 44
mm. The jaws can be opened and closed using the wing
nut on the screw that is fastened to one leg, and passes
through the other.

Pin vice (Fig 4): The pin vice is used for holding small
diameter jobs. It consists of a handle and a small collet
chuck at one end.  The chuck carries a set of jaws which
are operated by turning the handle.
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Toolmaker’s vice (Fig 5): The toolmaker’s vice is used
for holding small work which requires filing or drilling and
for marking of small jobs on the surface plate. This vice is
made of mild steel.

Toolmaker’s vice is accurately machined.

Leg vice

A leg vice is a holding device generally used in a forge shop
for bending and forging work. It is made fo mild steel to avoid
breakage while hammering.

Main pats of a leg vice (Fig 6)

The following are the main parts of a leg vice.

1 Solid jaw 2 Movable jaw

3 Threaded jaw 4 Spindle

5 Spring 6 Pivot

7 Leg 8 Clamp

Since the hinged jaw moves in a radial path, the job held in
this vice is not gripped properly because of the line contact.
(Fig 7) Hence a work which can be carried out on a bench
vice is not held on a leg vice. Jobs which require hammering
only are held on a leg vice.

Hacksaw frames and blades
Objectives: At the end of this lesson you shall be able to
• explain the different types of hacksaw frames
•  explain the different type of hacksaw blades
• describe the method of sawing

Hacksaw frame: A hacksaw frame is used along with a
blade to cut metals of different sections, and is specified
by the type and maximum length of the blade that can be
fixed.

Example

Adjustable hacksaw frame - tubular - 250 - 300mm or 8" -
12"

Types of hacksaw frames

Solid frame (Fig 1a): Only a blade of a particular standard
length can be fitted to this frame. e.g 300 mm or 250 mm.

Adjustable frame (flat type): Different standard lengths
of blades can be fitted to this frame i.e. 250 mm and
300 mm.

CG& M: TDM (Dies & Moulds) (NSQF - Revised 2022) - R.Theory for Ex. 1.2.15

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



30

Adjustable frame (tubular type) (Fig 1b): This is the most
commonly used type. It gives a better grip and control,
while sawing.

Parts of a hacksaw frame

1 Handle

2 Frame

3 Tubular frame with holes for length adjustment

4 Retaining pins

5 Fixed blade-holder

6 Adjustable blade-holder

7 Wing-nut

A hacksaw blade is made of either low alloy steel (LA) or
high speed steel (HSS), and is available in standard lengths
of 250 mm and 300mm. (Fig 2)

Parts of a hacksaw blade (Fig 2)

1 Back edge 2 Side

3 Centre line 4 Pin holes

Type of hacksaw blades

All-hard blade: The full length of the blade between the
pins is hardened and it is used for harder metals such as
tool steel, die steel and HCS.

Flexible blade: Only the teeth are hardened. Because
of their flexibility these blades are useful for cutting along
curved lines. Flexible blades should be thinner than all-
hard blades.

Pitch of the blade (Fig 3): The distance between adjacent
teeth is known as the ‘pitch’ of the blade.

    Classification          Pitch

Coarse 1.8 mm

Medium 1.4 mm & 1.0 mm

Fine 0.8 mm

Specification: Hacksaw blades are specified by the
length, pitch and type of material. (The width and thickness
of blade is standardised)

Example

300 x 1.8 mm pitch LA all-hard blade.

To prevent the hacksaw blade binding when penetrating
into the material, and to allow free movement of the blade,
the cut is to be broader than the thickness of the hacksaw
blade. This is achieved by the setting of the hacksaw teeth.
There are two types of hacksaw teeth settings.

Staggered set (Fig 4): Alternate teeth or groups of teeth
are staggered. This arrangement helps for free cutting,
and provides for good chip clearance.

Wave set (Fig 5): In this, the teeth of the blade are arranged
in a wave-form. The types of sets for different pictures are
as follows:

   Pitch            Type of set

0.8 mm Wave-set

1.0 mm Wave-set or staggered

Over 1.0 mm Staggered

For the best results, the blade with the right pitch should
be selected and fitted correctly.

Selection of blade: The selection of the blade depends
on the shape and hardness of the material to be cut.
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Pitch selection (Fig  6): For soft materials such as bronze,
brass, soft steel, cast iron, heavy angles etc. use a 1.8
mm pitch blade.

For tool steel, high carbon, high speed steel etc. use a
1.4 mm pitch. For angle iron, brass tubing, copper, iron
pipe etc. use a 1 mm pitch blade. (Fig 7)

For conduit and other thin tubing, sheet metal work etc.
use a 0.8 mm pitch. (Fig 8)

Method of sawing

Select the correct blade for the material to be cut.

HSS - Blades are used for tough resistant materials

High Carbon Steel - General cutting

Select the correct number of teeth / inch the general rule
is that atleast 3 teeth should extend across the surface of
the material to be cut.

The hand holds the hacksaw handle, and the index finger
is support the handle and also points in the direction of
cutting.

The other hand holds the frame, near the wing nut.  Cutting/
sewing should be carried out close to the jaws of the vice.
This ensures that the metal does not flex or bend under
the force of the hacksaw and the sawing motion.
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CG & M Related Theory for Exercise 1.2.16
Tool & Die Maker (Dies & Moulds) - Fitting

Elements of a file
Objectives: At the end of this lesson you shall be able to
• state what is file in fitting shop
• state the parts of a file
• state the material of a file.

File: A File is a hand cutting tool used to remove fine
amount of material from a workpiece. It is commonly used
in woodand metal working.

Filing is a method for removing excess material from a
workpiece by using a file which acts as a cutting tool.
Fig 1 shows how to hold a file. Files are available in many
shapes and sizes.

Parts of a file (Fig 2)

The parts of a file can be seen in Fig 2, are

Tip or Point

the end opposite to tang

Face or side

The broad part of the file with teeth cut on its surface

Edge

The thin part of the file with a single row of parallel teeth

Heel

The portion of the broad part without teeth

Shoulder

the curved part of the file separating tang from the body

Tang

The narrow and thin part of a file which fits into the handle

Handle

The part fitted to the tang for holding the file

Ferrule

A protective metal ring to prevent cracking of the handle.

Materials

Generally files are made of high carbon or high grade cast
steel. The body portion is hardened and tempered. The
tang is however not hardened.

Types of files
Objectives: At the end of this lesson you shall be able to
• explain the different shape of files(types)
• state the uses of  flat files, Hand files  square, round, half round, triangular and knife-edge files
• state the correct shape of files for filing different profiles.

For  filing and finishing different profiles, files of
different shapes are used

The shape of files is stated by its cross section.

Common files of different shapes: Flat file, Hand file,
Square file, Round file, Half round file, Triangular file and
Knife-edge file.

Flat file (Fig 1 )

These files are of a rectangular cross section. The edges
along the width of these files are parallel up to two-thirds
of the length, and then they taper towards the point. The
faces are double cut, and the edges single cut. These
files are used for general purpose work. They are useful
for filing and finishing external and internal surfaces.
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Hand file (Fig 2)

These files are similar to the flat files in their cross section.
The edges along the width are parallel throughout the length.
The faces are double cut. One edge is single cut whereas
the other is safe edge. Because of the safe edge, they are
useful for filing surfaces which are at right angles to
surfaces already finished.

Flat files are general purpose files. They are
available in all grades. Hand files are
particularly useful for filing at right angles to
athe finished surface.

Square File: The square file is square in its cross section.
It is used for filing square holes, internal square corners,
rectangular openings, keyways and splines. (Fig 3)

Round file: A round file is circular in its cross section. It
is used for enlarging the circular holes and filing profiles
with fillets. (Fig 4)

Half round file: A half round file is in the shape of a
segment of a circle. It is used for filing internal curved
surfaces. (Fig 5)

Triangular file: A triangular file is of a triangular cross
section. It is used for filing corners and angles which are
more than 60o. (Fig 7)

Square, round, half-round and triangular files are available
in lengths of 100, 150, 200, 250, 300 and 400mm. These
files are made in bastard, second cut and smooth grades.

Knife edge file: A knife edge file has the cross section of
a sharp triangles. It is used for filing narrow grooves and
angles above 10o (Fig 6)

The above files have one third of their lengths tapered.
They are available both single and double cuts.

Needle files
Objectives: At the end of this lesson you shall be able to
• explain the different shapes of needle files
• state the needle  files as per BIS.

Needle files are usually available in sets with assorted
shapes. These types of files are used for delicate, light
kinds of work. These files are available in bastard and
smooth grade.

Shapes:The common shapes of needle files are shown in
figure 1. The shapes are round edge, flat edge, flat taper,
half round, triangular, square, round, knife, feather edge,
crossing, barret and marking. (Fig 1)
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Special files
Objectives: At the end of this lesson you shall be able to
• explain the different types of special files
• state the uses of each type of special files.

In addition to the common type of files, files are also
available in a variety of shapes for ‘special’ applications.
These are as follows.

Riffler files (Fig 1): These files are used for die-sinking,
engraving and in silversmith’s work. They are made in
different shapes and sizes and are made with standard
cuts of teeth.

Nomenclature of needle files. (Fig 2)

Length: These files are available in a nominal length of
120mm to 180mm.

Grades: The grades of cut may be identified by the cut
number as follows

- bastard   - Cut 0.

- smooth - Cut 2.

Designation of needle files: The needle files are
designated by their names

- grade of cut

- nominal length

- BIS number

Example

A flat edge needle file with grade of cut bastard, having a
nominal length of 160mm shall be designated as flat edge
needle file bastard, 160 IS 3152

Mill saw files (Fig 2): Mill saw files are usually flat and
have square or rounded edges. These are used for
sharpening teeth of wood-working saws, and are available
in single cut.

Crossing file (Fig 3): This file is used in the place of a
half round file. Each side of the file has different curves. It
is also known as ‘fish back’ file.

Barrette file (Fig 4): This file has a flat, triangular face
with teeth on the wide face only. It is used for finishing
sharp corners.

Tinker’s file (Fig 5): This file has a rectangular shape
with teeth only at the bottom face. A handle is provided on
the top. This file is used for finishing automobile bodies
after tinkering.
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Rotary files (Fig 6): These files are available with a round
shank. They are driven by a special machine with a portable
motor and flexible shaft. These are used in diesinking and
mould-making work.

Machine files for hand filing machine (Fig 7): Machine
files are of double cut, having holes or projections to fix to
the holder of the filing machine. The length and shape will
vary according to the machine capacity. These files are
suitable for filing the inner and outer surfaces, and are
ideal for diesinking and other tool-room work.

Pinning of files
Objective: At the end of this lesson you shall be able to
• explain the pinning of file.

During filing, sometimes the metal chips (filings) will clog
between the teeth of files. This is known as ‘pinning’ of
files.

Files which are pinned will produce scratches on the
surface being filed, and also will not bite well.

Pinning of the files is removed by using a file brush also
called a file card, (Fig 1) with either forward or backward
stroke.

Filings which do not come out easily by the file card should
be taken out with a brass or copper strip. (Fig 2)

For new files, use only soft metal strips (brass or copper)
for cleaning. The sharp cutting edges of the files will wear
out quickly if a steel file card is used. When filing a
workpiece to a smooth finish more ‘pinning’ will take place
because the pitch and depth of the teeth are less.
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Care and maintenance of file
Objective: At the end of this lesson you shall be able to
• state the care and maintenance of file.

•   Do not use files having the blunt cutting edge

• Remember that files cut on the push stroke. Never
apply the pressure on the pull stroke, or you could crush
the file teeth, blunt them or cause them to break off.

• Prevent from pinning.

Cut of files
Objectives: At the end of this lesson you shall be able to
• explain the different cuts of files
• state the uses of each type of cut.

The teeth of all file are formed by cuts made on its face.
Files have cuts of different types. Files with different cuts
have different uses.

Types of cuts

Basically there are four types.

Single cut, Double cut, Rasp cut and Curved cut.

Single cut file (Fig 1)

A single cut file has rows of teeth cut in one direction across
its face. The teeth are at an angle of 600 to the centre line.
It can cut chips as wide as the cut of the file. Files with this
cut are useful for filing soft metals like brass, aluminium,
bronze and copper.

this, is known as UPCUT, and is at an angle of 510 . This
removes stock faster than the single cut file.

Rasp cut file (Fig 3)

The rasp cut has individual, sharp, pointed teeth in a line,
and is useful for filing wood, leather and other soft materials.
These files are available only in half round shape.

Application of chalk on the face of the file will help reduce
the penetration of the teeth and ‘pinning’.

Clean the file frequently in order to remove the filings
embedded in the chalk powder.

• Giving your files teeth a light brush with oil during long
storage.

• Normally do not apply any oil while filing.

• Files should be stored separatelly so that their faces
cannot rub against each other or against other tools.

Single cut files do not remove stock as fast double cut files,
but the surface finish obtained is much smoother.

Double cut file (Fig 2)

A double cut file has two rows of teeth cut diagonal to each
other. The first row of teeth is known as OVERCUT and they
are cut at an angle of 700 . The other cut, made diagonal to

Curved cut file (Fig 4)

These files have deeper cutting action and are useful for
filing soft materials like - aluminium, tin, copper, and
plastic.
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File specifications and grades
Objectives: At the end of this lesson you shall be able to
• state how files are specified
• explain the different grades of files
• state the application of each grade of file.

The curved cut files are available only in a flat shape.

The  selection of a file with a particular type of
cut is based on the material  to be filed. Single
cut files are used for filing soft materials. But
certain special files, for example, those used
for sharpening saws, are also of single cut.

Table (1)

 Grade of files (Number of cuts over the length of 10mm)

Length of file     Rough  Bastard Second cut    Smooth Deadsmooth

150mm 8 13 17    24 33

200mm 7 11 16    22 31

250mm 6 10 15    20 30

300mm 5 9 14    19 28

Files are manufactured in different types and grades to
meet the various needs.

Files are specified according to their length, grade, cut and
shape.

Length is the distance from the tip of a file to the heel.

File grades are determined by the spacing of the teeth.

A rough file is used for removing
rapidly a larger quantity of metal. It
is mostly used for trimming the
rough edges of soft metal castings.

A bastard file is used in cases
where there is a heavy reduction of
material

A second cut file is used to give a good
finish on metals. It is excellent to file
hard metals. It is useful for bringing the
jobs close to the finishing size.

A smooth file is used to remove small
quantity of material and to give a good
finish.

A dead smooth file is used to bring the
material to accurate size with a high
degree of finish.

The most used grades of files are bastard, second cut,
smooth and dead smooth.These are the the grades
recommended by the bureau of indian standards
(BIS)

Different sizes of files with the same grade will have varying
sizes of teeth. In longer files, the teeth will be coarser.

The number of cutting edge in rows in each of the above
grades over a Length of 10mm as shown in Table (1).
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CG & M Related Theory for Exercise 1.2.17
Tool & Die Maker (Dies & Moulds) - Fitting

Hammers
Objectives: At the end of this lesson you shall be able to
• state the uses of an engineer’s hammer
• identify the parts of an engineer’s hammer
• name the types of engineer’s hammer
• specify the engineer’s hammer.

An engineer’s hammer is a hand tool used for striking
purposes while punching, bending, straightening, chipping,
forging or rivetting.

Major parts of a hammer: The major parts of a hammer
are the head and the handle.

Hammer is made of drop - forged carbon steel, while the
wooden handle must be capable of absorbing shock.

The parts of a hammer - head are face (1), pein (2) cheek
(3) and the eyehole (4).

Face: The face is the striking portion. A slight convexity is
given to it to avoid digging of the edge. It is used for striking
while chipping, bending, punching, etc.

Pein: The pein is the other end of the head. It is used for
shaping and forming work like riveting and bending.The
pein is of different shapes such as:

- ball pein (Fig.2a)

- cross - pein (Fig.2b)

- straight pein. (Fig 2c)

The face and the pein are case hardened.

Cheek: The cheek is the middle portion of the hammer
head. The weight of the hammer is stamped here.

This portion of the hammer - head is left soft.

Eyehole: The eyehole is meant for fixing the handle. It is
shaped to fit the handle rigidly. The wedges fix the handle
in the eyehole. (Figs 3 and 4)

Application of hammer pein: The ball pein is used for
riveting. (Fig 5)
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The ball pein hammer is used for driving a chisel in parting
metal. (Fig 8)

The cross- pein is used for spreading the metal in one
direction. (Fig 6)

The straight pein is used at the corners. (Fig 7)

Specification: An engineer’s hammers are specified by their
weight and the shape of the pein. Their weight varies from
125 gms to 750 gms.

The weight of an engineer’s hammer, general work in a
machine/ fitting shop.

The ball pein hammers are used for general work in a
machine/ fitting shop.

Before using a hammer

- make sure the handle is properly fitted

- select a hammer with the correct weight suitable for
the job

- check the hammer head and handle whether any crack
is there

- ensure that the face of the hammer is free from oil or
grease.

Screwdriver
Objectives: At the end of this lesson you shall be able to
• state the different types of screwdrivers and their uses
• specify a screwdriver
• list the precautions to be observed while using screwdrivers.

Screwdrivers are used to tighten or loosen screws and are
available in various lengths.

Hand-held screwdrivers are of the following types.

Standard screwdriver (Light duty) (Fig 1)

It is made of a round shank/blade with metal, wood or
moulded insulated material handle.

Standard screwdriver (Heavy duty) (Fig 2)

The shank is square section for applying extra twisting
force with the end of a spanner. (Fig 3)

Heavy duty screwdriver (London pattern) (Fig 4)

It has a flat blade and is mostly used by carpenters for
fixing and removing wood screws.
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Philips screwdriver (Fig 5)

These are made with cruciform (Fig 6) tips that are unlikely
to slip from the matching slots. (Fig 7) Philips recess head
screws are shown in Fig 8.

The sizes of philips scredrivers are specified by point size
1,2,3 and 4.

Offset scerwdrivers (Fig 9)

These are useful in some situations (Fig 10) where the
normal screwdriver cannot be used because of the length
of the handle. They are also useful for applying greater
turning force.
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For quicker application ratchet offset screwdrivers are also
available with renewable tips. (Fig 11)

Specification

Screwdrivers (Fig 12) are specified according to the

- length of the blade

- width of the tip

Normal blade length: 45 to 300 mm. Width of blade: 3 to
10 mm

The blades of screwdrivers are made of carbon steel or
alloy steel, hardened and tempered.

Screwdrivers for special uses

Small sturdy screwdrivers ar available for use wher there
is limited space. (Fig 13)

Srewdrivers with blades sheathed in insulation are available
for the use of electricians. (Fig 14)

Make sure your hand and the handle are dry.

Hold the screwdriver axis in line with the axis of the screw.

While using a Philips scredriver apply more downward
pressure.

Keep your hand away to avoid injury due to slipping of the
screwdriver. (Fig 16)

Do not use screwdrivers with split or defective handles.
(Fig 17)

In the case of damaged screwdrivers, the blades can be
ground (the faces will be parallel with the sides of the
screw slot) and used. While grinding endure the end of
the tips is as thick as the slot of the screw.
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Spanners
Objectives: At the end of this lesson you shall be able to
• state the uses of spanners of different sizes
• identify the size of a spanner.

A spanner is a hand tool with jaws or opening or a ring at
one end or at both ends or at both ends for tightening or
slackening nuts and bolts and screw heads. (Fig 1) It is
made of drop forged, high tensile or alloy steel and heat
treated for strength.

Types of spanners

• Open and spanners

• Ring spanners

Open and spanners

They can be single-ended or double-ended.

Single-ended spanners (Fig 2)

These are general purpose spanners. Single-ended
spanners are mostly supplied with machine tools for a
specific purpose.

Double-ended spanners (Fig 3)

Double-ended spanners are standard spenners having two
different size openings. Some spanners are made of
chrome vanadium steel.

They are available in a set of 8, Nos 8 to 27 mm. (Fig 3)
8x10, 9x11, 12x13, 14x15, 16x17, 18x19, 20x22 and 24x27
mm.

Open and spanners bigger than 27 mm size are also
available.

Ring spanners (Fig 4,5 & 6)

These types of spanners are used where obstruction close
to the side of a nut prevails (Fig 4) and application of open-
ended spanners is not possible.

These are available in a set of 8 Nos. (8 to 27 mm) 8x9,
10x11, 12x13, 14x15, 16x17, 18x19, 20x22 and 24x27
mm.

Sizes and identification of spanners

Spanners for metric bolts, nuts and screws are marked
with the size across the jaw opening in mm.
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Special purpose spanners

- Tube or tubular box spanners (Figs 7 & 8)

- Socket spanners (Fig 9)

- Adjustable spanners (Figs 10&11)

- Hook spanners (C-spanner) (Figs 12 & 13)
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CG & M Related Theory for Exercise 1.2.18-19
Tool & Die Maker (Dies & Moulds) - Fitting

Linear measurement
Objectives: At the end of this lesson you shall be able to
• explain the base unit of linear measurement as per the international system of units of measurement (SI)
• describe the measuring standards of english and metric units
• state the multiples of a metre and their values
• state the purpose of steel rule
• state  the types of steel rule
• state the precautions to be followed while using a steel rule.

Necessity

All physical quantities are to be measured in terms of
standard quantities.

Unit

A unit is defined as a standard or fixed quantity of one
kind used to measure other quantities of the same kind.

Classification

Fundamental units and derived units are the two
classifications.

Fundamental units

Units of basic quantities of length, mass and time.

Derived units

Units which are derived from basic units and bear a constant
relationship with the fundamental units.

Ex : Area, Volume, Pressure, Force, etc.

System of units

F.P.S. system is the British system in which the basic
units of length, mass and time are foot, pound and second
respectively.

C.G.S. system is the metric system in which the basic
units of length, mass and time are centimetre, gram and
second respectively.

M.K.S system is another metric system in which the basic
units of length, mass and time are metre, kilogram and
second respectively.

S.I. units is referred to as Systems International units which
is again of metric and the basic units, their names and
symbols are Listed in table - 1

Fundamental units and derived units are the
two classification of units.

Length, mass and time are the fundamental
units in all the systems (ie) F.P.S, C.G.S, M.K.S
and S.I systems.

Table 1

Basic Quantity               Metric Unit                              British unit

Name Symbol Name Symbol

Length Metre m Foot F

Mass Kilogram kg Pound P

Time Second S Second S

Current Ampere A Ampere A

Temperature Kelvin K Farenheit Fo

Light intensity Candela Cd Candela Cd

When we measure an object , we are actually comparing
it with a known standard of measurement.

The base unit of length as per SI units is METRE.

Length - SI UNITS and MULTIPLES

Base unit

The base unit of length as per the International Systems
of units (SI) is metre. The table given below lists some
multiples of a  metre.

METRE(m)         = 1000 mm

CENTIMETRE (μm)  = 10 mm

MILLIMETRE  (mm)  = 1000 μm

MICROMETRE ( μm) = 0.001 mm

Measurement in engineering practice

Usually, in engineering practice, the preferred unit of length
measurement is millimetre. (Fig 1)
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Both large and small dimensions are stated in millimetres.
(Fig 2)

The British system of length measurement

An alternative system of length measurement is the British
system. In this system, the base unit is the Imperial
Standard yard. Most countries, including Great Britain itself,
have, however, in the last few years, switched over to SI
units.

Engineer’s steel rule (Fig 3) are used to measure the
dimensions of work pieces.

Steel rules are made of spring steel or stainless steel.
These rules are available in length 150mm, 300mm and
600mm. The reading accuracy of steel rule is 0.5 mm and
1/64 inch.

For accurate reading it is necessary to read vertically to
avoid errors arising out of parallax. (Fig 4)

Steel rule in English measure, they can also be available
with metric and English graduation in a complete range of
sizes 150, 300, 500 and 1000 mm. (Fig 5)

Other types of rule

• Narrow steel rules

• Short steel rules

• Full flexible steel rule with tapered end.

Narrow steel rule

Narrow steel rule is used to measure the depth of keyways
and depth of smaller dia, blind holes of jobs, where the
ordinary steel rule can not reach. Its width is approximately
5 mm and thickness 2 mm. (Fig 6)

Short steel rule (Fig 7)

This set of five small rules together with a holder is
extremely usefull for measurements in confined or hard to
reach locations which prevent the use of ordinary steel
rules. It is used suitably for measuring grooves, short
shoulder, recesses, key ways etc. In machining operation
on shapers, millers and tool and die work.

The rules are easily inserted in the slotted end of the holder
and are rigidly clamped in place by a slight turn of the
knurled nut at the end of the handle. Five rule lengths are
provided 1/4”, 3/8” and 1” and each rule is graduated in
32nds on one side and 64ths on the reverse side.
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Steel rule with tapered end

This rule is a favourate with all mechanics since its tapered
end permits measuring of inside size of small holes, narrow
slots, grooves, recesses etc. This rule has a taper from
1/2 inch width at the 2 inch graduation to 1/8 inch width at
the end. (Fig 8)

For maintaining the accuracy of a steel rule, it is important
to see that its edges and surfaces are protected from
damage and rust.

Do not place a steel rule with other cutting
tools. Apply a thin layer of oil when not in use.

Angular measurement

Angular measurement of angles of an object is usually
expressed in degrees, minutes and seconds. One degree
is divided into 60 minutes and one minute is to 60 seconds.

Measurements of fundamental, derived units

Metric British

Micron 1μ = 0.001 mm Thousandth of an inch  = 0.001”

Millimetre 1 mm = 1000μ Inch   = 1”

Centimetre 1 cm  = 10 mm Foot 1 ft   = 12”

Decimetre 1 dm  = 10 cm Yard 1 yd   = 3 ft

Metre 1 m   = 10 dm 1 furlong 1 fur      = 220 yds

Decametre 1 dam  = 10 metre 1 mile   = 8 furlong

Dividers
Objectives : At the end of this lesson you shall be able to
• state the parts of a divider
• state the uses of dividers
• state the specifications of divider
• state the important hints on divider points.

Dividers are used for scribing circles, arcs and for
transferring and stepping off distances. (Fig 1, 2 and 3)

Dividers are available with firm joints and spring joints.
(Figs 1 & 4). The measurements are set on the dividers
with a steel rule. (Fig 2)

The sizes of dividers range between 50mm to 200mm. The distance from the point to the centre of the fulcrum
roller (pivot) is the size of the divider. (Fig 4)

For the correct location and seating of the divider point
prick punch marks of 30° are used.
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The two legs of the divider should always be of equal length.
(Fig 5) Dividers are specified by the type of their joints and
length.

The divider point should be kept sharp in order to produce
fine lines. Frequent sharpening with an oilstone is better
than sharpening by grinding. Sharpening with an oilstone
is better than sharpening by grinding. Sharpening by
grinding will make the points soft.

Calipers
Objectives: At the end of this lesson you shall be able to
• state the commonly used calipers
• state the advantages of spring joint calipers.

Calipers are indirect measuring instruments used for
transferring measurements from a steel rule to a job, and
vice versa.

Calipers are classified according to their joints and their
legs.

Joint

- Firm joint calipers (Fig 1a)

- Spring joint calipers (Fig 1b)

Legs

- Inside caliper for internal measurement.(Fig 2)

- Outside caliper for external measurement. (Fig 3)

Calipers are used along with steel rules, and the accuracy
is limited to 0.5 mm. Parallelism of jobs etc. can be
checked with higher accuracy by using calipers with
sensitive feel.

Spring joint calipers have the advantage of quick setting
with the help of an adjusting nut. For setting a firm joint
caliper, tap the leg lightly on a wooden surface.
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Jenny calipers
Objectives: At the end of this lesson you shall be able to
• state the uses of a jenny caliper
• state the two types of legs of a jenny caliper.

Jenny calipers have one leg with an adjustable divider point,
while the other is a bent leg. (Fig 1) These are available in
sizes of 150 mm, 200 mm, 250 mm and 300mm.

Jenny calipers are used

- for marking lines parallel to the inside and outside edges
(Fig 2)

- for finding the centre of round bars (Fig 3)

These calipers are available with the usual bent leg or with
heel.

Calipers with bent leg (Fig 2B) are used for drawing lines
parallel along an inside edge. and the heel type (Fig 2A) is
used for drawing parallel lines along the outer edges.

The other names for this caliper are:

- heremaphrodite calipers

- leg and point calipers

- odd leg caliper

Types of marking punches
Objectives: At the end of this lesson you shall be able to
• explain the different punches in marking
• state the features of each punch and its uses.

Punches are used in order to make certain dimensional
features of the layout permanent. There are two types of
punches. They are centre punch and prick punch made of
high carbon steel, hardened and ground.

Centre Punch: The angle of the point is 90° in a centre
punch. This punch mark made by this is wide and not very
deep. This punch is used for locating centre of the holes.
The wide punch mark gives a good seating for starting the
drill. (Fig 1a)

Prick Punch / Dot punch: The angle of the prick punch is
30° or 60°. (Fig 1b) The 30° point punch is used for making
light punch marks needed to position dividers. The divider
point will get a proper seating in the punch mark. The 60°
punch is used for marking witness marks and called as
dot punch. (Fig 2)
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The witness marks should not be too close to
one another.

Marking off and marking off table
Objectives : At the end of this lesson you shall be able to
• state why marking off is necessary
• state the function of witness marks
• state the features of marking tables
• explain the uses of marking tables
• state the maintenace aspects concerning marking tables.

Marking off

Marking off or layout is carried out to indicate the locations
of operation to be done, and provide guidance during rough
machining or filing.

Witness marks

The line marked on metal surfaces is likely to be erased
due to handling. To avoid this, permanent marks are made
by placing punch marks at convenient mark intervals along
the marked line. Punch marks act as a witness against
inaccuracies in machining and hence, they are known as
witness marks.

Marking off table (Figs 1 and 2)

A marking table (marking-off table) is used as a reference
surface for marking on workpieces.

Marking tables are of rigid construction with accurately
finished top surfaces. The edges are also finished at right
angles to the top surface.

Marking tables are made of cast iron or granite, and are
available in various sizes. These tables are also used for
setting measuring instruments, and for checking sizes,
parallelism and angles.

Care and maintenance

A marking table is very precise equipment, and
should be protected from damage and rust.

After use, the marking table should be cleaned
with a soft cloth.

The Surface of the marking table, made of cast
iron, should be protected by applying a thin
layer of oil.
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Visual inspection of raw materials
Objective: At the end of this lesson you shall be able to
• explain rusting, scaling, corrosion

Rusting

Rusting is a chemical process which is common with
metals contaning iron.

In the presence of oxygen and moisture or water iron under
goes this chemical process and form a series of iron oxide

The reddish - brown color compound is known as rust.So
rust contains hydrated iron (III) oxide Fe2O

3

Ways to prevent rust

1 Using rust resistant alloys

2 Galvanization

3 Bluing

4 Organic coating

5 Regular maintenance

Scalling

Scalling occurs when minerals like calcium, carbonate
which can buidup on surfaces.

Ways to prevent scalling

1 Use of protective/antiscale coating.

Corrosion

Corrosion is a process where the metal corrodes. Corrosion
is a natural process and in the presence of a moist
atmosphere, chemically active metals get corroded.
Contrary to the popular belief, rusting and corrosion are
not the same.

Rusting is the process where iron corrodes due to exposure
to the atmosphere. Corrosion is a process where the water
or the moisture on the surfaceof the metal oxidizes with
the atmospheric oxygen,it is an oxidation reaction. The
main circumstance of corrosion occurs with iron because
it is a structural material in construction, bridges, buildings,
rail transport, ship, etc. Aluminium is also an important
structural metal, but even aluminium goes under oxidation
reactions. However, aluminium  doesn’t corrode or oxidize
as rapidly as its reactivity suggests.  An alloys of aluminium
or any other metal like magnesium can make aluminium
stronger,stiffer and harder.

The alkali metals like sodium need to be stored in oil as
they corrode quickly. Less reactive metals like lead and
copper are used to roof situations. Copper (Cu) corrodes
and forms a basic green carbonate and lead corrodes to
form a white lead oxide or carbonate.

Corrosion types and prevention method of corrosion
prevent

• Alloy’s

• Galvanizing

•  Electroplating
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CG & M Related Theory for Exercise 1.2.20
Tool & Die Maker (Dies & Moulds) - Fitting

Vernier calipers
Objectives: At the end of this lesson you shall be able to
• explain the parts of a vernier caliper
• state the constructional features of a vernier caliper
• state the uses of a vernier caliper.

A vernier caliper is a precision measuring instrument. It is
used to measure up to an accuracy of 0.02 mm. (Fig 1)

Parts of a vernier caliper (Numbers as per Fig 1)

Fixed jaws (1 and 2)

Fixed jaws are part of the beam scale. One jaw is used for
taking external measurements, and the other for taking
internal measurements.

Vernier slide (5)

A vernier slide moves over the beam and can be set in any
position by means of a spring-loaded thumb lever.

Beam (6)

The vernier slide and the depth bar attached to it slide over
the beam. The graduations on the beam are called the main
scale divisions.

Depth bar (7)

The depth bar is attached to the vernier slide and is used
for measurement of depth.

Thumb lever (8)

The thumb lever is spring-loaded which helps to set the
vernier slide in any position on the beam scale.

Vernier scale (9)

The vernier scale is graduated and marked on the vernier
slide. The divisions of this scale are called vernier divisions.

Main scale

The main scale graduations or divisions are marked on the
beam.

Sizes

Vernier calipers are available in sizes of 150, 200, 250, 300
and 600 mm. The selection of the size depends on the
measurements to be taken. Vernier calipers are precision
instruments, and therefore, extreme care should be taken
while handling them.

Movable jaws (3 and 4)

Movable jaws are part of the vernier slide. One jaw is used
for external measurements, and the other for internal
measurements. (Figs 2 and 3)
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Never use a vernier caliper for any purpose other than
measuring. Vernier calipers should be used only to measure
machined or filed surfaces.

They should never be mixed with any other
tools.
Clean the instrument after use, and store it in
a box.

Graduations and reading of vernier calipers
Objectives: At the end of this lesson you shall be able to

explain the least count of a vernier caliper
state how graduations are made on a vernier caliper with 0.02 mm least count
expalin how to read vernier caliper measurements.

Vernier calipers

Vernier calipers are available with different accuracies. The
selection of the vernier caliper depends on the accuracy
needed and the size of the job to be measured.

This accuracy/least count is determined by the graduations
of the main scale and the vernier scale divisions.

Vernier Principle

The vernier principle states that two different scales are
constructed on a single known length of line and the
difference between them is taken for fine measurements.

Determining the least count of vernier calipers

In the vernier caliper shown in Fig 1 the main scale divisions
(9 mm) are divided into 10 equal parts in the vernier scale.

i.e. One main scale division (MSD) = 1mm

One vernier scale division (VSD) = 9/10 mm

Least count = 1 MSD – 1 VSD

= 1 mm – 9/10 mm = 0.1 mm.

The difference between one

MSD and one VSD = 0.1 mm.

Reading vernier measurements

Vernier calipers are available with different graduations and
least counts. For reading measurements with a vernier
caliper, the least count should be determined first.
(The least count of calipers is sometimes marked on the
vernier slide.)

Fig 2 shows the graduations of a common type of vernier
caliper with a least count of 0.02 mm. In this, 50 divisions
of the vernier scale occupy 49 divisions (49 mm) on the
main scale.

Example

Calculate the least count of the vernier given in Figure 3.

Least count = 1 mm – 49/50 mm

= 1/50 mm

= 0.02 mm.

Example for reading vernier caliper (Fig 3)

Main scale reading = 60 mm

The vernier division coin-

ciding with the main scale

is the 28th division, value = 28 x 0.02

= 0.56 mm

Reading = 60 + 0.56 = 60.56 mm.
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Outside micrometer
Objectives: At the end of this lesson you shall be able to
• explain the parts of an outside micrometer
• state the functions of the main parts of an outside micrometer.

A micrometer is a precision instrument used to measure a
job, generally within an accuracy of 0.01 mm.

Micrometers used to take the outside measurements are
known as outside micrometers. (Fig 1)

The parts of a micrometer are listed here.

Frame

The frame is made of drop-forged steel or malleable cast
iron. All other parts of the micrometer are attached to this.

Barrel/sleeve

The barrel or sleeve is fixed to the frame. The datum line and
graduations are marked on this.

Thimble

On the bevelled surface of the thimble also, the graduation
is marked. The spindle is attached to this.

Spindle

One end of the spindle is the measuring face. The other end
is threaded and passes through a nut. The threaded
mechanism allows for the forward and backward movement
of the spindle.

Anvil

The anvil is one of the measuring faces which is fitted on the
micrometer frame. It is made of alloy steel and finished to
a perfectly flat surface.

Spindle lock-nut: The spindle lock-nut is used to lock
the spindle at a desired position.

Ratchet stop

The ratchet stop ensures a uniform pressure between the
measuring surfaces.

Graduations of metric outside micrometer
Objectives: At the end of this lesson you shall be able to
• state the principle of a micrometer
• explain the least count of an outside micrometer

Working principle

The micrometer works on the principle of screw and nut.
The longitudinal movement of the spindle during one
rotation is equal to the pitch of the screw. The movement
of the spindle to the distance of the pitch or its fractions can
be accurately measured on the barrel and thimble.

Graduations (Fig 1)

In metric micrometers the pitch of the spindle thread is
0.5 mm.

Thereby, in one rotation of the thimble, the spindle advances
by 0.5 mm.

On the barrel a 25 mm long datum line is marked. This line
is further graduated to millimetres and half millimeters (ie.,
1 mm & 0.5 mm). The graduations are numbered as
0,5,10,15, 20 & 25 mm.

The circumference of the bevel edge of the thimble is
graduated into 50 divisions of the thimble = 0.5 x 1/50 =
0.01 mm.

Accuracy or the least count of a metric outside
micrometer is 0.01 mm.

CG& M: TDM (Dies & Moulds) (NSQF - Revised 2022) - R.Theory for Ex. 1.2.20

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



54

Reading dimensions with outside micrometers
Objectives: At the end of this lesson you shall be able to
• state the required range of a micrometer
• explain how to  micrometer measurements.

Ranges of outside micrometer

Outside micrometers are available in ranges of 0 to 25 mm,
25 to 50 mm, 50 to 75 mm, 75 to 100 mm, 100 to 125 mm
and 125 to 150 mm.

For all ranges of micrometers, the graduation marked on
the barrel is only 0-25 mm. (Fig 1)

Reading micrometer measurements

How to read a measurement with an outside micrometer?
(Fig 2)

First note the minimum range of the outside micrometer.
While measuring with a 50 to 75 mm micrometer, note it as
50 mm.

Then read the barrel graduations. Read the value of the
visible lines on the left of the thimble edge.

13.00 mm

 + 00.50 mm

13.50 mm

Barrel graduation

Next read the thimble graduations.

Read the thimble graduations in line with the barrel datum
line, 13th div. (Fig 3)

Multiply this value with 0.01 mm (least count). 13 x 0.01
mm = 0.13 mm)

Add

Minimum range 50.00 mm
Barrel reading 13.50 mm
Thimble reading 00.13 mm

Total 63.63 mm

The micrometer reading is 63.63 mm.

Vernier micrometer graduation and reading
Objectives: At the end of this lesson you shall be able to
• state the graduations of a vernier micrometer (metric)
• state  vernier micrometer.

Vernier micrometer

Ordinary metric micrometers can measure only to an
accuracy of ±.01mm.

For taking more accurate measurements, vernier micro-
meters are useful. Vernier micrometers can measure to an
accuracy of ±.001 mm.

Construction and graduation

Vernier micrometers are very similar to the ordinary
micrometers in construction. The difference is in the
graduation. These micrometers have additional, equally
spaced graduations (vernier graduations) given above
the datum line. There are ten such vernier graduation
lines marked parallel above the datum line. (Fig 1) The
space between these 10 lines is equal to 9 divisions in the
thimble. (Fig 1)
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The value of 10 vernier divisions is

0.0 1 mm X 9 = 0.09 mm

The value of a vernier division

= 0 .09mm  = 0.009 mm.

    10

The least count =

1 thimble division – 1 Vernier division =

0.01 – 0.009mm = 0.001 mm or 1/1000 mm.

Reading a vernier micrometer (Fig 2)

Add up all the readings together.

Calculation

The range of micrometer is 0 to 25 mm.

1 Full mm division
visible before
the thimble edge 9 = 9.000 mm

2 Half mm division
visible after
the full mm divsion
on thimble 1 = 0.500 mm

3 Thimble division
below the index
line 46 = 0.460 mm

4 Vernier division
coinciding with
thimble division 3 = 0.003 mm

Reading 9.963 mm

Example

After measuring, read the full mm divisions visible on the
barrel.

9 full divisions 9 mm

Note the half divisions, if any, visible on the barrel.

1 half division 0.5 mm

Read the thimble divisions below the datum line. (Fig 2)

46 divisions 0.46 mm

Note the vernier division coinciding with the thimble division.

3 divisions 0.003 mm
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Vernier height gauge
Objectives: At the end of this lesson you shall be able to
• name the parts of a vernier height gauge
• state the functions of each part
• list out the specific uses of a vernier height gauge.

Specific uses of a vernier height gauge

Accurate measurements are important in layout (marking
off) and inspection work. (Figs 1 & 2)

Vernier height gauges are particularly suitable for marking
off accurate distances, and centre locations.

The graduations and readings are the same as those of a
vernier caliper.

Parts of a vernier height gauge and their functions

The main parts of a vernier height gauge and their functions
are given here. (Fig 3)

Base (1)

This is the datum from which measurements and settings
are made. The underside of the base is hardened, ground
and lapped.

Beam (2)

This is similar to the beam scale of a vernier caliper and is
attached to the base.

Vernier slide (3)

This unit slides on the beam and carries the vernier plate
(5), locking screws (6), fine setting device (4) and scriber
(7). Some vernier height gauges are provided with a rack
and pinion arrangement for moving the slide along the
beam.

Vernier height gauges are provided with both straight and
offset scribers.(Fig 4)
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Zero setting of the vernier height gauge.

The offset scriber permits zero setting of the instrument
from the datum surface.

While using a straight scriber, the zero setting of the
instrument is at a level above the datum surface. In this

case the zero setting is to be checked using the precision
round block, supplied along with the instrument.

Vernier height gauges with which we can measure from the
datum surface without the special offset scribers are also
available.(Fig 5)

The size of the vernier height gauge is stated by the height
of the beam. The most commonly used size has a beam
of 300 mm height.

Vernier height gauges are used with surface plates or other
accurate flat surfaces.

Scribers
Objectives: At the end of this lesson you shall be able to
• state the features of scribers
• state the uses of scribers.

Scribers

In lay out work it is necessary to scribe lines to indicate
the dimensions of the workpiece to be filed or machined.
The scriber is a tool used for this purpose.  It is made of
high carbon steel and is hardened. For drawing clear and
sharp lines, the point should be ground and honed
frequently for maintaining its sharpness.

Scribers are available in different shapes and sizes. The
most commonly used one is the plain scriber. (Fig 1)

While scribing lines, the scriber is used like a pencil so that
the lines drawn are close to the straight edge. (Fig 2)

Scriber points are very sharp; therefore, do not put the plain
scriber in your pocket.

Place a cork on the point when not in use to
prevent accidents.

Marking out
Objectives: At the end of this lesson you shall be able to
• state what is co-ordinate system
• list and brief the different co-ordinate system used in marking
• brief the datum line in marking..

Co-ordinate system

A coordinate system is a system consisting of a set of
points, lines or surfaces with each point having a unique
location or coordinate that is assigned to it.

A number line is a line on which positive and negative
whole numbers are represented. It typically start at 'O'
and goes up to positive infinity or negative infinity depending
on the direction. (Fig 1)
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Types of coordinate system

There are many types of coordinate system, but some
are commonly used.

They are

1 Cartesian coordinate system

2 rectangle coordinate system

3 polar coordinate system

Cartesian coordinate system

The Cartesian coordinate system is the most commonly
used coordinate system. It uses a coordinate plane with
two perpendicular axes, X and Y, to locate points. The x-
axis runs vertically.(Fig 2) Points are located by  their X
and Y coordinates which are measured in units of distance
from the origin (Fig 3).

Rectangular coordinate system (Fig 4)

A rectangular coordinate system is a three-dimensional
coordinate system that uses Cartesian coordinates to
specify the position of points in space. It uses three
perpendicular lines, called axes, to uniquely identify every
point.

The x-axis is the horizontal line that goes through the
point, the y-axis is the vertical line that goes through the
point, and the z-axis is the line that goes perpendicular to
the other two axes, and runs through the point. The point's
position is specified by its distance from the origin along
each axis. The origin is the point when the axes intersect.

Polar coordinate system

The polar coordinate system is a coordinate system that
uses two angular coordinate. The point (r,) lies on the unit
circle, which has its center at the origin and a radius of 1.
The polar coordinate system is shown in figure 5.

Method of Marking

The following methods are often used for marking

1 Datum Line Method

2 Center line method

3 Marking by Template

4 Marking of Center on Round Rod End

1 Datum Line Method

In this method, first, a baseline is applied which is called
a datum line and all further lines are preceded by the
preceding line.

This method is used where the jobs are finished at right
angles (Fig 6)

2 Center line method

This method of marking is used on odd-shaped jobs firstly,
a center line is drawn and other joint line of marking are
attached with reference to this center line (Fig 7)
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Bevel protractor
Objectives: At the end of this lesson you shall be able to
• state the names of sem-precision angular measuring instruments
• differentiate between bevel and universal bevel gauges
• state the features of bevel protractors.

The most common instruments used to check angles are
the:

- bevel or bevel gauge (Fig 1)

- universal bevel gauge (Fig 2)

- bevel protractor (Fig 3)

Point to be noted while marking

- Carefully study the drawing of the workpiece

- Determine the datum surfaces from which all the marks
are to be marked

- Calculate all the dimensions and allowances of the
workpiece

- Check the correct use of marking media on the surface
on the surface of the workpiece

- First mark straight horizontal, vertical and slant line
and then mark lines of circles

- After marking clean the tools used for marking

Bevel gauges

The bevel gauges cannot measure angles directly. They
are, therefore, indirect angular measuring instruments. The
angles can be set and measured with bevel protractors.

Universal bevel gauges

The universal bevel gauge has an additional blade. This
helps in measuring angles which cannot be checked with
an ordinary bevel gauge. (Fig 2)

Bevel protractor

The bevel protractor is a direct angular measuring instrument,
and has graduations marked from 0° to 180°. This instrument
can measure angles within an accuracy of ±1°. (Fig 3)
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Combination set
Objectives: At the end of this lesson you shall be able to
• identify the parts of a combination set
• state the uses of each attachment in a combination set.

Combination sets can be used for different types of work,
like layout work, measurement and checking of angles.

The combination set (Fig 1) has a

- protractor head (1)

- square head (2)

- centre head (3)

- rule (4)

Square head

The square head has one measuring face at 90° and
another at 45° to the rule.

It is used to mark and check 90° and 45° angles. It can also
be used to set workpieces on the machines and measure
the depth of slots. (Figs 2,3 and 4)

For ensuirng accurate results, the combination
set should be cleaned well after use, and
should not be mixed with cutting tools, either
while using or storing.

Protractor head

The protractor head can be rotated and set to any required
angle.

The protractor head is used for marking and measuring
angles within an accuracy of ±1°. The spirit level attached
to this, is useful for setting jobs in a horizontal plane.
(Fig 6)

Centre head

This along with the rule is used for locating the centre of
cylindrical jobs. (Fig 5)
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Pedestal grinders
Objectives: At the end of this lesson you shall be able to
• state the purpose of off-hand grinding
• state the machines with which off-hand grinding is done
• state the features of bench and pedestal grinders.

Off-hand grinding is the operation of removing material
which does not require great accuracy in size or shape.
This is carried out by pressing the workpiece by hand
against a grinding wheel.

Off-hand grinding is performed for rough grinding of jobs and
resharpening of

- scribers

- punches

- chisels

- twist drills

- single point cutting tools etc.

Off-hand grinding is performed with a bench or pedestal
grinder. (Figs 1 and 2)

Bench grinders

Bench grinders are fitted to a bench or table, and are useful
for light duty work.

Pedestal grinders

Pedestal grinders are mounted on a base (pedestal),
which is fastened to the floor. They are used for heavy
duty work.

These grinders consist of an electric motor and two
spindles for mounting grinding wheels. On one spindle a
coarse-grained wheel is fitted, and on the other, a fine
grained wheel. For safety, while working, wheel guards are
provided. (Fig 3)

A coolant container is provided for frequent cooling of the
work. (Fig 3)

Adjustable work-rests are provided for both wheels to
support the work while grinding. These work-rests must be
set very close to the wheels. (Fig 4)

Extra eye shields are also provided for the protection of the
eyes. (Fig 4)
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Maintaining grinding wheels
Objectives: At the end of this lesson you shall be able to
• explain difference between loading and glazing
• state the effects of loading and glazing
• explain difference between dressing and truing.

Diamond dressers (Fig 2): Bench type off-hand grinders
used for sharpening cutting tools are usually fitted with
smaller and rather delicate wheels.

Grinding wheels become inefficient due to two main causes
known as loading and glazing.

Loading

When soft materials such as aluminium, copper, lead etc.
are ground, the metal particles get clogged in the pores of
the wheel. This condition is called loading. (Fig 1)

Glazing

When a surface of the wheel develops a smooth and
shining appearance, it is said to be glazed. This indicates
that the wheel is blunt, i.e. the abrasive grains are not
sharp.

When such grinding wheels are used, there is a tendency
to exert extra pressure in order to make the wheels cut.
Excessive pressure on the grinding wheel will lead to the
fracture of the wheel, excessive heating of the wheel,
weakening of bonding of the wheel and bursting of the
wheel.

Dressing

The purpose of dressing is to restore the correct cutting
action of the wheel. Dressing removes the clogs on the
surface of the wheel and the blunt grains of the abrasive,
exposing the new sharp abrasive grains of the wheel which
can be cut and brought to shape efficiently.

Truing

Truing refers to the shaping of the wheel to make it run
concentric with the axis. When a new grinding wheel is
mounted, it must be trued before use. The cutting surface
of a new wheel may run out slightly due to the clearance
between the bore and the machine spindle. Grinding
wheels, which are in use, can also run out of true, due to
uneven loading while grinding.

Dressing and truing are done at the same time.

Grinding wheel dressers
Objectives: At the end of this lesson you shall be able to
• explain the common types of wheel dressers
• state the uses of each type of wheel dresser.

The wheel dressers used for off-hand grinders are star
wheel dressers (Fig 1) (Huntington type wheel dresser) and
diamond dressers.

The star wheel dresser consists of a number of hardened
star-shaped wheels mounted on a spindle at one end and
a handle at the other end.

While dressing, the star wheel is pressed against the face
of the revolving grinding wheel. The star wheel revolves and
digs into the surface of the grinding wheel. This releases
the wheel loading and dull grains, exposing sharp new
abrasive grains.

Star wheels are useful for pedestal grinders in which a
precision finish is not expected.

Star wheel dressers should be used only on
wheels which are large enough to take the
load.
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before using this tool. You must wear appropriate PPE and
follow all shop rules. Refer to the manufacturer's operating
manual for all operating procedures.

Before starting the bench or pedestal grinder

- Keep the tool rest as close to the grinding wheel as
possible without touching it. The tool rest must be
minimally within 3mm of the grinding wheel.

- If a magnetic chuck is being used on the surface
grinder, make sure it is holding the work securely before
starting to grind.

- Prior to starting the grinder, ensure the tang at the top
of the wheel opening is located within 6mm of the wheel.

- Before starting the grinder, make absolutely sure that
the grinding wheel clears the top of the work piece.
Approach the work piece manually to ensure this. Do
not feed the table in automatic grind mode.

While in operation

- Stand to one side of the wheel when turning on the
power. Damaged wheels will sometimes fly apart, and
this is most likely to happen upon startup.

- Be alert and cautious when a grinding operation requires
locating fingers close to the wheel. Feed the stock into
the wheel with light to medium pressure. Do not force
the piece.

- Do not use the side of the grinding wheel to shape
stock.

- Stand erect in front of the grinder with both legs straight
and slightly apart. Avoid stooping or leaning in to the
machine.

- Keep the grinding wheel dressed. Dressing a small
amount frequently is better than having to dress a lot
later and will allow the wheel to cut faster, cooler and
with a better surface finish. Dressing is cleaning and
smoothing the surface of the grinding wheel.

- Hold work securely while grinding, use the tool rest to
support the work when off-hand grinding on bench or
pedestal grinders.

Care and maintenance

- Dress the grinding wheels regularly

- Do frequent, light dressing rather than one hardly
dressing

- Replace the worn wheels it you cannot dress it

- Ensure the grinding speed does not exceed the operating
speed marked on the grinding wheels

- Visually inspect the grinding wheels for possible
damaged before mounting

- Do not grind on the side of a regular wheel

- Do not use a wheel theet doesnot fit properly to the
spindle.

These wheels are dressed and trued with diamond dressers.

Diamond dressers consist of a small diamond mounted on
a holder which can be held rigidly on the work-rest.

How to use a wheel dresser (Fig 3)

For dressing and truing, the dresser is slowly brought in
contact with the wheel face and moved across.

The finish obtained depends on the rate at which the
dresser is moved across the face.

For roughing, the dresser is moved faster.

For fine finish, the dresser is moved slowly.

Roughing will be efficient with a dresser that has a sharp
point, while, for fine finishing, a blunt diamond dresser is
more suitable.

Abrasive stick: When only a light dressing is required,
abrasive sticks can also be used. There are abrasive
materials made in the form of sticks for the convenience
of handling.

Diamond dressers, if moved too slowly, can
glaze the wheel.

Safety precautions

Prior to using a bench or pedestal grinder, you must receive
basic shop safety training and equipment specific training
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CG & M Related Theory for Exercise 1.2.21
Tool & Die Maker (Dies & Moulds) - Fitting

Marking media
Objectives: At the end of this lesson you shall be able to
• state the purpose of marking media
• explain the common types of marking media
• state the correct marking medium for different applications.

Purpose of marking media

In marking off/Layout, the surface of the job/workpiece is
coated with a medium to show the marked lines clear and
visible. To get clear and thin lines, the best layout medium
is to be selected.

Different marking media

The different marking media are Whitewash, Marking blue,
Prussian Blue, Copper Sulphate and Cellulose Lacquer.

Whitewash

Whitewash is prepared in many ways.

Chalk powder mixed with water

Chalk mixed with methylated spirit

White lead powder mixed with turpentine

Whitewash is applied to rough forgings andcastings with
oxidised surface. (Fig 1)

Whitewash is not recommended for workpieces of high
accuracy.

Copper sulphated

The solution is prepared by mixing copper sulphate with
water and a few drops of nitric acid. The copper sulphate is
used on filed or machine-finished surfaces. Copper sulphate
sticks to the finished surfaces well.

Copper sulphate needs to be handled carfully as it is
poisonous. Copper sulphate coating should be dried before
commencing marking, as otherwise, the solution may
stick on the instruments used for marking.

Cellulose lacquer: This is a commercially available
marking medium. It is made in different colours and dries
very quickly.

The selection of marking medium for a particular
job depends on the surface finish and the
accuracy of the workpiece.

In present days, marking media used are readily
available in aerosol container, which can be
applied by spraying on to any surface, which
needs marking.

Readymade  solutions of marking dye/ink which
are quick drying and thin layer to mark precise
dimensions and clear visible lines. Also
permanent marker pens are available in
different. colours, which are quick drying and
used for smaller workpieces of metal, wood
and plastics.

Marking blue

A Chemical dye, blue based colour mixed with methylated
spirit used for marking on workpieces which are reasonably
machined surface.

Prussian blue

This is used on filed or machine-finished surfaces. This will
give very clear lines but takes more time for drying  than  the
other marking media. (Fig 2)
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Surface plates
Objectives: At the end of this lesson you shall be able to
• state the necessity of surface plate
• state the material of surface plate
• state the specification of surface plate.

Surface plates - their necessity

When accurate dimensional features are to be marked, it
is essential to have a datum plane with a perfectly flat
surface. Marking using datum surfaces which are not
perfectly flat will result in dimensional inaccuracies. (Fig.1)
The most widely used datum surfaces in machine shop
work are the surface plates and marking tables.

Materials and construction

Surface plates are generally made of good quality cast
iron which are stress-relieved to prevent distortion.

The work-surface is machined and scraped.  The underside
is heavily ribbed to provide rigidity. (Fig 2)

For the purpose of steadiness and convenience in levelling,
a three point suspension is given. (Fig 3)

Smaller surface plates are placed on benches while the
larger surface plates are placed on stands.

Other materials used

Granite is also used for manufacturing surface plates.
Granite is a dense and stable material. Surface plates
made of granite retain their accuracy, even if the surface
is scratched.  Burrs are not formed on these surfaces.

Classification and uses

Surface plates used for machine shop work are available
in three grades - Grades 1, 2 and 3.  The grade 1 surface
plate is  more acceptable than the other two grades.

Specifications

Cast iron surface plates are designated by their length,
breadth, grade and the Indian Standard number.

Example

Cast iron surface plate 2000 x 1000 Gr1. I.S. 2285.

Care & maintenance

• Clean before and after use.

• Do not keep job on the surface plate.

• Don't keep any cutting tool on the table.
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CG & M Related Theory for Exercise 1.2.22
Tool & Die Maker (Dies & Moulds) - Fitting

'V' Blocks
Objectives: At the end of this lesson you shall be able to
• state the constructional features of 'V' Blocks
• explain the types of 'V' Blocks and state their uses
• state 'V' Blocks as per B.I.S recommended practice.

Constructional features

'V' Blocks are devices used for marking and setting up work
on machines. The features of the common type of 'V'Blocks
are as given in Figs 1 and 2.

The included angle of the VEE is 90° in all cases. 'V' Blocks
are finished to a high accuracy in respect of dimension,
flatness and squareness.

Types

Different types of 'V' blocks are available. As per BIS, there
are four types, as listed below.

Single level single groove 'V' Block (Fig 1)

This type has only one 'V' groove, and has single groove
(slots) on either side. These grooves are for accommodat-
ing the holding clamps.

Single level double groove 'V' Block (Fig 2)

This type will have one 'V' groove, and two grooves (slots)
on either side for clamping in two positions.

Double level single groove 'V' Block (Fig 3)

In this case, the 'V' Block will have two 'V' grooves on the
top and bottom, and a single groove for clamping on either
side.

Matched pair 'V' Block (Figs 4 & 5)

These blocks are available in pairs which have the same
size and the same grade of accuracy. They are identified
by the number or letter given by the manufacturer. These
sets of blocks are used for supporting long shafts, parallel
on machine tables or marking off tables.

Grades and materials

'V'Blocks are available in Grade A and Grade B.

Grade A 'V' Blocks

There are more accurate, and are available only up to 100
mm length. They are made of high quality steel.
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Grade B 'V' Blocks

These blocks are not as accurate as the ones in Grade A.
These blocks are used for general machine shop work.
These blocks are available up to 300 mm length. These 'V'
Blocks are made of closely grained cast iron.

Clamping devices for ̀ V'-Blocks

'U' clamps are provided for holding cylindrical jobs firmly on
'V' Blocks. (Fig 6)

Designation

'V' Blocks are designated by the nominal size (length) and
the minimum and maximum diameter of the workpiece
capable of being clamped, and the grade and the number
of the corresponding B.I.S. standard.

In the case of matched pairs, it should be indicated by the
letter M.

For 'V' Blocks with clamps it should be indicated as, 'WITH
CLAMPS'.

Example

A 50 mm long (nominal size) 'V' Block capable of clamping
workpieces between 5 to 40 mm in diameter and of Grade
A will be designated as

- 'V' Block 50/5-40 A - I.S.2949.

- In the case of a matched pair, it will be designated as

'V' Block M 50/5-40 A I.S.2949.

- For 'V' Block supplied with clamps, the designation
will be 'V' Block with clamp 50/5 40 A I.S. 2949.

Angle plates
Objectives: At the end of the lesson you shall be able to
• state the constructional features of different types of angle plates
• explain the types of angle plates
• state the uses of different types of angle plates
• state the grades of angle plates.

Constructional features

Angle plates have two plane surfaces, machined perfectly
flat and at right angles. Generally these are made of closely
grained cast iron or steel. The edges and ends are also
machined square. They have ribs on the unmachined part
for good rigidity and to prevent distortion.

Types of angle plates

Plain solid angle plate (Fig 1)

Among the three types of angle plates normally used, the
plain solid angle plate is the most common.  It has the
two plane surfaces perfectly machined at 90° to each other.
Such angle plates are suitable for supporting work-pieces
during layout work.  They are comparatively smaller in
size.

Slotted type angle plate (Fig 2)

The two plane surfaces of  this type of angle plate have
slots milled.  It is comparatively bigger in size than the
plain solid angle plate.

The slots are machined on the top plane surfaces for
accommodating clamping bolts. This type of angle plate
can be tilted 90° along with the work for marking or
machining. (Figs 3 and 4)
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Swivel type angle plate (Fig 5)

This is adjustable so that the two surfaces can be kept at
an angle.  The two machined surfaces are on two separate
pieces which are assembled. Graduations are marked on
one to indicate the angle of tilt with respect to the other.

Grades

Angle plates are available in two grades - Grade 1 and
Grade 2. The Grade 1 angle plates are more accurate and
are used for very accurate tool room type of work. The
Grade 2 angle plates are used for general machine shop
work. In addition to the above two grades of angle plates,
precision angle plates are also available for inspection
work.

Sizes

Angle plates are available in different sizes.  The sizes are
indicated by numbers. Table 1 gives the number of the
sizes and the corresponding size proportions of the  angle
plates.

Specification of angle plates

a Size 6 Grade 1

Box plate will be designated as - box angle plate 6 Gr
1  IS 623.

b Size 2 - Grade 2 angle plate will be designated as

Angle plate 2 Gr 2 I.S 623.

Table 1

Size No. L B H

1 125 75 100
2 175 100 125
3 250 150 175
4 350 200 250
5 450 300 350
6 600 400 450
7 700 420 700
8 600 600 1000
9 1500 900 1500
10 2800 900 2200

Grade 2 only
When both zeros coincide, the two plane surfaces are at
90° to each other. A bolt and nut are provided for locking in
position.

Box angle plate (Fig 6)

They have applications similar to those of other angle
plates. After setting, the work can be turned over with the
box enabling further marking out or machining. This is a
significant advantage. This has all the faces machined
square to each other.
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Care & Maintenance

- Clean before and after use.

- Apply oil after the use.

Parallel blocks
Objectives: At the end of this lesson you shall be able to
• explain the types of parallels
• state the constructional features of parallel blocks
• state parallel blocks as per BIS recommended
• state the uses of parallel blocks.

Parallel blocks of different types are used for setting
workpieces for machining.  The commonly used are of
two types.

- Solid Parallels

- Adjustable Parallels

Solid parallels (Solid parallel blocks) (Fig 1)

This is the type of parallel which is very much used in
machine shop work. They are made of steel pieces of
rectangular cross section, and are available in different
lengths and cross sectional sizes.

They are hardened and ground, and, sometimes, finished
by lapping.

Parallels are machined to close limits, and are perfectly
flat, square, and parallel throughout the length.  These are
made in pairs of identical dimensions.

Grades

Parallels are made in two grades -  Grade A and Grade B.
Grade A is meant for fine toolroom type of work, and Grade
B for general machine shop work.

Adjustable parallels (Fig 2)

These consist of two tapered blocks sliding one over the
other in a tongue and groove assembly. These types of
parallels can be adjusted and set to different heights.

Uses

Solid and adjustable parallels are used for parallel setting
of workpieces while machining. They are also useful for
raising the workpieces held in vices or machine tables to
provide better observation of the machining process.
(Fig 3)

Parallels are made in pairs and should be used
in matching pairs to ensure accuracy in set-up.

Care and maintenance

- Clean before and after the use.

- Apply oil after use

- Do not use as a hammer.

Sizes of parallels

These are given in TABLE 1, TABLE 2 and Fig 5.

Designation of parallels

Parallels are designated by the type, grade (for solid
parallels only) size, and the number of the standard.
(Fig 4)

Examples

Solid parallel A5 x 10 x 100  IS: 4241

Adjustable parallel 10 x 13 IS:4241
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Drill & Tap
Objectives: At the end of this lesson you shall be able to
• state the different types of drills
• explain the parts of a drill
• state the functions of each part of a drill.

Drilling is a process of making holes on workpieces. The
tool used for drilling is a drill and it is rotated with a
downward pressure causing the tool to penetrate into the
material.

Flat or spade drill (Fig 1)

This type of drill is used where the required size of twist drill
is not available. It is made from a round tool steel piece
which is forged to shape and ground to size, and then
hardend and tempered. This type of drill is used for hand
drilling (without power) or with a ratchet brace.

Straight fluted drill (Fig 2)

It has grooves or flutes running parallel to the drill axis. It is
mainly used in drilling brass, copper or soft materials. This
type of drill is inconvenient in standard practice as the chips
do not come out from the hole automatically. It is used to
drill sheet metals and cores in the castings.

Twist drills (Fig 3)

Table 1

Sizes of solid parallels

   Grade   Size T.W.L.

 A & B  5 x 10 x 100
 A & B 10 x 20 x 150
 A & B 15 x 25 x 150
 A & B 20 x 35 x 200
 A & B 25 x 45 x 250
 A & B 30 x 60 x 250
 A & B 35 x 70 x 300
        B 40 x 80 x 350
        B          50 x 100 x 400

Table 2

Range and size of Adjustable Parallels

    Height Range         Length

10 - 13 40
13 - 16 50
16 - 20 60
20 - 25 65
25 - 30 70
30 - 40 85
40 - 50          100

In this type, two spiral flutes or grooves run lengthwise
around the body of the drill. It is the most common type of
drill used for all purposes, and especially for faster drilling
of accurate holes and for harder materials - in comparison
with the other drills.
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Parts of a twist drill (Fig 3)

Point

The cone shaped end which does the cutting is called the
point. It consists of a dead centre (1), lips or cutting edge
(2) and a heel (3).

Tang (4)

This is provided only on taper shank drills, for driving (giving
torque to) the drill, which when overloaded, becomes
twisted or gets sheared off.

Flutes (5)

Flutes are the spiral grooves which run to the length of the
drill. The flutes help.

to form the cutting edge

to curl the chips and allow these to come out

the coolant to flow to the cutting edge.

Shank (8)

This is the driving end of the drill which is fitted on to the
machine. Shanks are of two types.

Taper shank, with Morse taper provided, is used for larger
diameter drills, and the straight shank is used for smaller
diameter drills.

Hand taps and wrenches
Objectives: At the end of this lesson you shall be able to
• state the uses of hand taps
• state the features of hand taps
• explain the different types of tap wrenches
• state the uses of the different types of wrenches.

Land/margin (6)

The land/margin is the narrow strip which extends to the
entire length of the flutes. The diameter of the drill is
measured across the land/margin.

Body clearance (7)

Body clearance is that part of the body which is reduced in
diameter to cut down the friction between the drill and the
hole being drilled.

Web (Fig 4)

Web is the metal column which seperates the flutes. it
gradually increases in thickness towards the shank.

Material for twist drills: Twist drills, used in a machine
shop, are usually made out of high speed steel. For drilling
hard materials at higher cutting speeds, there are drills with
carbide tips, brazed at the lips of the drill.

Use of hand taps: Hand taps are used for internal
threading of components.

Features (Fig 1): They are made from high carbon steel
or high speed steel, hardened, tempered and ground.
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Tap drill size
Objectives: At the end of this lesson you shall be able to
• state tap drill size
• state the tap drill sizes for metric and BSW thread tables
• state the tap drill sizes for ISO metric ISO inch.

The threads are cut on the periphery and are accurately
finished.

To form the cutting edges, flutes are cut across the thread.

The end of the shank of the tap is made of square shape for
the purpose of holding and turning the taps.

The end of the taps are chamfered (taper lead) for assisting,
aligning and starting of the thread.

The size of the taps, the thread standard, the pitch of the
thread, the diameter  of the tapping hole are usually marked
on the shank.

Marking on the shank are also made to indicate the type
of tap i.e. first, second and plug.

Types of taps in a set: Hand taps for a particular thread
are available as a set consisting of three pieces. (Fig 2)

These are:

– first tap or taper tap

– second tap or intermediate tap

– plug or bottoming tap

These taps are identical in all features except in the taper
lead. The taper tap is to start the thread. It is possible to
form full threads by the taper tap in through holes which are
not deep.

The bottoming tap (plug) is used to finish the threads of a
blind hole to the correct depth.For identifying the type of
taps quickly - the taps are either numbered 1,2 and 3 or
rings are marked on the shank.

The taper tap has one ring, the intermediate tap has two
and the bottoming tap has three rings. (Fig 2)

Double-ended adjustable tap wrench or bar type tap
wrench (Fig 3): This is the most commonly used type of
tap wrench. It is available in various sizes - 175, 250, 350
mm long. These tap wrenches are more suitable for large
diameter taps, and can be used in open places where there
is no obstruction to turn the tap.

It is important to select the correct size of wrench.

T-handle tap wrench (Fig 4): These are small, adjustable
chucks with two jaws and a handle to turn the wrench.

This tap wrench is useful to work in restricted places, and
is turned with one hand only. Most suitable for smaller
sizes of taps.

Solid type tap wrench (Fig 5): These wrenches are not
adjustable.

They can take only certain sizes of taps. This eliminates
the use of wrong length of the tap wrenches, and thus
prevents damage to the taps.

Tap wrenches: Tap wrenches are used to align and drive
the hand taps correctly into the hole to be threaded.

Tap wrenches are of different types, such as double-ended
adjustable wrench, T-handle tap wrench, solid type tap
wrench etc.

What is tap drill size?

Before a tap is used for cutting internal threads, a hole is
to be drilled. The diameter of the hole should be such that

it should have sufficient material in the hole for the tap to cut
the thread.

CG& M: TDM (Dies & Moulds) (NSQF - Revised 2022) - R.Theory for Ex. 1.2.22

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



73

Tap drill sizes for different threads

ISO metric thread

Tap drill size for M 10 x 1,5 thread

Minor diameter  = Major diameter - (2 x depth )

Depth of thread   = 0.6134 x pitch of a screw

2 depth of thread  = 0.6134 x 2 x pitch

                          = 1.226 x 1.5 mm

                         = 1.839 mm

Minor dia.     = 10 mm - 1.839 mm

                   = 8. 161 mm or 8.2 mm.

This tap drill will produce 100% thread because this is
equal to the minor diameter of the tap. For most fastening
purposes a 100% formed thread is not required.

A standard nut with 60% thread is strong enough to be
tightened until the bolt breaks without stripping the thread.
Further it also requirees a greater force for turning the tap
if a higher percentage formation of thread is required.

Considering this aspect, a more practical approach for
determining the tap drill sizes is

Tap drill size  = major diameter minus pitch

        = 10mm - 1.5 mm

        = 8.5 mm.

Compare this with the table of tap drill sizes for ISO metric
threads.

BSW inch (unified) threads formula

Tap drill size =

Major diameter -  
 

inch per threads No.of
inch  1

For calculating the tap drill size for 5/8” UNC thread

Tap drill size  = 5/8” - 1/11”

                     = 0.625” - 0.091”

                     = 0.534”

The next drill size is 17/32” (0.531 inches).

Compare this with the table of drill sizes for unified inch
threads.

What will be the size for the following threads?

a M20

b BSW 3/8

Refer to the chart for determining the pitches of
the thread.

Table for tap drill dize

Nominal ISO Metric (60°) B.S.W. (55°) Tap drill

diameter M.M Pitch Tap drill Nominal Threads per sizes
sizes diameter (inch)  inch (mm)

3 0.5 2.05 1/8 40 2.5
4 0.7 3.30 5/32 32 3.2
5 0.8 4.20 3/16 24 4.0
6 1.0 5.00 1/4 20 5.0
8 1.25 6.80 5/16 18 6.0
10 1.50 8.0 3/8 16 8.0
12 1.75 10.20 1/2 12 10
14 2.00 12.00 9/16 12 12.5
16 2.00 14.00 5/8 11 14.00
18 2.50 15.50 3/4 10 16.00
20 2.50 17.50 13/16 10 18.00
22 2.50 19.50 7/8 9 19.5
24 3.00 21.00 1 8 22.2

Die and die stock
Objectives: At the end of this lesson you shall be able to
• explain the different types of dies
• state the features of each type of die
• state the use of each type of die
• name the type of die stock for each type of die.

Uses of dies

Threading dies are used to cut external threads on cylindrical
workpieces. (Fig 1)

Types of Dies

The following are the different types of dies.

– Circular split die (Button die)
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– Half die

– Adjustable screw plate die

Circular split die/button die (Fig 2)

This has a slot cut to permit slight variation in size.

When held in the die stock, variation in the size can be
made by using the adjusting screws. This permits increasing
or decreasing of the depth of cut. When the side screws are
tightened the die will close slightly.(Fig 3) For adjusting the
depth of the cut, the centre screw is advanced and locked
in the groove. This type of die stock is called button pattern
stock.

Half die (Fig 4)

Half dies are stronger in construction.

Adjustments can be made easily to increase or decrease
the depth of cut.

These dies are available in matching pairs and should be
used together.

By adjusting the screw of the die stock, the die pieces can
be brought closer together or can be moved apart.

They need a special die holder.

Adjustable screw plate die (Fig 5)

This is another type of a two-piece die similar to the half die.

This provides greater adjustment than the split die.

The two die halves are held securely in a collar by means
of a threaded plate (guide plate) which also acts as a guide
while threading.

When the guide plate is tightened after placing the die
pieces in the collar, the die pieces are correctly located and
rigidly held.

The die pieces can be adjusted, using the adjusting screws
on the collar.

This type of die stock is called quick cut die stock.(Fig 6)

The bottom of the die halves is tapered to provide the lead
for starting the thread. On one side of each die head, the
serial number is stamped.

Both pieces should have the same serial numbers.

Die nut (Solid die) (Fig 7)

The die nut is used for chasing or reconditioning the
damaged threads.
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Blank size for external threading
Objective: At the end of this lesson you shall be able to
• state the diameter of blank size for external thread cutting.

Screw thread and elements
Objectives: At the end of this lesson you shall be able to
• state the uses of screw threads
• explain the difference between external and internal threads
• state the elements of screw threads.

Die nuts are not to be used for cutting new
threads.

The die nuts are available for different standards and sizes
of threads.

The die nut is turned with a spanner.

Why should the blank size be less?

It has been observed from practice that the threaded
diameters of steel blanks show a slight increase in diameter.
Such increase in the diameter will make the assembly of
external and internal threaded components very difficult. To
overcome this, the diameter of the blank is slightly reduced
before commencing the threading.

What should be the blank size?

The diameter of the blank should be less by 1/10th of the
pitch of the thread.

Example

For cutting the thread of M12 with 1.75 mm pitch the
diameter of the blank is 11.80.

Formula, D = d – p/10

= 12 mm – 0.175 mm

= 11.825 or 11.8 mm.

d = diameter of bolt

D = the blank diameter

p = pitch of thread

Calculate the blank size for preparing a bolt of M16 x 1.5.

Answer

_______________________________________________

_______________________________________________

_______________________________________________

What is a screw thread?

A screw thread is a ridge of uniform section formed helically
on the surface of a cylindrical body. (Fig 1)

An external screw thread is formed on the outer surface of
a cylindrical part. Examples: bolts, screws, studs, threaded
spindles, etc. (Fig 1)

An internal screw thread is formed on the inner surface of
a hollow cylindrical part. Examples: nuts, threaded lids
etc.

External threads and internal threads are assembled
together for different engineering uses. (Fig 2)

Uses of screw threads

Screw threads are used
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- as fasteners to hold together and dismantle
components when needed (Fig 3)

- to transmit motion on machines from one unit to another
(Fig 4)

- to make accurate measurements (Fig 5)

- to apply pressure (Fig 6)

- to make adjustments. (Fig 7)

- Parts of a screw thread (Fig 8)

Crest

The top surface joining the two sides of a thread.

Root

The bottom surface joining the two sides of adjacent
threads.

Flank

The surface joining the crest and the root.

Thread angle

The included angle between the flanks of adjacent threads.

Depth

The perpendicular distance between the roots and crest of
the thread.

Major diameter

In the case of external threads it is the diameter of the blank
on which the threads are cut and in the case of internal
threads it is the largest diameter after the threads are cut
that are known as the major diameter. (Fig 9)

This is the diameter by which the sizes of screws are
stated.
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Minor diameter

For external threads, the minor diameter is the smallest
diameter after cutting the full thread. In the case of internal
threads, it is the diameter of the hole drilled for forming the
thread which is the minor diameter.

Pitch diameter (effective diameter)

The diameter of the thread at which the thread thickness is
equal to one half of the pitch.

Pitch (Fig 8)

It is the distance from a point on one thread to a correspond-
ing point on the adjacent thread measured parallel to the
axis.

Lead

Lead is the distance a threaded component moves along
the matching component during one complete revolution.
For a single start thread the lead is equal to the pitch.

Helix angle

The angle of inclination of the thread to the imaginary
perpendicular line.

Hand

The direction in which the thread is turned to advance. A
right hand thread is turned clockwise to advance, while a
left hand thread is turned anticlockwise. (Fig 10)

Reamers
Objectives: At the end of this lesson you shall be able to
• state the use of reamers
• state the advantages of reaming
• explain difference between hand and machine reaming
• explain the elements of a reamer and state their functions.

What is a reamer?

A reamer is a multi-point cutting tool used for enlarging by
finishing previously drilled holes to accurate sizes.(Fig 1)

Advantages of ‘reaming’

Reaming produces

- high quality surface finish

- dimensional accuracy to close limits.

Also small holes which cannot be finished by other
processes can be finished.

Classification of reamers

Reamers are classified as hand reamers and machine
reamers. (Figs 2 and 3)

Reaming by using hand reamers is done manually for
which great skill is needed.

Machine reamers are fitted on spindles of machine tools
and rotated for reaming.

Machine reamers are provided with morse taper shanks for
holding on machine spindles.

Hand reamers have straight shanks with ‘square’ at the
end, for holding with tap wrenches. (Fig 3)

Parts of a hand reamer

The parts of a hand reamer are listed hereunder. Refer to
Fig 4.

Axis

The longitudinal centre line of the reamer.

Body

The portion of the reamer extending from the entering end
of the reamer to the commencement.

Recess

The portion of the body which is reduced in diameter below
the cutting edges, pilot or guide diameters.
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Shank

The portion of the reamer which is held and driven. It can be
parallel or tapered.

Circular land

The cylindrically ground surface adjacent to the cutting
edge on the leading edge of the land.

Bevel lead

The bevel lead cutting portion at the entering end of the
reamer cutting its way into the hold. It is not provided with
a circular land.

Taper lead

The tapered cutting portion at the entering end to facilitate
cutting and finishing of the hole. It is not provided with a
circular land.

Bevel lead angle

The angle formed by the cutting edges of the bevel lead and
the reamer axis.

Taper lead angle

The angle formed by the cutting edges of the taper and the
reamer axis.

Terms relating to cutting geometry flutes

The grooves in the body of the reamer to provide cutting
edges, to permit the removal of chips, and to allow the
cutting fluid to reach the cutting edges. (Fig 5)

Heel

The edge formed by the intersection of the surface left by
the provision of a secondary clearance and the flute. Fig 5)

Cutting edge

The edge formed by the intersection of the face and the
circular land or the surface left by the provision of primary
clearance. (Fig 5)

Face

The portion of the flute surface adjacent to the cutting
edge on which the chip impinges as it is cut from the work.
(Fig 5)

Rake angles

The angles in a diametral plane formed by the face and a
radial line from the cutting edge. (Fig 6)

Clearance angle

The angles formed by the primary or secondary clearances
and the tangent to the periphery of the reamer at the cutting
edge. They are called primary clearance angle and
secondary clearance angle respectively. (Fig 7)
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Helix angle

The angle between the edge and the reamer axis. (Fig 8)

Hand reamers
Objectives: At the end of this lesson you shall be able to
• state the general features of hand reamers
• explain the types of hand reamers
• explain difference between the uses of straight fluted and helical fluted reamers
• state the materials from which reamers are made and specify reamers.

General features of hand reamers (Fig 1)

Hand reamers are used to ream holes manually using tap
wrenches.

These reamers have a long taper lead. (Fig  2) This allows
to start the reamer straight and in alignment with the hole
being reamed.

Most hand reamers are for right hand cutting.

Helical fluted hand reamers have left hand helix. The left
hand helix will produce smooth cutting action and finish.

Most reamers, machine or hand, have uneven spacing of
teeth. This feature of reamers helps to reduce chattering
while reaming. (Fig 3)

Types, Features and Functions

Hand reamers with different features are available for
meeting different reaming conditions. The commonly used
types are listed here under.

Parallel hand reamer with parallel shank (Fig 4)

A reamer which has virtually parallel cutting edges with
taper and bevel lead. The body of the reamer is integral with
a shank. The shank has the nominal diameter of the cutting
edges. One end of the shank is square shaped for tuning
it with a tap wrench. Parallel reamers are available with
straight and helical flutes. This is the commonly used hand
reamer for reaming holes with parallel sides.

Reamers commonly used in workshop produce H8 holes.

Hand reamer with pilot (Fig 5)

For this type of reamer, a portion of the body is cylindrically
ground to form a pilot at the entering end. The pilot keeps
the reamer concentric with the hole being reamed.

Socket reamer with parallel shank (Figs 6 & 7)

This reamer has tapered cutting edges to suit metric morse
tapers. The shank is integral with the body, and is square
shaped for driving. The flutes are either straight or helical.
The socket reamer is used for reaming internal morse
tapered holes.
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Taper pin hand reamer (Fig 8)

This reamer has tapered cutting edges for reaming taper
holes to suit taper pins. A taper pin reamer is made with a
taper pin of 1 in 50. These reamers are available with
straight or helical flutes.

Use of straight and helical fluted reamers (Fig 9)

Straight fluted reamers are useful for general reaming work.
Helical fluted reamers are particularly suitable for reaming
holes with keyway grooves or special lines cut into them.
The helical flutes will bridge the gap and reduce binding and
chattering.

Material of hand reamers

When the reamers are made as a one-piece construction,
high speed steel is used. When they are made as two-
piece construction then the cutting portion is made of high
speed steel while the shank portion is made of carbon
steel. They are butt-welded together before manufacturing.

Specifications of a reamer

To specify a reamer the following data is to be given.

- Type

- Flute

- Shank end

- Size

Example

Hand reamer, Straight flute, Parallel shank of Ø 20 mm.

Machine reamers
Objectives: At the end of this lesson you shall be able to
• state the different types of commonly used machine reamers
• state the features and uses of machine jig reamers
• state the features and advantages of shell reamers
• explain the different types of machine reamers
• state the advantages of adjustable reamers
• state the advantages of floating reamer-holders
• explain the different taper reamers
• state the advantages of step drilling while taper reaming.

Reamers are used to finish previously drilled holes
accurately to smooth finish. This can be done either by
hand or on machine. Reamers used on machines are
called machine reamers. The basic difference between
hand and machine reamers is the lead angle at the cutting
end. (Fig 1) Hand reamers will have long taper lead while
machine reamers will have a short bevel lead.

The shank end of the hand reamers will be square to
facilitate reaming using tap wrenches. Machine reamers of
small diameters will have parallel shank and the larger
reamers are provided with taper shanks.

Types of machine reamers

Solid fluted machine reamer (jobber reamer)

This is idenitical to a hand reamer. These reamers are
either straight fluted or with left hand helix to prevent the
tendency of ‘cork screwing’ when rotated clockwise for
reaming. (Fig 2)

Chucking reamers (Fig 3)

These reamers are similar to jobber’s reamers but have
shorter and deeper flutes, and are available as straight or
helical fluted. This is a side cutting reamer and cuts along
the full length of the land and produces smooth and
accurately sized holes. The ends of these reamers are
slightly chamfered to initiate the cutting action.
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Rose reamer/rose chucking reamer (Fig 4)

This reamer is designed to cut on its end. The flutes help
in chip clearance and act as guides while cutting. This is
used when a considerable amount of metal is to be
removed, and the finish is not very critical. This is sometimes
used as a roughing tool. Final finishing is done with other
finishing reamers.

Machine jig reamers (Fig 5)

When reaming is done using jigs, the bushings of the jigs
can be used to guide the reamer. Machine jig reamers are
provided with special, long guide surfaces of standard
diameters according to the diameter of the reamer.

Reamers of this type are available with rear guides only or
with front and rear guides. (Fig 6) They can produce very
accurate holes in the spindle and bushes are aligned
accurately. While reaming deep holes it is better to select
the jig reamers with guides on both ends.

When reaming is carried out immediately after drilling in the
same setting, renewable bushes are used on the jig.
(Fig 7)

Shell reamer (Fig 8)

The shell reamer is an independent reaming unit which has
a slightly tapered hole through the centre that permits the
reamer to be held on a separate shank or arbor that has
driving lugs. Several sizes of reamers may be used with one
shank. Shell reamers are made with either fluted teeth
having clearance, or the rose chucking type which  cuts on
the end only.

Adjustable machine reamer

These reamers are easy to adjust when worn out. They can
be re- sharpened and adjusted back to the correct size. As
such these reamers have longer working life than ordinary
reamers.
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Adjustable remers have adjustable insert blades. (Fig 9)
When worn out or damaged, the blade can be easily
replaced. These reamers are not meant to produce holes
of different sizes. However, they can be used to increase
the hold slinghtly.

Note: Similarly, adjustable reamers are also available for
hand reaming. (Fig 10)

The size of the reamer can be adjusted by moving the
blades in the tapered slots using the nuts provided on either
end of the blade.

Reamers with floating holders: While machine reaming,
the taper lead at the reamer end guides into the hole being
reamed. In the event of any misalignment, the hole being
reamed can enlarge at the starting end. (Fig 11) This can
be avoided by the use of reamers with floating holders.
Floating holders compensate minor discrepancies in the
axis alignment. Floating holders are available with angular
floats and parallel floats. (Fig 12)
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Taper reamers

Taper machine reamers are manufactured in all standard
tapers and with tapered shank. They can be mounted
directly in the spindle of the machine.

For taper reaming the diameter on the hole drilled is slightly
smaller than the finished diameter of the small end. of the
taper.

While reaming, the taper reamer will have to remove more
material at the big end and less material at the small end.
(Fig 13) While cutting, the entire length of the reamer will
be in contact will the workpiece. This can cause chatter
marks and poor finish.

For better results use a roughing reamer first and then finish
with a finishing reamer. Step drilling the hole will help to
reduce the strain on taper reamers. (Fig 14)

Taper pin machine reamers (Fig 15)

These reamers are used for reaming taper holes needed for
fitting taper pins.

Drill size for reaming
Objective: At the end of this lesson you shall be able to
• state the hole size for reaming.

For reaming with a hand or a machine reamer, the hole
drilled should be smaller than the reamer size.

The drilled hole should have sufficient metal for finishing
with the reamer. Excessive metal will impose a strain on
the cutting edge of the reamer and damage it.

Calculating drill size for reamer

A method generally practised in workshop is by applying
the following formula.

Drill size = Reamed size – (Undersize + Oversize)

Finished size

Finished size is the diameter of the reamer.

Undersize

Undersize is the recommended reduction in size for
different ranges of drill diameter. (Table 1)

Table 1

Undersizes for reaming

Diameter of Undersize of
ready reamed rough bored
hole (mm) hole (mm)

under 5 0.1.....0.2

5......20 0.2.....0.3

21....50 0.3.....0.5

over 50 0.5.....1
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Drilling machines - Types & Application
Objectives: At the end of this lesson you shall be able to
• state types of drilling machines
• explain application of drilling machines

The drilling machine is one of the most important machine
tools in a workshop and second to lathe. It was primarily
designed to originate a hole.

Types of drilling machine

Drilling machines are made in many different types and
sizes, each designed to handle a class of work or specific
job to the best advantage.

The different types of drilling machines are

1 Portable drilling machine

2 Sensitive drilling machine

a Bench mounting

b Floor mounting

3 Upright drilling machine

4 Radial drilling machine

5 Gang drilling machine

6 Multiple spindle drilling machine

7 Automatic drilling machine

8 Deep hole drilling machine

Portable Drilling machine

As the name implies this type of drilling machine can be
operated with ease anywhere in the workshop and is used
for drilling holes in work pieces in any position which cannot
be drilled in a standard in a standard drilling machine.
Some of the portable machines are operated by hand
power, but most of the machines are driven by individual
motor. The entire drilling mechanism including the motor
is compact and small in size. The motor is usually of
universal type which may be driven by both A.C. and D.C.
The maximum size of the drill that it can be accommodated
is not more than 12 to 18mm. the machine is operated at
high speed as smaller size drills are only used. Some of
the portable machines are driven by pneumatic power.

Sensitive Drilling Machine (Fig 1&2)

The sensitive drilling machine is a small machine designed
for drilling a small hole at high speed in light jobs, the
base of the machine may be mounted on a bench or on
the floor. It consists of a vertical column, a horizontal table,
a head supporting the motor and driving mechanism, and
a vertical spindle for driving and rotating the drill. There is
no arrangement for any automatic feed of the drill spindle.
The drill is fed into the work by purely hand control. High
speed and hand feed are necessary for drilling small holes.
High speeds are necessary to attain required cutting speed

by small diameter drill. Hand feed permits the operator to
feel or sense the progress of the drill into the work, so that
the drill becomes worn out or jams on any account, the
pressure on the drill may be released immediately to
prevent it from breaking.

Box column section upright drilling machine (Fig 3)

The upright drilling machine with box column section has
square table fitted on the slides at the front face of the
machine column. Heavy box column gives the machine
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strength and rigidity. The table is raised or lowered by an
elevating screw that gives additional support to the table.
These special features permit the machine to work with
heavier workpieces, and holes more than 50mm in diameter
can be drilled by it.

1. Bevel gear drive to spindle, 2 Spindle, 3 Overhead shaft,
4 Back stay, 5 Counter shaft cone pulley, 6. Fast and
loose pulley, 7. Table elevating handle, 8. Foot pedal,
9.Base, 10. Rack 11. Table elevating clamp handle, 12.
Table clamp, 13. Table, 14. Column, 15. Handwheel for
quick hand feed, 16. Handwheel for sensitive hand feed.

Radial Drilling machine (Fig 4)

The radial drilling machine is intended for drilling medium
to large and heavy workpieces. The machine consists of a
heavy, round, vertical column mounted a radial arm which
can be raised and lowered to accommodate work pieces
of different heights. The arm may be swung around to any
position over the work bed. The drill head containing
mechanism for rotating and feeding the drill is mounted on
a radial arm and can be moved horizontally on the guide -
ways and clamped at any desired position. These three
movements in a radial drilling machine when combined
when combined together permit the drill to be located at
any desired point on a large work piece, the position of
the arm and the drill head is altered so that the drill spindle
may be moved from one position to the other after drilling
the hole without altering the setting of the work. This
versality of the machine allows it to work on large work
pieces. The work may be mounted on the table or when
the work is very large it may be placed on the floor or in a
pit.

1. Base, 2. column, 3. Radial arm , 4. Motor for elevating
the arm, 5. Elevating screw, 6. Guide ways, 7. Motor for
driving the drill spindle, 8. Drill head, 9. Drill spindle, 10.
Table

Gang Drilling Machine (Fig 5)

When a number of single spindle drilling machine columns
are placed side by side on a common base and have a
common work table, the machine is known as the gang
drilling machine. In a gang drilling machine four to six
spindles may be mounted side by side. In some machines
the drill spindles are permanently spaced on the work table,
and in others the position of the columns may be adjusted
so that the space between the spindles may be varied.
The speed and feed of the spindles are controlled
independently. This type of machine is specially adapted
for production work. A series of operations may be
performed on the work by simply shifting the work from
one position to the other on the work table. Each spindle
may be set up properly with different tools for different
operations.
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Multiple Spindle Machine (Fig 6)

The function of a multiple spindle drilling machine is to
drill a number of holes in a piece of work simultaneously
and to reproduce the same pattern of holes in a number of
identical pieces in a mass production work. Such machine
shave several spindles driven by a single motor and all the
spindles holding drills are fed into the work simultaneously.
Feeding motion is usually obtained by raising the work
table. But the feeding motion may also be secured by
lowering the drill heads. The spindles are so constructed
that their centre distance may be adjusted in any position
as required by various jobs within the capacity of the drill
head. For this purpose, the drill spindles are connected to
the main drive by universal joints. Drill jigs may be used
for guiding the drills in mass production work.

Automatic Drilling machine (Fig 7)

Automatic drilling machine can perform a series of
machining operations at successive units and transfer the
work from one unit to the other automatically. Once the
work is loaded at the first machine, the work will move
from one machine to the other where different operations
can be performed and the finished work comes out from
the last unit without any manual handling. This type of
machine is intended purely for production purposes and
may be used for milling, honing and similar operations in
addition to drilling and tapping.

Deep Hole Drilling Machine (Fig 8)

Special machines and drills are required for drilling deep
holes in rifle barrels, crank shafts, etc. The machine is
operated at high speed and low feed. Sufficient quantity of
lubricant is pumped to the cutting points for removal of
chips and cooling the cutting edges of the drill. A long job
is usually supported at several points to prevent any
deflection. Usually the work piece and drill rotates in
opposite direction while the drill is fed into the work.This
helps in feeding the drill in a straight path.The machine
may be horizontal or vertical type In some machines step
feed is applied. The drill is withdrawn automatically each
time when it penetrates into the work on a depth equal to
its diameter. This process permits the chip to clear out
from the work.

The work piece and drill rotates in opposite direction
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Construction of pillar type drilling machine
Objectives : At the end of this lesson you shall be able to
• state the features of a pillar drilling machine
• state the parts and uses of pillar drilling machine
• explain the features and function of a pillar drilling machine.

Upright  Drilling Machine

The upright drilling machine is designed for handling
medium sized workpieces. In Construction the machine
is very similar to a sensitive drilling machine for having a
vertical column mounted upon the base. But this is larger
and heavier than a sensitive drilling machine and is supplied
with power feed arrangement. In an upright drilling machine
a large number of spindle speeds and feeds may be
available for drilling different types of work. The table of
the machine also have different types of adjustments. There
are two general classes of upright drilling machine.

- Round column section or  pillar driling machine.

- Box column section

Construction of Pillar drilling machine: The round
column section upright drilling machine or pillar drilling
machine consists of a round column that rises from the
base which rests on the floor, an arm and a round table
assembly, and a drll head assembly.

The arm and the table have three adjustments for locating
workpieces under the spindle. The arm and the table may
be moved up and down on the column for accommodating
workpieces of different heights. The table and the arm may
be moved in an arc upto 180º around the column and may
be clamped at any position. This permits setting of the
work below the spindle. Moreover, heavy and odd-size work
may be supported directly on the base of the machine
and drilled after the arm is swung out the way. The table
may be rotated 360º about its own centre independent of
the position of the arm for locating workpieces under the
spindle.

The construction of the machine being not very rigid and
the table being supported on a horizontal arm, this is
particularly intended for lighter work. The maximum size
of holes that the machine can drill is not more than 50mm

Parts of pillar drilling machine (Fig 1)

1 Bevel gear drive to spindle, 2. Spindle . 3. Overhead
shaft, 4. Nack stay counter shaft cone pulley, 6. Fast and
loose pulley, 7. Table elevating handle foot pedal, 9. Base,
10. Rack on column, 11. Table elevating clamp hadle Table
clamp, 13. Table, 14. Column, 15. Handwheel for quick
hand feed and Handwheel for sensitive hand feed.

The compund table for a pillar type drilling machine (Fig 2)

This is a development of the box-column type pillar drilling
machine with a table mounted on the two slideways  to
give horizontal motions at 90° to each other, and controlled
by the operating screws.

A typical component for drilling on a compound table
machine is shown in Fig 3.

The work is clamped to the compound table which can
then be accurately adjusted to bring each hole under the
spindle axis, in turn for drilling. If the work is located
accurately on the table by locators in the ‘T’ slots, once
the position to the first hole is fixed the remaining holes
can be positioned by means of table movements without
recourse to marking out.
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Radial drilling machines
Objectives: At the end of this lesson you shall be able to
• state the features of a radial drilling machine
• state the uses of a radial drilling machine.

Features (Fig 1)

The radial drilling machine has a radial arm on which the
spindle head is mounted.

The spindle head can be moved along the radial arm and
can be locked in any position.

The arm is supported by a pillar (column).  It can be rotated
about with the pillar as centre.  Therefore, the drill spindle
can cover the entire working surface of the table.  The arm
can be lifted or lowered. (Fig 2)

The motor mounted on the spindle head rotates the spindle.
The variable speed gearbox provides a large range of r.p.m.

The spindle can be rotated in both clockwise and anti-
clockwise directions.

The base of the machine itself is the work table and is
provided with ‘T’ slots for clamping large workpieces.  An
auxiliary table is usually provided to which smaller
workpieces can be clamped, and in some cases, two such
tables are used.  One is placed on the machine while
drilling is in progress and the other is on one side, with the
previously finished work removed and new work positioned.
When the work is completed the tables are interchanged
by a hoist, the radial arm being swung clear for the purpose.

Radial drilling machines are used to drill

– large diameter holes

– multiple holes in one setting of the work

– heavy and large workpieces.

– angular holes on machines having tilting tables.
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Drilling operation - Counter sinking
Objectives: At the end of this lesson you shall be able to
• explain counter sinking
• list the purposes of counter sinking
• state the angles of counter sinking for different applications
• explain the different types of counter sinks and their applications.

Counter sinking

Countersinking is an operation of beveling the end of a
drilled hole. The tool used is called a  countersink.

Counter sinking is carried out for the following
purposes.

- To provide a recess for the head of a counter sink screw,
so that it is flush with the surface after fixing. (Fig 1)

- To deburr a hole after drilling

- To accommodate counter sink rivet heads.

- To chamfer the ends of holes for thread cutting and
other machining processes.

 Angles for counter sinking

Counter sinks are available in different angles and for
differeent uses.

75° Counter sink riveting.

80° Counter sink self-tapping screws.

90° Counter sink head screws and for deburring.

120° Chamfering ends of holes to be threaded or other
machining processes.

Counter sinks

Counter sinks of different types are available.

The commonly used counter sinks have multiple cutting
edges and are available in taper shank (Fig 2) and straight
shank.

For counter sinking small diameter holes special counter
sinks with one or two flutes are available. This will  reduce
the vibration while cutting.

They are particularly useful for heavy duty work.

The pilot is provided at the end for guiding the counter sink
to the hole.

Counter sinks with pilots are available with interchange
able and solid pilots.

Counter sink hole sizes

The counter sink holes according to Indian Standards IS
3406 (Part 1) 1986 are of four types.

Type A

Type B

Type C

Type E

These types are used for different purposes.

Counter sinks with pilot (Fig 3)

For precision counter sinking, needed for machine tool
assembling and after machining process, counter sinks
with pilots are used.

CG& M: TDM (Dies & Moulds) (NSQF - Revised 2022) - R.Theory for Ex. 1.2.22

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



90

Counter boring and spot facing
Objectives: At the end of this lesson you shall be able to
• explain the difference between counter boring and spot facing
• state the various types of counter bores and their uses
• state the correct counter bore sizes for different holes.

Counter boring

Counter boring is an operation of enlarging a hole to a
given depth, to house heads of socket heads or cap screws
with the help of a counter bore tool. (Fig 1)

Counter bore (tool)

The tool used for counter boring is called a counter bore.
(Fig 2) Counter bores will have two or more cutting edges.
At the cutting end, a pilot is provided to guide the tool
concentric to the previously drilled hole.

The pilot also helps to avoid chattering  while counter boring.
(Fig 3)

Counter bores are available with solid pilots or with
interchangeable pilots. The inter-changeable pilots provide
flexibility of counter boring on different diameters of holes.

Counter bores: sizes and specification

Counter bore sizes are standardized for each diameter of
screws as per BIS.

There are two main types of counterbores. Type  H  and
Type K. These types are used for different purposes.

Spot facing

Spot facing is a machining operation for producing a flat
seat for a bolt head, washer or nut at the opening of the
drilled hole. The tool is called a spot facer or a spot facing
tool. Spot facing is similar to counterboring, except that
the hole is shallower. Tools that are used for counterboring
can be used for spot facing as well. (Fig 4) Spot facing is
also done by fly cutters by end cutting action. The cutter
blade is inserted in the slot of the holder, which can be
mounted on to the spindle. (Fig 5)
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Cutting speed and r.p.m.
Objectives: At the end of this lesson you shall be able to
• define cutting speed
• state the factors for determining the cutting speed
• explain difference between cutting speed and r.p.m.
• state the r.p.m./spindle speed
• explain the r.p.m. for drill sizes from tables.

For a drill to give a satisfactory performance, it must
operate at the correct cutting speed and feed.

Cutting speed is the speed at which the cutting edge
passes over the material while cutting, and is expressed in
metres per minute.

Cutting speed is also sometimes stated as surface speed
or peripheral speed.

The selection of the recommended cutting speed for drilling
depends on the materials to be drilled, and the tool
material.

Tool manufacturers usually provide a table of cutting
speeds required for different materials.

The recommended cutting speeds for different materials
are given in the table. Based on the cutting speed recom-
mended, the r.p.m. at which a drill has to be driven, is
determined.

Materials Cutting
being drilled speed(m/min)
for HSS

Aluminium 70 - 100

Brass 35 - 50

Bronze(phosphor) 20 - 35

Cast iron (grey) 25 - 40

Copper 35 - 45

Steel (medium 20 - 30

carbon/mild steel)

Steel (alloy,high tensile) 5 - 8

Thermosetting

plastic (low speed

due to abrasive properties) 20 - 30

Calculating r.p.m.

 
m/min

1000
πdn

v
��

�

 
πd

1000v
n

�

�
�

n - r.p.m.

v - cutting speed in m/min.

d - diameter of the drill in mm

p = 3.14.

Examples

Calculate the r.p.m. for a high speed steel drill Ð24 to cut
mild steel.

The cutting speed for MS is taken as 30 m/min. from the
table.

      
 

r.p.m. 398
243.14
301000

n �
�

�
�

It is always preferable to set the spindle speed to the
nearest available lower range. The selected spindle speed
is 300 r.p.m.

The r.p.m. will differ according to the diameter of the drills.
The cutting speed being the same, larger diameter drills will
have lesser r.p.m. and smaller diameter drills will have
higher r.p.m.

The recommended cutting speeds are achieved only by
actual experiments.

Feed in drilling
Objectives: At the end of this lesson you shall be able to
• state what is meant by feed
• state the factors that contribute to an efficient feed rate.

Feed is the distance (X) a drill advances into the work in one
complete rotation. (Fig 1)

Feed is expressed in hundredths of a millimetre.

Example - 0.040 mm

The rate of feed is dependent upon a number of factors.

Finish required

Type of drill (drill material)

Material to be drilled

the feed rate. If these are not to the required standard, the
feed rate will have to be decreased.

It is not possible to suggest a particular feed rateif all the
factors are not taken into account.
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The table for the feed rate given here is based on the
average feed values suggested by the different
manufacturers of drills. (Table 1)

Table 1

Drill diameter Rate of feed
(mm) H.S.S. (mm/rev)

           1.0 - 2.5 0.040 - 0.060

           2.6 - 4.5 0.050 - 0.100

           4.6 - 6.0 0.075 - 0.150

           6.1 - 9.0 0.100 - 0.200

           9.1 -12.0 0.150 - 0.250

12.1 - 15.1 0.200 - 0.300

15.1 - 18.0 0.230 - 0.330

18.1 - 21.0 0.260 - 0.360

21.1 - 25.0 0.280 - 0.380

Too coarse a feed may result in damage to the cutting
edges or breakage of the drill.

Too slow a rate of feed will not bring improvement in surface
finish but may cause excessive wear of the tool point, and
lead to chattering of the drill.

For optimum results in the feed rate while
drilling, it is necessary to ensure the drill cutting
edges are sharp. Use the correct type of cutting
fluid.

Cutting speed, feed, drilling time calculation

Machining Time in drilling (Fig 2)

Machining time in drilling is determined by the formula:

            
min. 

r
sn

L
T

�
�

Where, n = r.p.m. of the drill

Sr = Feed per revolution of the drill in mm

L = Length of travel of the drill in mm

and T = Machining time in min.

L = l
1
 + l

2
 + l

3
+ l

4

Where, l
1
 = length of the workpiece

l
2
 = approach of the drill,

l
3
 = length of the drill point (0.29d)

l
4
 = overtravel

Example:

Calculate the drilling time to drill 12mm dia hole in a plate
of thickness 62mm, cutting speed 30m/min and federate
is 0.05mm/ rev

Formulae for drilling time 
 

srn
L

T
�

��

L = l
1
 + l

2
 + l

3
+ l

4

= 62 + 5 + 4 + 2

= 73mm

 
795

123.143
30 1000

n �
�

�
�

sr - 0.05 mm

 
1.84 minutes

7950.5
73

T �
�

�

= 1 minute 50 secs

Factors like rigidity of the machine, holding of the workpiece
and the drill, will also have to be considered while determining
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CG & M Related Theory for Exercise 1.2.23
Tool & Die Maker (Dies & Moulds) - Fitting

Dial test indicators
Objectives: At the end of this lesson you shall be able to
• state the principle of a dial test indicator
• state the parts of a dial test indicator
• state the important features of a dial test indicator
• state the functions of a dial test indicator
• explain the different types of stands.

Dial test indicators are instruments of high prescision,
used for comparing and determining the variation in the
sizes of a component. (Fig 1) These instruments cannot
give the direct reading of the sizes like micrometers and
vernier calipers. A dial test indicator magnifies small
variations in sizes by means of a pointer on a graduated
dial. This direct reading of the deviations gives an accurate
picture of the conditions of the parts being tested.

Principle of working

The magnification of the small movement of the plunger or
stylus is converted into a rotary motion of the pointer on a
circular scale. (Fig 2)

Types

Two types of dial test indicators are in use according to the
method of magnification.They are

- plunger type (Fig 3)

- lever type. (Fig 4)

The plunger type dial test indicator

The external parts and features of a dial test indicator areas
shown in figure 3.

1 Pointer 2 Rotatable bezel

3 Tezel clamp 4 Back lug

5 Transparent dial cover 6 Stem

7 Plunger 8 Anvil

9 Revolution counter

For converting the linear motion of the plunger, a rack and
pinion mechanism is used.

The lever type dial test indicator (Fig 4)

In the case of this type of dial test indicators, the
magnification of the movement is obtained by the mechanism
of the lever and scroll. (Fig 5)

It has a stylus with a ball- type contact, operating in the
horizontal plane.

This can be conveniently mounted on a surface gauge
stand, and can be used in places where the plunger type
dial test indicator application is difficult. (Fig 6)
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Important features of dial test indicators

An important feature of the dial test indicator is that the
scale can be rotated by a ring bezel, enabling it to be set
readily to zero.

Many dial test indicators read plus in a clockwise direction
from zero, and minus in the anticlockwise directions so as
to give plus and minus indications.

Uses (Figure 7 shows a few applications.)

- To compare the dimensions of a workpiece against a
known standard, eg.slip gauges.

- To check plane surfaces for parallelism and flatness.

- To check parallelism of shafts and bars.

- To check concentricity of holes and shafts.

Indicator stands

Dial test indicators are used in conjunction with stands for
holding them so that the stand itself may be placed on a
datum surface or machine tools. (Fig 8)

The different types of stands are (Fig 9)

- magnetic stand with universal clamp

- magnetic stand with flexible post

- general purpose holder with cast iron base.

The arrows indicate the provisions in the
clamps for insertion of the dial test indicator.
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CG & M Related Theory for Exercise 1.2.24
Tool & Die Maker (Dies & Moulds) - Fitting

Mass production and interchangeable manufacture
Objectives: At the end of this lesson you shall be able to
• state the advantages and disadvantages of mass production
• explain the meaning of the term, ‘interchangeability’
• state the necessity for the limit system
• state the different standards of system of limits and fits.

Mass production

Mass production means production of a unit, component
or part in large numbers.

Advantages of mass production

Time for the manufacture of components is reduced.

The cost of work piece is reduced.

Spare parts can be made available quickly.

Gauges are used to check the components.

Even unskilled workers can be employed for checking.

Manufacturing and measuring time is saved.

Disadvantages of mass production

Special purpose machines are necessary.

Jigs and fixtures are needed.

Gauges are to be used, hence the initial expenditure will
be high.

Selective assembly

Figures 1 & 2 illustrate the difference between a selective
assembly and a non-selective assembly.  It will be seen in
Fig 1 that each nut fits only one bolt.  Such an assembly
is slow and costly, and maintenance is difficult because
spares must be individually manufactured.

In modern engineering production, i.e. mass production,
there is no room for selective assembly.  However, insome
special circumstances, selective assembly is still justified.

Interchangeability

When components are mass-produced, unless they are
interchangeable, the purpose of mass production is not
fulfilled. By interchangeability, we mean that identical
components, manufactured by different personnel under
different environments, can be assembled and replaced
without any rectification during the assembly stage and
without affecting the functioning of the component when
assembled.

Necessity of the limit system

If components are to be interchangeable, they need to be
manufactured to the same identical size which is not
possible, when they are mass-produced.  Hence, it
becomes necessary to permit the operator to deviate by a
small margin from the exact size which he is not able to
maintain for all the components.  At the same time, the
deviated size should not affect the quality of the assembly.
This sort of dimensioning is known as limit dimensioning.

A system of limits is to be followed as a standard for the
limit dimensioning of components.

Various standard systems of limits and fits are followed
by different countries based on the ISO (International
Standards Organisation) specifications.

The system of limits and fits followed in our country is that
which is stipulated by the BIS. (Bureau of Indian Standards)

Other systems of limits and fits

-  British Standard System (BSS)

-  German Standard (DIN)

Non-selective assembly

Any nut fits any bolt of the same size and thread type.
Such an assembly is rapid, and costs are reduced.
Maintenance is simpler because spares are easily
available. (Fig 2)

Non-selective assembly provides interchangeability
between the components.
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CG & M Related Theory for Exercise 1.2.25
Tool & Die Maker (Dies & Moulds) - Fitting

The Indian standard system of limits and fits - terminology
Objectives: At the end of this lesson you shall be able to
• state the terms used under the BIS system of limits and fits
• define each term under the BIS system of limits and fits.

Size: It is a number expressed in a particular unit in the
measurement of length.

Basic size:It is the size based on which the dimensional
deviations are given. (Fig 1)

Actual size

It is the size of the component by actual measurement
after it is manufactured.  It should lie between the two
limits of size if the component is to be accepted.

Limits of size

These are the extreme permissible sizes within which the
operator is expected to make the component. (Maximum
and minimum limits) (Fig 2)

Maximum limit of size: It is the greater of the two limits
of  sizes. (Fig 2) (Table 1)

Minimum limit of size: It is the smaller of the two limits
of size. (Fig 2) (Table 1)

Hole: In the BIS system of limits and fits, all internal
features of a component including those which are not
cylindrical are designated as hole. (Fig 3)

Shaft: In the BIS system of limits and fits, all external
features of a component including those which are not
cylindrical are designated as shaft. (Fig 3)

Deviation: It is the algebraic difference between a size
and its corresponding basic size.  It may be positive,
negative or zero. (Fig 2)

Upper deviation: It is the algebraic difference between
the maximum limit of size and its corresponding basic
size. (Fig 2) (Table 1)

Lower deviation

It is the algebraic difference between the minimum limit of
size and its corresponding basic size. (Fig 2) (Table 1)

Upper deviation is the deviation which gives the maximum
limit of size.  Lower deviation is the deviation which gives
the minimum limit of size.

Actual deviation: It is the algebraic difference between
the actual size and its corresponding basic size. (Fig 2)

Tolerance: It is the difference between the maximum limit
of size and the minimum limit of size. It is always positive
and is expressed only as a number  without a sign. (Fig 2)

Zero line

In the graphical representation of the above terms, the
zero line represents the basic size.  This line is also called
the line of zero deviation. (Figs 1 and 2)

Fundamental deviation

There are 25 fundamental deviations in the BIS system
represented by letter symbols (capital letters for holes
and small letters for shafts), i.e. for holes - ABCD .... Z
excluding I,L,O,Q and W. (Fig 4)
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In addition to the above, four sets of letters JS,ZA,ZB and
ZC are included.

For shafts, the same 25 letter symbols but in small letters
are used. (Fig 5)

The position of tolerance zone with respect to the zero
line is shown in Figs 6 and 7.

The fundamental deviations are for achieving the different
classes of fits. (Figs 8 and 9)

Fundamental tolerance

This is also called ‘grade of tolerance’.  In the B.I.S.
system, there  are 18 grades of tolerances represented
by number symbols both for hole and shaft, denoted as
IT01, IT0, IT1, IT2 ......... IT16 (Fig 10)

A higher number gives a larger tolerance.

Grade of tolerance refers to the accuracy of
manufacture.

In a standard chart, the upper and lower deviations for
each combination of fundamental deviation and
fundamental tolerance are indicated for sizes ranging up
to 500 mm. (Refer to IS 919.)
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Tolerance size

This includes the basic size, the fundamental deviation
and the grade of tolerance.

Examples

25 H7 - is the  tolerance size of a hole whose basic size is
25.  The fundamental deviation is represented by the letter
symbol H and the grade of tolerance is represented by the
number symbol 7. (Fig 11)

25 e8 - is the tolerance size of a shaft whose basic size is
25.  The fundamental deviation is represented by the letter
symbol and the grade of tolerance is represented by the
number 8. (Fig 12)

A very wide range of selection can be made by the
combination of the 25 fundamental deviations and 18 grades
of tolerances.

Example

In figure 13, a hole is shown as 25 ± 0.2 which means that
25 mm is the basic dimension and ± 0.2 is the deviation.

As pointed out earlier, the permissible variation from the
basic dimension is called ‘DEVIATION’.

The deviation is mostly given on the drawing with
dimensions.

In the example, 25 ± 0.2, ± 0.2 is the deviation of the hole
of 25 mm diameter.  (Fig 13)  This means that the hole is
of acceptable size if its dimension is between

25 + 0.2 = 25.2 mm

    or

25 -  0.2 = 24.8 mm.

25.2 mm is the maximum limit. (Fig 14)

24.8 mm is the minimum limit. (Fig 15)

The difference between the maximum and minimum limits
is the TOLERANCE. Tolerance here is 0.4 mm.
(Fig 16)

All dimensions of the hole within the tolerance zone are of
an acceptable size as shown in Fig 17.

As per IS 696, while dimensioning the components as a
drawing convention, the deviations are expressed as
tolerances.
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Different Standard System of fits & limits (As per the Indian standard)
Objectives: At the end of this lesson you shall be able to
• define ‘fit’ as per the Indian Standard
• list out the terms used in limits and fits as per the Indian Standard
• state examples for each class of fit
• state the graphical representation of different classes of fits.

Fit

It is the relationship that exists between two mating parts,
a hole and a shaft, with respect to their dimensional
differences before assembly.

Expression of a fit

A fit is expressed by writing the basic size of the fit first,
(the basic size which is common to both the hole and the
shaft) followed by the symbol for the hole, and  the  symbol
for the shaft.

Example

30 H7/g6 or 30 H7 _ g6 or 30

Clearance

In a fit the clearance is the difference between the size of
the hole and the size of the shaft, when the hole is bigger
than the shaft.

Clearance fit

It is a fit which always provides clearance.  Here the
tolerance zone of the hole will be above the tolerance zone
of the shaft. (Fig 1)

Example

20 H7/g6

With the fit given, we can find the deviations from the chart.

For a hole 20 H7 we find in Table 1, +21.

These numbers indicate the deviations in microns.
(1 micron = 0.001 mm)

The limits of the hole are 20 + 0.021 = 20.021 mm and
20 + 0 = 20.000 mm. (Fig 2)

For a shaft 20 g6 we find in the Table _ 7

_ 20.

So the limits of the shaft are

20 _ 0.007 = 19.993 mm

and 20 _ 0.020 = 19.980 mm. (Fig 3)

Maximum clearance

In a clearance fit or transition fit, the maximum clearance
is the difference between the maximum size hole and the
minimum size shaft. (Fig 4)

Minimum  clearance

In a clearance fit, the minimum clearance is the difference
between the minimum hole and the maximum shaft.
(Fig 4)
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The minimum clearnace is 20.000 _ 19.993 = 0.007 mm.
(Fig 4)

The maximum clearnace is 20.021 _ 19.980 = 0.041 mm.
(Fig 4)

There is always a clearance between the hole and the
shaft.  This is the clearance fit.

Interference

It is the difference between the size of the hole and the
shaft before assembly, and this is negative.  In this case,
the shaft is always larger than the hole size.

Interference fit

It is a fit which always provides interference.  Here the
tolerance zone of the hole will be below the tolerance zone
of the shaft. (Fig 5)

Example

Fit 25 H7/p6 (Fig 6)

The limits of the hole are 25.000 and 25.035 mm. and the
limits of the shaft are 25.022 and 25.035. The shaft is
always bigger than the  size of the hole.  This is an
interference fit.

Maximum interference

In an interference fit, it is the algebraic difference between
the minimum hole size  and the maximum shaft size .
(Fig 7)

Minimum interference

In an interference fit, it is the algebraic difference between
the maximum hole size  and minimum shaft size.
(Figs 7 & 8)

In the example shown in figure 6,

the maximum interference is      = 25.035 _ 25.000

                                                   = 0.035.

the minimum inteference is        = 25.022 _ 25.021

                                                   = 0.001.

Transition fit

It is a fit which may sometimes provide clearance, and
sometimes interference.  When this class of fit is
represented graphically, the tolerance zones of the hole
and shaft will overlap each other. (Fig 8)

Example

Fit 75 H8/j7 (Fig 9)

The limits of the hole are 75.000 and 75.046 mm and those
of the shaft are 75.018 and 74.988 mm.

Maximum clearnace  = 75.046 _ 74.988

                                  = 0.058 mm.

If the hole is 75.000 and the shaft 75.018 mm, the shaft is
0.018 mm bigger than the hole.  This results in interference.
This is a transition fit because it can result in a clearance
fit or an interference fit.

Hole basis system

In a standard system of limits and fits, where the size of
the hole is kept constant and the size of the shaft is varied
to get the different classes of fits, it is known as the hole
basis system.
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The fundamental deviation symbol ‘H’ is chosen for the
holes, when the hole basis system is followed.  This is
because the lower deviation of the ‘H’ hole is zero.  It is
known as the ‘basic hole’. (Fig 10)

Shaft basis system

In a standard system of limits and fits, where the size of
the shaft is kept constant and the variations are given to
the hole for obtaining different classes of fits, then it is
known as shaft basis system.  The fundamental deviation
symbol ‘h’ is chosen for the shaft when the shaft basis is
followed.  This is because the upper deviation of the ‘h’
shaft is zero.  It is known as the ‘basic shaft’. (Fig 11)

The hole basis system is followed mostly.  This is because,
depending upon the class of fit, it will be always easier to
alter the size of the shaft as it is external, but it is difficult

to do minor alterations to a hole.  Moreover the hole can
be produced by using standard toolings.

The three classes of fits, both under the hole basis and
the shaft basis, are illustrated in figure 12.

The B.I.S. system of limits and fits - reading the standard chart
Objective: At the end of this lesson you shall be able to
• explain to the standard limit system chart and state the limits of sizes.

The standard chart covers sizes up to 500 mm (I.S.919 of
1963) for both holes and shafts.  It specifies the upper and
lower deviations for a certain range of sizes for all
combinations of the 25 fundamental deviations, and 18
fundamental tolerances.

The upper deviation of the hole is denoted as ES and the
lower deviation of the hole is denoted as EI.  The upper
deviation of the shaft is denoted as ‘es’ and the lower
deviation of shaft is denoted as ‘ei’.

Note

es is expanded as ECART SUPERIOR and ei as ECART
INFERIOR.

Determining the limits from the chart

Note whether it is an internal measurement or an external
measurement.

Note the basic size.

Note the combination of the fundamental deviation and
the grade of tolerance.

Then refer to the chart and note the upper and lower
deviations which are given in microns, with the sign.
Accordingly add or subtract from the basic size and
determine the limits of size of the components.

Example

30H7 (Fig 1)

It is an internal measurement.  So we must refer to the
chart for ‘holes’.

The basic size is 30 mm.  So see the range 30 to 40.

Look for es, and ei values in microns for H7 combination
for 30 mm basic size.

It is given as +0 to +25

Therefore, the maximum limit of the hole is  30 + 0.025 =
30.025 mm.

The minimum limit of the hole is 30 + 0.000 = 30.000 mm.

Refer to the chart and note the values of 40 g6.

Note

The table for tolerance zones and limits as per IS2709  is
attached. (Table 1)
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Other system of limits and fits

British standard system (BS)

British standard system is the system which is based on
ISO systems

BS 1916-1 gives guidance on tolerances, limits and fits
for engineering sizes up to 19.69 in. The recommendations
apply particularly to fits between cylindrical parts,
designated as "holes" and "shafts", in which case the
term "size" refers to the diameter of the mating parts.

DIN standard system

A DIN standard is a standard drawn up at the German
Institute for Standardization (DIN) in Berlin that sets unified
standards for products and processes, such as quality,
minimum performance, characteristics, dimensions, etc.

General tolerance for linear and angular dimensions are
are coverd in DIN ISI 2768 T1

Japanese Industrial Standards (JIS)

Japanese Industrial Standards (JIS) specifies the standards
used for industrial activities in Japan . The standardization
process is coordinated by the Japanese Industrial
Standards Committee and published through the Japanese
Standards Association. (JSA)

JSA - JIS B 0405

General Tolerances - Part 1: Tolerances for Linear and
Angular Dimensions Without Individual Tolerance
Indications

ANSI Standard Limits and Fits (ANSI B4.1-1967)

ANSI, This American Standard for preferred limits and fits
for cylindrical parts presents definitions of terms applying
to fits between non threaded cylindrical and makes some
recommendations on  preferred  sizes, fits, tolerances,
and allowances for use where they are applicable. The
ANSI B4.1 charts data are provided in thousandths (.001)
of an inch.

Europe standard

European Committee for Standardization (CEN). Is  specify
the standard

Tolerance standards vary depending on the manufacturing
processes. For example, the most common tolerance
standards that are used by engineers in Europe for
subtractive manufacturing (e.g. CNC machining) are defined
by ISO 2768 and ISO 286

Indian Standard (IS)

This Indian Standard ( Second Revision ) which is identical
with IS0 236-I : 1988 'IS0 system of limits arid fits - Part 1
: Bases of tolerances, deviations and fits' was adopted by
the Bureau of Indian Staridards on the recommendations
of the Engineering Standards Sectional Committee

IS0 SYSTEM OF LIMITS AND FITS

International Organization for Standardization (ISO)

IS 919 (Part 1) : 1993 IS0 288 - 1 : 1988

This part of IS0 286 gives the bases of the IS0 system of
limits and fits together with the calculated values of the
standard tolerances and fundamental deviations. These
values shall be taken as authoritative for the application of
the system.
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CG & M Related Theory for Exercise 1.2.26-27
Tool & Die Maker (Dies & Moulds) - Fitting

Geometrical tolerancing
Objectives: At the end of this lesson you shall be able to
• define geometrical tolerance
• state the necessity of using geometrical tolerances
• identify the recommended symbols for tolerancing
• under the three groups of form, altitude and location.

Form i.e. straightness, flatness, roundness, cylindricity
and profile of a line and a surface.

Attitude i.e. parallelism, squareness and angularity

Location i.e. position, concentricity and symmetry

Definition of geometrical tolerance

Geometrical tolerance is the maximum permissible overall
variation of form or position of a feature.

Reason for using geometrical tolerance

This will help the operator to produce the components,
particularly those parts which must fit together precisely.

To have an international system which will overcome the
usual language barrier. This is achieved by the use of
symbols which represent geometrical characteristics.

General principles of geometrical tolerances

The geometrical tolerance consists of a frame which
contains a symbol, representing the geometrical tolerance
zone, in this instance 0.05 for the characteristic of
parallelism. The symbol for flatness is shown accompanied
by the tolerance zone figure of 0.02 in the lower frame.
(Fig 1).

Notice that from each of the frames a leader is drawn so that
it is normal, it.e. at 90º to the relevant face and ending with
an arrow-head against the face.

Notice also that from the ‘paralleslism’ frame, another
leader is drawn terminating in a blacked-in equilateral
triangle on a projection drawn out from the base line. The
blacked-in triangle (about 4.5 mm high from base to apex)
is the symbol used to represent a datum face or line.

An alternate method of arranging the frames and symbols
is shown in Fig 2. Where the datum is given a letter and a
frame of its won and an independent leader line ending in
the blacked-in triangle, inverted and drawn against the
actual component base line.  The datum letter ‘A’ is then
added as an extra component in the geometrical tolerance
frame.

Recommended symbols for geometrical tolerancing

Geometrical tolerances are arranged into three groups.
They are tolerances of form, of attitude and of location.

Tolerances of FORM are identified by the use of symbols
for the following characteristics.

Characteristic Symbol

Straightness

Flatness

Roundness

Cylindricity

Profile of a line

Profile of a surface
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The application of symbols is indicated in (Fig3). Where
(3a), (3b), (3c) & (3d) show the use of geometrical tolernaces
controlling the straightness of a circular section part. In (3a)
and (3b) the leader lines from the tolerance frame end in an
arrow-head against the axis of the part. This means that the
geometrical tolerance applies to the full length of the part.
the interpretation at (3a) shows that for functional
acceptance, the entire main axis must lie between two
parallel straight lines 0, 1 apart in that plane.  At (3b) the
symbol for the diameter ® precedes the tolerance. This
means that the entire main axis must lie within a cylindrical
tolerance zone 0.1 mm diameter.

Figures (3c) and (3d) show the same geometrical tolerance,
applied this time to the diameter dimension of the smaller
diameter of the part.

This means that the geometrical tolerance applies over the
length of the dimensional feature only.

Fig 4 deal with the geometrical tolerance for flatness of a
surface, where the sumbol for flatness is followed by the
tolerance of 0.05. This Fig (4a) indicates that the actual
surface must be between two parallel planes 0.05 apart. If
a particular form of direction is prohibited, then this is
stated in a note form against the tolerance frame. Eg. “Not
concave.” (Fig 4b)

The geometrical tolerance controlling roundness of a part
is shown in Fig 5.  The interpretation for (5a) and (5b) is that
the true form of the periphery of the part at any cross-
section perpendicualr to the axis must lie between two
concentric circles whose radial distance apart is 0.02 for
(5a) and 0.03 for (5b).

For the sphere shown in (5c) the geometrical tolerance
applies to concentric circles with the radial distance apart
0.04 at the periphery at any section of maximum diameter.

The symbol controlling cylindricity is shown in Fig 6. Here
the interpretation shows, that for acceptance, the surface
of the part must be within two coaxial cylinders, whose
radial distance apart is 0.05.

Fig 7. shows the method of applying a geometrical tolerance
to a curved surface.The symbol is followed by the tolerance
0.05 which means that the actual surface must lie between
two surfaces enveloping a succession of sphere 0.05
diameter whose centre lies on the theoretical surface.

In Fig 8. the geometrical tolerance is applied to linear
dimensions controlling the profile. The rectangular ‘boxes’
around the 250 centre dimension and the 50 radius is the
method used to indicate theoretical dimensions i.e. the
dimensions relevant to perfect form.
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The interpretation of the geometrical tolerance is that the
actual profile must be between two lines which touch a
succession of circles 0.2 dia. whose centre lies on the
theoretical profile.

Tolerances of attitude are identified and indicated by the
use of symbols for the following.

Characteristic Symbol

Parallelism     //

Squareness

T

Angularity

A typical application of tolerances for these three
characteristics is shown in figures 9,10,11,12,13,14,15
and 16. Fig (9a) and (9c) show the application of tolerancing
to control ‘parallelism.’ (9a) shows that the axis of the upper
hole must lie between the two lines 0.08 apart which are
paralled with the datum axis, i.e., the axis of the lower hole,
as indicated by the leader ending in the blacked-in triangle.
In (9b) the method uses a separate datum letter ‘A’ which
is added to the frame after the tolerance of 0.05 diameter.
(Note the symbol ∅)  The requirement is that the upper hole
axis must lie within a cylindrical zone 0.05 diameter with
its axis parallel with the axis of the datum hole ‘A’.  Fig (9c)
shows a component whose upper surface must be between
two parallel planes 0.05 apart, paralled with teh bottom
datum surface.  While the overall tolerance zone is 0.05 as
shown in the upper section of the frame, the figures in the
lower section of the frame stipulate that over any length of
100 the parallelism tolerance is reduced to 0.02.

Examples of the application of the geometrical tolerance
for ‘squareness’ are shown in Figs 10, 11, 12 and 13 with
10, 11 and 12 using the separate box method for indicating
the datum.

The interpretation is as follows.

The axis of the vertical hole must lie between two parallel
lines, 0.05 apart, which are perpendicular to the common
datum axis ‘A’ of the two horizontal holes; (Fig 10).

The axis of the upper cylindrical portion must lie within a
cylindrical tolerance zome of 0.1 diameter, the axis of
which is perpendicular to the datum surface ‘A’. (Fig 11)

This shows that the right hand end face must lie between
two parallel planes 0.05 apart, which are perpendicular to
the datum axis. (Fig 12)

Here the datum surface is indicated by a leader from the
frame. The requirement is that the right hand face must lie
within the two parallel planes, 0.05 apart, which are
perpendicular to the datum surface. (13)

T

∠
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Geometrical tolerances for the control of ANGULARITY are
shown in Figs 14, 15 & 16.

The Fig 14 shows that the requirement is the axis of the
hole must lie within the cylindrical tolerance zone 0.1
diameter, the axis of which must be included at the
theoretical angle of 60º to the datum surface A.

In Fig 15 the requirement is that the right hand end face
must lie within the two parallel planes 0.08 apart which are
inclined at the theoretical angle of 75º to the datum axis A
of the through hole.

Fig 16 shows a  component whose upper angle face, must
lie between the two parallel planes 0.05 apart which are
inclined at the theoretical angle of 35º to the base, the
datum surface. Notice that the theoretical angle in each
example is boxed.

Tolerancces oflocation are identified and indicated by the
use of symbols for the following characteristics.

Characteristic Symbol

Position

Concentricity

Symmetry

Figs 17, 18 & 19 show typical examples of these
characteristics and symbols.  In Fig 17 the holw centre
dimensions of 25 and 30 are boxed to show that these are
the theoretical dimensions. The geometrical tolerance
requires that the holw centre must lie within a cylindrical
zone 0.05 diameter. The use of theoretical positions, also
known as ‘true positions.’ implies that the axis of the
cylinder is square with the plane of the drawing.  Fig 18
shows the hole with the same true positions, but with the
geometrical tolerances arranged to give greater tolerance
along the horizontal axis. The resulting requirement is that
the axis of the hole must lie within a rectangular box whose
sides are 0.03 and 0.06, and length equal to the width of the
component.
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In (Fig 19) the two holes are shown with their true position
spaced at 45º on a 30 mm pitch circle radius. The
geometrical tolerance shows that each actual hole centre
must lie within a cylindrical zone 0.08 diameter whose axis
lies at the true centre position. The tolerance cylinders are
disposed relative to the two datum features, namely the
axis of the smaller bore and the right hand end face. The
datum letters are included in the tolerance frame.

Examples of geometrical tolerance for ‘CONCENTRICITY’
are given in Figs 20,21 & 22. the interpretations are as
follows.

In Fig 20 the axis of the smaller diameter must lie within the
cylindrical zone 0.08 diameter which must be coaxial with
the datum axis i.e. the axis of datum diameter ‘A’.

In Fig 21 the axis of the two end portions must lie within a
cylindrical tolerance zone 0.08 dia.

Fig 22 the axis of the large central portion must lie within
a cylindrical zone 0.1 diameter which is coaxial with the
mean axis of the datum diameters ‘A’ and ‘B’. (Notice that
to indicate the requirement of the mean azis the datum
letters are separated by a hyphen and enclosed in the
same compartment of the tolerance frame)

The geometrical tolerance of ‘SYMMETRY’ follows in
Figs 23, 24 & 25 where the interpretations are:

Fig 23 the axis of the hole must lie between two parallel
planes, 0.08 apart which are symmetrically disposed
about the mean axial plane of datum width ‘A’ and ‘B’.
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Fig 24 the mean plane of the slot must be between two
parallel planes, 0.05 apart symmetically disposed about
the mean plane of the datum width ‘W’

Fig 25 the median planes of the two end slots must be
between two parallel planes, 0.06 apart.

A details drawing which indicates geometrical tolerances (Fig 26)

CG& M: TDM (Dies & Moulds) (NSQF - Revised 2022) - R.Theory for Ex. 1.2.26 - 27

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



112

Malleability (Fig 4): Malleability is the property of
permanently extending in all directions without rupture by
hammering, rolling etc, to change its size and shape. Lead
is a very malleable metal.

CG & M Related Theory for Exercise 1.2.28
Tool & Die Maker (Dies & Moulds) - Fitting

Physical and mechanical properties of metals
Objectives: At the end of this exercise you shall be able to
• state the different physical and mechanical properties of materials
• state the characteristics of the mechanical properties of metals.

Properties of metals

Metals have different properties. Depending on the type of
application, different metals are selected.

Physical properties of metals

- Colour - Conductivity

- Weight/Specific - Magnetic property

gravity

- Structure - Fusibility

Colour

Different metals have different colours. For example, copper
is of a distinctive red colour.  Mild steel is of a blue/black
sheen.

Weight

Metals differ based on their weight. A metal, like aluminium,
weighs lighter (specific gravity 2.8) than many others, and
a metal, like lead, is heavy  (specific gravity 9).

Structure (Figs 1 a and b)

Generally metals can also be differentiated by their internal
microstructure. Metals like wrought iron and aluminium will
have a fibrous structure, and metals like cast iron and
bronze will have a granular structure.

Fusibility (Fig 2)

It is the property possessed by a metal by virtue of which
it melts when heat is applied.  Many materials are subject
to the transformation in shape (i.e.) from solid to liquid at
different temperatures.  Tin has a low melting temperature
(2320C)and tungsten melts at a high temperature
(33700C).

Conductivity

Thermal conductivity and electrical conductivity are the
measure of the ability of a material to conduct heat and
electricity. Conductivity will vary from metal to metal.
Copper and aluminium are  good conductors of heat and
electricity.

Magnetic property

A metal is said to possess  magnetic property, if it is
attracted by a magnet.

Almost all ferrous metals, excepting some types of stainless
steel, can be attracted by a magnet and all
non-ferrous metals and their alloys will not be attracted by
a magnet.

Mechanical properties

The mechanical properties of a metal are

- ductility - malleability

- hardness - brittleness

- toughness - tenacity

- elasticity

Ductility (Fig 3)

A metal is said   to be ductile when it may be drawn out in
tension without rupture. Wire-drawing depends upon
ductility for its successful operation.  A ductile metal must
be both strong and plastic. Copper and aluminium are  good
examples of ductile metals.
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Hardness (Fig 5)

Hardness is a measure of a metal's ability to withstand
scratching, wear, abrasion and penetration.

Brittleness (Fig 6)

Brittleness is that property of a metal which permits no
permanent distortion before breaking. Cast iron is an
example of a  brittle metal, and it will break rather than bend
under shock or impact.

Toughness (Fig 7)

Toughness is the property of a metal to withstand shock or
impact. Toughness is the property opposite to brittleness.
Wrought iron is an example of a tough metal.

Tenacity  (Fig 8)

Tenacity of a metal is its ability to resist the effect of tensile
forces without rupture. Mild steel, wrought iron and copper
are examples of tenacious metals.

Elasticity (Fig 9)

Elasticity of a metal is its power of returning to its original
shape after the applied force is released. Properly
heat-treated spring is a good example of elasticity.

Classification of metals and its uses
Objectives: At the end of this lesson you shall be able to
• state what is ferrous and non ferrous metals
• list the different type of ferrous and non ferrous metals
• brief the uses of ferrous and  non ferrous metals
• differentiate between ferrous and non ferrous metals.

All engineering metals can be classified into two broad
categories of metal and non metal. They are ferrous and
non ferrous metals.

Ferrous metal: - Metals which contain iron as a major
content are called ferrous metal
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Non ferrous metal: - Metals that do not contain iron is
called non ferrous metal

Pure iron is of little use because it is too soft and ductile

These two categories are further classified as

Ferrous metals

Pig iron

Cast iron

- Grey cast iron,

- white cast iron,

- Alloy cast iron ,

- Malleable cast iron ,

- Nodular cast iron

- Wrought iron

Steel

Alloy steel ,

Stainless steel ,

Carbon steel

- Low carbon steel ,

- Medium carbon steel

- High carbon steel

Non ferrous metals

Copper

Aluminum

Brass bronze

Lead silver

Zinc tin etc

Non metals

Leather

Rubber

Polymers

Wood

Ceramics

Uses of Ferrous Metals

Commonly used examples of ferrous metals include steel,
stainless steel, carbon steel, cast iron and wrought iron:

Steel

A combination of iron and carbon, steel is renowned for
its strength and machinability. It is widely used in
construction, manufacturing and industrial metal
fabrication.

Stainless Steel

Stainless steel is an alloy steel made with the addition of
chromium to steel, which provides resistance against rust.

Carbon Steel

Carbon steel contains a high carbon content that is added
to iron to create an exceptionally hard metal that is used
for tools.

Low carbon steel

The low cost and malleability low carbon steels used.
For  bolts and nuts, forgings, etc

Medium carbon steel

Medium carbon steels are mainly used for making different
automotive industry components like gears, axles, shafts
but also bolts, nuts, screws etc. Steels ranging from
0.4…0.6% are also suitable for everything related to
locomotives and rails.

High carbon steel

The main use of high-speed steels used for  various cutting
tools: like drills, taps, tool bits, , saw blades, , router
bits, punches and dies etc

Cast Iron

Cast iron is a hard and wear resistant metal that is widely
used for items including cookware, machine tools,
engines, manhole covers and water pipes.

Grey cast iron

This is widely used for the casting of machinery parts like
machine bases , tables , slide ways

White cast iron

It is used in components which should be abrasion
resistant

Wrought Iron

Unlike most other ferrous metals, wrought iron is able to
resist corrosion and oxidation. It is typically used for
fences, railings and gates.

Uses of Non Ferrous Metals

Commonly-used non-ferrous metals include aluminium,
lead, silver, brass, gold, zinc, copper and tin:

Aluminum

Lightweight and easy to machine, shape and weld,
aluminium is used for a range of applications from food
cans and cookware to aeroplane parts and cars.

Copper

A good conductor of heat and electricity, copper is highly
ductile and malleable. It is widely used for electrical wiring
as well as in appliances and vehicles.

Lead

Lead is used in electrical power cables, batteries, pipes,
fuels, paint and for soldering.

Tin

Soft and malleable with a low tensile strength, tin is used
as a coating to prevent steel from corroding.
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Silver

Silver is used for a range of applications, including jewellery,
cutlery, electrical contacts and in mirrors.

Brass

Brass is used for fixtures and fittings including taps, hooks,
and doorknobs, as well as being used for light fittings and
screws, among other uses.

Sl.No Ferrous Metals Non Ferrous Metals

1

2

3

4

5

6

Ferrous indicates the presence of iron in a
bivalent state.

As ferrous contains iron, it shows magnetic
feature.

Ferrous metals are less resistant to
corrosion.

One special feature of ferrous metals is it
possesses high tensile strength and
durability.

Ferrous metals can be oxidized.

Ferrous metals make up the most recycled
materials in the world

The price of ferrous metal tends to be lower.

Gold

Used for jewellery, gold also has applications including
within the medical industry, in computers and also
electronics.

Zinc

A medium strength metal with a low melting point, zinc is
used to galvanise iron and steel to prevent rusting.

Difference between Ferrous and Non ferrous Metals

The main differences between ferrous and nonferrous Metals are given in table 1

Non-ferrous metals do not contain any iron.

Non-ferrous metals don't show any magnetic feature
which means it's non-magnetic.

Non-ferrous metals are more resistant to corrosion

One special feature of non-ferrous metals is their
malleability.

Non-ferrous metals cannot be oxidized.

As per the recycling goes, many non-ferrous materials
are relatively insufficient.

Prices of non-ferrous metals are greater than ferrous
metals
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CG & M Related Theory for Exercise 1.2.29
Tool & Die Maker (Dies & Moulds) - Fitting

Heat treatment of plain carbon steels
Objectives: At the end of this lesson you shall be able to
• state the purpose of heat treatment of steel
• state the types of structure, constituents and properties of plain carbon steels.

Heat treatment and its purpose

The properties of steel depend upon its composition and
its structure. These properties can be changed to a
considerable extent, by changing either its composition
or its structure. The structure of steel can be changed by
heating it to a particular temperature and then allowing it
to cool at a definite rate. The process of changing the
structure and thus changing the properties of steel, by
heating and cooling, is called ‘heat treatment of steel’.

Types of structures of steel (Fig 1)

The structure of steel becomes visible when a piece of the
metal is broken. The exact grain size structure can be
seen through a microscope. Steel is also classified
according to its type of structure.

Steel is an alloy of iron and carbon. But the carbon content
in steel does not exceed 1.7%

Ferrite

Pig - iron or steel with 0% carbon is called FERRITE which
is relatively soft and ductile but comparatively weak.

Cementite

When carbon exists in steel as a chemical compound of
iron and carbon it is called ‘iron carbide’ or CEMENTITE.
This alloy is very hard and brittle but it is not strong.

Eutectoid / Pearlite steel

A 0.84% carbon steel or eutectoid steel is known as
PEARLITE steel. This is much stronger than ferrite or
cementite.

Hypereutectoid steel

More than 0.84% Carbon steel or hypereutectoid steel is
pearlite and cementite.

Hypoeutectoid steel

Less than 0.84% carbon steel or hypoeutectoid steel is
pearlite and ferrite.

Structure of steel when heated (Fig 2)

If steel is heated, a change in structure commences from
7230C. The new structure formed is called ‘AUSTENITE’.
Austenite is non - magnetic. If the hot steel is cooled
slowly, the old structure is retained and it will have fine
grains which makes it easily machinable.

If the hot steel is cooled rapidly the austenite changes
into a new structure called ‘MARTENSITE’. This structure
is very fine, very hard and magnetic. It is extremely wear
resistant and can cut other metals.

Heat treatment processes and purposes

Because steel undergoes changes in structure on heating
and cooling, its properties may be greatly altered by
suitable heat treatment.

The following are the various heat treatments and their
purposes.

Hardening : To add cutting ability.

To increase wear resistance.

Tempering :To remove extreme brittleness caused by
hardening to an extent.

To induce toughness and shock-resistance.

Annealing : To relieve strain and stress.

To eliminate strain / hardness.

To improve machinability.

To soften the steel.

Normalising : To refine the structure of the steel.
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Heating/Quenching steel for heat treatment
Objectives: At the end of this lesson you shall be able to
• distinguish between the lower critical and the upper critical temperatures
• state the three stages in the ehat treatment process
• determine the upper critical temperature for different plain carbon steels from the diagram.

Critical temperatures

Lower critical temperatures

The temperature, at which the change of structure to
austenite starts - 723°C, is called the lower critical
temperature for all plain carbon steels.

Upper critical temperature

The temperature at which the structure of steel completely
changes to AUSTENITE is called the upper critical
temperature. This varies depending on the percentage of
carbon in the steel. (Fig 1)

Example

0.57% and 1.15% carbon steel: In these cases the lower
critical temperature is 723°C and the upper critical
temperature is 800°C.

For 0.84% carbon steel, both LCT and UCT are 723°C.
This steel is called eutectoid steel.

Three stages of heat treatment.

• Heating

• Soaking

• Quenching

When the steel on being heated reaches the required
temperature, it is held in the same temperature for a period
of time. This allows the heating to take place throughout
the section uniformly. This process is called soaking.

Soaking time

The depends upon the cross-section of the steel, its
chemical composition, the volume of the charge in the
furnace and the arrangement of the charge in the furnace.
A good general guide for soaking time in normal conditions
is five minutes per 10 mm of thickness for carbon and low
alloy steels, and 10 minutes per 10 mm of thickness for
high alloy steels.

Heating steel

This depends on the selection of the furnace, the fuel used
for heating, the time interval and the regulation in bringing
the part up to the required temperature. The heating rate
and the heating time also depend on the compositon of
the steel, its structure, the shape and size of the part to
be heat-treated etc.

Preheating

Steel should be preheated at low temperature up to 600°C
as slowly as possible.

Quenching

Depending on the severity of the cooling required, different
quenching media are used.

The most widely used quenching media are:

- brine solution

- water

- oil

- air

Brine solution gives a faster rate of cooling while air cooling
has the slowest rate of cooling.

Brine solution (Sodium chloride) gives severe quenching
because it has a higher boiling point that pure water, and
the salt content removes the scales formed on the metal
surfaces due to heating. This provides a better contact
with the quenching medium and the metal being heat teated.

Water is very commonly used for plain carbon steels. While
using water as a quenching medium, the work should be
agitated. This can increase the rate of cooling.

The quenching oil used should be of a low viscosity.
Ordinary lubricating oils should not be used for this purpose.
Special quenching oils, which can give rapid and uniform
cooling with less furning and reduced fire risks, are
commercially available. Oil is widely used for alloy steels
where the cooling rate is slower than plain carbon steels.

Cold air is used for hardening some special alloy steels.
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Hardening of carbon steel

Objectives: At the end of this lesson you shall be able to
• state the hardening of steel
• state the purpose of hardening the steel
• state the process of hardening.

What is hardening?

Hardening is a heat treatment process in which steel is
heated tp 30-500C above the critical range. Soaking time
is allowed to enable the steel to obtain a uniform
temperature throughout its cross-section. Then the steel
is rapidly cooled through a cooling medium.

Purpose of hardening

To develop high hardness and wear-resistance properties

Hardening affects the mechanical properties of steel like
strength, toughness, ductility etc.

Hardening adds cutting ability.

Process of hardening

Steel with a carbon content above 0.4% is heated to
30-500°C above the upper critical temperature (Fig 1). A
soaking time of 5mts./ 10 mm thickness of steel is allowed.
(Fig 1)

Then the steel is cooled rapidly in a suitable medium.
Water, oil, brine or air is used as a cooling medium,
depending upon the composition of the steel and the
hardness required.

Tempering the hardened steel

Objectives: At the end of this lesson you shall be able to
• state what is tempering
• state the purpose of tempering
• relate the tempering colours and temperatures with the tools to be tempered
• state the process of tempering of steels.

What is tempering?

Tempering is a heat treatment process consisting of
reheating the hardened steel to a temperature below 4000C
followed by cooling.

Purpose of tempering the steel

Steel in its hardened condition is generally too brittle to be
used for certain functions. Therefore, it is tempered.

The aims of tempering are:

- to relieve the internal stresses

- to regulate the hardness and toughness

- to decrease the brittleness

- to restore some ductility

- to induce shock resistance.

Process of tempering the steel

The tempering process consists of heating the hardened
steel to the appropriate tempering temperature
(Table 1) and soaking at this temperature, for a definite
period.

The period is determined from the experience that the full
effect of the tempering process can be ensured only, if the
tempering period is kept sufficiently long.

Table - 1

Tools or Temperature Colour
articles Centigrade

Degrees

Turning tools 230 Pale straw

Drills and 240 Dark straw
milling cutters

Taps and 250 Brown
shear blades

Punches, reamers, 260 Red brown
twist drills

Rivets, snaps 270 Brown purple

Press tools, 280 Dark purple
cold chisels

Cold set for 290 Light blue
cutting steels

Springs, screwdrivers 300 Dark blue

320 Very dark
blue

340 Greyish blue

For toughening 450-700 No colour
without undue
hardness
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Annealing of steel
Objectives: At the end of this lesson you shall be able to
• state the annealing of steel
• state the purpose of annealing
• state the processes of annealing.

The annealing process is carried out by heating the steel
above the critical range, soaking it for sufficient time to
allow the necessary changes to occur, and cooling at a
predetermined rate, usually very slowly, within the furnace.

Purpose

• To soften the steel

• To improve the machinability.

• To increase the ductility.

• To relieve the internal stresses.

• To refine the grain size and to prepare the steel for
subsequent heat treatment process.

Annealing process

Annealing consists of heating of hypoeutectoid steels to
30 to 500C above the upper critical temperature and 500C
above the lower critical temperature for hypereutectoid
steels. (Fig 1)

Soaking is holding at the heating temperature for 5mts./
10mm of thickness for carbon steels.

The cooling rate for carbon steel is 100 to 1500C/hr.

Steel, heated for annealing, is either cooled in the furnace
itself by switching off the furnace or it is covered with dry
sand, dry lime or dry ash.

Normalising steel
Objectives: At the end of this lesson you shall be able to
• state the meaning of normalising steel and its purpose
• state the process of normalising steel
• state the precaution to be taken while normalising steel.

The process of removing the internal defects or to refine
the structure of steel components is called normalising.

Purpose

To produce fine grain size in the metal.

To remove stresses and strains formed in the internal
structure due to repeated heating and uneven cooling or
hammering.

To reduce ductility.

To prevent warping.

Process

To get the best results from normalizing, the parts should
be heated uniformly to a temperature of 30 to 400C above
the upper critical temperature (Fig 1), followed by cooling
in still air, free from drought, to room temperature.
Normalizing should be done in all forgings, castings and
work-hardened pieces.

Precautions

Avoid placing the component in a wet place or wet air,
thereby restricting the natural circulation of air around the
component. Avoid placing the component on a surface
that will chill it.
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Surface hardening of steel
Objectives: At the end of this lesson you shall be able to
• name four different types of surface hardening processes
• state the purpose of case hardening
• state the purpose of carburising
• state the purpose of liquid carburising
• state the process of gas carburising.

Most of the components must have a hard, wear-resist-
ing surface supported by a tough, shock-resisting core
for better service condition and longer life.  This combina-
tion of different properties can be obtained in a single
piece of steel by surface hardening. (Fig 1)

Types of surface hardening

• Case hardening

• Nitriding

• Flame hardening

• Induction hardening

Case hardening

Parts to be hardened by this process are made from a
steel with a carbon content of 0.15% so that they will not
respond to direct hardening.

The steel is subjected to treatment in which the carbon
content of the surface layer is increased to about 0.9%.

When the carburised steel is heated and quenched, only
the surface layer will respond, and the core will remain
soft and tough as required. (Fig 2)

The surface which must remain soft can be insulated
against carburising by coating it with suitable paste or by
plating it with copper.

Case hardening takes place in two stages.

• Carburising in which the carbon content of the surface
is increased.

• Heat treatment in which the core is refined and the
surface hardened.

Carburising

In this operation, the steel is heated to a suitable temper-
ature in a carbonaceous atmosphere, and kept at that
temperature until the carbon has penetrated to the depth
required.

The carbon can be supplied as a solid, liquid or gas.

In all cases, the carbonaceous gases coming from these
materials penetrate (diffuse) into the surface of the
workpiece at a temperature between 880° and 930°C.
(Fig 3)

Pack carburising (Fig 4)

The parts are packed in a suitable metal box in which
they are surrounded by the carburising medium, such as
wood, bone, leather or charcoal, with barium carbonate
as an energiser.
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The lid is fitted to the box and sealed with fireclay and
tied with a piece of wire so that no carbon gas can es-
cape and no air can enter the box to cause de-
carburisation.

Liquid carburising

Carburising can be done in a heated salt bath.  (Sodium
carbonate, sodium cyanide and barium chloride are typi-
cal carburising salts.)  For a constant time and tempera-
ture of carburising, the depth of the case depends on the
cyanide content.

This is suitable for a thin case, about 0.25 mm deep.  Its
advantage is that heating is rapid and distortion is
minimised, and it is suitable for batch production.

Gas carburising

The work is placed in a gas-tight container which can be
heated in a suitable furnace, or the furnace itself may be
the container.

The carburising gas ‘methane or propane’ is admitted to
the container, and the exit gas is vented.

Fig 5 illustrates the appearance of the structure across
its section produced by carburising.

Heat treatment

After carburising has been done, the case will contain
about 0.9% carbon, and the core will still contain about
0.15% carbon.  There will be a gradual transition of the
carbon content between the case and the core. (Fig 2)

Owing to the prolonged heating, the core will be coarse,
and in order to produce a reasonable toughness, it must
be refined.

To refine the core, the carburised steel is reheated to
about 870°C and held at that temperature long enough to
produce a uniformity of structure, and is then cooled rap-
idly to prevent grain growth during cooling.

The temperature of this heating is much higher than that
suitable for the case, (Fig 2) and, therefore, an extremely
brittle martensite will be produced.

The case and the outer layers of the core must now be
refined.

The refining is done by reheating the steel to about 760°C,
to suit the case, and quenching it.

Tempering

Finally the case is tempered at about 200°C to relieve the
quenching stresses.

Fig 6 illustrates the appearance of the structure across
its section produced by case hardening.

Nitriding
Objectives: At the end of this lesson you shall be able to
• state the process of case hardening by gas nitriding
• state the process of case hardening by nitriding in a salt bath.

In the nitriding process, the surface is enriched not with
carbon, but with nitrogen.  There are two systems in com-
mon use, gas nitriding and salt bath nitriding.

Gas nitriding

The gas nitriding process consists of heating the parts at
500°C in a constant circulation of ammonia gas for up to
100 hours and cooling them in air.

Nitriding in salt bath

Special nitriding baths are used for salt-bath nitriding.  This
process is suitable for all alloyed and unalloyed types of
steel, annealed or not annealed, and also for cast iron.

Process

The completely stress-relieved workpieces are preheated
(about 400°C) before being put in the salt bath (about 520
- 570°C).  A layer 0.01 to 0.02 mm thick is formed on the
surface which consists of a carbon and nitrogen compound.
The duration of nitriding depends on the cross-section of
the workpieces (half an hour to three hours). It is much
shorter than for gas nitriding.  After being taken out of the
bath, the workpieces are quenched and washed in water
and dried.
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Advantages

The parts can be finish-machined before nitriding because
no quenching is done after nitriding, and, therefore, they
will not suffer from quenching distortion.

In this process, the parts are not heated above the critical
temperature, and, hence warping or distortion does not
occur.

The hardness and wear-resistance are exceptional.  There
is a slight improvement in corrosion resistance as well.

Since the alloy steels used are inherently strong when
properly heat-treated, remarkable combinations of strength
and wear-resistance are obtained.

Flame hardening
Objectives: At the end of this lesson you shall be able to
• state the process of surface hardening using a flame
• state the advantages and disadvantages of flame hardening.

Flame hardening

In this type of hardening, the heat is applied to the surface
of the workpiece by specially constructed burners.  The
heat is applied to the surface very rapidly and the work is
quenched immediately by spraying it with water.
(Figs 1 & 2) The hardening temperature is generally about
50°C higher than that for full hardening.

- It is advantageous for large workpieces.

- Short hardening time.

- Great depth of hardening.

- Easily controlled.

- Small distortion.

- Low fuel consumption.

The following are the disadvantages.

- Not suitable for small workpieces because of the
danger of hardening through.

- The workpieces must be stress-relieved before
hardening.

The workpiece is maintained at the hardening temperature
for a very short period only, so that the heat is not
conducted more than necessary into the workpiece.

Steels used for surface hardening will have a carbon content
of 0.35% to 0.7%.

The following are the advantages of this type of hardening.

- The hardening devices are brought to the workpiece.

Induction hardening
Objectives: At the end of this lesson you shall be able to
• state the process of the induction hardening method
• state the advantages of the induction hardening process.

Induction hardening

This is a production method of surface-hardening in which
the part to be surface-hardened is placed within an induc-
tor coil through which a high frequency current is passed.
(Fig 1)  The depth of penetration of the heating becomes
less, as the frequency increases.

The depth of hardening for high frequency current is 0.7
to 1.0 mm.  The depth of hardening for medium frequency
current is 1.5 to 2.0 mm.  Special steels and unalloyed
steels with a carbon content of 0.35 to 0.7% are used.

After induction-hardening of the workpieces, stress re-
lieving is necessary.
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The following are the advantages of this type of hardening.

- The depth of hardening, distribution in width and the
temperature are easily controllable.

- The time required and distortion due to hardening are
very small.

- The surface remains free from scales.

- This type of hardening can easily be incorporated in
mass production.

- Produce less distortion then convertional heat
treatment

The Advantages and Disadvantages of Induction
Hardening

Induction hardening is a type of heat-treating process that
typically subjects a metal part under induction heating and
quenching. After conducting this specific process, the
metal part is intended to undergo a martensitic formation,
allowing it to obtain features and properties that it does not
possess before.

The process of induction heating starts by placing a metal
part near a copper coil that has a significant level of
alternating current. Through eddy current and hysteresis
losses, the said coil can generate heat that is directed at
or near the surface of the metal part. Subsequently, the
metal part is directed or submerged under a water-based
quench, which then initiates its aforementioned martensitic
formation.

Induction hardening can bring numerous benefits to the
processing of different metal parts. The same process,
however, also share some disadvantages that manufacturers
may encounter along the way.

Advantages of Induction Hardening

- Improved Wear Resistance: One of the advantages
of induction hardening is that it can effectively improve
the wear resistance of a metal part. Metal parts that
have been annealed or treated to a softer condition can
significantly obtain improved wear resistance once they
undergo this process. After all, any improvement of a
part's hardness can likewise improve its wear resistance.

- Increased Fatigue Life: The residual compressive
stress at the surface of a part out of induction hardening
can easily obtain a huge improvement over its strength
and fatigue life. The induction hardening allows the part
to obtain a hardened structure that occupies more
volume than its core.

- Customised Hardness Level: With induction
hardening, metal parts can now be tempered easily.
granting manufacturers the ability to customise their
hardness level based on their set requirements. The
more these metal parts are tempered, the lower the
hardness and brittleness will be.

- Minimised Warpage: Another advantage of induction
hardening is that it does not warp the metal parts
significantly. You see, other types of hardening processes
are known for warping the metal part and its respective
surfaces. But with induction hardening, you can easily
process materials without significant and noticeable
warpage.

- Notable Low Costs: When it comes to overall costing,
induction hardening can be done without spending too
much money. The process likewise does not require
expensive metal parts. So, if you are thinking of
processing low cost steels, then you may proceed with
induction hardening.

Disadvantages of Induction Hardening

- Occurrences of Cracking: As for the disadvantage of
induction hardening, the entire process is more prone
to causing some cracks on the surfaces of metal parts
compared to other heat treatment processes. Induction
hardening can also produce hot spots at specific
features like keyways, grooves, cross holes, threads,
and many more.

- Greater Distortion Levels: Aside from cracking issues,
the process of induction hardening can also cause
more distortion on the metal parts than other heat
treatment processes. This distortion is brought by the
martensitic transformation that the part receives during
the process.

- Limitation on Materials: Despite the notable low costs
of induction hardening, this process can only work on
limited materials. This process can only work with
materials that contain enough carbon and other elements
so they can support all the features caused by the
martensitic transformation.
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CG & M Related Theory for Exercise 1.2.30
Tool & Die Maker (Dies & Moulds) - Fitting

Definition of machine and machine tool
Objectives: At the end of this lesson you shall be able to
• explain difference between machine and machine tool
• state the history & gradual development of lathe.

Definition of machine

Machine is a device that performs a related operation to
produce desired product. It can be stitching of cloth by a
sewing machine, producing a component in a forging
machine, or it can be a main production by using a CNC
machine technology

A machince tool is defined as a power driven machine
capable of holding / supporting the work & tool at
sametime, directing / guiding the cutting tool or job or
both to perform various metal cutting operations for
producing  various shapes & sizes

Fundamental of machine tools

Machine tool is a device that utilizes electric energy for
shaping and sizing a product by removing excess material
in the form of chips, with the help of cutting tool.

Machine tools are used for producing components at a
rapid rate. Optimum productivity from machine tool calls
for a fairly high degree of skill. Properly carried out
operations are capable of producing a large number of
components at a fairly rapid rate.

Machine tools and machines are two different things.
machine tools when taken as a group can produce a
machine tool, which is not true of machines.

Lathe, milling machine, shaping machine, slotter etc., are
all machine tools.

Every metal working machine cannot be called a machine
tool merely because it removes material. Forging hammers,
drawing dies, extruders, rolling machine etc., are not
machine tools.

Functions of machine tools

1 To hold and support the workpiece to be machined.

2 To hold and support the cutting tool.

3 To provide requisite motion to the workpiece / tool or
both.

4 To regulate the cutting speed and feed of the tool and
workpiece.

5 To hold various attachments for different operations.
Jobs and tools are held in properly designed devices
on a machine tool. Different machine tools are provided
with different holding devices.

In a workshop, a machine tool is generally used for
producing different shapes and for finishing the surfaces.

Classification of machine tools

1 According to the type of the surface generated.

i Cylindrical work machine tools - Lathes, capstan,
turret etc.,

ii Flat surfac machine tools - milling machine, shaping
machine planing machine etc.,

2 Classification based on the purpose of the machine tool.

i Single - purpose

ii Multi purpose

iii Special purpose

iv Transfer machine

v Numerically controlled

3 Classification based upon the size of chip

i Machine tools using cutting tools - lathe, milling,
planner, slotter etc.,

ii Machine tools using abrasives - honing, lapping
Grinding etc.,

Machine tool performance criteria

While designing a machine tool the following factors need
consideration.

1 It should be safe and easy to operate.

2 It should be accurate.

3 It should have good production capacity.

4 The operational cost should be low.

5 Controls should be located at convenient points.

6 Blanks should be such that they can be loaded and
clamped easily.

Factors in machininig operations

The operations of removing metal by means of the cutting
tool using some sort of machine tool in order to obtain a
desired shape is called machining.

It includes number of operations such as turning, boring,
shaping, milling etc.,

The selection of a machine tool for a particular operation
depends upon many factor such as

1 The shape and size of the product required.

2 The quantity of material to be removed.

3 The type of operation to be performed.
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4 The number of components required.

5 The type of material to be handled

Lathe and its parts
Objectives: At the end of this lesson you shall be able to
• state the main parts of the lathe
• state the lever positions
• state the various lubrication points.

6 The degree of accuracy required.

Turning and centre lathe

Turning is a machining process to bring the raw material
to the required shape and size by metal removal. This is
done by feeding a cutting tool against the direction of
rotation of the work.

The machine tool on which the job is made to rotate and
turning is carried out is known as a lathe.

Constructional features of a lathe (Fig 1)

A lathe should have provision:

- to hold the cutting tool, and feed it against the direction
of rotation

- to have parts, fixed and sliding, to get a relative
movement of the cutting tool with respect to the rotation
of the work

- to have accessories and attachments for performing
different operations.

Various Lubrication Points

1 Place a few drops of oil on the rockershaft bearing and
cams every time the lathe is in use.

2 Countershaft roller bearing - Fill both grease cups with
automotive cup grease every two weeks. Give the
grease cup caps a turn or so every time the lathe is
used.

3 Place a few drops of oil on the rockershaft lever bearings
and lever fulcrum bearing every time lathe is used.

4 Motor bearings - sleeve type motors have two oil cups
which should be filled once a week with S.A.E. No. 10.
Motor oil or equivalent. Ball bearing motors have a
sealed in - type bearing - every six months the small
headless screw in these bearings should be removed
and a moderate quantity of automotive cup grease forced
around the bearing.

5 Left and right headstock bearings - oil with No.10 motor
oil or equivalent every time the lathe is used.

6 Spindle pulley - every time the lathe is used in backgear,
remove the small screw in the bottom of the second
step of the idler pulley and oil freely with No. 10 motor
oil or equivalent. Replace screw.

7 Back gear spindle - every time the back gears are used,
remove the small screw in the centre of the back gear
spindle and oil freely with No 10 motor oil or equivalent.
Replace screw.
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8 Back gears and change gears - A small amount of
keystone No. 122 heavy outer gear lubricant or
equivalent applied to the gear teeth will aid in obtaining
smoother, more quiet operation. Be sure to remove all
oil in the gear teeth before applying this lubricant or it
will not adhere.

9 Change gear bearings - put a few drops No.10 motor
oil or equivalent on the change gear bearings each time
the lathe is used.

10 Lead screw stub bearing and reversing gears - put a
few drops of No. 10 motor oil or equivalent in the three
oil holes on the top of the reversing gear box every
time the lathe is used.

11 Carriage traverse gear case - every time the lathe is in
use, put a few drops of No 10 motor oil in oil hole on
top of gear case on back of carriage apron.

12 Carriage hand wheel bearing - put a few drops of No 10
motor oil or equivalent in the ball spring oil hole every
time the lathe is used.

13 Cross feed gear bearing - put a few drops of oil in the
ball spring oil hole every time lathe is used.

14 Half - nut lever bearing - put a few drops of No. 10 motor
oil or equivalent in the ball spring oil hole every time
the lathe is used.

15 Thread dial-once a week put a few drops of No.10 motor
oil or equivalent around the rim of the top of the thread
dial.

16 Wipers (front and back) - saturate the felts in the four
wipers, located on the carriage with oil every time the
lathe is used.

17 Cross slide screw - Put a few drops of  No. 10 motor oil
or equivalent in the oil hole above the front cross slide
screw bearing after removing the small screw. Replace
the screw. This should be done every time the lathe is
used. Clean the cross slide screw regularly with a small
stiff brush. Oil the screw threads by running the
compound rest back and forth.

18 Cross feed gears - put a few drops of oil in the oil hole
above the cross feed screw after removing the small
screw. Replace the screw. This should be done every
time the lathe is used.

19 Cross slide ways - clean regularly and apply a liberal
quantity of No. 10 motor oil or equivalent to the ways
whenever the lathe is used.

20 Compound slide screw - every time the lathe is used
put a few drops of No. 10 motor oil or equivalent in the
oil hole on top of compound rest and above
thecompound screw bearing.

21 Compound slide ways - clean regularly and apply a
liberal quantity of No. 10 motor oil or equivalent to the
ways whenever the lathe is used.

22 Lead screw - about once a month clean the lead screw
threads with kerosene and a small stiff brush and apply
a small amount of No. 10 motor oil or equivalent.

23 Rack (on bed, under front way) - about once a month
apply a small amount of cup grease to the rack after
cleaning with kerosene and a small stiff brush.

24 Lead screw bearing (right end of lathe) - put a few drops
of No. 10 motor oil or equivalent in the oil hole on top of
the bearing every time the lathe is used.

25 Place a few drops of oil between the handwheel and
screw bearing when ever using lathe.

26 Tailstock centre lubricant - fill the small cup on the
tailstock with a mixture of white lead and oil and apply
to the tailstock center whenever turning between
centres. If white lead is not available, used a liberal
amount of cup grease on the center.

27 Tailstock ram - keep the outside surface of the tailstock
ram well oiled.

28 Lathe bed ways - keep the bed ways oiled at all times
with No. 10 motor oil or equivalent and free from chips.
Wipe off the ways before using and cover with fresh oil.
Always leave a generous film of oil on the ways when
the lathe is not in use. The lathe should be completely
covered when not in use. During all grinding operations
cover bed ways with canvas or carboard.

Keep all the lathe bearing surfaces perfectly
clean. Dirt is the natural enemy of accurate
lathe work.

Lubrication points on lathe
Objectives: At the end of this lesson you shall be able to
• describe the lubrication points
• brief the schedule of lubrications.

Lubrication of machines and equipments

The length of time a machine will retain its accuracy and
give satisfactory service depends on the lubrication and
care it receives. It is essential that lubrication of machines
should be carried out systematically at regular intervals
as recommended in the service manual supplied by the
machine manufacturer.

The manufacturer's manual contains all the necessary
details like grade of oil, grease, oiling and greasing points
and also indicates the time intervals of lubrication.

The lubrication points of lathe as shown in Fig 1.

Type of lubricant, period of lubrication and method of
lubrication.
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1 Head stock gear box filling the oil twice a year gear
box oil.

2 Cross slide oiling daily by gun oily.

3 Top slide oiling daily by gun oily.

4 Tailstock oiling daily by gun oiler.

5&6 Lead screw and feed rod bearing grease by grease
gun

7 Bed ways oiling daily by gun oiler use lubrication oil.

Lever position of lathe
Objectives: At the end of this lesson you shall be able to
• describe the levers to be changed for different speeds
• brief to change the lever for feed and direction.

The lever available on lathe to change the different speed,
feed and direction are shown in Fig 1.

Lever 1&3 to get the different spindle speed lever 2 is used
to change the direction of the spindle.

Lever 4 Start and stop lever

Lever 5 Used to engage lead screw for thread cutting and
disengaged feed rod for automatic feed.

Lever 6 Used to engage according to pitch of thread while
thread cutting.
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CG & M Related Theory for Exercise 1.3.31 & 33
Tool & Die Maker (Dies & Moulds) - Turning

Introduction to Lathe
Objectives: At the end of this lesson you shall be able to
• state the different types of lathes and their uses
• state the parts and their function
• state the method of specifying a centre lathe.

Lathe introduction

Lathe is a machine widely used for wood works and
machining of metal parts. Lathe is a machine which turns
the work piece against a machine tool. The lathe is used
for facing, turning, knurling, taper cutting, threading, gear
cutting and many other metal and wood works.

Lathes are classified depending upon their application and
functionality.

Light duty lathe - These machine find their application in
automobile, electronic, electrical industries and are
manufactured from quality tested raw materials.

Medium duty lathe - These machines are powerful than
the light duty lathes and can work on bigger work pieces
and have more strength than the light duty lathes.

Heavy duty lathe - these machines are manufactured
from hightest grades of materials like iron and steel. They
are designed for high precision heavy duty operations.

All geared lathe - In all geared lathe, all the rotating
components of the machines are driven by the same
source at different speeds by using gears to perform various
operations.

Imported lathe - imported lathes are high quality lathes
used for high precision operations.

Depending upon the modes of  operation, the lathe can be
classified as

Manual lathe - In these lathes, the tool handling is done
manually and so the precision of work also depends upon
the skill of the person handling the machine.

CNC lathe - CNC lathes are completely automated lathes.
We just have to feed the instructions into the computer
and the lathe will perform the operations according to the
data fed to the computer.

Types of lathe

1 Speed lathe

a Wood working

b Centering

c Polishing

d Spinning

2 Engine lathe (or) centre lathe

a Belt drive

b Individual motor drive

c Gear head lathe

3 Bench lathe

4 Tool room lathe

5 Capstan and turret lathe

6 Special purpose

a Wheel lathe

b Gap bed lathe

c T-lathe

d Duplicating lathe

7 Automatic lathe

8 CNC Lathe

Speed lathe

- The speed lathe has been so named because of very
high speed of the head stock spindle.

- It consists of head stock, tailstock and tool post
mounted on adjustable slide.

- Tool is fed into the work by hand control.

- It has no gear box lead screw and carriage.

- Different speeds are obtained by cone pulley (1200-
3600rpm)

- Wood working, spinning, polishing, centering operations
can be performed.

Engine lathe (or) centre lathe

- The term engine is because of that early lathes were
driven by steam engine.

- It consists of basic parts like bed, head-stock and tail
stock but head-stock is more robust and has additional
drive mechanism for multiple speeds.

- Engine lathe can feed cutting tool both in cross and
longitudinal directions with the help of carriage, feed
rod, and leadscrew.

- Belt drive lathe gets power from an over head line shaft
equipped with speed cone and one or more back gears.

- Individual motor driven lathe gets power from individual
motor.

- A geared head lathe gets its power from constant speed
motor and all speed changes are obtained by shifting
various gears located in the headstock.
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Bench lathe

- It is mounted on bench and has the same features like
engine lathe.

Tool room lathe (Fig 1)

- It has the same features like engine lathe and has very
low to high speed up to 2500rpm.

- It has taper turning attachment, draw in collet
attachment, thread chasing dial, relieving attachment,
steady and follower rest, pump for coolant.

- Used for precision work on tools, dies, gauges.

Capstan and turret lathe (Fig 2 & 3)

- Wheel lathe is used for finishing the journal and turning
the thread on locomotive wheels.

- The gap bed lathe can accommodate the jobs having
extra diameter.

- T- lathe is intended for machining the rotors for jet
engines, axis of bed is right angles to the axis of head
stock spindle.

- Duplicating lathe is used for duplicating the shape of
given template using mechanical or hydraulic system.

Special purpose lathe

- These are high speed, heavy duty, mass production
lathes with complete automatic control.

- Once the tools are set and machine is started it
performs automatically all the operations to finish at a
time.

- Change of tools, speeds and feeds can be done
automatically, operator can run 5 to 6 machines at a
time.
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- CNC Lathe ( CNC)

- Complex shapes machined easily.

- High production rate.

- Accuracy and repeatability is achieved.

- Less operation skill and involvement.

- Reduced space.

Centre lathe parts

The following are the main parts of a lathe.

Headstock

Tailstock

Carriage

Cross-slide

Compound slide

Bed

Quick change gearbox

Legs

Feed shaft

Lead screw

Head stock

The following are the functions of a headstock. (Fig 1)

- Provide a means to assemble the work-holding devices.

- Transmit the drive from the main motor to the work.

- Accommodate shafts, gears and levers for a wide range
of varying work speeds.

- Ensure arrangement for lubricating the gears, shafts
and bearings.

Tailstock

It is a sliding unit on the bed-ways of the lathe bed.  It is
situated on the right hand side of the lathe.  It is made in
two parts namely the ‘base’ and the ‘body’.  The base
bottom is machined accurately and has ‘V’ grooves
corresponding to the bed-ways.  It can slide over the bed
and can be clamped at any position on the bed by means
of the clamping unit.  The body of the tailstock is assembled
to the base.  Graduations are marked on the rear end of the
base and a zero line is marked on the body.

When both zero lines coincide, the axis of the tailstock is
in line with the axis of the headstock.

The body and base are made out of cast iron.  The parts of
a tailstock are: (Fig 4)

- base (A)

- body (B)

- spindle (barrel) (C)

- spindle locking lever (D)

- operating screw rod (E)

- operating nut (F)

- tailstock hand wheel (G)

- key (H)

- adjusting screws (J)

- clamping unit (I)

Functioning of a tailstock: By rotating the hand wheel,
the barrel can be moved forward or backward. The barrel
can be locked in any required position.  The hollow end of
the barrel at the front is provided with a Morse taper to
accommodate the cutting tools with a taper shank.
Graduations are sometimes marked on the barrel to
indicate the movement of the barrel.  With the help of the
adjusting screws, the body can be moved over the base
laterally, and the amount of movement may be read
approximately referring to the graduations marked.  This
arrangement is to offset the centre of the tailstock as
required for taper turning.

Purpose of the tailstock

- To accommodate the dead centre  to support lengthy
works to carry out lathe operations.

- To hold cutting tools like drills, reamers, drill chucks
provided with taper shank.

- To turn external taper by offsetting the body of the
tailstock with respect to the base.

Lathe bed

Functions of a lathe bed

The functions of a lathe bed are:

- to locate the fixed units in accurate relationship to each
other

- to provide slideways upon which the operating units
can be moved.

Constructional features of a lathe bed (Fig 5)

The lathe bed generally consists of a single casting.  In
larger machines, the bed may be in two or more sections
accurately assembled together.  Web bracings are
employed to increase the rigidity.  For absorbing shock
and vibration, the beds are made heavy.
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A combined swarf and coolant tray is provided on the lathes.
This may be an integral part with the lathe bed.

The bed is generally carried by cast iron or welded sheet
metal legs of box section.  This provides the necessary
working height for the lathe.  Very often the electrical
switchgear unit and the coolant pump assembly are housed
in the box section of the legs at the headstock end.

Bed-ways (Fig 6)

The bed-ways or slideways assist in accurate location
and sliding of the accessories/parts mounted on this.  The
bed-ways are of three types.

- Flat bed-ways (Fig 7)

- ‘V’ bed-ways (Fig 8)

- Combination bed-ways (Fig 9 & 10)

Normally the bed-ways stop at a distance away from the
headstock with a gap at this point.  This enables to mount
larger diameters of works.

Some lathes have detachable section of the bed, which
can be fitted when desired, to enable the saddle to operate
close to the headstock. (Fig 10)

Some bed-ways are fine finished by grinding.  Some lathes
have their bed-ways hand-scraped.  Some have their bed-
ways hardened and ground.  The wear-resisting qualities
of bearing surfaces are improved by employing chilled iron
castings.

The beds are mostly made up of close  grained  grey cast
iron.

Lathe carriage

Carriage (Fig 11)

The carriage is the lathe feature that provides the method
of holding and moving the cutting tool. It consists of two
major parts.
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- The apron

- The saddle

The apron (Fig 11)

The apron is bolted to the front end of the saddle. It contains
the mechanism for moving and controlling the carriage.

The saddle (Fig 11)

The saddle is that part of the carriage that fits the bed
slideways and moves along the bed between the head
and the tailstock.

It is an assembly consisting of the following parts.

- Cross-slide

- Compound rest

- Top slide

- Tool post

Cross-slide  (Figs 11 & 12)

This part is mounted on the top of the saddle base and it
moves along the saddle base in a direction perpendicular
to the bed.  This movement is accomplished by means of
a screwed spindle and hand wheel.

Compound rest (Figs 11 & 12)

This is fitted on the top of the cross-slide and may be
swivelled horizontally, clockwise or anticlockwise through
360°.

Top slide (Fig 11)

This part is connected to the compound rest by means of
a screwed spindle and it has a short travel on the compound
rest.  It provides a means of supporting the tool post which
holds the cutting tool.

By swivelling the compound rest the top slide may be set
to a desired angle to the cross-slide and fed at that angle,
and turn tapers.

In the normal case the compound rest is set so that the
top slide is at right angles to the cross-slide and in this
position the setting angle is 0°.

Feed shaft (Fig 13)

Usually the carriage is moved manually by means of a
hand wheel.  But the carriage can also be moved by power
(automatic feed). The power for automatic feed comes from
the headstock and is transmitted to the carriage through
the feed shaft.

Lead screw (Fig 13)

Centre lathes, equipped with power feed, also have a
provision for screw cutting.  A special threaded spindle
called lead screw, mounted on the front of the lathe bed
and driven through the quick change gearbox, helps to cut
screw threads.

In some small lathes the lead screw and feed shafts are
combined.

Both the lead screw and the feed shaft pass through the
apron of the carriage.  Controls on the apron enable the
feed shaft or the lead screw to be connected to the carriage
at the operator’s will.

Feed lever

This lever is used to engage and disengage the automatic
feed mechanism which provides automatic feeding for both
facing and turning operations.
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Tool posts

The tool post fitted on the top slide holds and supports the
tool firmly. (Fig 14)

The commonly used types of tool posts are:

- American type tool post or single way tool post

- indexing type tool post or square tool post

- quick change tool post.

Single way tool post (Fig 15)

It consists of a circular tool post body and a pillar with a slot
for accommodating the tool or tool-holder.  A ring base, a
rocker arm (boat piece) and a tool-clamping screw complete
the assembly of this type of tool post.

The tool is positioned on the boat piece and is clamped by
the screw.  The centre height of the tool tip can be adjusted
with the help of the rocker arm and the ring base.  Only one
tool can be fixed in this type of tool post.  The rigidity of the
tool is less as it is clamped with only one screw.

Indexing type tool post (Fig 16)

It is also called a square tool post or a four-way tool post.
Four tools can be fixed in this type of tool post, and any one
of them can be brought into the operating position.  The
indexing may be manual or automatic.

The advantages are as follows.

Each tool is secured in the tool post by more than one
screw and, therefore, the rigidity is more.

Frequent changing of the tool for different operations need
not be done as all the four tools can be clamped at the same
time.

The disadvantage is that skill is required to set the tools,
and it takes more time to set to the centre height.

Quick change tool post (Fig 17)

Modern lathes are provided with this type of tool post.
Instead of changing the tools, the tool-holder is changed in
which the tool is fixed.  This is expensive as a number of
tool-holders may be needed to preset various tools.  But it
can be set to the centre height easily, and has the best
rigidity for the tool.

Centre lathe  specification

The size of a lathe is specified by (Fig 18)

- the length of the bed (l)

- the maximum diameter (swing) of the work that can be
turned (d)

- the length between centres (c) and
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- the pitch of the lead screw.

- the maximum diameter of bar that passes through hole
of the head stock spindle.

- number of  spindle speeds and feeds available.

- power input.

- floor space requried.

Safety to be observed while  working on a lathe
Objective :  At the end of this lesson you shall be able to
• state the precautions to be observed before starting work on a lathe, during work and after.

Before starting the work

Ensure that the lubricating system is functioning.

The mating gears should be in proper mesh and the power

feed levers are in neutral position.

The work area should be clean and tidy.

The safety guards should be in place.

During work

Never try to stop a rotating chuck with your hand. A rotating

chuck is dangerous.

Switch off the machine before making any adjustment on

the lathe.

It is dangerous to leave the chuck key in the chuck.

Remove it immediately after use. (Fig 1)

Single point tools are sharp and dangerous.  Be extra

careful when using them.

Chips are sharp and dangerous.  Never remove them with

your bare hands.  Use a chip rake or brush.

You must always know where the emergency stop switch.

After work

Clean the lathe with a brush and wipe with cotton waste.

Oil the bedways and lubricating points.

Clean the surroundings of the lathe, wipe the dirt and

coolant and remove the swarf.

Stop lathe before taking measurements of any kind.

Follow job specifications for speed and depth of cut for

material being turned.

Do not lean on machine. Stand erect, keep your face and

eyes away from flying chips.

Do not make adjustments while the machine is operating

unit unitl the machine has come to complete stop. Do

not leave lathe unattended while it is running.

CG& M: TDM (Dies & Moulds) (NSQF - Revised 2022) - R.Theory for Ex. 1.3.31 - 33

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



135

CG & M Related Theory for Exercise 1.3.34
Tool & Die Maker (Dies & Moulds) - Turning

Lathe operations - facing
Objectives :  At the end of this lesson you shall be able to
• list the various types of operations of lathe machine
• state the meaning of each operation
• brief the purpose, defects of each operations.

Facing

This is an operation of removing metal from the work-face
by feeding the tool at right angles to the axis of the work.
(Fig 1)

Purpose of facing

- To have a reference plane to mark and measure the
step lengths of the work.

- To have a face at right angle to the axis of the work.

- To remove the rough surface on the faces of the work
and have finished faces instead.

- To maintain the total length of the work.

Facing may be rough or finish facing.  Rough facing is done
to remove the excess metal on the face of the work by
coarse feeding with more depth of cut,  leaving sufficient
metal for finishing.

Rough facing is done by feeding the tool from the periphery
of the work towards the centre of the work.  Finish facing
is the operation to have a smooth face by removing the
rough surface produced by the rough facing.

Finish facing is done by feeding the tool from the centre of
the work towards the periphery. (Figs 2a and 2b)

Rough facing is done by choosing a spindle r.p.m. according
to the average diameter of the work, with the recommended
cutting speed, coarse feed and more depth of cut.

Finish facing is done by choosing a cutting speed about
twice that of the cutting speed for roughing, with a fine feed
rate of 0.05 mm approximately and with a depth of cut of not
more than 0.1 mm.

The following are the defects found in facing a work. (Fig 3)

step lengths of the work.
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A concave face

This is caused by the tool digging into the work during the
feeding as the tool is not clamped rigidly.  By clamping the
tool rigidly with minimum overhang, this defect can be
avoided.

A convex face

This is caused by the blunt cutting edge of the tool and the
carriage not being locked.  To avoid this defect, re-sharpen
the tool and use it; also lock the carriage to the bed of the
lathe.

A pip left in the centre

This is due to the tool not being set to the correct centre
height.  By placing the tool to the correct centre height, this
defect can be avoided.

Plain turning & Step turning

Plain turning (Parallel turning)

This operation involves removal of metal from the work and
it has a cylinder for the full travel of the tool on the work,
keeping the same diameter throughout the length.

Plain turning is done in two stages.

- Rough turning, using roughing tool or knife tool.
(Figs 4a and 4b)

- Finish turning using a finishing tool. (Fig 4c)

It is done after rough turning, and it aims to bring the size
of the work within the specified accuracy and with better
surface finish.  The tool to be used in this case will be a
finish turning tool.  Finish turning is also carried out from the
tailstock end towards the headstock end.

The spindle speed is calculated according to the material
being turned, diameter of the work, the tool material and the
recommended cutting speed diameter of the works.

Step turning

Step turning is an operation performed on lathe machine
where the excess material is removed from the work piece
to obtain various steps at different diameters. (Fig 5)

Lathe Operations - Centre Drilling

Centre drilling (Fig 6)

It is an operation of drilling and countersinking a hole on
the face of the work, and on the axis of the work.It is done
by a cutting tool known as centre or combination drill held
in a drill chuck. The drill chuck is mounted in a tailstock
spindle and the feeding of the drill to the work is done by
rotating the tailstock hand wheel. The spindle speed for
the work rotation is calculated, taking into consideration
the plain drilling diameter and the recommended cutting
speed for the drilling.(Fig 7)

Defects in centre drilled holes

The two major defects in centre drilling are:

- Insufficient depth of plain drilled portior (Fig 8)

- centre drilling done to deep. (Fig 9)
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The first depth results in making the tip of the centre to
contact the work surface, and the conical portion of the
centre does not have any contact with the bearing surface
of the centre drilled hole. Undue friction and overheating
will be noticed which will damage the tip of the centre.
Sometimes, breakage is also possible and the broken
part of the centre may get welded to the centre hole.By
feeding the centre drill upto 3/4 th of the 60° countersink,
this defect is avoided.

When the centre drill feeding is too much, a plain drilled
portion by the body of the centre drill will be formed at the
nose of the bearing surface of the centre hole, and the
area of contact between the bearing surface and the work
- supporting centre will be the only point of contact, as
illustrated in Fig 10. This will not provide proper support to
the work and any operation if carried out, may result in
dimensional inaccuracy, chatter and poor surface finish.

To rectify this defect, face the work, work permits, and
feed the centre drill to the recomended length.

Centre drills

It is made of high steel and is cylindrical in shape.At both
the ends, it has a plain drill and countersink as its integral
part. It is hardened and ground. It is available in standard
sizes.

Classification as per Indian Standard

Indian standard classifies centre drills into three types.

They are Type A, Type B and Type D.

The differences lies in the formation of the countersink by
each type

Uses and specifications

Type ‘A’ centre drill is used to produce centre holes with
plain drilled portion and countersink.It is designated as
centre drill A.

Type ‘B’ centre drill is used to produce a centre hole with
a plain drilled portion and a countersink, and has a further
conical portion to form additional countersinking to protect
the centre hole. (Fig 11)

The third type, ‘D’ is designated as centre Drill R 1.6 x 4.0
IS: 6710.This also has provision to provide a protected
centre hole. This has an enlarged radius, machined along
with the countersinking portion: (IS: 6710) (Fig 12)

Methods of centre drilling

Centre drilling can be done on a

- drilling machine

- lathe

- centering machine.

The selection of a particular method of centering depends
on the size and shape of the component.

A drill chuck is used to hold the centre drill, Sometimes
special holders/collets are also used. In mass production,
the raw material ends are centered using a centre drillling
machine.

While central drilling ensure the following

Choose the right size and type of centre drill according to
the diameter of the work.

Select the recommended cutting speed and calculate the
spindle r.p.m. taking into consideration the small plain
drilling diameter of the centre drill.
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The job diameter does not have influence on the spindle
speed

The face of the work should be free from any ‘pip’.

The alignment of lathe centres is perfect

The drill chuck used has no damages on the holding fingers
and also on the morse taper shank.

All the three jaws of the chuck act simultaneously.

The overhang of the tailstock barrel should be as minimum
as possible.

If any one of the above points is not observed, htere are
possibilities to have a centre hole with defects,and
breakage of centre drill might result.

Parting off operation: Parting off or cutting off is the
operation of severing a finished part from the rough or
finished stock.

Setting of parting tool

Set the parting tool exactly on the centre with as little back-
rake as possible. (Fig 13)

Adjust the parting off tool so that it extends one half of the
diameter of the work plus about 3mm for clearance from the
tool-holder (Fig 14)

If the cutting tool is too high, it will not cut
through the workpiece. If it is too low, the work
may be bent and the cutting tool damaged.

Procedure

Select the correct type of tool for a specified job.

Hold the work with the minimum overhang in a chuck.

Set the tool square with the work so that it does not rub
against the sides of the groove, as it is fed into the work.
(Fig 15)

Set the spindle speed to half the speed for turning.

Move the carriage so that the right hand side of the blade
is at the point where the work is to be cut off. (Fig 16)

Start the lathe and feed the tool steadily into the work using
the cross-slide handle.

Continue to feed the tool into the work until the part is
severed.

Precautions

The work should protrude from the chuck jaws, sufficiently
enough to permit the cut to be made as close as possible
to the chuck jaws.

The work must always be held securely in a chuck or a
collet.

If the workpiece is held between centres, it
may bend or break and fly aut of the lathe
during parting off. (Fig 17)

Use a right hand offset tool-holder. (Fig 18)

A work having more than one diameter should be gripped
on the larger diameter while parting.

Intermittent feed tends to dull the tool’s cutting
edge.

Heavy feed causes jamming and tool breakage.

Use sufficient coolant on steel. Brass and cast iron should
be cut off dry.
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Make sure the saddle is locked during the entire operation.

Reduce the rate of feed, when the work is almost cut off.

While parting off long work, it should be supported with the
tailstock centre.

If the machine is in good condition, the automatic cross
feed may be used.

When the tool has penetrated to about the depth of its
width, withdraw it and move it sideways with the compound
slide and feed again.

The above operation should be repeated frequently to
minimise the tendency of the tool to dig in and cause
trouble.

When the parting off operation is almost completed, hold
the workpiece by hand to prevent it from falling, so that
damage can be avoided.

Grooving

Grooving is the process of turning a grooved form or channel
on a cylindrically turned workpiece. The shape of the
cutting tool and the depth to which it is fed determine the
shape of the groove.

Types of grooves

Square grooves

Square grooves are frequently cut at the end of a section
to be threaded in order to provide a channel into which a
threading tool may run. A square groove cut against a
shoulder allows a matching part to fit squarely against the
shoulder. (Fig 19)

When a diameter is to be finished to size by grinding, a
groove is generally cut against the shoulder to provide
clearance for the grinding wheel and to ensure a square
corner.

Square grooves are cut with a tool bit ground to the width
of the square groove to be formed.

A square groove also serves the purpose of providing space
for forks of shift levers in sliding gear assemblies.

Round groove

Round grooves serve the same purpose as square grooves.
They are generally used on parts subjected to stress. The
round groove eliminates the sharpness of the square
corners and strengthens the part at the point where it tends
to fracture. A tool bit with a round nose ground to the
required radius is used to cut round grooves. (Fig 20)

'V' Shaped groove

'V' shaped grooves are most commonly found on pulleys
driven by ̀ V' belts. The ̀ V' shaped groove eliminates much
of the slip which occurs in the other forms of the belt drive.
A ̀ V' groove may also be cut at the end of a thread to provide
a channel into which the threading tool may run. (Fig 21)

A tool bit ground to the desired angle is used to cut a
shallow ̀ V' groove. Larger ̀ V' grooves such as those found
on pulleys should be cut with the lathe compound rest set
to form each face of the groove individually.
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Chamfering (Fig 22)

It is the operation of bevelling the edge of a cylinder or a bore
to a definite length.

Purpose of chamfering

The following are the purposes of chamfering.

- To remove burrs and sharp edges from the turned
components to make their handling safe.

- To permit for easy assembly of mating components (a
shaft and a hole).

- To avoid the formation of feather edges on the threaded
parts.

- To provide better appearance.

Methods of chamfering

Form tool method

Chamfering can be done with the help of a cutting tool,
having its edges ground to the angle of the chamfer and by
directly applying the tool on to the edge of the work.
(Fig 23)

The tool is fed either longitudinally or crosswise. Depth is
calculated by the graduated collars.

Compound slide method

Chamfering is also done by a tool fixed on the tool post,
swivelling the compound slide to the angle of chamfer. Then
the carriage is locked and the tool is fed by the top slide.
(Fig 24)

Filing method

This is a crude method, and is adopted only when the
accuracy and finish are not a criterion. This is limited to
external chamfer.  The file is held on to the edge of the work
to the angle of the chamfer and moved along the edge of the
rotating work.  A gentle pressure is applied until the
required length of chamfer is achieved.

Length of chamfer is the distance measured parallel to the
axis. (Fig 25)
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Boring tool and boring
Objectives : At the end of this lesson you shall be able to
• explain the different types of boring tools
• state the advantages of the different boring tools.

Boring is the process of enlarging and truing an existing
drilled or core hole with a single point cutting tool.

Necessity of boring a hole

- To enlarge a drilled hole  larger than the drill size as
drills are available in standard sizes only.

- To obtain concentricity of the hole.

- To maintain accuracy of  the hole.

- To obtain better surface finish.

- To remove the error formed by drilling, and to facilitate
the reaming operation.

Boring tools and holders

Boring is an internal operation performed on the drilled or
core holes. The cutting edge of a boring tool is ground
similar to the left hand plain turning tool. But the operation
being performed is from right to left. (Fig 1)

Parts of a rough boring tool (Figs 1,2 & 3)

Types of boring tools

The following are the different types of boring tools.

- Solid forged tools

- Boring bars with bits

- Brazed tools (Fig 4)

- Throw-away bits inserted in special holders.

Solid forged tools (Fig 5)

The solid forged boring tool is generally made of high speed
steel, with the end forged and ground to resemble a left
hand turning tool. They are light duty tools and are used
on small diameter holes. They are held in  special tool
holders which are mounted in the tool post.

Occasionally tungsten carbide or high speed steel tips
are brazed to low carbon bars, for economy.

Boring bars with inserted bit  (Fig 6)

The boring bar tool-holder is mounted in the tool post and
is used for heavier cuts than those for the forged boring
tool.

The square tool bits are set at angles of 30°, 45° or 90° in
the broached holes in the bar.
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The boring bars may be plain type or end cap type. The
cutting tool of the plain type is held in position by a set
screw. The cutting tool of the end-cap type is held in
position by the wedging action of a hardened plug.

The round or square section tool bits may be inserted in
boring bars, the size depending on the diameter of the
bar.

The tool bit may be square to the axis of the bar for plain
boring or at an angle for facing shoulder, or threading up
to a shoulder.

The bar is held in a split or ‘V’ block holder.

The advantages of Different boring tools

Solid boring tools

Available with square and round shank.

Enables to mount on the tool post easily.

Re-grinding is easy.

As the tool is integral, alignment is easy.

Can be easily forged to the required shape and angle.

Boring bars and inserted bits

Used for heavy duty boring operation.

Used for deep boring operation.

Tool changing is faster, thereby re-sharpening time is
avoided.

Cost is less because the boring bar is made out of low
carbon steel.

Boring tools can be set square to the axis of the boring bar
or at an angle very quickly.
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CG & M Related Theory for Exercise 1.3.35
Tool & Die Maker (Dies & Moulds) - Turning

Lathe cutting tools
Objectives :  At the end of this lesson you shall be able to
• explain difference between end-cutting and side-cutting tools
• state the features of each type
• explain the different shapes of cutting tools used for lathe operations
• state the characteristics and uses of different shapes of lathe tools.

Cutting tools - classification

Cutting tools are classified as:

_ single point cutting tools

_ multi-point cutting tools

_ form tools.

Single point cutting tools

The single point cutting tools have one cutting edge which
performs the cutting action.  Most of the lathe cutting tools
are single point cutting tools. (Fig 1)

End-cutting tools have their cutting edge at the front end
of the tools and are used on lathes for plunge-cut operations.

Single point cutting tools used on lathes may be grouped
into:

_ side-cutting tools

_ end-cutting tools. (Fig 2)

Side cutting edge tools have their cutting edges formed on
the side of the cutting tool, and are used on lathes for most
of the operations.  They are again classified as right hand
tools and left hand tools. (Fig 3)  A right hand tool operates
from the tailstock end towards the headstock, and a left
hand tool operates from the headstock end towards the
tailstock.  The cutting edge is formed accordingly.

Multi-point cutting tools (Fig 4)

These tools have more than one cutting edge and remove
metal from the work simultaneously by the action of all the
cutting edges.  The application of multi-point cutting tools
on the lathe is mostly done by holding the tool in the
tailstock and feeding it to the work.

Form tools (Fig 5)

These tools reproduce on the work the form and shape of
the cutting edges to which they are ground.  Form tools
perform the operations on the work by the plunging action,
and are fixed on the tool post, square to the axis of the
work, and are fed by the cross-slide.  They may have their
cutting edges formed on square or rectangular section tool
blanks acting radially. The form tools may be either
circular form tools or tangential form tools.  They may
require special holders to which they are fixed, and the
holders themselves are clamped on the tool posts for the
operations.
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Lathe cutting tool - types

The tools used on lathes are:

_ solid type tools

_ brazed type tools

_ inserted bits with holders

_ throw-away type tools (carbide).

Solid tools (Fig 6)

tips of the shank metal pieces are machined on the top
surface according to the shape of the tips so as to
accommodate the carbide bits. These tools are economical,
and give better rigidity for the tools than the inserted bits
clamped in the tool-holders.  This is applicable to high
speed steel brazed tools also.

These are tools having their cutting edges ground on solid
bits of square, rectangular and round cross-sections.
Most of the lathe cutting tools are of the solid type, and
high carbon steel and high speed steel tools are used.  The
length and cross-section of the tool depend upon the
capacity of the machine, the type of tool post and the
nature of the operation.

Inserted bits with holders (Fig 7)

Solid high speed steel tools are costly, hence, sometimes
inserted bits are used.  These bits are small in size, and
are inserted in the holes of the holder.  These holders are
held and clamped in the tool posts to carry out the
operations.  The disadvantage in this type of tools is that
the rigidity of the tool is poor.

Brazed tools (Fig 8)

These tools are made of two different metals.  The cutting
portion of these tools is of cutting tool materials, and the
body of the tools does not possess any cutting ability, and
is tough.  Tungsten carbide tools are mostly of the brazed
type.  Tungsten carbide bits of square, rectangular and
triangular shape are brazed to the tips of the shank.  The

Throw-away type tools (Fig 9)

Carbide brazed tools when blunt or broken need grinding
which is time absorbing and expensive.  Hence, they are
used as throw-away inserts in mass production.  Special
tool-holders are needed and the carbide bits of rectangular,
square or triangular shapes are clamped in the seating
faces and machined on this type of special holders.

The seating faces are machined in such a way that the
rake and clearance needed for the cutting bits are
automatically achieved when the bits are clamped.

Lathe cutting tools shapes

Lathe cutting tools are available in a variety of shapes for
performing different operations.  Some of the lathe cutting
tools generally used are shown in Figs 10 &11.
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Lathe tools - angles and their functions
Objectives :  At the end of this lesson you shall be able to
• state the angles of a lathe cutting tool
• state the characteristics of a rake angle
• state the characteristics of a clearance angle
• state the characteristics of a relief angle.

A lathe tool in action is shown in Fig 1. Notice that the
section of the tool is basically a square or rectangle with
a modified shape at the cutting end.  If it is not modified and
used, full face surface will make contact with the work and
the tool can hardly penetrate into the work. (Fig 2)
Otherwise the surface of the tool will only rub against the
workpiece and hardly any cutting will take place.  But by
shaping the tool as shown in Fig 3, the full surface contact
will be eliminated and a cutting edge will be created.  The
angle which is responsible for the creation of the cutting
edge is called the clearance angle.

The tool in Fig 1 has some  more angles ground in it to
make the metal removal more efficient, and these angles
are  shown in respect of general roughing tool in Fig 4.

The angles are:

_ side cutting edge angle

_ end cutting edge angle

_ top rake angle

_ side rake angle

_ front clearance angle

_ side clearance angle.
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Side cutting edge angle

(Approach angle) (Fig 5)

This is ground on the side of the cutting tool.  The cutting
will be oblique.  The angle ground may range from 25°to 40°
but as a standard a 30° angle is normally provided.  The
oblique cutting has certain advantages over an orthogonal
cutting, in which the cutting edge is straight.  More depth
of cut is given in the case of oblique cutting since when the
tool is fed to the work, the contact surface of the tool
gradually increases as the tool advances, whereas, in the
case of orthogonal cutting, the length of the cutting edge
for the given depth fully contacts the work from the
beginning itself, which gives a sudden maximum load on
the tool face.  The area, over which heat is distributed, is
more in oblique cutting. (Fig 6)

End-cutting edge angle (Trial angle) (Fig 7)

The end-cutting edge angle is ground at 30° to a line
perpendicular to the axis of the tool, as illustrated in
Fig 4. The side-cutting edge angle and the end-cutting
edge angle, when ground, form a nose (wedge) angle of 90°
for the tool.

Top or back rake angle (Fig 8)

The rake angle ground on a tool controls the geometry of
chip formation for any given material.  It controls the
mechanics of the cutting action of the tool.  The top or back
rake angle of the tool is ground on the top of the tool, and
it is a slope formed between the front of the cutting edge
and the top face.  If the slope is from the front towards the
back of the tool, it is known as a positive top rake
angle,(Fig 8A)  and, if the slope is from the back of the tool
towards the front of the cutting edge, it is known as the
negative back rake angle. (Fig 8B)

The top rake angle may be ground positive, negative or
zero according to the material to be machined.  When
turning soft, ductile materials which form curly chips, the
positive top rake angle ground will be comparatively more
than for turning the hard brittle metals.

When turning hard metals with a carbide tool it is the usual
practice to give a negative top rake.  Negative top rake
angle tools have more strength than the positive top rake
angle tools.

Side rake angle (Fig 9)

The side rake angle is the slope between the side of the
cutting edge to the top face of the tool widthwise.  The
slope is from the cutting edge to the rear side of the tool.
It varies from 0° to 20° according to the material to be
machined.  The top and side rakes, ground on a tool,
control the chip flow and this results in a true rake angle
which is the direction in which the chip that shears from the
work passes.
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Front clearance angle (Fig 10)

This angle is the slope between the front of the cutting
edge to a line perpendicular to the axis of the tool drawn
downwards.  The slope is from the top to the bottom of the
tool, and permits only the cutting edge to contact the work,
and avoids any rubbing action.  If the clearance ground is
more, it will weaken the cutting edge.

Side clearance angle (Fig 11)

The side clearance angle is the slope formed between the
side cutting edge of the tool with a line perpendicular to the
tool axis drawn downwards at the side cutting edge of the
tool.  The slope is from the top of the side cutting edge to
the bottom face.  This is also ground to prevent the tool
from rubbing with the work, and allows only the cutting
edge to contact the work during turning.  The side
clearance angle needs to be increased when the feed rate
is increased.

When grinding the rake and clearance angles, it is better
to refer to the standard chart provided with the recommended
values, and then grind.  However, actual operation will
indicate the performance of the tool and if any modification
is needed for the angles ground on the tool.

Side relief angle (Fig 12)

This angle is ground on the parting and the undercutting
tools on both sides.  This will provide the width of the
cutting edge slightly broader than the back of the cutting
edge.

This permits clearance between the sides of the tool and
the groove walls formed by the plunging action of the tool,
thereby, preventing the tool from getting jammed in the
groove and causing breakage. The relief is kept as minimum
as possible.  Too much of relief will weaken the tool cutting
edge, and also permit the chips to clog in the gap, causing
the tool in both cases to break.  Side relief is also provided
sometimes to the main cutting edge of the facing tools,
permitting only the cutting point performing the operation,
when the tool axis is set perpendicular to the lathe axis.
The side relief angle normally does not exceed 2°.

Relationship between rake, clearance and wedge
angles (Fig 13)

The rake angle (μ), clearance angle ( g) and the wedge
angle (b) have close relationship for efficiency in cutting.
Excessive rake angle reduces the wedge angle, which
helps in good penetration and it is particularly useful for
cutting soft metals.  A decreased wedge angle weakens
the tool strength.  Therefore, for cutting hard metals, the
rake angle is zero or negative.  The clearance angle is
generally fixed depending on the geometry of the surface
being cut.
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CG & M Related Theory for Exercise 1.3.36
Tool & Die Maker (Dies & Moulds) - Turning

Different Types and Specifications of Carbide Tools
Objectives: At the end of this lesson you shall be able to
• identify the different types of carbide tools
• state the specifications of carbide tools.

Types of chip

Cemented carbide tools are available as brazed tipped
tools and throwaway tips held in specially designed tool
holders. Standard shapes of carbide-tipped turning and
facing tools are shown in the figures 5.8.1 to 5.8.9 carbide
tipped cut off and boring tools are also available. These
tools are re-sharpened as needed using special silicon
carbide and diamond wheels.

Standard terms for carbide tools as specified in ISO.

ISO 1 Straight turning tool

ISO 2 Cranked turning tool

ISO 3 Offset facing tool

ISO 4 Wide nose square turning tool

ISO 5 Offset turning and facing tool

ISO 6 Offset side cutting tool (Offset knife tool)

ISO 7 Recessing tool (parting tool)

ISO 8 Boring tool

ISO 9 Corner boring tool (finishing)

The carbide tools are specified according to

1 The operations (rough and finish)

2 Right hand or left hand

3 Material being turned and machine conditions (Refer
Table 1)

Classification

Classifications of carbide tool according to their range of
application (1S: 2428-1964)

The method of referring to a straight ISO carbide tool by a
manufacturer.
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The method of referring to a straight ISO carbide tool by a
manufacturer is shown in Fig 2
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CG & M Related Theory for Exercise 1.3.37&38
Tool & Die Maker (Dies & Moulds) - Turning

Types of chips, chip brakers and tool life
Objectives: At the end of this lesson you shall be able to
•  state the types of chips
• state the function of chip breakers and their uses
• state the relationship between cutting speed  and tool life
• explain tool life index equation
• state the maximum cutting speed for a given tool life.

Types of chip

The form and dimension of a chip in metal machining
indicate the nature and quality of a particular machining
process, but the type of chip formed is greatly influenced
by the properties of the material being cut and various
cutting conditions.

In engineering manufacture particularly in metal machining
processes hard brittle metals have a very limited use, and
ductile metals are mostly used. Chips of ductile metals
are removed by varying proportions of tear, shear, and flow.
This results in three general types of shapes (Fig 1)

1 The discontinuous or segmental form.

2 The continuous or ribbon type.

3 The continuous with built-up edge.

Discontinuous or segmental chips consist of elements
fractured into fairly small pieces ahead of the cutting tool.
This type of chip is obtained in machining most brittle
materials, such as cast iron and bronze. These materials
rupture during plastic deformation, and form chips as
separate small pieces. As these chips are produced, the
cutting edge smoothes over the irregularities, and a fairly
good finish is obtained. Tool life is also reasonably good,
and the power consumption is low. Discontinuous chips
can also be formed on some ductile metals only under
certain conditions particularly at very low speeds and if
the coefficient of friction is low. With ductile metals however
the surface times is bad end the tool life is short

Conditions tending to promote its formation include: brittle
metal, greater depth of cut, low cutting speed and small
rake angle.

Continuous chips consist of elements bonded firmly
together without being fractured. Under the best conditions
the metal flows by means of plastic deformation, and gives
a continuous ribbon of metal which, under the microscope,
shows no signs of tears or discontinuities. The upper side
of a continuous chip has small notches while the lower
side, which slides over the tool face, is smooth and shiny.
The continuous form is considered most desirable face, is
smooth and shiny. The continuous form is considered most
desirable for low friction at the rool-chip interface, lower
power consumption, long tool life and good surface finish.

Factor favourable to its formation are: ductile metal, such
as mild steel, copper, etc., fine feed, high cutting speed,
large rake angle, keen cutting edge, smooth tool face and
an efficient lubrication system.

The term built-up edge implies the building up of a ridge of
metal on the top surface of the tool and above the cutting
edge. It appears that, when the cut is started in ductile
metals, a pile of compressed and highly stressed metal
forms at the extreme edge of the tool. Owing to the high
heat and pressure generated there, this piled up metal is
welded to the cutting tip and forms a “false” cutting edge
tool. This is usually referrd to as the “built up edge”. This
weld metal is extremely strain hardened and brittle. So
the weaker chip metal tears away from the weld as the
chip moves along the tool face. The buit-up becoming
unstable, breaks down and some fragments leave with
the chip as it passes off and the rest adheres to the work
surface producing the characteristic rough surface. The
built-up edge appears to be a rather permanent structure
as long as the cut is continuous at relatively high speeds
and has the effect of slightly altering the rake angle. At
very high speeds, usually associated with sintered carbide
tools, the the built-up edge is very small or nonexistent,
and a smooth machined surface results.

Conditions tending to promote the formation of built-up
edges include: low cutting speed, low rake angle, high
feed, lack of cutting fluid and large depth of cut.
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The chip breakers and their uses

Chip breaker

Chip  breaker means  with which the continuous long curly
chips are broken into comparatively small pieces  for easy
handling,  thus  preventing  it from becoming a work hazard.

Types of chip breakers (Fig 2)

- Step type - built in

- Groove type - built in

- Clamp type  - mechanical

The common methods of breaking  the chips in normal
shop practice are summarized here.

- By  clamping a piece  of  sheet metal in the path of the
coil.

- By a step type chip breaker  in which  a step is ground
on  the face  of  the tool,  along  the cutting edge.

- By  a groove type chip  breaker in  which  a  small
groove  is ground behind the cutting edge.

- By a clamp type chip breaker in which a thin  carbide
plate  or clamp  is brazed or screwed  on the face of
the tool.

Throw-away tip tool-holders are provided with chip breakers.

Necessity for breaking the chips

Long    and unbroken chips produced while turning  ductile
materials   are  difficult   to handle  and  injurious  to  the
operator. They should be broken into convenient  lengths
for  easy disposal and also  to protect   the   finished
work-surfaces.  Therefore, tools are  provided with  devices
to curl   and  break  the   chips.  These devices, which are
called  chip  breakers are  in  the form of ground chip
breakers in the  case  of  brazed   carbide tools,  and
external or pre–sintered  chip breakers in the case of
disposable, indexable  inserts.   However, with  high speed
steel  tools, this  problem  may  not   arise because  at low
cutting  speeds the chip has often natural curl and tends
to be brittle  enough to break on its own.

Tool life and factors effecting tool life
Objectives: At the end of this lesson you shall be able to
• State what is life
• explain the factors effecting the tool life.

Tool life is a most important factor in the evaluation of
machinability,

 it is the period of time in which the tool cuts effectively
and efficiently.

The methods of expressing tool life.

There are many ways of expressing the tool life, such as

− Time unit - It is the most commonly used tool life unit.

− Volume of material removed by tool during its total
lifespan.

− Number of work pieces machined by a tool.

Tool life most commonly expressed in minute, expected
life of some tool material is given below

Cast tool steel - 120 minute

High speed steel tool - 60 to120 minute

Cemented carbide tool - 420 to 480minute

Factor affecting tool life:

− Cutting speed

− Feed and depth of cut

− Tool geometry

− Tool material

− Work material

− Nature of cutting

− Rigidity of machine tool and work

− Cutting fluids

Cutting speed:

It is major for affecting tool life.

It varies inversely with tool life which leads to parabolic
curve as shown in Fig 1

Tool life relation is invented by F.W.Taylor.

CG& M: TDM (Dies & Moulds) (NSQF - Revised 2022) - R.Theory for Ex. 1.3.37 - 38

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



153

VTn= C

V = cutting speed in m/min,

 T = Tool life in min,

 n = Tool life index

C = machining constant

N and C are constant for a given set of conditions

Feed Rate and Depth of Cut:

According to the Taylor's tool life equation, tool life
decreases when feed rate increases. Also, same for the
depth of cut.

Tool Geometry:

The tool geometry greatly affects the tool life. the effect of
all the tool parameters on tool life is as follows

− Back Rake Angle.

− Principal Cutting Edge.

− Clearance Angle.

− Nose Radius.

Back Rake Angle:

Larger the rake angle smaller will be the cutting angle and
larger will be shear angle, this reduces the cutting force
and power, and hence less heat generated during cutting,
means reduced cutting temperature, results in longer tool
life.

But on the other hand, increasing the rake angle results in
mechanically weak cutting edge the positive rake tool
experiences shear stress and the tip is likely to be
sheared-off.

Negative rake increases cutting force and power, hence
more heat and temperature generated results in smaller
tool life.

Therefore, there lies an optimum value of the back rake
which depends upon tool material and work material. It
ranges from -5° to +15°. An optimum value of rake angle is
about 14° which gives maximum tool life.

Fig. 2 shows cutting process using positive and negative
rake tools. The positive rake tool experiences shear stress
and the tip is likely to be sheared off. Whereas tool with
negative rake experiences

Principal Cutting Edge:

Fig 3 shows two different arrangements of principal cutting
edge angles. Fig. 3 (a), the contact is gradually starting
from a point quite away from the tip. Therefore, the tool
experiences the cutting force gradually and over a larger
area. Hence the tool is safer and tool life is more as
compared to the Fig. 2(b) in which the principal cutting
edge angle is 90°.

compressive stress. The carbide and ceramic tools are
generally given negative rake because they are weak in
shear and good in compression

Clearance Angle:

Increase in clearance angle results in significant reduced
flank wear, so increased tool life. But the cutting edge will
become weaker as the clearance angle is increased.
Therefore an optimum value is required. The best
compromise is 5° (with carbide tools) to 8° (with H.S.S.
tools) for common work materials.

Nose Radius:

The nose radius improves tool life and surface finish.

There is an optimum value of nose radius at which the tool
life is maximum.

− If the radius exceeds optimum value, the tool life
decreases.

− Larger radius means larger area of contact between
the tool and work piece. Due to which more frictional
heat is generated, results in increased cutting force.
Due to which the work piece may starts, vibrating,
hence if rigidity is not very high, brittle tools (carbides
and ceramics) will fail due to chipping of cutting edge.

Tool Material:

− The major requirements of cutting tool materials are:
Hot hardness, impact toughness, and wear resistance.
For better tool life, the material must have the above
properties. Fig. 4 shows tool life variation against cutting
speeds for different tool materials.
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It is very clear from the figure; at any cutting speed the
tool life is maximum for ceramic tool and lowest for the
high speed steel tool. So using ceramic tool maximum
volume of material could be removed at any cutting speed
for a specific tool life.

Hardness of Work piece:

As the hardness increases, the permissible velocity
decreases for a given tool life. For example, the tool life is
50 minutes for cutting less hard material, now if say harder
material is to be cut then to maintain the tool life as 50
minutes, the cutting velocity should be reduced
proportionate.

Nature of Cutting:

If the cutting is intermittent, the tool bears impact loading,
results in chance of its quick failure. In continuous and
steady cutting, the tool life is more.

Rigidity of Work piece-Machine Tool System:

Higher is the rigidity of system higher will be the tool life.
Lower the rigidity of the system, higher is the chance of
tool failure, by vibrations of tool or work piece. Rigidity is
the prime requirement in case of intermittent cutting
especially when brittle tools are used.

Type of Cutting Fluid and its Method of Application:

Application of suitable cutting fluid obviously increases
tool life or in other words, for the same tool life, allowable
cutting speed increases. Fig. 9.30 shows the effect of
cutting fluid on tool life for different tool materials. The tool
life even increases by 150 per cent at some speeds. All
types of cutting fluids do not have equal effect, some of
them more, some are less
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CG & M Related Theory for Exercise 1.3.39
Tool & Die Maker (Dies & Moulds) - Turning

Lathe driving mechanism for all gear types
Objectives: At the end of this lesson you shall be able to
• state the functions of headstock
• explain the difference between cone pulley headstock and all geared headstock.

Headstock

It is a fixed unit of lathe on the left hand side. (Fig 1)

Its main functions are to:

- provide a means to assemble work - holding devices

Transmit the drive from the main motor to work to make it
revolve

Accommodate shafts with fixed and sliding gears for
providing a wide range of work speeds

Have shift levers to slide gears to bring in mesh for different
speeds

Have a means for lubricating the gears, shafts and
bearings.

Constructional features of all-geared headstock
(Fig 2)

It is a box-section alloy iron casting having a top cover
which can be removed, if needed, It has an input shaft
which is connected by means of ‘V’ belts to the main
motor, and runs at constant speed. It is equipped with
clutches and a brake.

There may be two or more intermediate shafts on which
sliding gears are mounted. The main spindle is the last
driven shaft in the headstock assembly. The nose of the
spindle is outside the headstock casting and is designed
to accommodate the work-holding devices.

The levers operating the forks of the sliding gears are
situated outside in the front of the headstock casting. A
sight glass is provided on the top to indicate the functioning
of the automatic lubricating system and side of sight glass
is provided oil length of the machine.

Cone pulley headstock (Fig 3)

It has a stepped cone pulley mounted on the main spindle
and is free to revolve. It is connected by means of a flat
belt to a similar cone pulley, the steps arranged in a
reversing order. This cone pulley gets the drive from the
main motor.

The spindle is mounted on the bush bearings in the
headstock casting and a gearwheel called ‘bullgear’ keyed
to it. A pinion is coupled to the cone pulley. The back gear
unit has a shaft which carries a gear and a pinion. The
number of teeth of the gear and pinion on the back gear
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Shaft corrresponds to the number of teeth on the bull gear
and the pinion on the cone pulley. The axis of the back
gear shaft is parallel to the axis of the main spindle, and
the back gear is brought in engagement or disengagement
with the cone pulley system by means of a lever. The
back gear unit is engaged to have reduced spindle speeds.
(Fig 4)

A three-stepped cone pulley headstock provides three
direct ranges of speeds through the belt connection. and
with the back gear in engagement, three further ranges of
reduced speeds.

Advantages

Easy for maintenance.

Can take up heavy load.

Less noise during functioning.

During overloads, the belt slips off, and hence, no major
damage to the lathe is caused.

Positive drive when the back gear is in engagement.

Disadvantages

Number of spindle speeds limited to the the number of
steps in the cone pulley.

Takes time to change spindle speeds.

Needs adjustments of bush bearings.

Back gear
Objectives: At the end of this lesson you shall be able to
• state the construction details of Back gear assembly
• state the function and purpose of Back gear.

Back gear

As its name implies “back gear” is a gear mounted at the
back of the head stock. It is used to reduce the speed.

Necessity of back gear: For machining big job, taking
rough cut use need more power at reduced speed of spindle
the back gear provides this feature in a lathe

Use of backgear

It enables to rotate the chuck at very slow speed

It provides increased turning power

It is highly suitable for turning large diameter casing (200
rpm)

It reduces the rpm but increases the torque

Even the largest face plate mounted job can be turned
succesfully

The spindle is mounted on the bush bearings in the
headstock casting and a gear wheel called ‘bullgear’ keyed
to it. A pinion is coupled to the cone pulley. The back gear
unit has a shaft which carries a gear and a pinion. The
number of teeth of the gear and pinion on the back gear
shaft corresponds to the number of teeth on the bull gear
and the pinion on the cone pulley. The axis of the back
gear eccentric shaft is parallel to the axis of the main
spindle, and the back gear is brought in engagement or
disengagement with the cone pulley system by means of
a lever. The back gear unit is engaged to have reduced
spindle speeds. (Fig 1)
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Tumbler gear set
Objectives: At the end of this lesson you shall be able to
• state the purpose of the tumbler gear mechanism
• state the construction details of the tumbler gear mechanism.

Tumbler gear mechanism (Fig 1)

The tumbler gear mechanism is used for changing the
direction of rotation of the lead screw and feed shaft. It is
normally situated between the spindle drive and the feed
gear box. It consists of 3 gears arranged in a simple gear
train, mounted on a bracket can be shifted into 3 positions.

For forward rotation of the lead screw and feed shaft.

For neutral position (no rotation of lead screw and feed
shaft)

For the reverse rotation of the lead screw and feed shaft.

In practice, the first driver gear of a screw cutting train is
not fitted directly to the lathe spindle but is mounted on a
driver stud which rotates at the same speed as the spindle.

The driving gear on the spindle drives the fixed stud gear,
and, since they have the same speed, they must be of the
same size. Tumbler gear A is always in mesh with the
driven gear and in mesh with the fellow tumbler gear B. In
the figure, the drive is directed through the tumbler gear A,
and tumbler gear B is idle.

If the tumbler bracket is moved upwards, tumbler gear A
rolls around the driven gear until it is out of mesh with the
driver gear, and tumbler gear B moves into mesh with the
driver, reversing the direction of the driven gear. Thus the
two trains available are: 

Forward: Driver —> A  —> Driven

Reverse: Driver —> B  —> A —> Driven.

In yet another position of the tumbler bracket, tumbler
gears A or B do not mesh with the driver gear and no drive
is transmitted to the driven gear. No feed movement or
thread cutting is possible.

Feed machanism of lathe
Objectives: At the end of this lesson you shall be able to
• explain the parts of the feed machanism
• state the functional features of the feed mechanism.

Feed mechanism (Fig 1)

The feed mechanism of a lathe enables automatic feeding
longitudinally and transversely as needed. By automatic
feeding the finish on the work will be better, the feeding of
the tool will be uniform by a continuous rate and it takes
less time to finish the operation while manual labour is
avoided.

The feed mechanism comprises the following.

Spindle gear (A)

Tumbler gear unit (B)

Fixed stud gear (C)

Change gear unit (DEFG)

A three-stepped cone pulley headstock provides three
direct ranges of speeds through the belt connection, and
with the back gear in engagement, three further ranges of
reduced speeds (Fig 2).
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Quick change gearbox (H)

Feed shaft/ lead screw (I)

Apron meachinsm (not in figure)

The proportionate tool movement for each revolution of work
is achieved through all the above units of the feed
mechanism.

Spindle gear

The spindle gear is fitted to the main spindle, and it is
outside the headstock casting. It revolves along with the
main spindle.

Tumbler gear unit

The tumbler gear unit itself consists of three gears, each
having the same number of teeth and it connects the
spindle gear to the fixed gear. It is also called the reversing
gear unit as it is used to change the direction of feed of
the tool for the same direction of rotation of the spindle. It
can be engaged and spindle. It can be engaged and
disengaged with the fixed spindle gear by the operation of
the hand lever provided in the unit. (Fig 2)

The fixed stud gear

The fixed stud gear gets the drive from the main spindle
gear through the tumbler gear unit and runs at the same
number of revolutions per minute as the spindle gear on
most lathes.

Change gear unit

The fixed stud gear transmits its drive through a change
gear unit to the quick change gearbox. The change gear
unit has provision for changing the driver, the driven and
the idler gears from the set of change gears available for
the purpose of feed changing as an additional unit. (Fig 3)

Quick change gearbox

The quick change gearbox is provided with levers outside
box casting, and by shifting the levers, different gears are
brought in mesh so that different feed rates can be given
to the tool. A chart listing the different feed rates for the
different positions of the levers is fixed to the casting, and
by referring to the table, the levers may be engaged in
position for the required feed rate. (Fig 4)

The feed shaft

The feed shaft gets its drive from the quick change gearbox,
and through the apron mechanism, the rotary movement
of the feed shaft is converted into the linear movement of
the tool.

The apron mechanism

The apron mechanism has an arrangement for transmitting
the drive from the feed shaft to the saddle for longitudinal
movement of the tool or to the cross-slide for the transverse
movement of tool. (Fig 5)
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Cutting speed and feed, depth of cut and recommended speed
Objectives: At the end of this lesson you shall be able to
• explain the recommended cutting speed for different materials from the chart
• state the factors governing the cutting speed
• state the factors governing feed.

Cutting speed (Fig 1)

The speed at which the cutting edge passes over the
material, which is expressed in metres per minute is called
the cutting speed. When a work of a diameter ‘D’ is turned
in one revolution the length of portion of the work in contact
with the tool is pxD. When the work is making ‘n’ rev/min,
the length of the work in contact with the tool is p x D x n.
This is converted into metres and is expressed in a formula
form as

                 
 

1000
πDN

V �

Where V  = cutting speed in metre/min

π  = 3.14

D = diameter of the work in mm.

N = r.p.m.

Example

Find out the rpm of the spindle for a 50 mm bar to cut at
25 m/min.

πD
1000V

N 
1000
πDN

V ��

 
r.p.m 159

3.14
500

503.14
251000

��
�

�

When more material is to be removed in lesser time, a
higher cutting speed is needed. This makes the spindle to
run faster but the life of the tool will be reduced due to
more heat being developed. Recommended cutting speeds
are given in chart form which provides normal tool life under
normal working conditions. As far as possible the
recommended cutting speeds are to be chosen and the
spindle speed calculated before performing the operation
(Fig 2)

Factors governing the cutting speed

Finish required

Depth of cut

Tool geometry

Properties and rigidity of the cutting tool and its mounting

Properties of the workpiece material

Rigidity of the workpiece

Type of cutting fluid used & Rigidity of machine tool
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Relationsship of r.p.m to the cutting speed on different diameter (Fig 3)

Cutting speed 120m/min Length of metal passing cutting Calculated r.p.m of
tool in one revolution  spindle

....................... 78.5 mm 1528

....................... 157.0 mm 764

....................... 235.5 mm 509.5

Feed (Fig 4)

The feed of the tool is the distance it moves along the
work for each revolution of the work, and it is expressed in
mm/rev.

Factors governing feed

Tool geometry

Surface finish required on the work

Rigidity of the tool

Coolant used.

Depth of cut (Fig 4)

It is defined as the perpendicular distance measured
between the machined surface (d) and the unmachined
surface (D) expressed in mm.

              

 
2

dD
cut of Depth

�
�

Rate of metal remove

The volume of metal removal is the volume of chip that is
removed from the work in one minute, and is found by

multiplying the cutting speed, feed rate and the depth of
cut.

Cutting speeds and feeds for H.S.S. tools are given
in table 1

Table 1

Material being turned Feed Cutting speed

Aluminium 0.2 - 1.00 70-100

Brass (alpha) - ductile 0.2 - 1.00 50-80

Brass (free cutting) 0.2 - 15 70 - 100

Bronze (phosphor) 0.2 - 1.00 35 - 70

Cast iron (grey) 0.15 - 0.7  25 - 40

Copper 0.2 - 1. 00 35 - 70

Steel (mild) 0.2 - 1. 00 35 - 50

Steel (medium - carbon) 0.15 - 0.7 30 - 35

Steel (alloy high tensile) 0.08 - 0.3 5 - 10

Thermosetting plastics 0.2 - 1. 00 35 - 50

Note

For super HSS tools the feeds would remain the same,
but cutting speeds could be increased by 15% to 20%

A lower speed range is suitable for heavy, rough cuts.

A higher speed range is suitable for light, finishing cuts.

The feed is selected to suit the finish required and the rate
of metal removal.

When carbide tools are used, 3 to 4 times higher cutting
speed than that  of the H.S.S. tools may be chosen.
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CG & M Related Theory for Exercise 1.3.40
Tool & Die Maker (Dies & Moulds) - Turning

Orthogonal cutting and oblique cutting
Objectives: At the end of this lesson you shall be able to
• explain difference between orthogonal cutting and oblique cutting
• state the advantage and disadvantages of orthogonal cutting
• state about the work holding devices
• state the advantages and disadvantages of oblique cutting.

Orthogonal cutting (Fig 1)

Orthogonal cutting is a process of cutting operation where
only two forces are acting on the tool which are shown in
figure 1, They are:

- tangential force

- axial force.

In orthogonal cutting, the cutting edge is parallel to the
axisof the tool.

The major force is the tangential force, but the following
factors affect the magnitude of both the forces.

Rake angle

Depth of cut

Rate of feed

Resistance to cutting by the material of the work piece

Friction between the chip and the tool

Orthogonal cutting is suitable for finish turning where the
depth of cut is less. The chattering during turning is much
reduced. The main disadvantage is at the start of the cutting
itself as the load will act suddenly on the tool.

Oblique cutting (Fig 2)

Oblique cutting is a process of cutting operation where
three forces are acting on the tool as shown in the figure.
They are:

- axial force

- tangential cutting force

- radial force.

Though the radial force does not affect the power
consumed, it gives stability to the cutting operation. This
force keeps the cross-slide screw and nut in contact. In
oblique cutting the cutting edge is at an angle to the axis
of the tool.

Advantages of oblique cutting

For the given depth of cut the load is distributed at the
start of the cutting operation.

As the length of the cutting edge is more, load per unit
area is less.

It is suitable for rough turning.

Disadvantages of oblique cutting

The tool has to be ground for the approach angle. So more
cutting tool material is consumed.

As it produces an angular shoulder to make it a square
shoulder, another cutting tool should be used.

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



162

CG & M Related Theory for Exercise 1.3.41
Tool & Die Maker (Dies & Moulds) - Turning

Lathe accessories - work holding devices : Four jaw chuck
Objectives : At the end of this lesson you shall be able to
• explain the parts of a Four jaw chuck
• state the constructional features of a Four jaw chuck.

Four-jaw chuck (Fig 1)

The four-jaw chuck is also known as an independent
chuck, since each jaw can be adjusted independently; a
work can be trued to within 0.001" or 0.02 mm accuracy,
using this chuck.

This type of chuck is much more heavily constructed than
the self-centering chuck, and has much greater holding
power.  Each jaw is moved independently by a square
thread screw.  The jaws are reversible for holding large
diameter jobs.  The independent four-jaw chuck has four
jaws each working independently of the others in its own
slot in the chuck body and actuated by its own separate
square threaded screw.  By suitable adjustment of the
jaws, a workpiece can be set to run either true or eccentric
with the machine centre.

Finished jobs when held in a four-jaw chuck can be trued
with the help of a dial test indicator.

The checking of the workpiece should be carried out near
the chuck and repeated as far from it as the workpiece
permits, to ensure that the work is not held in the chuck
at an angle to the axis of rotation.

The independent adjustment also provides the facility of
deliberately setting the work off-centre to produce an
eccentric workpiece. (Fig 2)

The parts of a four-jaw chuck are the:

- back plate

- body

- jaws

- square threaded screw shaft.

Back plate

The back plate is fastened to the back of the body by
means of Allen screws.  It is made out of cast iron/steel.
Its bore is tapered to suit the taper of the spindle nose.  It
has a keyway which fits into the key provided on the
spindle nose.  There is a step in front  on which the thread
is cut.  A threaded collar, which is mounted on the spindle,
locks the chuck by means of the thread, and locates by
means of the taper and key.  Some chucks do not have
back plates.

Body

The body is made out of cast iron/cast steel and the face
is flame-hardened.  It has four openings 90° apart to
assemble the jaws and operate them.  Four screw shafts
are fixed on the periphery of the body by means of finger
pins.  The screw is rotated by means of a chuck key.  The
body, hollow in the cross-section, has equi-spaced circular
rings provided on the face, which are marked by numerical
numbers.  Number 1 starts in the middle, and increases
towards the periphery.

Jaws

The jaws are made out of high carbon steel, hardened and
tempered, which slide on the openings of the body.  These
jaws are reversible for holding hollow work.

The back side of the jaw  is square-threaded which helps
in fixing the jaws with the operating screws.

Screw shaft

The screw shaft is made out of high carbon steel, hardened,
tempered and ground.  The top portion of the screw shaft
is provided with a square slot to accommodate the chuck
key.  On the body portion, a left hand square thread is cut.
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In the middle of the screw shaft, a narrow step is made and
held by means of finger pins.  The finger pins permit the
screws to rotate but not to advance.

Lathe accessories - work holding devices : Three jaw chuck
Objectives : At the end of this lesson you shall be able to
• explain  the parts of a three jaw chuck
• state the constructional features of a three jaw chuck
• explain the difference between a three jaw chuck and a four jaw chuck
• state the merits and demerits of the four jaw chuck over a 3 jaw chuck.

The three jaw chuck (Fig 1)

The three jaw chuck is also known as self-centering
chuck. The majority of the chucks have two sets of jaws
for holding internal and external diameters. Only perfectly
round work, or work with equally spaced flats, divisible by
three, should be held in a three jaw chuck.

The construction of a three jaw chuck shows that the scroll
not only clamps a component in place but also locates the
component. This is fundamentally a bad practice, since
any wear in the scroll and / or the jaws impairs the
accuracy of location.  Further, there is no means of
adjustment possible to compensate for this wear.

The jaws of this type of chuck are not reversible, and
separate internal and external jaws have to be used.

Parts of a three jaw chuck (Fig 1)

-  Back plate

-  Body

-  Jaws

-  Crown wheel

-  Pinion

Back plate

The back plate is fastened at the back of the body by
means of allen screws. It is made out of cast iron. Its bore
is tapered to suit the taper of the spindle nose. It has a key-
way which will fit into the key provided on the spindle nose.
There is a step in the front on which the thread is cut.

The threaded collar, which is mounted on the spindle,
locks the chuck by means of the thread, and locates by
means of the taper and the key.

Body

The body is made out of cast steel, and   the face is
hardened.   The body has three openings - 120° apart to
assemble the jaws and operate them. Three pinions are
fixed on the periphery of the body to operate the jaws by
means of a chuck key.  The body is hollow in cross-
section. The crown wheel is housed inside the body.

Jaws

The jaws are made out of high carbon steel, hardened and
tempered, which slide on the openings of the body. Generally
there are two sets of jaws, viz. external jaws and internal
jaws. External jaws are used for holding solid works.
Internal jaws are used for holding hollow works. The steps
on the jaws increase the clamping range. The back side of
the jaws are cut out of scroll thread. Each jaw is numbered
in a sequential manner, which will help in fixing the jaws in
the corresponding numbered slots.

Crown wheel

The crown wheel is made out of alloy steel, hardened and
tempered.   On one side of the crown wheel a scroll thread
is cut to operate the jaws and the other side is tapered on
which bevel gear teeth are cut to mesh the pinion. When
the pinion is rotated by means of the  chuck key, the crown
wheel rotates, thus causing the jaws to move inward or
outward depending upon the rotation.

Pinion

The pinion is made out of high carbon steel, hardened and
tempered. It is fitted on the periphery of the body. On the top
of the pinion, a square slot is provided to accommodate the
chuck key. It has a tapered portion on which the bevel gear
teeth are cut, which match with the crown wheel.

Merits of a Four jaw chuck

- A wide range of regular and    irregular shapes can be
held.

- Work  can  be  set  to  run concentrically or eccentrically
at will.

- Has considerable gripping power; hence, heavy cuts
can be given.

- The jaws are reversible for internal and external work.
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- Work can be readily performed on the end face of the
job.

- There is no loss of accuracy as the chuck gets worn
out.

- Workpieces must be individually set.

- The gripping power is so great that a fine work can be
easily damaged during setting.

Comparison between a 3 jaw chuck and 4 jaw chuck

Three Jaw chuck Four Jaw chuck

Only cylindrical or hexagonal work can be held.  A wide range of regular and irregular shaped jobs can be
held.

Internal and external jaws are available. Jaws are reversible for external and internal holding.

Setting up of work is easy. Setting up of work is difficult.

Less gripping power. More gripping power.

Depth of cut is comparatively less. More depth of cut can be given.

Heavier jobs cannot be turned. Heavier jobs can be turned.

Workpieces cannot be set for eccentric turning. Workpieces can be set for eccentric turning.

Concentric circles are not provided on the face. Concentric circles are provided.

Accuracy decreases as chuck gets worn out. There is no loss of accuracy as the chuck gets worn
out.

Merits of a Three jaw chuck

- Work can be set quickly and trued easily.

- A wide range of cylindrical and hexagonal work can be
held.

- Internal and external jaws are available.

Demerits of a Three jaw chuck

- Accuracy decreases as chuck gets worn out.

- Run out cannot be corrected.

- Only round and hexagonal components can be held.

- When  accurate setting or concentricity with an existing
diameter is required, a self-centering chuck is not
used.

Specification of a chuck

To specify a chuck, it is essential to provide details of the:

- type of chuck

- capacity of the chuck

- diameter of the body

- width of the body

- the method of mounting to the spindle nose.

Examples

Three  jaw self-centering chuck

Gripping capacity 450 mm

Diameter of the body 500 mm

Width of the body 125 mm

Tapered or threaded method of mounting

Chucks other than three jaw and four jaw types and their uses
Objectives : At the end of this lesson you shall be able to
• explain the chucks other than the three jaw and four  jaw types
• state their constructional features
• state the uses of each of these chucks.

Apart from the   four  jaw independent chucks and self
centering chucks, other types of chucks are also used on
a centre lathe. The choice depends upon the component,
the nature of the operation, the number of components to
be machined.

Some of the other types of chucks are:

- two jaw concentric chuck

- combination chuck

- collet chuck

- magnetic chuck

- hydraulic chuck or air operated chuck.

Two jaw concentric chuck  (Fig 1)

The constructional features of this chuck are similar to
those of Three jaw and Four jaw chucks.

Each jaw is an adjustable jaw which can be operated
independently. In addition to this feature, both jaws may
be operated concentric to the centre. Irregular shaped
works can be held. The jaws may be specially machined
to hold a particular type of job.
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Combination chuck

The combination chuck is normally a four jaw chuck in
which the jaws may be adjusted either independently as
done in a four jaw chuck, or together, as done in a three
jaw universal chuck.

This kind of chuck is used in places where duplicate
workpieces are to be machined. One piece is accurately
set as done in a four  jaw chuck, and the subsequent jobs
are held by operating the centering arrangement.

Collet chuck (Fig 2)

A collet is a hardened steel sleeve having slits cut partly
along its length. It is held by a draw-bar which can be drawn
in or out in the lathe spindle. The collet is guided in the
collet sleeve, and held with the nose cap. It is possible to
change the collet for different cross-sections depending
on the cross-section of the raw material.

There are three most commonly used types of collet
chucks.

- Push-out chucks

- Draw-in chucks

- Dead length bar chucks

The operation of these chucks may be manual, pneumatic,
hydraulic or electrical. They are mainly used to hold round,
square, hexagonal or cast profile bars. (Fig 3)

Push-out chucks (Fig 4)

The collet closes on the workpiece in a forward direction
and consequently an end-wise movement of the work
results. The cutting pressure tends to reduce the grip of
the collet on the workpiece.

Draw-in chuck (Fig 5)

The collet closes on the workpiece in a backward direction
and movement of the work. Take special care to avoid
errors of length due to this fault. The cutting pressure
increases the grip of the collet on the workpiece.

Dead length bar chucks (Fig 6)

These chucks are widely used in modern machines as they
provide an accurate end-wise location of the workpiece. The
chuck does not move end-wise during gripping or closing
operation. These chucks are made to hold round, hexagonal
or square bars, and when they are not gripping, they maintain
contact with the core thus preventing swarf and chips
collecting between the collet and the core.

The disadvantage with these chucks is that each collet
cannot be made to grip bars which vary by more than about
0.08 mm without adjustment.
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Magnetic chuck (Figs 7a & 7b)

This chuck is designed to hold the job by means of
magnetic force. The face of the chuck may be magnetized
by inserting a key in the chuck and turning it to 180°. The
amount of magnetic force may be controlled by reducing
the angle of the key. The truing is done with a light
magnetic force, and then the job is held firmly by using the
full magnetic force.

Hydraulic chuck or air-operated chuck  (Fig 8)

These chucks are mainly used for getting a very effective
grip over the job. This mechanism consists of a hydraulic
or an air cylinder which is mounted at the rear end of the
headstock spindle, rotating  along with it. In the case of a
hydraulically operated chuck the fluid pressure is
transmitted to the cylinder by operating the valves. This
mechanism may be operated manually or by power. The
movement of the piston is transmitted to the jaws by
means of connecting rods and links which enable them to
provide a grip on the job.

Uses of a two jaw concentric chuck

It is mainly employed to hold an irregularly shaped job. As
the chuck is designed with two jaws, it can be used as a
turning fixture.

Uses of a combination chuck

This chuck may be used both as a universal three jaw
chuck and as a four jaw independent chuck. This chuck is
very useful where duplicate workpieces are involved in the
turning.

Uses of a collet chuck

It is mainly used for holding jobs within a comparatively
small diameter. The main advantage of collets lies in their
ability to centre work automatically and maintain accuracy
for long periods. It also facilitates to hold the bar work.

Uses of a magnetic chuck

This type of a chuck is mainly used for holding thin jobs
which cannot be held in an ordinary chuck. These are
suitable for works where a light cut can be taken on the job.

Uses of hydraulic or air-operated chuck

These chucks are mainly used in mass production because
of their speedy and effective gripping capacity.

Driving plate and face plate
Objectives : At the end of this lesson you shall be able to
• explain between the features and the uses of different driving plates
• state the features and uses of different face-plates.

When turning jobs in between centres, driving plates are
used.

 They are:

- catch plates

- driving plates

- safety driving plates.

Catch plate

It is designed with a ‘U’ slot and an elongated slot to
accommodate the bent tail of the lathe carrier. (Fig 1)

Driving plate with pin

It is designed with a projected pin which locates the straight
tail of the lathe carrier. (Fig 2)

CG& M: TDM (Dies & Moulds) (NSQF - Revised 2022) - R.Theory for Ex. 1.3.41

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



167

Safety driving plate

It is similar in construction to that of a driving plate but is
equipped with a cover to protect the operator from any
injuries. (Fig 3)

It is made of cast steel and is machined to have its face
perfectly at right angles to the bore.  It is provided with a
stepped collar at the back.  The bore is designed to suit the
spindle nose to which the plate has to be mounted.

Uses

The driving plate with a straight tail carrier provides a
positive drive for the workpiece.

Catch plates with bent tail carriers use a minimum length
of the workpiece for clamping purposes.

A safety driving plate protects the operator from likely
injuries.

Face-plates

They are similar in construction to that of the lathe catch
plates but are larger in diameter.

The different types of face-plates are:

- face-plates with only elongated radial slots (Fig 4)

- face-plates with elongated slots and ‘T’ slots (Fig 5)

- face-plates with elongated radial slots and additional
parallel slots. (Fig 6)

Face-plates are used along with the following accessories.

Clamps, ‘T’ bolts, angle plates, parallels, counterweights,
stepped blocks, ‘V’ blocks etc.

Uses

Large, flat, irregular shaped workpieces, castings, jigs and
fixtures may be firmly clamped to a face-plate for various
turning operations.

A work can be mounted on a face-plate while the face-plate
is on the lathe spindle or on the workbench.  If the
workpiece is heavy or awkward to hold, the workpiece is
mounted while the face-plate is on the workbench.  Before
mounting the face-plate and it is set up to the spindle, it is
advantageous to locate the workpiece on the face-plate
and centre the workpiece.  Centre a punch mark or hole
approximately on the face of the workpiece.  This makes
it easier to true the work after the face-plate is mounted on
to the spindle.
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The position of the bolts and clamps is very important, if a
workpiece is to be clamped effectively.

If a number of duplicate pieces are to be machined, the
face-plate itself can be set up as a fixture, using parallel
strips and stop blocks.

Dismounting and mounting of chucks
Objectives : At the end of this lesson you shall be able to
• explain how to dismount and mount chucks from a spindle nose.

Depending upon the nature and delicacy of operators,
different work-holding devices are to be mounted and
dismounted on to the lathe spindle nose.

Dismounting a chuck

Switch off the motor.

Hold a ∅ÆÆ30x30mm iron piece projecting about 250mm
more than the chuck to enable easy and safe lifting.

Set the spindle to the lowest speed.

Place a wooden block in the gap between the chuck body
and the lathe bed. The thickness of the wooden block
should be such that it can freely enter the above gap.

Loosen the chuck from the spindle nose. (Fig 1)

Slide and place the chuck on the wooden block. (Fig 2)

Clean and store the chuck.

Mounting a chuck

Aligning the chuck taper with the spindle nose taper and
fastening with a screw type flange.

The application of the face-plate with the accessories in
different set ups  is shown in the sketches below.
(Figs 7,8 and 9)

Aligning the taper of both the chuck and the spindle nose
and fastening with nuts/bolts or with cams.
Place the wooden block which was used for dismounting
the chuck on the bed near the spindle nose (Fig 3) before
mounting the chuck.

CG& M: TDM (Dies & Moulds) (NSQF - Revised 2022) - R.Theory for Ex. 1.3.41

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



169

CG & M Related Theory for Exercise 1.3.42
Tool & Die Maker (Dies & Moulds) - Turning

Knurling, meaning necessity types, grades of cutter and speed for knurling
Objectives: At the end of this lesson you shall be able to
• define knurling operation
• state the purpose of knurling
• state the different types of knurls and knurling patterns
• explain the grades of knurls
• explain the various types of knurling tool-holders.

Knurling (Fig 1)

It is the operation of producing straight lined, diamond
shaped pattern or cross lined pattern on a cylindrical
external surface by pressing a tool called knurling tool.
knurling is not a cutting operation but it is a forming
operation. Knurling is done at a slow spindle speed (1/3
times the turning speed). Soluble oil is to be used as
coolant mostly and, sometimes straight cutting oil may
be used to get better finish.

It is a knurling of diamond shaped pattern. It is done by
using a set of rolls. One roller has got right hand helical
teeth and the other has left hand helical teeth.

Straight knurling (Fig 3)

It is a knurling of straight lined pattern. This is done by
using either a single roller or a double roller with straight
teeth.

Purpose of knurling

The purpose of knurling is to provide.

- a good grip and make for positive handling.

- good appearance

- for raising the diameter to a small range for assembly
to get a press fit.

Types of knurls and knurling patterns

The following are the different types of knurling patterns.

Diamond knurling, Straight knurling, Cross knurling,
Concave knurling and Convex knurling.

Diamond knurling (Fig 2)

Cross knurling (Fig 4)

It is a knurling having a square shaped pattern. It is done
by a set of  rollers, one having straight teeth the other
having teeth at right angles to the axis of knurl.

Concave knurling (Fig 5)

This is done by a convex knurl on a concave surface. This
is done only by plunging the tool. The tool should not be
moved longitudinally. The length of the knurling is limited
to the width of the roller.
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Convex knurling (Fig 6)

This is done by using a concave knurl of a convex surface.
This is also done by plunging the tool.

Grades of knurling (Fig 7)

Knurling can be done in three grades.

Coarse knurling, Medium knurling and Fine knurling

Coarse knurling is done by using coarse pitched knurls of
1.75mm pitch. (14 TPI)

Medium knurling is done by using medium pitched knurls
of 1.25 mm pitch. (21 TPI)

Fine knurling is done by using fine pitched knurls of 0.75mm
pitch. (33 TPI)

Types of knurling tool-holders

The different types of knurling tool-holders are:

- single roller knurling tool-holders (parallel knurling tool-
holders)

- knuckle joint type knurling tool-holders

- revolving types of knurlling tool-holders (universal
knurling tool-holders).

A knurling tool-holder has a heat-treated steel shank and
hardened tool steel knurls. The knurls rotate freely on
hardened steel pins.

Differences between different types types of knurling tool-holders are given in Table -1

Table -1

Single roller Knuckle joint Revolving type

Only one roller is used. A pair of rollers are used. Three pairs of rollers are used.

Only one pattern Cross or diamond Knurling patterns of
of knurling can knurling pattern different pitches
be produced with this can be produced. can be produced.
type of knurling tool-holder.

It is not self-centering. It is self-centering. It is self-centering.

Single roller knurling tool-holder (Fig 8)

It has only one single roller which produces a straight
lined pattern.

Knuckle joint type knurling tool-holders (Fig 9)

This tool holder has a set of two rollers of the same knurling
pitch. The rollers may be of straight teeth or helical teeth.
it is self-centering.

Revolving head knurling tool (Fig 10)

This tool-holder is also called a universal knurling tool-
holder. It is fitted with 3 pairs of rollers having coarse,
medium and fine pitches. These are mounted on a revolving
head with pivots on a hardened steel pin. It is also self-
centering.
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Knurling - Speed and Feed

The tables shown be used as a guide for determining the
amount of end-feed or in-feed per revolution of the work.
The rate of the feed for diamond pattern knurling is slower
than that for straight or diagonal knurling.

Straight or Diagonal

End -FEED KNURLING

Approximate

FEED per REVOLUTION

T.P.I Alum Brass Mild Steel Alloy Steel

12 .008” .006” .004”

16 - 20  .010” .008” .005”

25 - 35  .013” .010” .007”

40 - 80 .017” .012” .009”

Straight or Diagonal

IN - FEED KNURLING

Approximate

REVOLUTION

T.P.I Alum Brass Mild Steel Alloy Steel

12 12 15 25

16 - 20 10 13 22

25 - 35 8 11 20

40 - 80 6 9 18

Vernier bevel protractor
Objectives: At the end of this lesson you shall be able to
• identify the parts of a universal bvel protractor
• state the functions of each part
• list out the uses of a vernier bevel protractor.

The vernier bevel protractor is a precision instrument meant
for measuring angles to an accuracy of 5 minutes. (5)

Parts

The following are the parts of vernier bevel protractor.
(Fig 1)

Stock

This is one of the contacting surfaces during the
measurement of an angle. Preferably it should be kept in

contact with the datum surface from which the angle is
measured.

Dial

The dial is an integrated part of the stock. It is circular in
shape, and the edge is graduaged in degrees.

Disc

It is pivoted to the dial and can be rotated through 360°.
The vernier scale of the instrument is attached to the disc.
The disc is locked to the dial when reading the
measurement.

Blade

This is the other surface of the instrument that contacts
the work during measurement. It is fixed to the dial with
the help of the clamping lever. A parallel groove is provided
in the centre of the blade to enable it to be longitudinally
positioned whenever necessary.

Locking screws

Two knurled locking screws are provided, one to lock the
dial to the disc, and the other to lock the blade to the dial.
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All parts are made of good quality alloy steel, properly
heat-treated and highly finished. A magnifying glass is
sometimes fitted for clear reading of the graduations.

Uses of a vernier bevel protractor

Apart from being used for measuring angles (Fig 2) a
vernier bevel protractor is also used for setting work-
holding devices on machine tools. Work-tables etc.

Graduations on universal bevel protractor
Objectives: At the end of this lesson you shall be able to
• state the main scale graduations on the dial
• state the vernier scale graduations on the disc
• explain the least count of the vernier bevel protractor.

The main scale graduations

For purposes of taking angular measurements, the full
circumference of the dial is graduated in degrees. The
360° are equally divided and marked in four quadrants,
from 0 degree to 90 degrees, 90 degress to 0 degree, 0 to
90 degrees and 90 degrees to 0 degrees. Every tenth
division is marked longer and numbered. Each division
represents 1 degree. The graduations on the dial are known
as the main scale divisions. On the disc, 23 divisions
spacing of the main scale is equally divided into 12 equal
parts on the vernier. Each 3rd line is marked longer and
numbered as 0, 15, 30, 45, 60. This constitutes the vernier
scale. Similar graduations are marked to the left of 0 also.
(Fig 1)

One vernier scale division (VSD) (Fig 2)

 
55'1

12
11

1
12
23 o

oo

��

The least count of the vernier bevel protractor

When the zero of the vernier scale coincides with the zero
of the main scale, the first division of the vernier scale will

be very close to the 2nd main scale division. (Fig 2)
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For any setting of the blade and stock, the reading of the
acute angle and the supplementary obtuse angle is
possible, and the two sets of the vernier scale graduations
on the disc assist to achieve this. (Fig 3)
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Reading of universal bevel protractor
Objectives: At the end of this lesson you shall be able to
• explain acute angle setting
• explain obtuse angle setting.

For reading acute angle set up (Fig 1)

First read the number of whole degrees between zero of
the main scale and zero of the vernier scale.

Note the line on the vernier scale that exactly coincides
with any one of the main scale divisions and determine
its value in minutes. (Fig 2)

If you read the main scale in an anticlockwise direction,
read the vernier scale also in an anticlockwise direction
from zero.

If you read the main scale in a clockwise direction, read
the vernier scale also in a clockwise direction from zero.

For obtuse angle set up (Fig 3)

The vernier scale reading is taken on the left side as
indicated by the arrow. (Fig 4) The reading value is
subtracted from 180° to get the obtuse angle value.

To take the vernier scale reading, multiply the coinciding
divisions with the least count

Example: 10 x 5’ = 50’

Total up both the readings to get the measurements =
41° 50’.

Reading 22 30’

Measurement 180° - 22°30’ = 157°30’
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CG & M Related Theory for Exercise 1.3.43
Tool & Die Maker (Dies & Moulds) - Turning

Cutting Tool Materials
Objectives :  At the end of this lesson you shall be able to
• list the different cutting tool materials
• state the properties and uses of various types of cutting tool materials.

Review Of Cutting Tool Materials: Various types of
materials are used for making tools and tips. Each one has
advantages and disadvantages.

High Carbon Steel (0.9% to 1.5% carbon)

This is useful for making cutting tools for light finishing cuts
and for machining soft materials. It is quite tough,but the
cutting edge softens and wears quickly, due to heat
generated whilst cutting (at 250°C). So, a fairly slow speed
must be used.

High speed steel (HSS): Besides carbon, it contains
tungsten, chromium, vanadium, molybdenum as alloying
metals. It loses its hardness at 6000C. It is probably the
most popular type of tool material. It is tough enough to
withstand most cutting shocks, and retains its hardness at
higher speeds than high carbon steel. It will cut most
materials quite satisfactorily, and is useful for general
purpose work.

Satellite: This is a rather brittle, non-ferrous, cast alloy
comprising of cobalt, chromium, tungsten and carbon (1.8
to 2.5%). It is very hard and withstands heat up to 1000°C.
It is useful for machining hard, chilled castings and similar
materials.

Cemented carbide: It is a compound of carbon, cobalt
and tungsten or titanium tantalum or niobium. It is the
hardest cutting tool material normally used. It is capable of
withstanding temperatures even above 1000°C. Several
grades of cemented carbide tools are available, each tool
suits a particular material. It is important to select the
correct grade of tool for the material to be turned; If not, an
inferior surface texture may result. The tools are either
tipped with cemented carbide, which is brazed on to a
carbon steel shank or the tips may be of the throw away
type.

Coated Carbides: A thin coating (extremely thin layer of
5 to 7 microns) of titanium carbide is deposited over
processed inserts. Good toughness is combined with very
high wear resistance in the inserts. In the same working
condition, the cutting edge of a coated carbide insert may
be 3 to 4 times longer than a conventional carbide insert.
Also, 40% higher cutting speeds can be used.

Ceramics: The latest development in metal cutting tools
are the use of aluminum oxide, generally referred to as
ceramics. Ceramic tools are made of aluminum oxide
powder in a mould. Ceramic tool materials are made in the
form of tips that are to be clamped on metal shanks. These
tools have very low heat conductivity and extremely high
compressive strength. But, they are quite brittle and have
a low bending strength. For this reason, these materials

cannot be used for tools operating in interrupted cuts with
vibrations, as well as for removing a heavy chip. But they
can withstand temperatures up to 1200°C and can be used
at cutting speeds 4 times of that for cemented carbides and
up to about 40 times of that for high speed steel tools. Heat
conductivity of ceramics is very low. The ceramic tools are
generally used without a coolant.

Diamonds: The diamond is the hardest known tool material
and can be run at cutting speeds about 50 times greater
than that for HSS tool and at temperatures up to 16500 C.
In addition to its hardness, diamond is incompressible, is
of a large grain structure, and readily conducts heat and
has a low coefficient of friction. Diamonds are suitable for
cutting very hard materials such as glass, plastics,
ceramics and other abrasive materials and for producing
fine finishes. The maximum depth of cut recommended is
0.125 mm with feeds of 0.05mm. To summarize, the two
most commonly used tool materials are the high speed
steel and the cemented carbide.

High speed steel tools may be used when:

- Working with great accuracy on small diameters

- Turning small diameters, if the machine is not capable
of running at a high rpm

- Screw cutting

- Intermittent cutting.

Cemented carbide tools may be used when:

- A fast and higher rate of metal removal is needed

- Cutting hard and non-ferrous materials

- High speed thread cutting is involved.

Comparative cutting speeds

Recommended speeds will vary according to the following
factors: the kind and hardness of material being cut, the
rate of feed, the depth of cut, the finish desired, the rigidity
of the machine, the rigidity of the work set up, the type of
cutting tool and the type of cutting fluid used. The lathe
must be capable of running at high speeds, as very higher
speeds are used with carbide tools. To obtain a good
surface texture on small diameter work, the machine must
be rigid and in good condition.

Properties of cutting tool materials

The cutting tool material must have the following properties

- Hot hardness

- Wear resistance
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Brazing is a metal-joining process in which two or more
metal items are joined together by melting and flowing a
filler metal into the joint, with the filler metal having a lower
melting point than the adjoining metal.

There are many heating methods available to accomplish
brazing operations. The most important factor in choosing
a heating method is achieving efficient transfer of heat
throughout the joint and doing so within the heat capacity
of the individual base metals used. The most commonly
used heating methods are

−  Torch brazing

−  Furnace brazing

−  Induction brazing

−  Dip brazing

−  Resistance brazing

−  Vacuum brazing

Fluxing

Flux is a chemical compound applied to the joint surfaces
before brazing. A coating of flux on the joint area guards the
surfaces from the air, preventing oxide formation. It also
dissolves and absorbs any oxides that form throughout
heating or that was not completely removed in the cleaning
process.

Filler

A variety of alloys are used as filler metals for brazing
depending on the intended use or application method. In
general, braze alloys are composed of three or more
metals to form an alloy with the desired properties. The filler
metal for a particular application is chosen based on its
ability to wet the base metals,

Braze alloy is generally available as rod, ribbon, powder,
paste, cream, wire and etc

The common types of filler metals used are

− Aluminum-silicon

− Copper

− Copper-silver

− Copper-zinc (brass)

− Copper-tin (bronze)

− Gold-silver

− Nickel alloy

− Silver

The basic process of brazing

Cleaning

Cleaning the metal parts is to get rid of oil and grease. In
most cases cleaning can be done by dipping the part into
a suitable decreasing solvent, by vapor or by alkaline
cleaning

If the metal surfaces are coated with oxide or scale, it can
be removed by chemically or mechanically

For chemical cleaning use an acid pickle treatment

For mechanical cleaning use grinder or file and etc (Fig1)

Make arrangement for seating the carbide tip (Fig 2)

Brazing and grinding of carbide tipped tools
Objectives :  At the end of this lesson you shall be able to
• state what is brazing
• list the type of brazing
• brief the  flux and filler in brazing
• explain the process of  brazing
• Enumerate the grinding process of brazed carbide tipped tools.

- Toughness

- Shock resistance

- Chemical stability

- Low friction

- Favourable cost
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Once the parts are thoroughly cleaned, it is good practice
to flux and braze as soon as possible. This avoids the
chance of recontaminations

Fluxing

Coat the flux to the properly cleaned surface with a light
layer of black flux. Black flux has more boron than white flux
and works longer at higher temperature.

Cut the filler material (sheet) to the shape of carbide tip and
place it in position on the tool shank as shown in Fig 3

Apply a layer of flux on the filler sheet.

Place the clean carbide tip on the top, of the flux layer and
coat the outside with a thick layer of flux Fig 4

Brazing

Hold the part in place with a ceramic rod while brazing.

Heat the whole part as evenly as possible until the whole
joint is at the proper temperature.  This is usually a dark
cherry red.  Remember that the part has to be hot enough
all the way through.

Once the parts are hot enough you will see the alloy flow
out of the joint.  You may also feel the part move just a bit
as the alloy turns liquid.  Once the part is the right color
(dark cherry red to cherry red) and the alloy is coming out
just a bit (and it may feel mushy), then wiggle the part just
a little bit to allow any flux or fumes to escape.

The torch flame is important both as a source of heat and
as a way to protect the material.  The flame needs to be a
reducing flame, which means it, is a little oxygen starved.

Once the torch is removed the heating stops immediately
and the plate begins to cool

The point to be made here is that the brazing process is a
manual process but it is extremely precise and the time at
full brazing temperature is very short,  Considerably less
than a second.  This is important because part of successful
brazing is to hold the materials at temperature long enough
to form an intermediate compound in a layer between the
two materials and the brazing alloy.

Slowly cool the carbide to minimize cracking of the carbide
and clean the flux. The flux cleans of with worm water.

Grinding of brazed carbide tipped tools on tool grinder
(Fig 5 &6)

− Grind the side cutting edge and side relief angle on the
tool shank using  aluminum oxide grinding wheel

−  Grind end cutting angle and end relief angle on the tool
shank using aluminum oxide grinding wheel

− Grinding side cutting angle and side clearance angle on
carbide tip using silicon grinding wheel

− Grinding end cutting angle and end clearance angle on
carbide tip using silicon grinding wheel

− Grind nose radius and its clearance angle on carbide tip
using diamond grinding wheel

− Lap the cutting edges using oil stone
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CG & M Related Theory for Exercise 1.3.44
Tool & Die Maker (Dies & Moulds) - Turning

Types of  taper
Objectives :  At the end of this lesson you shall be able to
• state the uses of tapers
• identify the elements of a taper
• state the different standard tapers and their uses.

A  taper is uniform increase or decrease in diameter along
the length of a cylinder.

Uses of taper

Tapers are used for the following.

- Assist to transmit drive in the assembled parts.

- Used for easy assembly and disassembly of parts.

- Gives self-alignment in the assembled parts.

Elements of taper (Fig 1)

Big diameter in mm D

Small diameter in mm d

Length of the taper in mm     l

Included taper angle in degrees     θ

Total length of job in mm L

Expression of taper and its conversion

The methods by which tapers can be expressed are:

- giving the big dia. small dia. and the length of taper
(Fig 2)

- giving the included angle of the taper in degrees.
(Fig 3)

- giving Taper per foot (TPF)

Example

5/8" taper per foot means in a length of 12" taper (1 foot)
the difference in diameter is 5/8" or mm per metre (Fig 4)

- giving taper in ratio - Ratio 1:20 means, for a taper
length of 20 units the difference in diameter is 1 unit
(Fig 5)

- mentioning by standard taper.

Example

MT3 (Morse taper number 3)

The relationship between the elements of a taper-

j =   included angle of a taper

a =  Half included angle of a taper

 
l2
dD

α Tan
�

�
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2000
TPM

or
24

TPF
Tanα �

 
2

Ratio
Tanα �

Classification of tapers

Tapers are classified as

- self-holding tapers

- quick releasing tapers.

Self-holding taper (Fig 6)

A self-holding taper has the property of holding the two
parts together and be able to assemble together without
any additional locking device such as keys.  Just insert the
internal taper into the external taper with a slight ‘bang’ and
they get locked together.  These tapers have a smaller
taper angle that is limited to a maximum of 3°.

Example

Taper shank of drills, reamers and sleeves.

Quick releasing taper (Fig 7)

Quick releasing tapers in contrast to the self-holding tapers
do not hold the parts together by themselves. They require
additional locking devices for holding. (They have a larger
included angle the value of which is not less than 18°.  The
purpose of quick releasing tapers is only to provide perfect
alignment of the tool mating parts.)

Example

Arbor of milling machines.

Different standard tapers and their uses

The common standard tapers in use are:

- Morse taper (MT)

- Brown and Sharpe taper (BS)

- Jarno taper (JT)

- metric taper

- pin taper.

Morse taper

The Morse taper is the most commonly used standard
taper in the industry.  It is a self-holding taper.  This taper
is usually used in spindles of lathes and drilling machines,
shanks of drills, reamers, centres, etc.  The Morse taper is
denoted by the letters MT.  It is available from MT0 to MT7.
The numbers MT0 to MT5 are commonly used on taper
shanks of twists of drills, reamers and lathe centres.  The
included angle of the Morse taper is approximately 3° and
the taper per foot is 5/8".

Brown and Sharpe taper

Both quick releasing and self-holding tapers are available
in Brown and Sharpe tapers.  The taper used in the arbors
of a milling machine is a quick-releasing Brown and Sharpe
taper, having a taper of 3 1/2" T.P.F.

Brown and Sharpe self-holding tapers are available from
BSI to BS18.  The taper per foot is 1/2" except BS10  which
has a taper of 0.5161" taper per foot.

Jarno taper

Jarno tapers are self-holding and are used on external
tapers of the lathe spindle nose where the chuck or face
plate is mounted.  It is available from Nos. 1 to 20.  The
amount of taper per foot is 0.6".  The dimensions of this
taper will be as follows.

Big diameter of taper = 
 

8
Number

Small diameter of taper =  

Length of taper =  

Jarno taper is mostly used in die-making machines.

Metric taper

Metric taper is available as both self-holding and quick-
releasing tapers.  A self-holding metric taper has an
included angle of 2° 51' 51".

Quick releasing metric tapers are used as the external
tapers of lathe spindle noses.  Metric tapers are expressed
by numbers which represent  the  big diameter of the taper
in millimetres.

Standard pin taper

Standard pin tapers are used in taper pins. It is a self-
holding taper.  It is available both in Metric and British
systems.  The amount of taper is 1:50 in the metric system
and 1:48 (1/4" TPF) in the British system.
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Taper turning methods
Objectives: At the end of this lesson you shall be able to
• state the methods of turning tapers on lathes
• state how each method is performed
• state the advantages and disadvantages of each method.

Methods of turning taper on a lathe

The different methods of taper turning on a lathe are:

-  form tool method

-  compound rest method

-  tailstock offset method

-  taper turning attachment method

-  taper turning by combining feeds.

Form tool method (Fig 1)

This method is used in mass production for producing
small lengths of taper.  The form tool should be set at right
angles to the axis of the work and feed.

The carriage should be locked while turning taper by this
method.

Compound rest method  (Fig 2)

In this method,  the compound rest is swivelled to half the
included angle of the taper, and the taper is turned by
feeding the top slide.

The angle ' 
2


 '  to which the compound rest is set is found

by the formula

tan 2


  = 

where

D =   big diameter of taper

d =   small diameter of taper

 =   length of taper

2


=   1/2 included angle in degrees.

Advantages

- Both internal and external tapers can be produced.

- Steep tapers can be produced.

- Easy setting of the compound rest.

Disadvantages

- Only hand feed can be given.

- Threads on the taper portion cannot be produced.

- The taper length is limited to the movement of the top
slide.

Tailstock offset method (Fig 3)

In this method the job is held at an angle, and the tool
moves parallel to the lathe axis.  The body of the tailstock
is shifted on its base to an amount corresponding to the
angle of the taper.

These tapers can be turned between centres only, and this
method is not suitable for producing steep tapers.  The
amount of offset is found by the formula

offset =

where

D =   big diameter of taper

d =   small diameter of taper

 =   taper length

L =   total length of the job.
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Advantages

- Power feed can be given.

- Good surface finish can be obtained.

- Maximum length of taper can be produced.

- External thread on taper portion can be produced.

- Duplicate tapers can be produced.

Disadvantages

- Only external taper can be turned.

- Accurate setting of the offset is difficult.

- Taper turning is possible when the work is held between
centres only.

- Damages the centre drilled holes of the work.

- The alignment of the lathe centres will be disturbed.

Taper turning attachment method (Fig 4)

A special attachment is provided on a few modern lathes.
Here the job is held parallel to the axis and the tool moves
at an angle.  The movement of the tool is guided to the
required angle by the attachment.

Advantages

- Both internal and external tapers can be produced.

- Threads on both internal and external taper portions
can be cut.

- Power feed can be given.

- Lengthy taper can be produced.

- Good surface finish is obtained.

- The alignment of lathe centres is not disturbed.

- It is most suitable for producing duplicate tapers
because the change in length of the job does not affect
the taper.

- The job can be held either in chuck or in between
centres.

Disadvantage

- Use is limited to turning of slow taper angles only.

Calculation of the compound slide swivel angle
Objectives :  At the end of this lesson you shall be able to
• derive a formula to determine the swivel angle
• solve problems involving taper calculation
• refer to tables and determine the value of the angle for the arrived result
• determine the depth of cut to reduce the taper length

Derivation of the formula

For convenience a tapered job whose small diameter is
zero is taken (Fig 1) to illustrate as to how the formula can
be derived.

The taper is divided into two angled triangles by the centre
line. By referring to the shaded right angled triangle in
figure 1, the side (b) shown against the half included angle
of taper a/2, is termed as the opposite side. The side (a)
is termed as the adjacent side and side (c) is termed as
the hypotenuse.

There is a relationship between the sides of the triangle
and the a/2. They can be expressed as ratios. The ratio of
the sides (b) and (a) is a constant value for a given angle
a/2. This ratio b/a does not change for a given value of a/2.
This means that if 'b' increase or decrease there will be a
proportionate increase or decrease of side 'a' making the
ratio b/a constant. This ratio between the opposite side to
the adjacent side of an angle in a right angled triangle is
referred to as the tangent value of the angle.

The equation for the tangent 2/2 is therefore, Tan 2/2= b/a.
Since this value is the same for a particular angle, the
tangent values for all angles are put together into tables
under the heading 'Natural Tangents'. Therefore, they need
no longer be calculated individually, but can be taken from
the tables.

Referring to Fig 2, which has a small diameter also, the
shaded triangle D-d refers to 'b' of the formula and I refers
to 'a' of the formula.
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Tan of half the included angle = .
2

ratio Taper

The taper ratio is given as 1:5

Tan of half included angle of taper = .
2

ratio Taper

Tan 0.1
10

1

2

1/5

2

α


  
2

α
5° 45'.

The compound slide swivel angle is 5° 45'.

Taper per foot is given to determine the compound slide
swivelling angle.

Example

(Given 5/8" TPF)

This means that the different in diameter (D-d) is 5/8" for
taper length of 1 foot or 12".

Tan α/2 = 
2I

dD 

There D - d =5/8" and I = 12"

Tan α/2 =
0.0260

8x24

5

122

8

5"




α/2 = 1°26'

The formula is Tan of half included =  
24

foot per Taper

Remember that it is half included angle of the
taper to which the tops slide is to be swivelled

To determine the depth of cut to be given to get a definite
in length of the taper, the taper angle remaining same.
(Fig 4)

Referring to Fig 4, 9 is the radius at the bigger end, (also
the difference in diameter divided by 2, since the small
diameter of the taper is zero) 5 is the length of the taper, 4
is the change in the taper length, 1 is the depth of cut to
be given to get the change in taper length.

6 Opposite side to  
2

α

7 Adjacent side

8 Hypotenuse

Then I = 4 x tan a/2.

D = 30 mm d = 22 mm & I =40 mm

Now the formula becomes

Tan α/2= .
21

dD

2xI

dD

I

2

dD 







For example, referring to Fig 3 we have

Tangent α/2 =  

0.1.
10

1

80

8

80

2230

2I

dD








Referring to the logarithm tables of Natural Tangents we
find that the angle whose tangent value is O.1, is 5°. 45',
and this is the top slide swivelling angle to turn the tapered
job of Fig 3.

Taper expressed as a ratio to determine the swivel
angle

The general formula is Tan  
2I

dD

2

α 


This can be rewritten as

Tan  
2

1
x

I

dD

2

α 


This 
I

dD 
 is the taper ratio

Hence the formula becomes
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Example: The taper length 5 of Fig 4 with an included
angle of 20° is to be shortened by 2 mm. What should be
the depth of cut?

I = 4 x tan 
2

α

1 = 2 mm x  
2

tan20

   =2 mm x tan 10°

   =2 x 0.1763

   = 0.3526 mm.

Hence a depth of cut of 0.35 mm is to be given in order to
reduce the taper length by 2 mm, the taper included angle
remaining the same 20°.

Calculation of taper turning by offsetting tailstock
Objectives :  At the end of this lesson you shall be able to
• describe the amount of offset by experessing the diameter
• describe the amount of offset by expressing TPF.

Calculation of the amount of offset

If the taper is expressed by giving the big diameter (D)
the small diameter (d) the length of taper (I), then

I 2
Ld)(D

offset
��

�

Where L = total length of job

Example

The big diameter of a tapered job (D) = 30 mm.

The small diameter of the tapered job (d) = 26 mm.

The length of taper portion (I) = 100 mm.

Total longth of job (L) = 200 mm

I 2
Ld)(D

offset
��

�

1002
20026)(30

�

��
�

1002
2004

�

�
�

= 4 mm

If the taper is expressed in TPF then the amount of offset

 
2

LTPF �
�

where TPF is given in inches

L = total length of job

If taper is expressed as a ratio then the amount of offset

 
2

Lratio �
�

If taper is expressed by included angle i.e. 2

Offset = L x tan

where L = total length

= 1/2 included angle in degrees.

Different methods of offsetting the tailstock (Fig 1)

Setting offset with the help of the inside measuring jaws
of a vernier caliper to the required mm, if direct graduation
is not provided on the base of the tailstock.

Using a dial test indicator.

Using a cross-slide graduated collar and feeler gauge.
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CG & M Related Theory for Exercise 1.3.45
Tool & Die Maker (Dies & Moulds) - Turning

Sine bar - Description and uses
Objectives: At the end of this lesson you shall be able to
• state the principle of a sine bar
• state the sizes of sine bars
• state the features of sine bars
• state the different uses of sine bars.

A sine bar is a precision measuring instrument for checking
and setting of angles. (Fig 1)

The principle of a sine bar

The principle of  a sine bar is based on the trigonometrical
function.

In a right angled triangle the function known as Sine of the
angles is the relationship existing between the  opposite
side to the angle and the hypotenuse. (Fig 2)

It may be noted that for setting the sine bar to different
angles, slip gauges are used.

A surface plate or marking table provides the datum surface
for the set up.

The sine bar, the slip gauges and the datum surface upon
which they are set  to form a right angled triangle. (Fig 3)

The sine bar forms the hypotenuse (c) and the slip gauge
stack forms the side opposite (a).

Sin of the angle 

                  

 
c
a

  θ Sin =

Features

This is a rectangular bar made of stabilized chromium
steel.

The surfaces are accurately finished by grinding and
lapping.

Two precision rollers of the same diameter are mounted
on either end of the bar.  The centre line of the rollers is
parallel to the top face of the sine bar.

There are holes drilled across the bar. This helps in reducing
the weight, and also it facilitates clamping  of sine bar on
angle plate.

The length of the sine bar  is the distance between the
centres of the rollers.  The commonly available sizes are
100 mm, 200  mm, 250 mm and 500 mm. The size of a
sine bar is specified by its length.

Uses

Sine bars are used when a high degree of accuracy to
less than one minute is needed for
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– measuring angles (Fig 4)

– marking out  (Fig 5)

– setting up for machining. (Fig 6)

Determining taper using sine bar and slip gauges
Objectives:  At the end of this lesson you shall be able to
• state correctness of a known angle
• explain the height of slip gauges to a known angle.

Sine bars provide a simple means of checking angles to a
high degree of accuracy of not less than one minute upto
450.

The use of a sine bar is based on trigonometric function.
The sine bar forms the hypotenuse of the triangle and the
slip gauges form the opposite side.   (Fig 1)

Checking the correctness of a known angle

For this purpose first  choose the correct slip gauge
combination for the  angle to be checked.
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The component to be checked should be mounted on the
sine bar after placing the selected slip gauges under the
roller.  (Fig 1)

A dial test indicator is mounted on a suitable stand or
vernier height gauge.  (Fig 2)  The dial test indicator is
then set in first position as in the figure and the dial is set
to zero.

Move the dial to the other end of the component (second
position). If there is any difference then the angle is
incorrect. The height of the slip gauge pack can be adjusted
until the dial test indicator reads zero on both ends.  The
actual angle can then be calculated and the deviation, if
any, will be the error.

Method of calculating  the slip gauge height

Example (Fig 3)

Exercise 1

To determine the height of slip gauge for an angle of 25°
using a sine bar of 200 mm long.

 
 

c
a

  θ Sin =

                           θ = 25°

a = C Sine q

 = 200 x 0.4226

                         a = 84.52 mm

The height of the slip gauge required is   84.52 mm.

The value of sinq can be obtained from
mathematical tables. (Natural trigonometrical
functions)

Tables are also available with readily worked out sine bar
constants for standard sine bar  lengths.

Calculating the angle for tapered components

Example 2

The height of the slip gauge used is 84.52 mm.The length
of the sine bar used is 200 mm.

What will be the angle of the component? (Fig 4)

 
c
a

  θ Sin =

    
200

84.52


                           Sine q  = 0.4226

The angle whose sine value is 0.4226 is 25°.  Hence the

angle of tapered component is 25°.

Classroom Assignment

1 What will be the angle of the workpiece if the slip
gauge pack height is 17.36 mm and the size of the
sine bar used is 100 mm? (Fig 5)

Answer ________________________

2 Calculate the height of the slip gauge pack to raise a
100 mm sine bar to an angle of 3° 35

1
.

Answer ________________________
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Slip gauges, types uses and selection
Objectives: At the end of this lesson you shall be able to
• state the features of slip gauges
• state the different grades of slip gauges and their uses
• state the number of slips in standard sets
• state the precautions to be followed while using slip gauges.

Slip gauges or gauge blocks are used as standards for
precision length measurement.  (Fig 1)  These are made
in sets and consist of a number of hardened blocks, made
of high grade steel with low thermal expansion.  They are
hardened throughout, and heat treated further for
stabilization.  The two opposite measuring faces of each
block are lapped flat and parallel to a definite size within
extremely close tolerances.

These slip gauges are available in various  sets with different
numbers.  (Fig 2)  (Ref.Table 1)

A particular size can be built up by wringing individual slip
gauges together.  (Figs 3 & 4)

Wringing is the act of joining the slip gauges together
while building up to sizes.

steel or tungsten carbide.  These are used for protecting
the exposed faces of the slip gauge pack from damage
while in use.

Grades

The following four grades of slip gauge are recommented
as per IS 2984 -1981.

Grade ‘00’ , Grade ‘0’ Grade ‘1’ & Grade ‘2’

Grade ‘00’ shall normally be used for calibration purposes.
It shall not be used in combination.

Grades 0,1 and 2 are intended for general use.

Grade ‘0’ is used only for calibration of Inspection Grade
‘1’, Grade ‘1’ is used in tool room and standards room. It
is also used for calibration of Grade ‘2’.

Grade ‘2’ is used on machines for setting purposes and
on surface plate for inspection purposes in shop floor. It is
also used for zero setting of precision measuring
instruments in shop floor. For further details refer IS
2984 - 1981

Some sets of slip gauges also contain protector slips of
made to standard thickness from higher wear-resistant
steel or tungsten carbide.  These are used for protecting
the exposed faces of the slip gauge pack from damage
while in use.

Grades

The following four grades of slip gauge are recommented
as per IS 2984 -1981.

Grade ‘00’ , Grade ‘0’ Grade ‘1’ & Grade ‘2’

Grade ‘00’ shall normally be used for calibration purposes.
It shall not be used in combination.
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Grades 0,1 and 2 are intended for general use.

Grade ‘0’ is used only for calibration of Inspection Grade
‘1’, Grade ‘1’ is used in tool room and standards room. It
is also used for calibration of Grade ‘2’.

Grade ‘2’ is used on machines for setting purposes and
on surface plate for inspection purposes in shop floor. It is
also used for zero setting of precision measuring
instruments in shop floor. For further details refer IS
2984 - 1981

B.I.S. recommendations

Three grades of slip gauges are recommended as per IS -
2984. They are:

          Grade ‘00’

Grade ‘0’

Grade 1

Grade 2.

Care and maintenance points to be remembered
while using slip gauges

(Avoid handling the slip gauges with bare hands since
this affects the size of them due to heating).

Use a minimum number of blocks as far as possible while
building up a particular dimension.

While building the slip gauges, start wringing with the
largest slip gauges and finish with the smallest.

While holding the slip gauges do not touch the
lapped surfaces.

If available use protector slips on exposed faces.(Fig 5)

After use, clean the slips with carbon tetrachloride and
apply petroleum jelly for protection against rust.

Before use, remove petroleum jelly with carbon
tetrachloride.  Use chamois leather to wipe the lapped
surfaces.

Table 1

Set of 112 pieces  (M 112)

          Range (mm)              Steps (mm)      No.of pieces

Special piece   1.0005             -                  1

1st series 1.001 to  1.009 0.001 9

2nd series 1.01 to  1.49           0.01 49

3rd series 0.5 to 24.5                 0.5 49

4th series  25.0 to 100.0          25.0 4

       Total pieces 112

 Set of 103 pieces (M 103)

          Range (mm)              Steps (mm)   No.of pieces

Special piece 1.005 - 1

1
st
 series 1.01 to 1.49           0.01 49

2
nd

 series 0.5 to 24.5 0.5 49

3
rd
 series 25 to 100 25.0 4

             Total pieces 103

Set of 47 pieces (M 47)

          Range (mm)               Steps (mm)     No.of pieces

1st series 1.005  -  1

2nd series 1.01 to 1.09 0.01 9

3rd series 1.1 to 1.9                 0.1 9

4th series 1.0 to 24.0                1.0 24

5th series 25.0 to 100.0          25.0 4

              Total pieces 47

 Set of 78 pieces (M 78)

          Range (mm)        Steps (mm) No.of pieces

1.0025    -  1

1.005    -  1

1.0075    -  1

1.01 to 1.49                 0.01 49

0.5 to 9.5                       0.5 19

10.0 to 50.0                 10.0   5

75.0 & 100.0                   -   2

              Total pieces                                78
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  Set of 87 pieces (M 87)

          Range (mm)        Steps (mm)   No.of pieces

1st series 1.001 to 1.009 0.001 9

2nd series 1.01 to 1.49            0.01 49

3rd series 0.5 to 9.5                   0.5 19

4th series 10.0 to 100.0           10.0 10

            Total pieces 87

  Set of 46 pieces  (M 46)

   Range (mm)       Steps (mm)   No.of pieces

1st series 1.001 to 1.009 0.001 9

2nd series 1.01 to 1.09            0.01 9

3rd series 1.1 to 1.9                  0.1 9

4th series 1.0 to 9.0                  1.0 9

5th series 10.0 to 100             10.0 10

            Total pieces 46

Even though there are a number of sets of slip

gauges available, the popularly recommended

are:  M 112, M 87, M 46, M 38 and M 9

  Set of 38 pieces (M 38)

    Range (mm) Steps (mm) No.of pieces

1.005                                     - 1

1st series  1.01 to 1.09 0.01 9

2nd series 1.1 to 1.9             0.1 9

3rd series 1 to 9.0                 1.0 9

4th series 10.0 to 100         10.0 10

              Total pieces 38

  Set of 86 pieces (M 86)

          Range (mm)         Steps (mm)   No.of pieces

1st series 1.001 to 1.009 0.001  9

2nd series 1.01 to 1.49 0.01 49

3rd series 0.5 to 9.5 0.5 19

4th series 10.0 to 90.0 10.0 9

            Total pieces 86

  Set of 9 pieces (M 9)

          Range (mm)         Steps (mm)   No.of pieces

1.001 to 1.009              0.001               9

Selection and determination of slip gauges for different sizes
Objective: At the end of this lesson you shall be able to
• state slip gauges for different sizes.

For determining a particular size, in most cases a number
of slip gauges are to be selected and stacked one over
the other by wringing of the slip gauges.

While selecting slip gauges for a particular size using the
available set of slip gauges, first consider the last digit of
the size to be built up. Then consider the last or the last
two digits of the subsequent value and continue to select
the pieces until the required size is available.

Example

Building up a size of 44.8725 mm with the help of 112
piece set.  (Table 1)

 Set of 112 pieces

Range (mm)             Steps (mm)       No.of pieces

1.0005 - 1

1.001 to 1.009 0.001 9

1.01 to 1.49 0.01 49

0.5 to 24.5 0.5 49

25.0 to 100.0  25.0 4

            Total pieces 112

Table 1

Procedure Slip pack        Calculation

a First write the 44.8725
required dimension.

b Select the slip gauge
having the 4th deci-       1.0005 1.0005
mal place.                     Substract

43.872

c Select 1st series
slip that has the 1.002 1.002
same last figure.           Substract

42.87

d Select the 2nd series
slip that has the same 1.37 1.37
last figure and  that       Substract
will leave .0  or 0.5 41.5
as the last figure.

e Select a 3rd series
slip that will leave 16.5 Substract 16.5
the nearest 4th series
slip (41.5-25=16.5). 25.00
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f Select a slip that
eliminates the 25.0 Substract 25.00
final figure.

                     Add 44.8725 0

Procedure Slip gauge Calculation
pack

a First write the . 44.8725
required dimension

b Two numbers of 2.000 Substract   2.0000
protectorslips of 42.8725
1mm each

c Select the slip 1.0005 Substract   1.0005
gauge having the 41.8720
4th decimal  place

d Select 1st series 1.002 Substract  1.0020
slip that has the 40.8700
same last figure

e Select the 2nd series 1.3700 Substract  1.3700
slip that has the 39.5000
same last figure and
that will leave .0 or
0.5as the last figure

f Select a 3rd series 16.5000 Substract  16.5000
slip that will leave the  23.0000
nearest 4th series
slip

g Select a slip that 23.0000 Substract 23.0000
eliminates the
final figure

Care and maintenance of slip gauges & sine bar
Objective:At the end of this lesson you shall be able to
• state the preventive measures to be taken for protecting slip gauges and sine bar

Precision measuring instruments play an important role in
maintaining the quality of the products. Measuring
Instruments are also very expensive. It is important that the
instruments are well looked after and maintained by the
person who uses it.

Protection against corrosion

High atmospheric humidity and sweat from hands can
cause corrosion to instruments. Avoid this.

Acid-free vaseline (petroleum jelly) applied lightly on the
instruments can give protection against corrosion. (Fig 1)

Be sure that the instruments are thoroughly cleaned and
free from water or moisture before applying vaseine.

Use chamois leather for giving a light coating of vaseline.

Always clean the slip gauges with carbon tetrachloride and
apply petroleum jelly after use.
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CG & M Related Theory for Exercise 1.4.46
Tool & Die Maker (Dies & Moulds) - Milling

Milling machines
Objectives: At the end of this lesson you shall be able to
• state the introduction of milling machines
• classify the types of milling machines
• state the specification of milling machine.

Introduction

A milling machine is a machine tool that removes metal
as the work is fed against a rotating multipoint cutter. The
cutter rotates at a high speed and because of the multiple
cutting edges it removes metal at a very fast. The machine
can also holds one or more number of cutters at a time.
This is why a milling machine finds wide application in
production work. This is superior to other machines as
regards accuracy and better surface finish, and is designed
for machining a variety of tool room work.

Principle of milling (cutting)

In milling, the cutter has a rotary movement, the speed of
which depends upon the cutting speed required. Driving
the milling arbor at various rotational speeds makes it
possible to achieve approximately the same cutting speeds
[peripheral speed] with cutters of different diameters.

While the milling cutter (a) rotates at a high speed, and
because of the multiple points, it removes metal at a very
fast rate, in comparision with other machine tools. (Fig1)

Job (b) can be machined manually or automatically.

By milling we can produce flat (horizontal, vertical, angular)
and formed surfaces. (Fig 2)

A milling machine finds wide application in production work
as the machine can hold one or more number of cutters at
a time, and is good in accuracy, surface finish etc.

Classification

The classification according to the general design of the
milling machine is:

- column and knee type

- fixed bed type

- planer type

- special type

But out of these types the one that is used most in general
workshop is the column and knee type machine.

In the column and knee type category the following
machines are covered.

- Plain/horizontal milling machine (Fig 3)

- Vertical milling machine (Fig 4)

- Universal milling machine (Fig 5)

1 Plain milling machine (Fig 3)

• More rigid and sturdy than other machines and
accommodate heavy work.
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• Table may be fed either by hand or by power against a
rotating cutter and in the three directions namely
longitudinately.

• Milling cutters mounted on the horizontal arbor.

• Spindle rotates horizontally and parallel to the mchine
table.

• As angular feeding is possible suitable for milling helical
gears, helical grooves etc,.

The universal millling machine is similar in construction to
the plain machine. But its table, apart from having
movements in 3 directions, can also be swivelled about
the horizontal axis. The maximum swivelling is 45° both
the clockwise and anticlockwise directions. (Fig 6)

The swivelling of the table permits angular feeding. Because
of this, the universal milling machine is suitable for milling
helical gears, helical grooves, etc,.

This machine is supported with different attachments like
vertical head, slotting head, rack-milling attachment.

2 Vertical milling machine (Fig 4)

• Distinguished from the horizontal milling machine by
position of the spindle vertical or perpendicular to the
work table.

• The spindle rotates about the vertical axis.

• Spindle moved up and down by spindle feed and also
may be filted or swivelled.

• Most suitable for boring, pocket milling, profile milling
and for making keyways.

3 Universal milling machine (Fig 5)

• Table apart from having movements in 3 directions and
also can be swivelled about its horizontal axis.

• Maximum swivelling can be made is 45° both in
clockwise and anticlockwise direction.

CG & M : TDM (Dies & Moulds) (NSQF - Revised 2022) - R .Theory for Ex. 1.4.46
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CG & M Related Theory for Exercise 1.4.47
Tool & Die Maker (Dies & Moulds) - Milling

Construction and specification
Objective: At the end of this lesson you shall be able to
• state the main parts of a milling machine and its functions.

Part of a milling machine

The principle parts of a milling machine (Fig 1) are as
follows.

Base

The base of the machine serves as a foundation member
for all the other parts which rest upon it. It is made of cast
iron. It carries a column.

Column

The column is the main supporting frame mounted vertically
on the base. The column houses all the driving mechanism
for the spindle and table feed. The main motor is usually
incorporated in the column. The top of the column is
finished to hold an overarm that extends outward at the
front of the machine. The lower part of the column is a
study box base, which incorporates the cutting fluid tank.

Knee

The knee is of rigid casting that slides up and down along
a precision-machined guideway. The knee houses the
speed mechanism of the table and the different controls
to operate it. The feed motor and gearbox are usually
incorporated in the knee.

Gearbox

The gearbox for the spindle drive comprises shafts with
bearings and gears, Fig 2 and controls for the setting of
the spindle speed.

Spindle

The spindle is housed in the upper part of the column and
receives power from the motor and transmits it to the arbor.

The front end of the spindle projects from the column face
and is provided with a tapered hole into which various
cutting tools and arbors may be mounted. The accuracy
in machine depends primarily on the rigidity of the spindle.
The speed of the spindle can be selected by the speed
gearbox, and the feeds can be selected through the feed
gearbox. The spindle is arranged horizontal milling machine
and vertically in the vertical milling machine. (Fig 3 & 4)© N
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Saddle (Fig 5)

The saddle is placed on the top of the knee which slides
come guideway, set exactly at 90° to the column face.A
cross-feed screw near the top of the knee engages a nut
on the bottom of the saddle to move it horizontally for
applying the cross-feed.

Table (Fig 6)

The table rests on the guideway on the saddle and travels
longitudinally. ‘T’ slots are provided on the table to mount
the workpieces directly or to mount the work-holding
devices. The longitudinal feed-stops are located on the
front of the table. This disengage the machine feed at a
set position. The table is also fitted with a hand wheel for
hand feed in the longitudinal direction, and a lever for
locking the table. There is a gutter around the edges of
the table to collect the cutting fluid.

Overarm and brace (Fig 5)

The overarm is mounted on the top of the column above
the spindle, and is intended as a support when milling
with an arbor. The arm is adjustable so that the bearing
support may be provided nearest to the cutter.

The brace provides extra stability to the machine. It must
be loosened before the table elevation setting is altered.

Electrical equipment (Fig 7)

The electrical equipment for the different controls of the
machine is usually grouped in the column. The equipment
consists mainly of fuses, motor breakers and contactors.
Motor breakers switch off the power in the event of an
overload.

Cutting fluid equipment (Fig 8)

The cutting fluid equipment consists of a pump, piping
and hoses, a nozzle and shut-off valve, and a tank in the
machine base.

The specification/size of a milling machine is
specified as follows

1 The size of the table (length and width)

2 The maximum lengths of longitudinal, cross and vertical
travel of the table.

3 Number of spindle speeds, number of feeds.

4 Spindle nose taper.

5 Power required.

6 Net weight of the machine.

7 The floor space required.

8 Type of the machine.

Example of specification (Milling)

Spindle

1 Spindle position - Horizontal

2 Spindle taper - ISO 50

3 Spindle motor power - (7.5 KW or more)

4 Spindle speed range - 35 to 1800 r.p.m.

CG & M : TDM (Dies & Moulds) (NSQF - Revised 2022) - R .Theory for Ex. 1.4.47
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Table

1 Table size - 2055 mm x 355 mm or more

2 Clamping area 1600 mm x 355 mm

3 Max. permissible load on table 500 kg or more

4 The table top should hacve longitudinal T-slots. The
dimension of T-slots is to be specified by supplier.
Vendor to specify.

5 Longitudinal traverse 1200 mm or more.

6 Vertical traverse 425mm or more.

7 Cross traverse 320 mm or more 2.2.8 swivelling of Table
45 degree.

Feed Rates

1 Rapid traverse rate longitudinal 4000 mm/min or more.

2 Rapid traverse rate cross 800 mm/min or more.

3 Feed rates longitudinal 8-1600 mm/min (approx).

4 Feed rates cross 1.6 - 320 mm/min.

In addition to the above net weight, floor space required,
work holding devices, cutter holding devices attachment
and accessories required may furnished.

CG & M : TDM (Dies & Moulds) (NSQF - Revised 2022) - R .Theory for Ex. 1.4.47
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CG & M Related Theory for Exercise 1.4.48
Tool & Die Maker (Dies & Moulds) - Milling

Driving and feed mechanism of milling machine
Objectives: At the end of this lesson you shall be able to
• state type of mechanism
• explain the automatic feed
• describe the manual feed.

Milling machine mechanism is divided into two types:

Spindle drive mechanism

Table feed mechanism

The spindle drive mechanism is incorporated in the column.
All modern machines are driven by individual motors housed
with in the column. The spindle receives power from a
combination of gears and clutch assembly. By altering
gears spindle receives multiple speed.

Table feed mechanism contained with in the knee of the
machine table. It has three different feed movements.

Longitudinal feed movement

Cross feed movement

Vertical feed movement

These three movements can get manual feed or automatic
feed. By swiveling the three handle wheels we can give
manual feed. By engaging the clutch operating levers we
can get the automatic feed as follows:

Fig 1 illustrates the power feed mechanism contained
within the knee A of the machine to enable the table C to
have three different feed movements, i.e longitudinal, cross
and vertical. The power is transmitted from the feed gearbox
H consisting of change gears to shaft 23 in the knee A of
the machine by a telescopic - shaft 11. Both ends of the
shaft 11 are provided with universal joint 10 and 12.

Telescopic shaft and universal joints are necessary to allow
vertical movement of the knee A, gear 14 attached to the
jaw clutch 20, is keyed to the shaft 23 and receivers gear
13 which is free to rotate on the extreme end of the cross
feed screw 7. Bevel gear 22 is free to rotate on shaft 23
and is in mesh with gear 19 fastened to the evaluating
screw 15,16 serves as a nut for 15, and as a screw in nut
17,15 and 16 therefore, serve as a telescopic screw
combination and a vertical movement of the knee is thus
possible. As soon as the clutch 20 is engaged with the
clutch attached to the bevel gear 22 by means of a lever
4,22 rotates and this being in mesh with gear 19 causes
the elevating screw 15 to rotate in 16 giving a vertical
movement of the knee. like-wise, when the clutch21, which
is a keyed to the cross feed screw 7, is engaged with the
clutch attached to gear 13, power comes to the screw 7
through gears 4 and 13. This causes the screw 7 to rotate
in nut 6 of the clamp bed giving a cross feed movement of
the clamp bed D and saddle B.

Gear 18 is fastened to shaft 23, and meshes with gear 25
which is fastened to the bevel gear 24. Again 24 meshes
with gear 5 attached to a vertical shaft which carries at its
upper end another bevel gear 3. Gear 3 meshes with gear
2 which is fastened to the table feed screw 1. Therefore,
longitudinal feed movement of the table is possible through
gears 18,25,24,5,3, and 2.
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CG & M Related Theory for Exercise 1.4.49-50
Tool & Die Maker (Dies & Moulds) - Milling

Different types of milling cutter and their uses - cutter nomenclature
Objectives: At the end of this lesson you shall be able to
• state the two main categories of milling cutters
• state the different types of plain milling cutters
• state the uses of plain milling cutters.

Milling cutters

Milling cutters generally fall into two categories, solid
cutters and inserted tool cutters.

Solid cutters (Fig 1)

These cutters are those in which the teeth have been cut
into the body of the cutter. The teeth may be straight
(parallel) or helical (at an angle) to the axis of the cutter.
Solid type cutters are generally made of high speed steel.

Inserted tool cutter (Fig 2)

These cutters have removable and replaceable teeth which
are fastened or locked into the body of the cutter. The
inserted tool construction is generally used on large cutters
as the blades can be quickly replaced when they become
dull.

Plain milling cutters

Plain milling cutters are cylindrical, having teeth on the
periphery only. They are used to produce flat surfaces, by
feeding the table longitudinally. The cutter teeth may be
straight or helical according to the size of the cutter. Wider
plain cutters are used for slab milling which are known as
slab milling cutters.

Types of plain milling cutters

Light duty plain milling cutters

These are less than 19mm wide usually have straight teeth.
(Fig 3) Those over 19mm wide have a helix angle of about
25°. (Fig 4)

This type of cutter is used only for light milling operations
since it has too many teeth to permit the chip clearance
required for heavier cuts.

Heavy duty plain milling cutters (Fig 5)

These cutters have fewer teeth than the light duty ones,
which provides for better chip clearance. The helix angle
upto 45°.
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The greater helix angle on the teeth produces a smoother
surface due to shearing action and reduces chatter. Less
power is required for the cutter than what the straight tooth
and small helix angle cutters require.

Helical plain milling cutters (Fig 6)

These cutters are high helix cutters with the helix angles
from 45° to over 60°. They are particularly suited to this
milling of wide and intermittent surfaces in contour and
profile milling. These cutters are used for milling soft steels,
brass, etc.

Plain milling cutters are also made in shank type. These
are sometimes nicked on their periphery on a helical pattern
for chip breaking and smooth operation.

Specification

The size of the plain milling cutter is specified by the outside
diameter, length and the bore size.

Example

∅ 50 x 100 x 27 bore, 45°
Direction of helix of the cutter

The teeth (cutting edge) of a cutter may be either straight
or follow a helix.

If the cutter axis is hold vertically and the helix is towards
the right side it is called a right hand helix cutter. (Fig 7)
and if the helix is towards the left side, it is called a left
hand helix cutter (Fig 8)

The helix angle generates a force directed along the cutter
axis during cutting and a reaction to this force in the
workpiece.

When a cutter has a helix and a cut of the same hand,
this force will pull the cutter away from the spindle.(Fig9)
when the helix and cut are of opposite hands, the force
will press the cutter into the spindle. (Fig 10) As a
consequence, cutters having a helix and a cut of the same
hand can only be safely used when they are positively
attached to the spindle. The frictional hold of a taper is
inadequate in this situation.

When mounting a cutter on the arbor of a milling machine,
it is particularly important that the hands of the cut and
the helix are checked.
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Side and face cutters
Objective: At the end of this lesson you shall be able to
• state the different types of side and face milling cutters and their uses.

These cutters differ from plain milling cutters due to the
fact that they have teeth on the periphery and face.

These cutters are mainly used for step milling, slot milling
and straddle milling. These cutters are available from 50
to 100 mm in diameter and the width of the cutters ranges
from 5 to 32 mm.

Types of side and face milling cutters

Half side milling cutter (Fig 1)

Cutters with teeth on one side only are called half side
milling cutters and are used for heavy straddle milling,
and for machining one side only.

Plain side and face milling cutter (Fig 2)

Inside and face milling cutters with teeth on both the sides
are known as plain side and face milling cutters and are
used for slot cutting (Fig 3) and face milling. These cutters
are also used for straddle milling. (Fig 4).

Staggered teeth side milling cutter (Fig 5)

These cutters have alternate teeth with opposite helix
angles. Due to this design, the chip space increases to a
great extent. These cutters are used for milling deep and
narrow slots or keyways.

Interlocking side milling cutter (Fig 6)

This cutter is formed out of two half side milling cutters or
two staggered teeth side milling cutters. They are made
to interlock to form one unit. The teeth of the two cutters
may be plain or of alternate helix. The cutters are used for
milling wider slots of accurate width. The width of the cutter
can be varied by inserting spacers between the two halves
of the cutter.

The width of the cutter ranges from 10 to 32 mm with the
diameters ranging from 50 to 200 mm. The width of the
cutter may be adjusted to the max/min of 4 mm. The
interlocking cutters can be adjusted to compensate for thr
wear, and get sharpened as well.
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End mill cutters
Objectives: At the end of this lesson you shall be able to
• list the different types of end mill cutters and their uses
• state the application of slot mill cutters
• state the different types of methods of holding end mill cutters
• explain the influence of down-milling and up-milling in end mill cutters.

End mill cutters

End mill cutters have the cutting teeth on the end as well
as on the periphery, and are filted to the spindle by a
suitable adapter.

The end mill is used for milling small faces, slots, (Fig 1)
for milling profiles (Fig 2) and milling recesses. (Fig 3)
Some end mills have indexable inserts which can be
replaced when worn out. (Fig 4)

End mill cutters are solid type of cutters in which the shank
and the cutters are integral. (Fig 5)

End mill cutters have straight shank (Fig 5) or taper shank
(Fig 6).

CG & M : TDM (Dies & Moulds) (NSQF - Revised 2022) - R .Theory for Ex. 1.4.49-50
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Slot drills

The two-flute type (Fig 7) is called a slot drill.  The slot drills
have flutes which meet at the cutting end, forming two
cutting tips across the bottom.  These tips are of different
lengths, one extending beyond the central axis of the
cutter.  This permits the slot drill to be used in amilling
machine for drilling a hole to start a slot that does not
extend to the edge of the metal.  It is used for plunge milling
like keyways etc.

Angular and slitting saw milling cutter
Objectives : At the end of this lesson you shall be able to
• state the different types of angular milling cutters and their uses
• state the specification of angular milling cutters
• explain slitting saw cutters and their uses
• state the specification of a slitting saw cutter.

Angular milling cutters

These cutters have teeth on the periphery, and the cutting
edges are placed on a conical surface.

Angular cutters have teeth that are neither parallel nor
perpendicular to the cutting axis.

Angular milling cutters are made with a hole for use in
horizontal milling, or with a shank for use in both horizontal
and vertical milling. (Fig 1)

They may be divided into two groups.

Single angle milling cutters

These cutters have teeth on the angular surface, and may
or may not have teeth on the flat side.  The included angle
between the flat face and the angular face designates the
cutters, such as 45° or 60° angular cutter. (Fig 2) They may
be of the shell or shank type.

Specification

A    shell    end   single angle  cutter of diameter D = 80,
angle μ= 50° of  ‘tool type’ H and for right hand cutting shall
be specified and designated as

Shell end single angle milling cutter   80 x 50°H  IS:6256.

A dovetail milling cutter type A having diameter D = 20 mm,
angle μ = 60° of tool type ‘N’ for right hand cutting shall be
specified as

Dovetail milling cutter A20 x 60°N BIS 6255.

In type ‘A’, the small end is having less diameter and in type
‘B’ the small end is having more diameter than in type A.

Single angle cutters are used to dovetail guideways etc.
(Fig 3)

Equal angle milling cutters

These cutters have two intersecting angular surfaces with
cutting teeth on both.  When these cutters have equal
angles on both sides of the line at right angle to the axis
(symmetrical), they are designated as per the size of the
included angle such as 45°, 60° or 90°.  Double angle
cutters have two cutting edges. (Fig 4a)
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Specification

An equal angle milling cutter of diameter D = 56 mm for
angle 60° of ‘tool type’ N shall be specified as Equal angle
milling cutter  56 x 60° N IS 6326.

It is used to machine Vee slots. (Fig 4b)

Double unequal angle cutter

When the angles formed are not the same (unsymmetrical),
the cutters are designated by specifying the angle on both
sides of the plane or line. (Fig 5)

These cutters are generally used for milling the flutes on
taps or reamers.  The cutters are marked with the type of
taps or reamers for which they should be used.

Specification

A double angle milling cutter of diameter D = 50 mm, b =
12 mm and angle  75° of ‘tool type H and for right hand
cutting shall be  specification as

Double angle milling cutter 50 x 12 x 75°H IS 6325.

Slitting saw

It is basically a thin plain milling cutter.  It has a large
number of teeth. (Fig 6)

In order to prevent the sides of the saw from rubbing or
binding when in use, the sides are relieved or dished.
(Fig 7)

Slitting saws are made in widths of 3 to 6 mm.  Because
of the thin cross-section, they should be operated at
approximately one  quarter to one  eighth of the feed per
tooth used for the other cutters.  For non-ferrous metals,
these speeds can be increased.  Unless a special driving
flange is used for slitting saws, it is not advisable to key the
saw to the milling arbor.

The arbor nut should be pulled up as tightly as possible by
hand only.  Since slitting saws are so easily broken, some
operators find it desirable to adopt climb or down-mill
method when sawing.  However to  overcome the play
between the lead screw and nut, the backlash eliminator
should be engaged.

A slitting saw is specified by its outside diameter, bore
diameter and thickness.

Example : 150 x 6 x 27 mm bore
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Form milling cutters
Objectives : At the end of this lesson you shall be able to
• state the name of different types  form milling cutters and their uses
• state the specification of form milling cutters.

Form milling cutters have irregular profile on the cutting
edges in order to generate an irregular outline of the work.
They are normally solid but, sometimes, may have inserted
teeth.  Different types of standard form cutters are described
below.

Convex milling cutter

These cutters have their teeth curved outwards on the
circumferential surface to form the contour of a semi circle.
Concave semi-circular surfaces are produced with this
cutter. (Fig 1)  The diameter of the cutter ranges from 50 to
125 mm and the radius of the semi circle ranges from 1.6
to 20.0 mm. (Fig 2)

Concave milling cutter

These cutters have their teeth curved inwards on the
circumferential surface to form the contour of a semi circle.

The diameter of the cutter ranges from 56 to 110 mm and
the radius of the semi circle ranges from 1.5 to 20.0 mm.

Corner rounding milling cutter

The corner rounding milling cutters have their teeth curved
inwards on the circumferential surface to form the contour
of a quarter circle.  A convex surface is produced with this
cutter.  This cutter is used for cutting a radius on the corner
or edges.  It may be of either  the shank or arbor type.

Corner rounding cutters are available with their teeth having
placed on one side or both the sides. (Fig 4)

The cutters are specified by the type, diameter width,
radius of the form and bore size.

‘T’ slots cutters
Objectives : At the end of this lesson you shall be able to
• state the purpose of ‘T’ slot milling cutters
• state the specification of the ‘T’ slot milling cutters.

‘T’ slot cutters

These cutters are profile-sharpened side milling cutters
with a straight or taper shank. (Fig 1)  They have staggered
teeth and are either solid or tipped in construction.  Due to
the staggered teeth  the chips are cleared without clogging.

The ‘T’ slot cutter is  used to cut ‘T’ shaped slots in machine
tool work tables. (Fig 2) Before cutting the ‘T’ slot, a narrow
vertical groove is machined with an end mill or a slot milling
cutter.
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This cutter can also be used to mill undercuts in wider
milled channels. (Fig 3)

Specification

A ‘T’ slot milling cutter with plain paralled shank for milling
a ‘T’ slot of nominal size 12, tool type N, for right hand
cutting is designated as plain parallel shank ‘T’ slot cutter
12 BIS:2668.  When the cutter is  required with a tool type

other than N, an appropriate tool type H or S shall be added
to the designation after the size.

Tool type

N - for mild steel, soft cast iron and medium hard non-
ferrous metals.

H - for specially hard and tough metals.

S - for soft and ductile material.

A ‘T’ slot milling cutter with Morse taper shank with tapped
hole for milling a ‘T’ slot of nominal size 18, tool type N, for
right hand cutting is designated as taper shank ‘T’ slot
cutter 18 BIS:2668.  When the cutter is required with a tool
type other than N, an appropriate tool type H or S shall be
added in the designation immediately after the size.

Example : 16 N BIS 2668

Special milling cutters
Objectives : At the end of this lesson you shall be able to
• state the woodruff keyway cutter, thread cutter, gear cutter, tap and reamer cutter and state their uses
• state the sprocket cutter, spline cutter, fly cutter and bolted cutter and state their uses.

Many types and sizes of cutters are available. The selection
of an appropriate cutter for a particular type of operation is
very important.

Woodruff key cutters

These are similar in appearance to ‘T’ slot cutters.  These
cutters have cutting edges on the periphery only.  There are
no side teeth. (Fig 1)

They are used for milling semi-cylindrical keyways in
shafts for woodruff key seats. (Fig 2)

This cutter is provided with a shank which may be parallel
or with Morse taper.  These cutters are either solid or
tapered in construction.  They can either be of the arbor or
shank type.

This cutter may have straight or staggered teeth.

Specification

A woodruff key slot milling cutter, type A of diameter
d = 16.5 mm and width b = 5 mm and tool type ‘N’ for right
hand cutting shall be specified as woodruff slot milling
cutter A 16.5 x 5 N BIS2669.
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When the cutter is required for left hand cutting, the letter
‘L’ shall be added before the size in the designation.

Type ‘A’ is for straight teeth and type B for staggered teeth.

Thread milling cutter

For milling the threads of specific form and size, thread
milling cutters are used.  Generally acme and worm-
threads are produced on the workpiece by thread milling
cutters.

Both parallel shank and taper shank thread milling cutters
are available. (Fig 3)

Gear cutter (Fig 4)

These cutters are used to machine gear teeth by milling.

These cutters having formed cutting edges reproduce the
shape of the cutter teeth on the gear blank.  According to
the gear  teeth profile the shape of the cutter  teeth may be
involute or cycloid.  These cutters are available in a very
wide range of sizes covering the various sizes of gear tooth.

Example

Involute  cutter, 3mm module, 27 mm bore, cutter No.5

Sprocket cutters  (Fig 5): These cutters are designed to
cut the teeth of sprocket wheels which are used in chain
drives, such as those found on bicycles and on machinery
in general.

Spline cutters  (Fig 6)

These cutters are used to cut splines.  They are marked
with the type and size of the spline that they should be used
for.

Tap and reamer cutter (Fig 7)

These cutters are used for producing grooves or flutes in
taps and reamers.  These are the special type of double
angle cutters.

The point end of the tool is rounded and the tooth profile
corresponds to the type of groove that it is to produce.

Fly cutters (Fig 8)

Fly cutters are single point tools having only one cutting
edge.  These tools are held in various types of holders.

These cutters are used to machine shapes which cannot
be produced using standard milling cutters.

These are also used to mill flat surfaces which are truly flat
to a very high standard of accuracy.

This cutter is used in tool room and in emergency when
standard cutters are not available.
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Bolted cutters (Fig 9): The face milling cutters having no

shank but one of a larger diameter and they are bolted

directly on to the nose of the spindle.

This cutter is used for face milling on large areas of the
workpiece.  For utmost rigidity, this system is used.

The cutter has a body with slots and fixing devices for the
cutting teeth which are fixed into the body.  The cutting
teeth, which may be made of high speed steel or carbide,
can easily be replaced when worn out.
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CG & M Related Theory for Exercise 1.4.51
Tool & Die Maker (Dies & Moulds) - Milling

Milling cutter materials
Objectives: At the end of this lesson you shall be able to
• list the various type of milling cutter materials
• state material composition and their properties
• brief the effect the coated materials on milling cutters.

Milling tool materials

The most common materials in milling tools include:

Carbon steel: This is the most inexpensive material of
the bunch and includes 0.6-1.5% carbon with small
amounts of manganese and silicon. You’ll typically find
this material used for low-speed operations in twist drills,
forming tools, milling cutters, and turning.

High-speed steel (HSS): This material combines
chromium, tungsten, and molybdenum to give HSS
improved hardness, toughness, and wear resistance over
carbon steel. HSS tools are generally more expensive
than others, but they’re built to last and provide a high
material removal rate for both ferrous and nonferrous
materials.

Solid carbide: This material is more resistant to wear
than HSS but also prone to chipping instead of wearing
out evenly over time. Because of this, solid carbide used
mainly in finishing applications in newer milling machines
or those with less spindle wear. Typically carbide tools
are made by sintering carbide with another metal, like
tungsten, titanium, or tantalum, giving these tools high
heat resistance amd making them ideal for high-quality
surface finishes.

Ceramics: Ceramics are corrosion-resistant and made
from aluminium oxide and silicon nitride, Their heat and
wear resistamce means they can function in high heat
cutting environments where other tools would not. These
tools are typically ideal for cast iron, hard steels, and
super alloys.

Coating: Coating on milling cutters increase hardness,
enhance tool longevity, and allow for faster cutting
speeds. The most popular coatings include

Titanium Nitride (TiN): The standard finish used on
alloy steel, aluminium, and plastic.

Titanium carbonitride (TiCN): Provides a better wear
resistance than TiN.

Super-life Titanium Nitride (A1-TiN): The best coating
for high feed/speed and high temperature appliations.
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CG & M Related Theory for Exercise 1.4.52
Tool & Die Maker (Dies & Moulds) - Milling

Job holding devices
Objectives: At the end of this lesson you shall be able to
• explain vices, clamps, v-block, parallel block
• list the type of slotting tool and its tool angle.

Work holding device

Work pieces that are to be machined should be held with
support firmly such that there is no slackening of the work
while machining. Otherwise the jobs will be damaged,
dimensional accuracies will vary, and sometimes the
cutting tool/ cutter itself will break. Due to this reason, the
operator may be injured.

The different types of work holding/supporting devices are
as follows.

Machine vices and clamps

There are two main types of machine  vices used on slotter.

Plain machine vice (Fig 1)

It is very robust in construction and so it is used on
machines where it is used only for squaring and stock
removal.

Swivel base vice (Fig 2)

It is the most commonly used on a slotter. The base can
be swivelled to the desired angle to machine angular jobs.

Strap clamps (Fig 3)

They are used for clamping the workpiece directly on the
machine table. Straps come in different shapes and they
are used in conjunction with T bolts/nuts.

Tee bolts (Fig 4a)

These bolts having Tee shaped heads are suitable for the
table slots of a machine. The body of the bolt is provided
with sufficient length of threads so that the same bolt can
be used for holding jobs of various thicknesses.

Different clamping arrangements are shown in Fig 4b to
12.

A normal clamping unit (Fig 4b) consists of a Tee bolt, nut
washer, clamp and fulcrum block - plain/stepped.

Toe dogs and poppets

These are used for machining the top surfaces of huge
jobs having no holes on the side, or small repetitive jobs
as shown in Figs 5 & 6 (parallel plate A, workpiece B
protective strip C, poppet D, toe dog E, stop F).
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Angle plate (Fig 7)

‘C’ clamp (H)

Vee block (Fig 8)

These are ‘V shaped blocks and are used for supporting
round jobs in clamping.

Parallel strips (Fig 9)

These are perfectly ground steel strips used for elevating/
supporting the workpiece. They should be used only on
machined surfaces.

Degree parallels (K in Fig 10)

These are the steel strips with ground angular surface:
Because of this, angular surfaces can be generated without
swivelling the tool head.
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CG & M Related Theory for Exercise 1.4.53
Tool & Die Maker (Dies & Moulds) - Milling

Milling cutter holding devices
Objectives : At the end of this lesson you shall be able to
• state the different types of arbors
• state the uses of arbors
• name the parts of an arbor
• specify the arbor
• brief the different methods of holding end mills.

Types of arbors and their uses

An arbor is considered as an extension of the machine
spindle on which milling cutters are mounted.  Arbors are
provided with quick-release taper shanks for proper
alignment with the spindle.  There are two types of arbors,
normally used for holding the cutters.  They are (1) long
arbor and (2) short or stub arbor.

Long arbor (Fig 1)

Long arbors are used for holding cutters in both horizontal
and universal milling machines.  The milling cutter (a) is
driven by a key (b) which fits into the keyway (c) on the
arbor and cutter.  This prevents the cutter from turning on
the arbor.  The spacer (d) and bearing bushings (e) hold the
cutter in position on the arbor after the nut (f) has been
tightened.

The tapered end of the arbor (a) is held securely with the
machine spindle (b) by a draw-in bar (c) and lock-nut (d).
(Fig 2)  The flange (e) has two notches (f) to engage with
the spindle tennon for transmitting the power.

The outer end of the arbor assembly is supported by the
bushing and the arbor support.

Long arbors with I.S.O.taper shanks are available in
different diameters.  The normal diameters   used commonly
are Ø16, Ø22,Ø27, Ø32, Ø40 and the taper is ISO40/50.

The arbor is designated by the taper number, diameter and
length.

Example   ISO40 x Ø 22 x 500 mm.

ISO40 = Type of taper

Ø 22 = diameter of the arbor in ‘mm’

500mm = length of the arbor

Stub arbor

Stub arbors are used to mount various tapers of cutters in
the spindle of horizontal and vertical milling machines.

The arbors are held with the machine spindle by a taper
and a draw-in bar.  The arbors are of three types (A), (B)
& (C) as shown in Fig 3.

Types

Type A (Fig 4) is used to mount the shell end mills and
similar cutters.

The cutter is pushed on the arbor so that the arbor key (a)
fits with the slot (b) on the cutter.  The cutter is tightened
on the arbor using the screw (c).
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Type B (Fig 5) is used to mount large face milling cutters.
It is made with a centralizing spigot (a) to ensure that the
cutter is centralized with the cutter spindle.

The cutter is held on the arbor by four screws (b).  It has
a slot (c) which fits over the spindle (d) to provide the drive.

Type  C (Fig 6) is a Morse taper adapter arbor (a).  It is used
to hold drills, reamers, chucks (b), etc. which have taper
shanks and also Morse taper sleeves (c)  which are used
to adapt a Morse taper to a larger taper.

According to B.I.S. specifications stub arbors with Morse
taper shanks are available from 13 to 27 mm in diameters.

The stub arbor is designated by the taper number, dia-
meter and length.

Collet chuck (Fig 7)

The chuck is supplied with a set of spring collets (Fig 8)
in various sizes to suit the shanks of standard parallel
shank cutters.

The chuck body Fig 9(a) is mounted in the machine
spindle nose in the same way as the horizontal milling
arbor.

The collet (b) (of the same size as that of the cutter shank)
is pushed in to the chuck body.  The nut (c) is screwed on
until it just grips the collet.

The cutter (d) is inserted into the collet and then the nut is
tightened using the special spanner supplied with the
chuck.

Adapters

These are used to reduce the internal taper in the work
spindle, so that it fits on required arbor or cutter. (Fig 10)
This type is used for holding the cutters with internal
thread.  Another type of adapters (shown in Fig 11) with
Morse taper and flat tongs is used for holding taper shank
end mills with tongs.
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Self-locking chucks (Heavy duty chucks)

The cutter is provided with fine pitch thread at the end of
the cutter shank.  The cutter is mounted by turning with the
thread provided into the chuck body and clamping.
(Fig 12)

The common methods used to mount end mills in  vertical
milling machine are shown in Figs 13 to 16.
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CG & M Related Theory for Exercise 1.4.54-55
Tool & Die Maker (Dies & Moulds) - Milling

Milling process
Objective: At the end of this lesson you shall be able to
• state the different milling processes.

Although the majority of operations performed on a knee
and column type machine are either plain milling or side
milling, several other operations or combinations of
operations may be performed too.

Plain or slab milling (Fig 1)

It is the production of a horizontal flat surface parallel to the
axis of the milling machine. (Fig 1)  The workpiece is held
in a vice or fixture, or fastened directly on to the table.

Side milling (Figs 2 a & b)

It is the process of machining a vertical flat surface
perpendicular to the axis of the milling machine arbor.  This
operation is performed by the combined action of the
peripheral and side teeth on a side and facing cutter.

Face milling

It is done to produce a flat surface parallel to the column
of the machine.  This is done by means of a face milling
cutter mounted on the vertical milling machine spindle.
(Fig 3).  Face milling may also be done in a horizontal
milling to produce horizontal flat surfaces. (Fig 4)

End milling (Fig 5)

It is an operation similar to face milling but done using a
much smaller cutter.  Cutting is done on the end of the
cutter as well as on the periphery.  This operation is used
for facing small surfaces, milling slots or grooves, producing
internal recesses and for truing the edges of a workpiece.
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Up milling and down milling
Objectives : At the end of this lesson you shall be able to
• distinguish between  ‘up’ milling and ‘down’ milling
• state the advantages and disadvantages of ‘up’ milling and ‘down’ milling.

The two operating procedures are distinguished by the
directions in which the teeth of the cutter and the feed of the
workpiece move.

Up-cut milling

The most commonly used method of feeding is to bring the
work against the direction of rotation of the cutter. (Fig 1)
This is otherwise known as convention milling.  This is the
most commonly used method.

In up-milling the removal of chip by each cutting edge starts
at the thinnest part of the chip (a) and progresses to the
thickest part. (Fig 2)  The cutting edge slides in the material
before it starts to cut.  This scraping causes a good deal
of heat and wear on the cutter.  As the cutter teeth emerge
from the material, the accumulated cutting forces are
suddenly released.

The cutter and workpiece suddenly spring apart, the
machine chatters, and the material surface is flawed by
ripples.  The spindle for the milling is tensioned in the
direction of the feed.  The forces involved are taken up by
the flank of the thread in contact.

Advantages

Up-cut milling is feasible on any milling machine.  The hard
skin of a casting is machined off from underneath.

The cutter first penetrates the less hard layer within.

Chances of cutter breakage are less.

Disadvantages

The workpiece tends to get lifted.

The scraping process makes tool service intervals short.

It is at a maximum force while the metal chip is being milled
off.

Down-cut milling

In down-milling or climb-milling the feed moves in the same
direction as the rotation of the cutter. (Fig 3)
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In this method, chip removal starts at the thickest part.  The
cutter cuts into the material straightway and does not slide.
(Fig 4)  As a result less heat is developed and there is less
wear on the cutter.

In this method, the workpiece is pressed down on the work
table by the cutting pressure and thus prevents the
workpiece from lifting. (Fig 5)  This is an advantage,
especially when milling long workpieces.
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Advantages

- The service of the cutter is comparatively longer.

- The cutting rates are higher.

Disadvantages

- There are restrictions on using down-cut milling.

- As a tooth starts to cut, the cutter tends to climb.

- Play in the spindle thread causes the milling table to
move jerkily.

- Displacing the table leads to more material being
removed than is planned.

The consequence of the above are:

- the cutter teeth break

- the workpiece is damaged

- there is risk of the workpiece being wrenched or pulled
free.

This method is not recommended unless the machine
table is fitted with a backlash eliminator.
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Because in climb-milling the cutter is pulling the workpiece,
it should only be carried out on a machine having a
‘backlash eliminator’.  This is because the backlash
eliminator takes up any clearance in the feed drive
mechanism and prevents the cutter from being pulled
along.

If down-milling is tried on a machine without a backlash
eliminator, the workpiece will move along in a series of jerks
(Fig 6), resulting in  very poor finish and even breakage of
the cutter.
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CG & M Related Theory for Exercise 1.4.56
Tool & Die Maker (Dies & Moulds) - Milling

Cutting speed and feed
Objectives: At the end of this lesson you shall be able to
• calculate the revolution per minute for various cutters and materials
• select and calculate proper feeds for various cutters and materials
• explain the correct procedure for taking roughing and finishing cuts.

Cutting speeds, feeds and depth of cut

The efficiency of a milling operation depends upon the
cutting speed, feed, and depth of cut.

If the cutter is run too slowly valuable time will be wasted,
while excessive speed results in loss of time in replacing
and regrinding cutters.  Somewhere between these two
extremes is the efficient cutting speed for the material
being machined.

The rate at which the work is fed into the revolving cutters
is important.  If the work is fed too slowly time will be
wasted and chatter may occur which shortens the tool life
of the cutter.  If the work is fed too fast, the cutter teeth
can be broken.  Much time will be wasted if several
shallow cuts are taken instead of one deep or roughing
cut.  Therefore speed, feed and depth of cut are the three
important factors in any milling operation.

Cutting speed

The cutting speed for a milling cutter is the speed at which
the cutting edge or tooth cuts into the workpiece. (Fig 1)

It is expressed in metres per minute.

The following important factors must be considered when
determining the proper revolutions per minute at which to
machine a metal.

- Type of work material

- Cutter material

- Diameter of the cutter

- Surface finish required

- Depth of cut being taken

- Rigidity of the machine and work set up

Since different types of metals vary in hardness, structure
and machineability, different cutting speeds must be used
for each type of metal and for various cutter materials.

The cutting speeds for the more common metals for HSS
milling cutters are shown in Table 1.

Calculation

m/min
1000

DN
 (V) speed Cutting
π

=

 
D3.1416

1000V
N(r.p.m)

×

×
=

Since only a few machines are equipped with a variable
speed drive which allows them to be set to the exact
calculated speed, a simplified formula can be used to
calculate the revolution per minute.

The p(3.1416) on the bottom line of the formula will divide
the 1000 of the top line approximately 320 times.  This
results in a simplified formula which is close enough for
most milling operations.

(mm) D

320(m)V 
N(r.p.m)

×
=

where ‘D’ is diameter of the cutter.

Example

Calculate the revolution per minute required for f75 mm
high speed steel cutter when cutting machine steel.
(V = 30 m/min.)

128
75

9600

75

32030
r.p.m ==

×
=

From the Table 2  the intersection of ∅ 75mm and cutter
speed of 30 m/min. is in between 115 and 140 r.p.m.  This
can be taken as 128 r.p.m. as calculated.

Too fast a speed will shorten the cutter tool
life; too slow a speed will waste time.

Milling feeds and depth of cut

The two other factors which affect the efficiency of a
milling operation are the milling FEED or the rate at which
the work is fed into the milling cutter and the DEPTH of
CUT taken at each pass.

Feed

Feed is the rate at which the work moves into the revolving
cutter.  It is measured in millimetres per minute (m/min.)
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Feed rate is specified in mm/min.

The feed is expressed in milling machines by following
three different methods.

Feed per tooth

Feed per tooth is defined by the distance the work
advances and the time between engagement by  two
successive teeth.  It is expressed in mm/tooth of the
cutter.(Fig 2)

- workpiece material

- strength and uniformity of the workpiece

- type of finish and accuracy required

- power and rigidity of the machine.

Feed per cutter revolution

Feed per cutter revolution is  the distance the work
advances in the time when the cutter runs through one
complete revolution.  It is expressed in mm/revolution of
the cutter.

Feed per minute

Feed per minute is defined by the distance the work
advances in one minute. It is expressed in mm/ minute.

The rate of feed has an effect on the life of the cutter. An
increase in feed, using the same cutting speed and depth
of cut will reduce the amount of wear of the cutter.

In general we can say that the

- cutting speed should be be reduced when feed is
increased (Fig 3)

- cutting speed should be increased when feed is
reduced. (Fig 4)

The feed rate on a milling machine depends on a variety of
factors such as

- width and depth of cut

- type of cutter

- sharpness of the cutter

Calculation

The formula used to find the work feed is

feed mm/min.(S) = N x Cpt x r.p.m.

where N = number of teeth in milling cutter

Cpt = chip per tooth for a particular cutter

r.p.m. = revolution per minute of the milling cutter.

Example 1

Calculate the feed in mm/min. for a Æ75, six-teeth helical
carbide milling cutter when machining a cast iron
workpiece (V = 60 and Cpt = 0.18).

First calculate the r.p.m. of the cutter

 
256

75

32060
r/min. =

×
=

Feed (mm/min.) = N x C.p.t x r.p.m.

= 6 x 0.18 x 256

= 276.4

= 276 mm/min.

The spindle speed (revolution per minute) must
always be calculated before the feed rate can
be calculated.

Example 2 (Fig 5)

CG & M : TDM (Dies & Moulds) (NSQF - Revised 2022) - R .Theory for Ex. 1.4.56

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



218

A cutter having 8 teeth is to have a feed of 0.04 mm/tooth.
The spindle speed is to be 200 r.p.m.  What feed, in mm/
min. should be set on the machine?

While rough milling, where the purpose is to remove
surplus metal as quickly as possible and finish is not
important, a heavy feed and low cutting speed are used.
(Fig 6)  However, the cutting speed should not be reduced
too much as the cutter would then be operating under very
heavy cutting forces.

For finish milling, the quality of the surface finish is,
ofcourse, important.  Therefore, a light feed and a high
cutting speed are used. (Fig 7)

Cutting speed should be reduced when the feed
is increased.

Cutting speed should be increased when the
feed is reduced.

Depth of cut

The depth of cut is the depth to which the cutter
penetrates the workpiece surface during a given cut.  It is
the perpendicular distance (Fig 8) measured between the
original and the final surface of the workpiece.

Where a smooth and accurate finish is needed, it is a
good practice to take roughing and finishing cuts.
Roughing cuts should be deep with a feed as heavy as the
work and machine will permit with low cutting speed.
(Fig 9)  Heavier cuts may be taken with helical cutters
having fewer teeth than with those having many teeth.
Cutters with fewer teeth are stronger and have greater chip
clearance than cutters with more teeth.

Finishing cuts should be light with a fewer and finer feed
than is used in roughing cuts. (Fig 10)  The depth of cut
should be atleast 0.4 mm.  Light cuts and extremely fine
feeds are not advisable, since the chip taken by each
tooth will be thin and the cutter will often rub the surface of
the work.   When a fine finish is required, the feed should
be reduced rather than the cutter speed; more cutters are
dulled by high speeds than by high feeds.

The table 1 shows the cutting speed (V) in metres per
minute (m/min) for various materials, using high speed
(HSS) milling cutters of various types. They must be con-
sidered as average values which may vary according to
actual working conditions.
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Table 1

Table for selecting cutting speeds for high speed steel milling cutters

Material to be BHN Shell and End S& F Cylind. Slot’g Form In.tooth
machined hardness Mill mill cutter cutter cutter cutter face mill

Mild steel 150 20-30 20-30 15-25 15-25 15-25 30-45 20-30

Medium carbon steel 200 15-25 15-20 15-20 20-30 15-20 15-25 15-25

High carbon steel 300 10-15 10-15 10-15 12-20 10-15 13-20 13-20

Stainless steel 200 22-30 22-30 15-25 15-25 20-30 15-25 20-30

Malleable iron 160 15-22 15-22 15-20 15-20 20-30 15-20 18-25

Soft cast iron 180 max 15-20 15-25 15-20 15-20 20-30 15-20 15-25

Hard cast iron Over 180 13-17 10-15 10-15 10-15 10-25 10-15 13-17

Hard brass &
hard bronze - 40-60 40-60 30-45 30-45 70-90 30-45 50-60

Soft brass &
soft bronze - 40-60 40-60 25-35 25-35 70-90 25-35 40-50

Copper - 30-45 30-45 30-45 30-45 70-90 25-35 50-60

Aluminium alloy - 200-300 200-300 150-300 150-300 200-300 150-250 200-400
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CG & M Related Theory for Exercise 1.4.57
Tool & Die Maker (Dies & Moulds) - Milling

Machining time for milling
Objectives: At the end of this lesson you shall be able to
• state the importance of machining time
• calculate the machining time.

Importance of machining time

Time means money. Any engineering product should be
manufactured at the shortest time possible to the required
accuracy and quality. Machining time is one of the main
factors for cost estimation of a product.

It is always good to plan how much time is needed for a
particular milling operation. This will also enable you to
plan for the appropriate machine, the right type of cutters,
selection of speed, feed etc. In order to save time and
increase productivity.

The total machining time depends on

- the length of the workpiece to be machined

- the method of milling employed i.e. rough or finish milling

- the size of the cutter.

Selection of a milling cutter should be such that the width
of the job is covered by the cutter in one pass. If the width
of the workpiece is more than the width of the cutter,
machining has to be done by more than one pass. The
total time therefore depends on the number of passes also.

The total time required to mill a surface for any milling
operation is calculated from the formula

Total time for milling (th)

(S) revolution per feed
(L) cutter the of travel total

 =

The total travel of the cutter ‘L’ is equal to l + la +lx

where l = length of workpiece to be milled

la = run up travel of the cutter from start of cut to
go to the full given depth.

lx = run over the minimum distance the cutter has
to move away from the work after the cut is
taken.

Calculation of la (Fig 1)

By Pythogoras Theorem, we have

2

a
2

d2(la)
2

2

d
⎟
⎠
⎞

⎜
⎝
⎛

⎟
⎠
⎞

⎜
⎝
⎛

−+=

2

a
2

d
2

2

d2
(la) ⎟

⎠
⎞

⎜
⎝
⎛

⎟
⎠
⎞

⎜
⎝
⎛

−−=

la = d.a - a2 = a(d-a)

la = a)a(d −

Where

d = cutter diameter

a = cutting depth.

Calculation of ‘U’ (Fig 2)

Feed per tooth = Sz in mm

Feed per revolution S = Sz x Z m

Feed for ‘n’ revolutions ‘u’ = Sz x Z x N mm/min.

Where

‘U’ = total feed per minute

Z = number of teeth of cutter

n = r.p.m. of the cutter

Calculation of ‘th’ (Fig 3)

The milling time = minuteperfeed
(i) travels of number x travel Cutter

nxZxSz
ixL

u
i x L
==
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r.p.m.xcuttertheofteethofno.xtooth per  feed
travels  of  number x travel Cutter

=

To determine the milling time, the total travel
of the cutter L is calculated and it is equal to l
+ la + lx where l is the length of work, la is the

run up to be calculated as equal to a)a(d −
and lx will be the known value.

Example (Fig 4)

A milling cutter of 80 mm diameter has nine teeth. It is to
mill a 240 mm long workpiece. The run over is 4 mm and
the depth of cut is 5 mm. A cutting speed of 12 metres/
min. and feed per tooth of 0.15 mm have been selected.

Determine the milling time.

r.p.m48
πx80

1000x12
πxd

1000V x 
n ===

Total milling time = 
nxZxSz

ixL

(L = l + la + lx)

la = 5)5(80a)-a(d −=

= mm19.4mm75x5 =

la = 4 mm

L = l + la + lx = 240 + 19.4 + 4 mm = 263.4 mm

2 th = 4.07min.
48x9x0.15

1x263.4
=
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CG & M Related Theory for Exercise 1.4.58
Tool & Die Maker (Dies & Moulds) - Milling

Milling machine operations
Objectives: At the end of this lesson you shall be able to
• explain the plain, face, angular and form milling
• describe slot, gang and straddle milling
• explain up and down milling.

Plain milling

It is the operation of production of a flat surface parallel to
the axis of rotation of the cutter. It is also called as slab
milling. Plain milling cutters and slab milling cutters are
used to perform this operation. Fig 1 shows plain milling
operation.

Face milling

The face milling is the operation performed by the face
milling cutter rotated about an axis at right angles to the
work surface. End mills and side & face milling cutter are
also used at times to perform this operation. Fig 2 shows
face milling operation.

Angular milling

Production of an angular surface on a work piece other than
at right angles to the axis of the milling machine spindle is
known as angular milling. Example of angular milling is the
production of the “V” blocks. Fig 3 shows angular milling
operation.

Form milling

The form milling is the operation of production of irregular
contours by using form cutters. Machining convex and
concave surfaces and gear cutting are some examples of
form milling. Fig 4 shows form milling operation.

Slot milling (Fig 5)

The operation of production of slot of different sizes can be
produced in a milling machine by using a plain milling
cutter and by an end mill or side milling cutter.
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Gang milling

It is the operation of machining several surfaces of work
simultanously by feeding the table against a number of
cutters (either of same type of different type) mounted on
the arbor of the machine. This method saves much of
machining time and mostly used in production work. Fig 6
shows gang milling operation.

Straddle milling

It is  the operation of production of two vertical surfaces on
both sides of the work by two side milling cutters mounted
on the same arbor. By using suitable spacing collars, the
distance between the two cutters is adjusted correctly. The
straddle milling is commonly used to produce square or
hexagonal surfaces. (Fig 7)

Up-cut milling

The most commonly used method of feeding is to bring the
work against the direction of rotation of the cutter. (Fig 8)
This is otherwise known as convention milling. This is the
most commonly used method.

In up-milling the removal of chip by each cutting edge starts
at the thinnest part of the chip (a) and progresses to the
thickest part. The cutting edge slides in the material before
it starts to cut. This scraping causes a good deal of heat
and wear on the cutter. As the cutter teeth emerge from the
material, the accumulated cutting forces are suddenly
released.

The cutter and workipiece suddenly spring apart, the
machine chatters, and the material surface is flawed by
ripples. The spindle for the milling is tensioned in the
direction of the feed. The forces involved are taken up by the
flank of the thread in contact.

Down-cut milling

In down-milling or clamp-milling the feed moves in the same
direction as the rotation of the cutter. (FIg 9)

In this method, chip removal starts at the thickest part. The
cutter cuts into the material straight way and does not
slide. As a result less heat is developed and there is less
wear on the cutter.

In this method, the work piece is pressed down on the work
table by the cutting pressure and thus prevents the work
piece from lifting. This is an advantage, especially when
milling long workpieces.

End milling (Fig 10)

End milling is the operation of producing a flat surface
which may be veritcal, horizontal or at an angle in reference
to the table surface.

The cutter used is an end mill. The end mill cutters are also
used for production slot, grooves and key ways.

A vertical milling machine is more suitable for end milling
operation.
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CG & M Related Theory for Exercise 1.4.59-60
Tool & Die Maker (Dies & Moulds) - Milling

Milling attachments
Objective: At the end of this lesson you shall be able to
• state the different types of milling machine attachments and their application.

The application of a milling machine to various machining
operations can be enhanced by the use of different types
of attachments used in conjunction with the fundamental
features of the machine.

Vertical milling attachment (Fig 1)

This attachment is mounted on the front of the column and
can be driven by the spindle of plain and universal milling
machines. The attachment consists of a housing, a spindle
head and bevel drive gears with 1:1 ratio. The spindle has
a standard taper and drive lugs for the cutters.

The spindle housing has a swivel mechanism to permit the
spindle to be angled with respect to the table of the milling
machine. A graduated scale is fitted to the housing to
permit setting of a selected angle. A lock is provided to hold
the attachment at the selected angle.

It is used to perform milling operations which would
otherwise need to be performed on a vertical milling
machine.

High speed attachment (Fig 2)

The high speed attachment is used to drive small milling
cutters at high speeds. The attachment consists of a
housing containing a step-up gearing and a small spindle

by means of which the spindle speed can be increased by
four or six times.

It may be fitted to the vertical or horizontal machine as
required.

Slotting attached (Fig 3)

The slotting attached is used to provide a reciprocating
drive for a single point cutting tool. It may be used for cutting
at any angle in the vertical plane to produce keyways, slots
and corners.

Universal spiral attachment (Fig 4)

This attachment is used when it is required to mill spirals
with a plain milling machine.

It consists of a housing fitted with a swivel plate for
mounting on the face of the milling machine column. The
body may then be swivelled about the axis of the machine
spindle.

The attachment is fitted with a small spindle rotated by the
machine spindle through the gearing in the housing.
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The small spindle is also capable of swivelling with respect
to the housing.

The combination of the two swivelling actions permits the
small spindle to be set at any compound angle with respect
to the column of the milling machine.

This attachment is particularly useful for cutting helical
threads, gears, worms and racks.

Rack milling attachment

The rack milling is mounted between the face of the column
and the outer support on a plain or universal milling
machine. It consists of a fixed housing fitted with an angle
drive and a spindle. The spindle axis is fixed parallel to the
table. (Fig 5)

In rack milling, the cross-feed is used to move the cutter
into the workpiece, and the longitudinal feed is used to
index the cutter to produce the rack teeth.

A special rack indexing attachment (Fig 6) is used to move
the work longitudinally, the exact amount needed for
accurate spacing of the teeth.

At one end of the table is fastened a bracket which carries
a locking indexing wheel together with change gears for
gearing to the table feed screw.

To index any required spacing, change gears are selected
which will produce one or more complete turns of the
indexing wheel.   For each indexing operation, the index pin
is withdrawn and the table advanced by turning the table
feed screw until the pin drops into the slot again, and locks
the wheel.

This method is positive and much more reliable than setting
the table to a graduated dial directly fitted to the table feed
screw.

Circular table attachment

This attachment is used for profile milling, surfacing
quantities of small pieces in the one set up, and for many
other circular operations in the horizontal plane such as
slotting and dovetailing.

It consists of a base, a worm gear drive mechanism and a
small circular work table. (Fig 7)

The base is bolted to the table and the drive mechanism
connected with the feed mechanism of the milling machine.
A crank for manual feed is also provided.

The workpiece is secured to the circular table and the table
is rotated by the feed mechanism for circular cuts.

By combining the rotary motion with one or more of the
other feeds of the machine, profiles of  almost any shape
can be milled.  The hand crank can be replaced by an
indexing device for requiring accurately spaced slots,
holes or grooves.
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CG & M Related Theory for Exercise 1.4.61
Tool & Die Maker (Dies & Moulds) - Milling

Coolants
Objectives: At the end of this lesson you shall be able to
• state the purpose of using coolant
• state the properties of coolant
• list the type of coolant.

Coolant

It is matter/substance used to reduce the heat produced
by tool and work. The heat affects the life and accuracy of
machine, tool and job becomes hardened.

Purpose of coolant

To cool the job to avoid expansion by heat

To cool the cutting points of the tool and save temper and
cutting efficiency.

To wash away the chip

To obtain a smooth finishing

To reduce friction between the tool and work

To prevent the machine from corrosion

Properties of coolant

Higher the viscosity

Good oiliness

Should have high fire point

Should be chemically stable

Low sulphur content (less than 3%)

Should be harmless to skin of operator

Odorless - Should not have bad smell.

Types of coolant

The most common machine coolants used today belong
to one of two categories based on their oil content.

Oil based machine coolants - Including straight oils and
soluble oils

Chemical machine coolants - Including synthetics and
semi synthetics

Fluids vary in suitability for metal working operations due
to their excellent lubricity while water miscible fluids provide
the cooling properties required for most turning and grinding
operations.

Oil based machine coolants

Straight oils - 100% petroleum oil

Soluble oils - 60% to 90% petroleum oil

Chemical machine coolants

Synthetics - No petroleum oils

Semi synthetics - 2% to 30% petroleum oil

Lubricants
Objectives: At the end of this lesson you shall be able to
• state the purpose of using lubricants
• state the properties of lubricants
• state the qualities of a good lubricant.

With the movement of two mating parts of the machine,
heat is generated. If it is controlled the temperature may
rise resulting in total damage of the mating parts. Therefore
a film of cooling medium with high viscosity is applied
between the mating parts which is known as a ‘lubricant’.

A ‘lubricant’ is a substance having an oily property available
in the form of fluid, semi-fluid, or solid state . It is the
lifeblood of the machine, keeping the vital parts in perfect
condition and prolonging the life of the machine. It saves
the machine and its parts from corrosion, wear and tear,
and it minimise friction.

Purposes of using lubricants

- Reduces friction.

- Prevents wear.

- Prevents adhesion.

- Aids in distributing the load.

- Cools the moving elements.

- Prevents corrosion.

- Improves machine efficiency.

Properties of lubricants

Viscosity

It is the fluidity of an oil by which it can withstand high
pressure or load without squeezing out from the bearing
surface.

Oiliness

Oiliness refers to a combination of wettability, surface
tension and slipperiness.  (The capacity of the oil to leave
an oily skin on the metal.)
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Flash point

It is the temperature at which the vapour is given off from
the oil (it decomposes under pressure soon).

Fire point

It is the temperature at which the oil catches fire and
continues to be in flame.

Pour point

The temperature at which the lubricant is able to flow when
poured.

Emulsification and de-emulsibility

Emulsification indicates the tendency of an oil to mix
intimately with water to form a more or less stable
emulsion.  De-emulsibility indicates the readiness with
which subsequent separation will occur.

Methods of applying lubricant
Objective: At the end of this lesson you shall be able to
• list and explain the different methods of lubrication.

The following methods are used for efficient
lubrication.

- Gravity feed method

- Force feed method

- Splash method

Gravity feed method

There are numerous ways of employing this principle, vary-
ing from the simple oil hole to the more elaborate wick
and glass-sided drip feed lubricators in which the flow of
the oil may be controlled and observed through  the glass.
A selection of these lubricators is shown in Fig 1.

Force (Pressure) feed method

There are various systems of lubrication employing a
pressure feed to the lubricant, and the most important of
such systems may be classified roughly into the following.

- Continuous feed of oil under pressure to each bearing
concerned.  In this method an oil pump driven by the
machine delivers oil to the bearings and back to a sump
from which it is drawn by the pump.

- Pressure feed by hand pump in which change of oil is
delivered to each bearing at intervals (once or twice a
day) by the machine operator. (Fig 2)

- Oil or grease gun method.  The oil hole leading to each
bearing is fitted with a nipple and by pressing the nose
of the gun against this and the lubricant is forced into
the bearing.  (Figs 3 a, b, c & d )
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Splash method

In this method the shaft, or something attached to it,
actually dips into the oil and a stream of lubricant is
continually splashed round the parts requiring lubrication.

This method is employed for the gears and bearings inside
all gear drives, the lower parts of the gears actually dipping
in the oil. (Figs 4a, b and c)

A common method of employing splash lubrication is known
as ‘ring oiling.’

Classification of lubricants
Objectives: At the end of this lesson you shall be able to
• state solid lubricants and their application
• state liquid and semi-liquid lubricants and their application
• state liquid and semi-liquid lubricants and their application
• differentiate between coolants and lubricants.

Lubricants are classified in many ways.  According to their
state, lubricants are classified as:

- solid lubricants

- semi-solid or semi-liquid lubricants

- liquid lubricants.

Solid lubricants

These are useful in reducing friction where an oil film cannot
be maintained because of pressure and temperature.
Graphite, molybdenum disulphide, talc, wax, soap- stone,
mica and french chalk are solid lubricants.

Semi-liquid or semi-solid lubricants

Greases are semi-liquid lubricants of higher viscosity than
oil.  Greases are employed where slow speed of heavy
pressure exists.  Another type of application is for high
temperature components, which would not retain liquid
lubricants.

Liquid lubricants

According to the nature of their origin, liquid lubricants are
classified into:

- mineral oil

- animal oil

- synthetic oil.

According to the product line of Indian Oil Corporation the
lubricants are classified as:

- automotive lubricating oils

- automotive special oils

- rail-road oils

- industrial lubricating oils

- metal working oils

- industrial special oils

- industrial greases

- mineral oils.

For industrial purposes the commonly used lubricants for
machine tools are:

- turbine oils

- circulating and hydraulic oils (R & O Type)

- circulating and hydraulic oils (anti-wear type)

- circulating oil (anti-wear type)

- special purpose hydraulic oil (anti-wear type)

- fire-resistant hydraulic fluid
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- spindle oil

- machinery oils

- textile oils

- gear oils

- straight mineral oils

- morgan bearing oils

- compressor oils.

In each type, there are different grades of viscosity and
flash point.  According to the suitability, lubricants are
selected using the catalogue.

Example 1

Spindle oils are graded according to their viscosity and
flash point.

Servospin  -    2

Servospin  -    5

Servospin  -  12

Servospin  -  22

Servospin oils are low viscosity lubricants containing anti-
wear, anti-oxidant, anti-rust and anti-foam additives.  These
oils are recommended for lubrication of textile and machine
tool spindle bearings, timing gears, positive displacement
blowers, and for tracer mechanism and hydraulic systems
of certain high precision machine tools.

Example 2

Gear oils are graded according to their  viscosity and flash
point.

Servomesh -   68

Servomesh - 150

Servomesh - 257

Servomesh - 320

Servomesh - 460

Servomesh - 680

Servomesh oils are industrial gear oils blended with lead
and sulphur compounds.  These oils provide resistance to
deposit formation, protect metal components against rust
and corrosion, separate easily from water and are non-
corrosive to ferrous and non-ferrous metals.

These oils are used for plain and anti-friction bearings
subjected to shock and heavy loads, and should be used
in systems where the operating temperature does not
exceed 90o C.  These oils are not recommended for use in
food processing units.

Servomesh A-90 is a litumenous product which contains
sulphur-lead type and anti-wear additive.  It is specially
suitable for lubrication of heavily loaded low-speed open
gears.

Servomesh  SP 68

Servomesh  SP 150

Servomesh  SP 220

Servomesh  SP 257

Servomesh  SP 320

Servomesh  SP 460

Servomesh  SP 680

Servomesh SP oils are extreme pressure type industrial
gear oils, which contain sulphur-phosphorous compounds
and have better thermal stability and higher oxidation
resistance compared to conventional lead-napthenate gear
oils.

These oils have good de-emulsibility, low foaming tendency
and provide rust and corrosion protection to metal surfaces.
These oils are recommended for all heavy duty enclosed
gear drives with circulation or splash lubrication system
operating under heavy or shock load conditions up to a
temperature of 110o C.

Similarities between coolant and lubricant

• A particular cutting fluid can serve as a coolant as well
as lubricant at the same time. However, cooling and
lubrication capabilities vary from one cutting fluid to
another.

• Irrespective of its purpose (cooling or lubrication), the
cutting fluid can be delivered to the cutting zone in
several ways including flood cooling and MQL
(minimum quantity lubrication).

• Irrespective of cooling or lubrication purpose, a cutting
fluid should have high boiling point and high thermal
stability.

• Both cooling and lubrication actions require good
wettability so that the cutting fluid can quickly spread
over the relevant surfaces.

CG & M : TDM (Dies & Moulds) (NSQF - Revised 2022) - R .Theory for Ex. 1.4.61

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



230

Differences between coolant and lubricant

Coolant Lubricant

Basic purpose of coolant is to take away generated Basic purpose of lubricant is to reduce coefficient of
cutting heat from the cutting zone, and thereby keep friction between rake surface of cutter and chip, and
the cutting zone temperature low. thereby minimize rate of heat generation.

Coolant acts on the generated heat. It cannot reduce Lubricant can reduce the rate of heat generation.
rate of heat generation. It has no influence on removing heat that is already

generated.

Coating on cutting tool has no role as coolant. Coating layer on cutting tool sometimes acts as
lubricant.

To act as good coolant, the cutting fluid should To act as good lubricant, the cutting fluid should
possess high specific heat capacity. possess high lubricity.

Water is considered as a good coolant owing to its Water is not good lubricant. it has poor lubrication
higher specific heat capacity. Note that water is capability or low lubricity.
highly corrosive, so rarely used as cutting fluid.
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CG & M Related Theory for Exercise 1.4.62
Tool & Die Maker (Dies & Moulds) - Milling

Indexing or dividing head
Objectives: At the end of this lesson you shall be able to
• state what is indexing
• list the types of indexing heads
• state the principle of direct indexing.

What is indexing?

It is an operation of dividing the circumference of a workpiece
into equally spaced divisions (Fig 1) for milling gears,
splines, squares, cutting of flutes in reamers, etc.

Indexing is also used to rotate the workpiece at a
predetermined ratio to the table feed rate to produce cams,
helical grooves etc.

This operation is performed on a milling machine by means
of an indexing attachment which is called as indexing head
or the dividing head.

Types of indexing heads

The most common types of indexing heads dividing
heads are

- direct indexing head (Fig 2)

- simple indexing head (Fig 3)

- universal indexing head. (Fig 4)

Direct indexing

Purpose of direct indexing

Direct indexing is a rapid method of indexing.  It is used
where a large number of identical pieces are indexed by
very small number of divisions.  Usually, this type of
indexing can be performed on a direct indexing head.

Principle of direct indexing

Direct indexing may be employed whenever the number of
divisions required can be divisible without remainder into
the number of holes or slots in the direct index plate.

Direct indexing mechanism (Fig 5)

It consists of a housing, a spindle with a driving lug and an
indexing crank.  The rear of the housing is fitted with a flat
index plate which has a number of holes spaced around the
circumference of the circles of different radii.
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The number of holes varies from circle to circle.  The index
plate usually has three circles of holes with 24, 30, 36 holes
respectively.

Another type of index plate (Fig 6) which is having a number
of slots (ie.24 or 30 or 36 slots) on the periphery of the index
plate, is fitted to the front end of the spindle nose. (Fig 2)
The spindle is rotated by hand and locked by a pin.

The handle of the indexing crank, which can be moved
radially, is fitted with a spring-loaded index pin.  The index
pin engages with the holes in the indexing plate.

While indexing, the pin is taken out from the index plate
hole.  The spindle is rotated by the crank and after the
required position is reached, it is again locked by the
pin.The workpiece can be set up in a chuck on the indexing
head spindle or between centres using the indexing head
and a matching tailstock.  For centre work, any suitable
carrier may be used to engage the workpieces with the
driving lug on the indexing head spindle. (Fig 7)

Plain or simple indexing
Objectives : At the end of this lesson you shall be able to
• state the purpose of simple indexing
• explain the simple indexing mechanism.

Purpose of simple indexing

Simple indexing is used to obtain a greater number of
divisions that cannot be obtained by direct indexing.  This
operation may be performed in both simple and universal
dividing heads.

Principle of simple indexing

It is carried out using 40:1 ratio of the worm and worm-
wheel mechanism.  One rotation of the worm, rotates the
worm-wheel spindle 1/40 of a complete turn.  A fractional
part of 1/40 of the revolution of the worm-wheel can be
performed by using the index plate.

Simple indexing mechanism (Fig 1)

The simple indexing mechanism consists of a 40 tooth
worm-wheel fastened to the spindle, a single start worm, a
crank for turning the work shaft and an index plate and
sector.

The worm-wheel is keyed to the spindle shaft, and meshes
with the warm shaft.  When the worm is given one complete
turn, the worm-wheel advances one tooth or, as it has 40
teeth it will revolve 1/40 of a revolution.

In other words, 40 turns of the index crank will make the
spindle revolve one complete revolution.

To facilitate indexing to fraction of a turn, index plates are
used to cover practically all the numbers.

Index plate

The index plate is mounted behind the index crank.  It is a
circular plate provided with a circle of holes representing
different divisions of the circle.

The object of these plates is to allow the worm to be moved
a fractional part of a turn.

The two systems in common use are the Brown and
Sharpe index system and the Cincinnati index plate
system.

Brown and Sharpe  index plate system (Fig 2)

The Brown and Sharpe system has three index plates and
each plate has six circles of holes.
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Plate No.1 - 15, 16, 17, 18, 19, 20

Plate No.2 - 21, 23, 27, 29, 31, 33

Plate No.3 - 37, 39, 41, 43, 47, 49

With the three index plates, simple indexing can be used
for all divisions up to 50, even numbers up to 100, except
96.

Cincinnati and parkinison index plate system

The Cincinnati and parkinison system uses one index plate
with eleven circles of holes on each side.  The plate is
reversible and this gives twenty two cycle of holes.

First side - 24, 25, 28, 30, 34, 37, 38, 39, 41, 42, 43

Second side - 46, 47, 49, 51, 53, 54, 57, 58, 59, 62, 66

Index crank (Fig 3)

The index crank is fitted to the end of the worm-shaft.  The
crank carries a spring-loaded index pin to engage the hole
in the plate.

The crank is rotated by withdrawing the knob, turning the
crank around a selected circle of holes and releasing the
knob to engage the pin in the required hole.

Sector arms (Fig 4)

There are two sector arms which fit on the face of the index
plate.

The arms can be set apart to cover a required number of
holes between them.

Adjustment is made by slackening the lock screws,
moving the arms to the desired setting and re-tightening the
screws to lock the arm in position.

The arms eliminate the need for counting the number of
holes each time the crank has to be turned by a set number
of divisions.

Formula for simple indexing

N

40
movementcrankIndex 

‘N’ is the number of turns of the crank required.

Angular indexing
Objectives : At the end of this lesson you shall be able to
• state the need for angular indexing
• state the principle of angular indexing.

It is often necessary to index for a certain number of
degrees as when machining, keyways, grooves, flats or
other features located at angles to each other. (Fig 1)

Angular indexing can be carried out using a simple index-
ing head equipment.

Principle

Most indexing heads require 40 turns of the crank to rotate
the spindle once.
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Calculating of indexing
Objectives: At the end of this exercise you shall be able to
• explain the indexing movement required for direct indexing
• explain the indexing movement required for simple indexing
• explain the indexing movement for angular indexing
• explain the crank movement for linear indexing.

Direct indexing

If six slots are to be machined and the 30 circles located.
No.of index crank movement

5
6

30

required divisions No.of

plateindex  the in holes No.of
===

3

1
 3

12

40

N

40
 movement crankIndex ===

One revolution of the spindle = 360 degrees or 40 turns of
the crank.

If the crank is turned once, the spindle rotates 1/40 of a turn
and 1/40 of 360° is 360/40 = 9 degrees. (Fig 2)

It follows that 1/9 turn of the crank will give a spindle
movement of 1 degree.

Linear Indexing
Objectives : At the end of this lesson you shall be able to
• state the purpose of linear indexing
• state the principle of linear indexing, using  an indexing head
• state the crank movement for linear indexing.

Linear indexing

The operation of producing accurate spaces on a piece of
flat stock, or that of linear graduating is easily accomplished
on the horizontal milling machine Fig 1.

In this process the work may be clamped to the table or
held in a vice, depending on the shape and size of the part.
Care must be taken to align the workpiece parallel to the
table travel.

Principle

To produce an accurate longitudinal movement of the table,
the dividing head spindle is geared to the lead screw of the
milling machine.

If the dividing head spindle and the lead screw are connected
with gears of 1:1 ratio, ie. With equal number of teeth and
the index crank turned one revolution, the spindle and lead
screw on an inch milling machine, would revolve one fortieth
(1/40th) of  a revolution.  This rotation of the lead screw
having 4 threads per inch 1/40 x 1/4 ( is equal to) 1/160 =
0.00625 inch (0.15875 mm). Thus five turns of the index
crank would move the table 5 x 0.00625, or 1/32 in (0.79375
mm).

Simple indexing

Find the number of turns of the crank required to index 12
divisions.

The pin is inserted in every fifth hole of the 30 hole circle.

All divisions that are exactly divisible by 360° can also be
obtained - 180°, 120°, 90°, 45°, 30° and 15°. This indexing
can also be performed by simple indexing head by
disengaging worm from worm wheel. (Fig 8)

To index the fractional part of a turn, select an index plate
which has a circle of holes exactly divisible by the
denominator of the fraction. In this case 3.

Assuming that a plate is chosen having a circle of holes
equal to 24, then the number of holes that the index pin
would have to move for 1/3 of a turn would be
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holes 8
3

1
x

1

24
=

Each division would require three complete turns of the
index crank and 8 holes on the 24 hole circle.

Example

Find the number of turns of the index crank for indexing 43
holes.

43

40

N

40
 movement crankIndex ==

In this case a partial turn of the crank for each division is
only required. A circle having 43 holes is available, so that
for each division, the index crank is turned 40 holes in the
43 hole circle.

Angular indexing

Index for 45°

turns 
9

5
 13

9

122
9
D

T

22 1 forIndex 

turns complete 5
9

45
9

D
T

==

=

°

==

=

That is 13 complete turns and 5/9 of a turn. This is obtained
by setting an index plate with a circle of holes divisible by
9 and setting the sector arms of 5/9 of a turn.

If a 18 hole circle is used

5/9 x 18 = 10 holes

Then T = 13 turns + 10 holes of the 18 holes in the circle.
(Fig 3) using brown and sharp company index plate No.1

Indexing in minutes

One revolution of the crank gives a spindle movement of 9°
and to convert the degrees into minutes multiply by 60.

9° = 9 x 60 = 540 minutes.

The number of turns of crank is found by dividing the angle
to be indexed in minutes by 540.

540

(M) minutesinindexedbetoAngles
turnsNo.of 

Example (Figs 4 to 6)

To index an angle of 34°40'

Angle in minutes = 34 x 60 + 40 = 2080

27

23
3

27

104

54

208

540

2080

540

M
T 

3 complete turns plus 23 holes spaces in the 27 hole circle
will give an index angle of 34° 40' by using brown and sharp
company plate No.2

Indexing in seconds

One revolution of the crank  gives a spindle movement of 9°
and to convert the degrees into seconds multiply by 60 x
60.

9° = 9 x 60 x 60 = 32400 seconds

Index crank movement =

32400

seconds in  workof ntdisplacemeAngular

Linear indexing

Calculation

The formula for calculating the indexing for linear graduations
in thousands of an inch is
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  where N = spacing required in inch

T = No.of turns of index crank

If the lead screw of a metric milling machine has a pitch of
5mm, one turn of the index crank would move the table one-
fortieth of 5mm, or 0.125 mm. Therefore, it would require
four complete turns on the crank to move the table by 0.5
mm.

The formula for calculating the indexing for linear graduations
in millimeters is

  where N = spacing required in mm

T = No.of turns of index crank

Other suitable movements may be obtained by
using the appropriate hole circle and/or different
change gears ratio, other than 1:1.
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CG & M Related Theory for Exercise 1.5.63-66
Tool & Die Maker (Dies & Moulds) - Grinding

Introduction to grinding machine types
Objectives: At the end of this lesson you shall be able to
• state the importance of the grinding operation
• list the common types of precision grinders and its purposes.

Grinding is a metal cutting operation performed by means
of a rotating abrasive wheel that act as a cutting (multipoint)
tool (Fig. 1). Mostly grinding is a finishing operation with
high degree of surface quality accuracy of shape and
dimension. It removes comparatively less metal (0.25 to
0.50mm) in most operations.

Grinding has three advantages over other metal
cutting methods.

- It is the only economical method of cutting hard
materials like hardened steel.

- It produces very smooth surfaces up to N4, suitable for
bearing surface.

- Surface pressure is minimum in grinding. It is suitable
for light work, which will spring away from the cutting
tool in the other machining processes.

Types of grinding operations

There are four main grinding operations.

Surface grinding (Fig 2)

It is the operation of using precision grinding machines to
produce flat or plain surfaces on workpieces. The workpiece
is at a constant speed below the grinding wheel.

External cylindrical grinding (Fig 3)

It produces a straight or tapered cylindrical surface. The
workpiece is rotated about its own axis between centres
as it passes lengthwise across the face of a revolving
grinding wheel.

Internal cylindrical grinding (Fig 4)

The workpieces are held in the chuck and rotated precisely
about their axis. A revolving grinding wheel, smaller than
the dia. of the hole to be ground, is set against the rotation
of the workpiece and traverses along the surface of the
hole.

Form grinding (Fig 5)

It produces formed surfaces. Specially shaped grinding
wheels grind the formed surfaces as is the case in grinding
gear teeth, threads, splined shafts etc.
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Surface grinding machine
Objectives: At the end of this lesson you shall be able to
• state the uses of a surface grinder
• state the four common types of surface grinders
• state the main parts and their functions of a surface grinder
• state the specification of surface grinder.

Grinding Machines

Grinding machines are precision machine tools, designed
to remove metal from a workpiece to close tolerances (up
to 0.0025 mm) and to produce high quality surface finish
(up to N4).

There are two major groups of grinding machines.

- Off hand or rough grinders

- Precision grinders

The common types of precision grinders are:

- Surface grinders

- Cylindrical grinders

- Tool and cutter grinders.

Surface grinders

Surface grinders are used to grind flat, parallel surfaces or
stepped surfaces. The surface produced by a surface
grinder is more economical and more accurate than the
surface obtained by filling or scraping.

Cylindrical grinder

Cylindrical grinders are used to grind external and internal
cylindrical surfaces. The cylindrical surfaces produced may
be plain, tapered or stepped.

Tool and cutter grinder

A tool and cutter grinder is mainly used to sharpen single
point cutting tools, milling cutters etc. It also can be used
as a surface and cylindrical grinder along with some
attachments.

Surface grinding machine

It is a precision grinding machine to produce flat surface,
Parallel surface or stepped surface. It is a move economi-
cal and more practical method of accurately finishing flat
surface than filing and scraping. The abrasive wheel is
used as a cutting tool. It has more number of cutting edges
than single point cutting tool, hence removes metal fastly
and accurately.

Types of surface grinders

There are four types of surface grinders

Horizontal spindle reciprocating table (Fig 1)

Horizontal spindle rotary table (Fig 2)

Vertical spindle reciprocating table. (Fig 3)

Vertical spindle rotary table. (Fig 4)

A horizontal spindle type surface grinders widely used,
grinding is normally done on the periphery of the wheel.
The area of contact is small and the speed is uniform over
the grinding surface.

Horizontal spindle reciprocating table surface grinder

Main parts (Fig 5)

• Base • Saddle

• Table • Wheel head
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Base

It is a rigid rectangular box contains the driving mechanism
(hydraulic device tank and motor). It has a column at the
back for supporting the wheel head on the top of the base
provide precision guide ways for moving saddle.

Saddle

It is a frame. It contains the table in its cross wise
movement. It is used to give cross feed to the work. It can
be moved by hand or auto feed.

Table

It is fitted on the saddle. It is reciprocates along the guide
ways to provide the longitudinal feed to the work. The
surface is accurately machined and T-slots are provided

for clamping of workpieces directly on the table or for
clamping magnetic chuck and grinding fixtures. It is moved
by hand or auto feed.

Wheel head

It is mounted on the column secured to the base. It can
be moved vertically up and down to by rotating a hand
wheel accommodate work piece of different height and
set the wheel for depth of cut. The wheel rotates at a
constant wheel speed. (1500 rpm)

Some surface grinding machines the dressing unit mounted
top of the wheel head and slide to dressing the wheel with
help of rotating micrometer collar handle. Dress the wheel
0.015mm to 0.025mm to giving a feed.

Specification of surface grinder

- Maximum dia. of the wheel that can be held on the
spindle.

- Working surface of table (length & wide)

- Vertical traverse of wheel head (height)

- Table cross and traverse (movement) feed rate.

- Speed of wheel.

- HP of wheel head motor.

- Types of drive (Incase of hydraulic drive hydraulic pump
HP)

- Floor space required.

- Net weight of the machine.

Eg. Praga, 175mm wheel 400mm stroke, hydraulic surface
grinder. Model 451.

Detailed specifications and dimensions of a surface grinder
are furnished by the manufacturer in the operator's
instructional manual.  Refer to one such manual of your
section with the help of your instructor.
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Tool and cutter grinder
Objectives: At the end of this lesson you shall be able to
• state the purpose of a tool and cutter grinder
• state the parts and functions of a tool and cutter grinder
• specify a tool and cutter grinder.

Cylindrical grinders
Objectives: At the end of this lesson you shall be able to
• state the purpose of a cylindrical grinder
• name the 4 types of cylindrical grinders
• state the parts and  functions of a plain centre type  cylindrical grinder
• specify a cylindrical grinder.

Cylindrical grinders are used to grind the external or inter-
nal surfaces of a cylindrical workpiece.

By cylindrical grinding the diameter of a workpiece can be
maintained to a close tolerance (up to 0.0025 mm), and a
high quality surface finish can be obtained (up to N4).

The four types of cylindrical grinders are:

- external cylindrical grinders

- internal cylindrical grinders

- universal cylindrical grinders

- centreless grinders.

Plain centre type cylindrical grinder (Fig 1)

It is mainly intended to produce plain, stepped or tapered
external cylindrical surfaces.

Parts

The main parts of this type of a cylindrical grinder are the:

a  base

b   wheel head

c   table

d   headstock

e   foot-stock.

Functions

Base (A) is made out of cast iron.  It is heavy and provides
rigidity to the machine. The top surface is machined to
form guideways to the table.

The wheel head (B) is mounted on the cross-slide.  It
moves perpendicular to give depth of cut.

The table (C) is mounted on the bed-ways.  It  recipro-
cates past the wheel.  It can be swivelled to grind taper.
Trip dogs are provided to control reciprocation.

The headstock (D) is mounted on the table at the left end.
It has a motor with 2 or 4 speed steps to drive the work.  A
dead centre is mounted in the spindle of this head to sup-
port the workpiece between centres.

The foot-stock (E) is mounted on the table at the right
hand side.  It can be moved and locked at any place along
the table  length to hold different lengths of work.  The
spindle is spring-loaded and carries a dead centre to sup-
port the work.

The spring tension provides even, stiff support.

Specification

A cylindrical centre type grinder is specified by the maxi-
mum diameter and length of the workpiece that can be
accommodated between centres.  The diameter of the
workpiece   should not be more than half of the capacity
given.

In a machine shop, much of the machining operations is
done by single point tools or multi-point tools called mill-
ing cutters.  The cutting tools become blunt due to con-
stant use, and need re-sharpening for continued produc-
tion.

Such re-sharpening is done in tool rooms, where a tool
and cutter grinder is used for this purpose.

A universal tool and cutter grinder is used to re-sharpen
reamers, taps, single point tool and milling cutters, dies
and punches.

Parts and construction of a tool and cutter grinder (Fig 1)

Base

It supports all the other parts of the machine.  The body
and frame are in one unit.  The driving and feed mecha-
nism are fitted in the body.
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Saddle

It is on the top of the body; it carries the table and traverses
crosswise to the table movement.

Table

It is on the saddle.  It reciprocates and can be swivelled
to the required angle.

Column

It is on the back of the machine and it carries the wheel
head which moves up and down for the depth of cut.

Wheel head

It has two grinding wheels on both ends of the spindle
and can be swivelled to the required angle (360°).

Work head

It is a separate part and is fitted on the table for cylindri-
cal works.  It is driven by a separate motor fitted with the
work head.  It moves along the table and can be swivelled
to any angle (180°).

A tailstock is provided for supporting the mandrel between
centres.

Specification of tool and cutter grinder

1 Maximum dia. of the wheel that can be held in the
spindle.

2 Maximum height of the job that can be ground.

3 Maximum length of the job that can be ground.

4 Maximum breadth of the job that can be ground.

5 Type of drive

   -  hydraulic

   -  electrical.

6 Number of attachments

Attachments

A tool and cutter grinding machine is also used as a sur-
face grinding, cylindrical grinding and internal grinding
machine with the help of certain attachments.

Safety to be observed while working on grinding machine
Objective: At the end of this lesson you shall be able to
• state the precautions to be observed while working on grinding.

Safety precautions

All grinding machines have parts that move at high speed.

The machines are fitted with guards to protect the operator
form injury and to make operation of the machine as safe
as possible

Despite this, accidents still happen.

These accidents are usually caused by :

- Ignorance

- Thoughtlessness

- Carelessness

Lack of consideration for the safety of others.

These accidents can be prevented by thinking before

doing.

Various unsafe conditions and procedure are mentioned
throughout this manual. Learn to recognize them and gain
a clear understanding of what should be done in each
case.

 The safety precautions to be taken when using grinding
machines may be divided into four areas.

- General

- Machine

- Personal

General safety precautions

- Key the work area around machines free of obstacles
and waste a material.
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- Immediately clean up any oil, grease or coolant spilled
on the floor.

- Place cleaning cloths and  waste materials in the
proper containers after use

- Store hand tools and accessories away from machines
after use.

- Do not handle workpieces which may be hot as a result
of grinding operations.

- Use the correct hand tool for the job in hand.

- Seek assistance when handling heavy machine
accessories, grinding wheels or workpieces.

- Learn the location  of the  nearest fire alarm.

- Learn where fire extinguishers are located and how to
use them,

- Stop, look and think before starting any new operation.

- Ensure lighting is adequate.

- Always be courteous, considerate an obliging to
others.

Machine safety precautions

- Operation machines only when you are authorized by
your instructor to do so.

- Follow  your instructor's directions carefully.

- Keep  your fingers away from the moving parts of the
machine

- Do not start a machine unless all machine guards are
correctly fitted.

- Make sure the workpiece is securely fitted to the work
table before starting  a grinding operation.

- Do not handle the surface of the workpiece while the
machine is operating.

- Do not use your hand to stop movement of any part of
the machine.

- Use a brush, not your hand, to clean ground material
from the workpiece  and machine.

- Keep the machine free of tools, accessories and parts
not being used at the time.

- When setting the work table for automatic traverse,
allow the wheel to over travel the workpiece in each
direction.

- Do not clamp hardend workpiece too tightly in the jaws
of a vice.

- Whenever possible, use a coolant during a grinding
operation.

- If a grit exhaust system is fitted to the machine, use it
all times during grinding.

- Stop the machine before cleaning or oiling it or before
making any adjustments to the accessories or to the
workpiece.

- Dot not leave a machine while it is still running.

- Do not touch or lean on a machine someone else is
using.

- Do not divert eh attention of someone else using a
machine.

Personal safety precautions

- Wear goggles at all times when using a grinding
machine.

- Report any injuries, however slight, to your instructor
or supervisor

- Wear close - fitting clothes.

- Avoid wearing a tie and long sleeves. If necessary,
truck your tie carefully inside your shirt or keep in inside
of outer clothing, buttoned or zipped up high and roll
up your sleeves.

- If your hair is long, wear a protective head covering
and make sure your hair  is completely enclosed in
side it.

- Do not wear a watch, rings or other loose ornaments.

- Do not wear gloves.

- Wipe your hands clean before operating a machine,
adjusting accessories or handing a workpiece.
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CG & M Related Theory for Exercise 1.5.67-68
Tool & Die Maker (Dies & Moulds) - Grinding

Grinding wheels, types, application
Objectives: At the end of this exercise you shall be able to
• explain the type and names of different shapes of grinding wheels
• state the application of each type of grinding wheel.

Grinding wheels are made in different shapes and sizes
for grinding different jobs and for use in different machines.
The size may differ in diameter, face width and bore dia.

The following are the standard shapes of grinding wheels.

Straight wheel:  Type 1 (Fig 1)

This type of wheels is used on cylindrical, surface and
centreless grinders for grinding cylindrical and flat surfaces.
Sometimes this type of wheel is used on rough grinders
for off hand grinding.

Cylinder: Type 2 (Fig 2)

This type of wheel is used on both horizontal and vertical
spindle surface grinders for the surface grinding operations.

Tapered (both sides) Type 4  (Fig 3)

It is mainly used for rough grinding.  The tapered sides
reduce the chance of breaking.

Recessed one side: Type 5 (Fig 4)

It is used for cylindrical, surface and centreless grinding.
The recess provides clearance for the flange.

Straight cup: Type 6 (Fig 5)

It is used on surface grinders and on tool and cutter grinders
to grind flat surfaces.

Recessed both sides: Type 7 (Fig 6)

Used on cylindrical, surface and centreless grinders. The
recesses provide clearance for both flanges.

Flaring cup: Type 11 (Fig 7)

It is used on tool and cutter grinders mainly to sharpen
milling cutters and reamers.

Dish: Type 12 (Fig 8)

Used on tool and cutter grinders to sharpen milling cutters
with narrow slots like formed relieved cutters, hobs etc.

Saucer: Type 13 (Fig 9)

It is used for sharpening circular and handsaws.  It is also
used for gashing milling cutter teeth.

Segmented wheels (Fig 10)

This type of wheels is formed by holding segments of
abrasives using a metal holder.  This is mainly used on a
vertical spindle surface grinder.
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Mounted wheels (Fig 11)

These are wheels with less than 50 mm dia. formed on a
steel shank to various shapes.  Mounted wheels are mainly
used for die grinding, deburring and for finishing  operations.
Used on pneumatic or electric grinders.

Types of wheel faces

To do different operations different types of wheel faces
are produced by manufacturers. (Fig 12)

Grinding wheel specification

A grinding wheel is specified by its marking, shape, outside
dia. bore dia. thickness etc. (Fig 13a)

A recessed wheel is specified with all the above given
particulars plus the dia. of the recess and the depth of the
recess. (Fig 13b)

Grinding wheel marking system

eg. A     56   K  5     V   75

1st Position ‘A’ denotes ‘ Abrasives’ ie., Aluminium Oxide

2nd Position ‘56’ denotes ‘Grit size’ ie., Medium

3rd Position  ‘K’ denotes ‘Grade’ ie., Medium

4th Position   ‘5’ denotes ‘ Structure’ ie., Dense

5th Position ‘V’ denotes ‘Bond’ ie., Vitrified

6th Position ‘75’ denotes manufacturer’s Code  if any
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CG & M Related Theory for Exercise 1.5.69 - 72
Tool & Die Maker (Dies & Moulds) - Grinding

Marking system and selection of grinding wheel
Objectives: At the end of this lesson you shall be able to
• explain marking system of grinding wheel
• state the selection of grinding wheel.

Introduction

Standard wheel marking specifying all the important wheel
characteristics. The marking system comprises of seven
symbols which are arranged in the following order. (Fig 1)

Example

Marking system

51 - A46 H5V8

Specification of grinding wheels

A grinding wheel is specified by the:

standard wheel marking

outer diameter of the wheel

bore diameter of the wheel

thickness of the wheel

type (shape) of the wheel

Example

32 A46 H8V 15

250 x 20 x 32

Straight wheel

Table 1

Position Position Position Position Position Position Position

0 1 2 3 4 5 6

Manufacture’s Type of Grain size Grade Structure Type of Manufacture’s
symbol for abrasive (optional) bond own mark
abrasive (optional)
(optional)

51 A 46 H 5 V 8

Selection of grinding wheels for internal grinding
Objectives: At the end of this lesson you shall be able to
• list the factors considered while selecting grinding
• list three types of applications of internal grinding.

Internal grinding are widely used in bearings and automobile
industry.

Such as bore grinding of inner rings, bore grinding of gears,
track grinding of outer rings and steering nuts etc.

In internal grinding, the grinding of internal surfaces the
confirmity between the wheel and workpiece, is
substantially higher.

For selection of grinding wheels IS: 1249 - 1958 provides
recommendations on the general considerations, which
guides the selection of grinding wheels for different
applications.

The main factors considered while selecting grinding wheel
are:

- Material to be ground and its hardness

- Stock removal

- Severity of operation

- Surface finish

- Area of grinding contact

- Wheel speed

- Wheel and dry grinding
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- Machine condition

- Work speed

The illustration and working application of internal grinding
wheels one shown in Fig 1 and 2.

Selection of grinding wheel for tool and cutter grinder
Objective: At the end of this lesson you shall be able to
• state the factors which affect the selection of grinding wheel.

For grinding a job the right grinding wheel is to be selected.
The selection of a grinding wheel will depend on the following
factors.

- Factors affecting the selection of abrasive

a Materials of high tensile strength, viz. alloy steel,
hard bronzes steel and wrought iron.

- Aluminium oxide

b Hardened tool steel high speed steel drills cutters
and for cool and precision grinding.

- White Aluminium oxide

c Materials of low tensile strength, viz., Aluminium,
copper, cast-iron, stone ad marble.

- Silicon carbide.

d Tungsten carbide tipped tools

- Green silicon carbide.

- Factors affecting the selection of grit.

a Great amount of stock to remove - Course grain.

b Soft and tough materials - Course grain.

c Fine finish - Fine grain.

- Factors affecting the selection of grade

a Hard materials - Soft wheel.

b Soft materials - Hard wheel.

c Great area of contact - Soft wheel.

d Low wheel surface speed - Hard wheel.

e Unstable and shaky foundation

of grinding machine. - Hard wheel.

f Off-hand grinding - Hard wheel.

- Factors affecting the selection of structure

a Soft and tough material - Open structure.

b Fine finish - dense structure.

c cylindrical and tool grinding - medium structure

d External grinding - dense structure.

- Factors affecting the selection of bond.

a General purpose and maximum
cutting efficiency - vitrified

b Wheels of very large diameter
and wheels required quickly to
special order. - silicate

c very thin wheel - shellac or rubber.

d very high finish where rapid
cutting is not important - shellac or rubber

Selection and use of grinding wheels for different
applications are usually given in grinding wheel
manufactures catalogue

Standard size of wheels are available.
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CG & M Related Theory for Exercise 1.5.73-74
Tool & Die Maker (Dies & Moulds) - Grinding

Procedure for mounting of grinding wheels, balancing of grindng wheels
Objectives: At the end of this lesson you shall be able to
• state what is a wheel balancing
• name the method of balancing
• state the procedure of balancing.

Wheel balancing

Wheel balancing is an action of bringing the grinding wheel
to rotate concentric to its axis and the weight and density
of wheel are uniform throughout its circumference.

Before testing the balancing of the wheel it is true

Necessary of wheel balancing

- A god surface finish is possible to the work surface.

- Prevents wheel vibration and breakage

- Prevents chatter marks on the work surface

- Improves the dimensional accuracy of the work.

- Considerably increases the life of grinding wheel.

- Prevents the damage of the spindle / bearings.

Small wheel normally to not require any balancing, but
larger diameters of the wheel important is the balancing .
Similar equipment used to balance the wheels of motor
cars.

Method of balancing

- Static balancing

- Dynamic balancing

Static balancing means that when the wheel is cantered in
balancing mandrel and placed on a balancing stand.

Dynamic balancing means that when the wheel can be
while it is running on the machine. For getting still better
result.

Wheel mounted on a balancing collet (Fig 1 & 2)

Large grinding wheels must be mounted on a balancing
collet and balanced before being fitted to the grinding
machine. The collect  remains fitted to the wheel during
use.

To balance a wheel proceed as follows (Fig 3)

- Mount the wheel on a balancing collect.

- Fit a balancing arbour to the collet.

- Remove the adjustable weight from the collet.

- Place the arbour collect and wheel assembly on a pair
of balancing ways in a position near the centre of the
ways.

-    Ensure that the ways are perfectly horizontal.

- Use are accurate spirit level for this if none is mounted
on the ways.
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Grinding wheel dressing
Objectives: At the end of this lesson you shall be able to
• state three important purposes of dressing a grinding wheel
• differentiate between dressing and truing
• state the types of wheel dressers and their uses.

- Allow the wheel to roll slowly on the ways by a very
gentle push until it comes to rest. In this rest position
the heavy spot of the wheel will be on the lower part of
the wheel.

- Do not push so hard that the wheel rolls off the ways.

- Make a chalk mark on the wheel at the point opposite
to the heavy spot. This will be the uppermost position
of the wheel when it is at rest.

- Mount the balancing weights on either side of the chalk
mark.

- Test as before by allowing the wheel to rotate slowly
on the balancing ways, each time moving the weights
a little further back from the chalk mark after the wheel
comes to rest until a perfect balance is obtained.

- The wheel is balanced when it gently comes to a stop
with no tendency to roll back regardless of which por-
tion of the wheel was the lowest at the start of the roll.

- Fix the weights in the balance position by tightening
the weight set screws.

- Remove the arbor from the collect.

- The balanced wheel with its collet assembly is now
ready for mounting on the grinding machine spindle.

Wheels in use should be re-balanced at inter-
vals since the balance may change with wear
of the wheel.

Caution:

If a wheel is re-dressed during service, it must
be re-balanced after the dressing operation.

Dressing is an operation to change the cutting action of a
wheel or to recondition the grinding surface. Grinding
wheels should be dressed and trued regularly to improve
the followings:

Work production

Wheel performance

Grinding economy

Dressing (Fig 1)

Dressing refers to the removing of clogs and blunt abra-
sive grains from the surface of the grinding wheel. Dress-
ing grains exposes the cutting edges which restore the
correct cutting action of the wheel. Dressing is done on a
glazed or loaded wheel to recondition it.

Truing: Truing refers to the shaping of the wheel to make
it run concentric with the axis. When a new grinding wheel
is mounted, it must be trued before use to remove the run
out.

Truing is done on the wheel which is out of shape due to
long use. Sometimes a wheel is also trued to change the
shape of the grinding wheel face for a specific grinding
operation like form grinding. (Fig 2)

In most of the cases both dressing and truing are done at
the same time.

There are three basic types of wheel dressers. They are:

• diamond • steel • abrasive

Diamond dressers (Fig 3)

A diamond dressing tool has a hard diamond mounted in
a metal shank. The shank is fitted in a tool holder for
location on the grinding machine to perform dressing.

Diamond dressers are most effective for dressing preci-
sion grinding wheels.

A low feed of a diamond dresser can glaze the wheel.
They are specified by their weight in carats. Usually 0.5
carat to 1 carat diamonds are used for dressing upto 200
mm dia. wheels.
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Steel dressing tools (Fig 4)

Steel dressers for dressing grinding wheel have rotary cut-
ting surfaces made from hard steel.

They are held in place against the grinding wheel by hand
and moved across the face of the grinding wheel to do the
dressing. A tool rest or other rigid support must be used
during this operation.

The main types of steel dresser are:

Star and disc dresser (used for coarse grained wheel)

Corrugated disc dresser (used for smooth finish)

Lock disc dresser (used for medium roughing wheel)

Solid cylinder dresser (used for instead of a diamond dress)

Abrasive dressers

When only light dressing is required abrasive sticks can
be used. There are abrasive materials made in the form of
square or round sticks or put in metal tubes for convenient
handling.

This type of dressers is more convenient in tool and cutter
grinders where frequent dressing and truing is necessary

Glazing and loading, their effects, causes and remedies
Objectives: At the end of this lesson you shall be able to
• differentiate between glazing and loading of a grinding wheel
• state the effects of a glazed and loaded wheel while grinding
• state the causes and remedies for glazing
• state the causes and remedies for loading.

Glazing

When the surface of a grinding wheel develops a smooth
and shining appearance, it is said to be glazed. (Fig 1)
This indicates the abrasive particles on the wheel face are
not sharp. These are worned down to bond level.

Loading

When soft materials like aluminium, copper, lead, etc. are
ground the metal particles get clogged between the abra-
sive particles. This condition is called loading. (Fig 2)

The effects of a glazed or a loaded grinding wheel are
almost the same. They are:

- excessive cutting pressure between wheel and work

- more heat generation
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Roughness values symbols and surface quality
Objectives: At the end of this lesson you shall be able to
• state the values of surface roughness
• state the indication of surface roughness.

Letter symbols for roughness

Indication of surface roughness values.

 S. No. Roughness value Roughness grade Roughness Manufacturing process
Ra in microns Number Symbol

1 50 N12 Flame cutting, hacksaw cut,
bandsaw cut, shot blast etc.

2 25.0 N11 Sand casting, planning, shaping
filling etc.

3 6.3 N9 Milling, drilling, die casting,
3.2 N8 turning,forging,boring  etc.
1.6 N7

4 0.8 N6 Centreless grinding, cylindrical
0.4 N5 grinding, cold rolling, internal
0.2 N4 grinding,extrusion,surface

grinding,broaching,hobbing
EDM, reaming etc.

5 0.1 N3 Super finishing, lapping honning
0.05 N2 etc.

0.025 N1

∼ 
∇ 

∇∇ 

∇∇∇ 

∇∇∇∇ 

- burning of the ground surface

- poor surface finish

- inaccuracies in the size and shape of the workpiece

- wheel breakage (sometimes)

A dull or glazed wheel should be dressed for the following
reasons

To reduce heat generated between the work surfaces and
the grinding wheel.

To reduce the strain on the grinding wheel and the ma-
chine

To improve the surface finish and accuracy of the work

To increase the rate of metal removal

Cause and remedies of glazing

Wrong selection of glazing

Wrong selection of grinding wheels means
hard grade wheel in place of soft wheel and
fine grain size in place of medium grain size.

Select a grinding wheel of the right grade and size.

High wheel speed: Set the wheel to the recommended
speed.

Feed too fine: Set the feed rate correctly.

Dirty coolant: Change the coolant

A glazed or a loaded grinding wheel can be reused after
removing the glazed or loaded particles from the grinding
wheel face.
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Surface symbol indications

Symbol Symbol stands for

Surface symbol indication

1 The basic symbol consists of two legs of unequal length
inclined at approximately 60°.

A bar is added to the basic symbol, if the material removal
by machining is required.

A circle is added to the basic symbol, if the material removal
is not permitted.

A line is added to the larger leg, if some special
characteristics have to be indicated.

Surface roughness obtained by any production method.

Surface roughness obtained by without removal of any
material.
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Indicating the sampling length.

Direction of lay, surface pattern by the production method
employed.

Indicating of allowance in mm.

Symbol Symbol stands for

Surface roughness obtained by removal of material by
machining.

Indicating the production method.

Indicating the surface treatment or coating unless
otherwise stated, the numerical value of the roughness,
applies to the surface roughness after treatment coating.
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Symbol Symbol stands for

Surface texture.

Surface quality
Objectives: At the end of this lesson you shall be able to
• state the meaning of roughness value
• state the parameters on which surface quality depends
• state the method of measuring roughness
• define the symbols for surface roughness.

When components are produced either by machining or by
hand processes, the movement of the cutting tool leaves
certain lines or patterns on the work surface.  This is known
as surface texture.These are, in fact, irregularities, caused
by the production process with regular or irregular spacing
which tend to form a pattern on the workpiece. (Fig 1)

The components of surface texture

Roughness (Primary texture)

The irregularities in the surface texture result from the
inherent action of the production process. These will
include traverse feed marks and irregularities within them.
(Fig 2a)

Waviness (Figs 2b & 2c)

This is the component of the surface texture upon which
roughness is superimposed. Waviness may result from
machine or work deflections, vibrations, chatter, heat
treatment or warping strain.

The requirement of surface quality depends on the actual
use to which the component is put.

Examples

In the case of slip gauges (Fig 3) the surface texture has
to be extremely fine with practically no waviness.  This will
help the slip gauges to adhere to each other firmly when
wrong together.
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The cylinder bore of an engine (Fig 4) may require a certain
degree of roughness for assisting the lubrication needed for
the movement of the piston.

For sliding surfaces the quality of surface texture is very
important.

When two sliding surfaces are placed one over the other,
initially the contact will be only on the high spots. (Fig 5)
These high spots will wear away gradually.  This wearing
away depends on the quality of the surface texture.

Due to this reason it is important to indicate the surface
quality of components to be manufactured.

The surface texture quality can be expressed and  assessed
numerically.

‘Ra’ Values

The most commonly used method of expressing the
surface texture quality numerically is by using Ra value.
This is also known as centre line average (CLA).

The graphical representation of Ra value is shown in
Figures 6 & 7. In Figure 6 a mean line is placed cutting
through the surface profile making the cavities below and
the material above equal.

The profile curve is then drawn along the average line so that
the profile below this is brought above.

A new mean line (Fig 7) is then calculated for the curve
obtained after folding the bottom half of the original profile.

The distance between the two lines is the ‘Ra’ value of the
surface.

The ‘Ra’ value is expressed in terms of micrometre
(0.000001) or (m); this also can be indicated in the
corresponding roughness grade number, ranging from N

1
 to

N
12

.

When only one ‘Ra’ value is specified, it represents the
maximum permissible value of surface roughness.
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Lay: Symbols for designating the direction of lay are shown and interpreted in table 1.

Table 1

Example showing Interpretation Direction of tool marks

 

__ Lay approximately parallel to the
__ line representing the surface to

which, the symbol is applied.

Lay approximately perpendicular to
the line representing the surface to
which the symbol is applied.

X Lay angular in both direction to line
representing the surface to which the
symbol is applied.

M Lay multidirectional.

C Lay approximately circular relative to
the centre of the surface to which the
symbol is applied.

R Lay approximately radial relative to
the centre of the surface of which the
symbol is applied.

P Lay particulate, non-directional,
or protuberant.
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The grit or grain size refer to the actual size of the abrasive
particles. The grains size is denoted by a number. The
sieve used to size the grain.

The larger the grit size number the finer the grit and the
smaller the grit size number the large the grit.

Grade (Fig 2)

Grade indicates the strength of the bond and, therefore,
the ‘hardness’ of the wheel. In a hard wheel the bond is
strong and it securely anothers the grit in place, and
therefore, reduce the rate of wear. In a soft wheel, the
bond is weak and the grit is easily detached resulting in a
high rate of wear.

CG & M Related Theory for Exercise 1.5.75-80
Tool & Die Maker (Dies & Moulds) - Grinding

Grinding wheel - Abrasives - Bond - Grade - Grit- structure
Objectives: At the end of this lesson you shall be able to
• explain grinding wheel
• state the types of abrasives
• explain grain and grade
• state the types of bonds.

Grinding wheel

A grinding wheel is multipoint cutting tool made up of many
hard particles known as abrasive. The abrasive grains are
held together with adhesive substance known as bond.

The wheel may consist of one piece or segments of abrasive
blocks built up to a solid wheel.

Abrasives

An abrasives are hard, tough, sharp edge and resistance
to fracture used for cutting other materials.

There are two types of abrasives

Natural abrasive

Artificial abrasive

Natural abrasives

The natural abrasives are emery, corundum, sandstone or
solid quartz and diamond.

Emery is a natural aluminium oxide. It contains aluminium
iron oxide and other impurities.

Corundum also natural aluminium oxide it contains upto
95% and remainder is impurities.

Sand stone or quartz is one of the natural abrasive stones
from which grind stones are shaped.

Diamond is less than quality of gem are crushed to
produce abrasive grains for making grinding wheels and
lapping compound.

Artificial abrasive

The artificial abrasive are silicon carbide and aluminium
oxide.

Silicon carbide (SiC)

Silicon carbide abrasives are manufactured from silica
sand. Silicon carbide is hard and brittle. It is used for
grinding low tensile material like brass, copper, grey cast
iron, aluminium. Silicon carbide is represented by letter
‘S’.

Aluminium oxide (AI
2
O

3
)

This is manufactured from mineral bauxite. Aluminium
oxide is tough and less brittle. It is used for grinding high
tensile strength material like steels. Carbon steels,
malleable iron, high speed steel and wrought iron.
Aluminium oxide is represented letter ‘A’.

The abrasives are selected depending upon the material
being ground.

‘Green’ silicon carbide is used for very hard materials with
low tensile strength such as cemented carbides.

‘Brown’ aluminium oxide is used for general purpose
grinding of tough materials.

Aluminium oxide is used for grinding die steels.

Grain size (Grit size) (Fig 1)
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Alphate letters are used to indicate the grade of wheel

A to H - Soft

I to P - Medium

Q to Z - Hard

Structure (Fig 3)

This indicates the amount of bond present between the
individual abrasive grains, and the closeness of the
individual grains to each other. An open structured wheel
will cut more freely. That is, it will remove more metal in a
given time and produce less heat. It will not produce such
a good finish as a close structured wheel.

Bond

The bond is the substance which, when mixed with abrasive
grains, holds them together, enabling the mixture to be
shaped to the form of the wheel, and after suitable treatment
to take on the form of the wheel and the necessary
mechanical strength for its work. The degree of hardness
possessed by the bond is called the ‘grade’ of the wheel,
and this indicates the ability of the bond to hold of bonding
materials used for making wheels.

Types of bonds and their uses

Vetrified bond (V)

This is the most widely used bond. It has high porosity
and strength which makes this type of wheel suitable for
high rate of stock removal. It is not adversely affected by
water, acid, oils at ordinary temperature conditions.

Silicate bond (S)

Silicate wheels have a milder action and cut with less
harshness than vitrified wheels. For this reason they are
suitable for grinding fine edge tools, cutlery etc. This bond
is used for making large dia grinding wheels.

Shellac bond (E)

This is used for heavy duty, large diameter wheels where
a fine finish is required. For example, the grinding of mill
rolls.

Rubber bond (R)

This is used where a small degree of flexibility is required
on the wheel as in the cutting of the cutting off wheels.

Resinoid bond (B)

This is used for high speed wheels. Such wheels are used
in foundries for dressing castings. Resinoid bond wheels
are also used for cutting off parts. They are strong enough
to withstand considerable abuse.

Oxychloride bond (O)

The abrasive grains are mixed with magnesium chloride
and magnesium oxide. This bond is used for making disc
shaped wheels.

The bond ensures a cool cutting action so best for dry
grinding operation. This bond is used for making segmented
wheels.The structure is specified by number from 1 to 15.1 is

indicating dense structure 15 indicates most wider
structure. 1 to 8 dense and 9 to 15 and above indicates
open structure.

Open structure wheel is used for grinding soft tough and
ductile metal and used rough grinding.

A closed structure wheel is used for finish grinding of hard
and brittle metal.
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CG & M Related Theory for Exercise 1.6.81
Tool & Die Maker (Dies & Moulds) - AutoCAD & Pro - E

AutoCAD of its screen components
Objectives: At the end of this lesson you shall be able to
• brief the methods of starting and existing AutoCAD drawing
• explain the various screen components in AutoCAD
• describe the setting of unit of areas in AutoCAD
• state what s Auto CAD and its uses.

The computer aided drafting

Starting around the mid 1970s, as computer aided design
systems began to provide more capability than just an
ability to reproduce manual drafting with electronic drafting,
the cost benefit for companies to switch to CAD became
apparent. The benefit of CAD systems over manual drafting
are the capabilities one often takes for granted from
computer systems today; automated generation of Bill of
Material, auto layout in integrated circuits, interference
checking, and many others. Eventually CAD provided the
designer with the ability to perform engineering calculations.
During this transition, calculations were still performed
either by hand or by those individuals that could run
computer programs. CAD was a revolutionary change in
the engineering industry, where draftsmen, designers and
engineering roles begin to merge. It did not eliminate
departments, as much as it merged departments and
empowered draftsman, designers and engineers. CAD is
just another example of the pervasive effect computers
were beginning to have on industry.

Current computer-aided design software packages range
from 2D vector-based drafting systems to 3D solid and
surface modelers. Modern CAD packages can also
frequently allow rotations in three dimensions, allowing
viewing of a designed object from any desired angle, even
from the inside looking out. Some CAD software is capable
of dynamic mathematical modeling, in which case it may
be marketed as CADD.

CAD is used in the design of tools and machinery and in the
drafting and design of all types of buildings, from small
residential types (houses) to the largest commercial and
industrial structures (hospitals and factories).

 CAD is mainly used for detailed engineering of 3D models
and/or 2D drawings of physical components, but it is also
used throughout the engineering process from conceptual
design and layout of products, through strength and
dynamic analysis of assemblies to definition of
manufacturing methods of components. It can also be
used to design objects. Furthermore many CAD applications
now offer advanced rendering and animation capabilities so
engineers can better visualize their product designs. CAD
has become an especially important technology within the
scope of computer-aided technologies, with benefits such
as lower product development costs and a greatly shortened
design cycle. CAD enables designers to layout and develop
work on screen, print it out and save it for future editing,
saving time on their drawings

The AutoCAD

AutoCAD is a Computer Aided Design (CAD) program
used by just about every Engineering and Design office in
the world. Although there are alternative CAD packages,
AutoCAD is by far the most widely used system. Autodesk's
AutoCAD is the industry leader in CAD package used by
Civil Engineers, Architects, Mechanical & Electrical
Engineers, Aeronautical Engineers plus many other
disciplines.There have been several versions of AutoCAD
over the years, with each new version introducing new and
more powerful features than its predecessor.

Advantages Of Using Computer Aided Design (CAD)
Over Manual Drafting

Draw to Scale

The advantages of CAD include: the ability to producing
very accurate designs; Drawings can be created in 2D or
3D and rotated; other computer programmes can be linked
to the design software. With manual drafting, you must
determine the scale of a view before you start drawing. This
scale compares the size of the actual object to the size of
the model drawn on paper. With CAD, you first decide what
units of measurement you will use, and then draw your
model at 1:1 scale.

Lay Out The Drawing

When you draft manually, you first select a sheet, which
usually includes a pre-printed border and title block. Then
you determine the location for views' plans, elevations,
sections, and details. Finally, you start to draw. With CAD,
you first draw your design, or model, in a working
environment called model space. You can then create a
layout for that model in an environment called paper space.
A layout represents a drawing sheet. It typically contains
a border, title block, dimensions, general notes, and one or
more views of the model displayed in layout viewports.
Layout viewports are areas, similar to picture frames or
windows, through which you can see your model. You
scale the views in viewports by zooming in or out.

Organize Drawing Information

With manual drafting, you can separate information onto
individual transparent overlays. For example, a building
plan might contain separate overlays for its structural,
electrical, and plumbing components. With CAD, layers
are equivalent to transparent overlays. As with overlays,
you can display, edit, and print layers separately or in
combination. You can name layers to help track content,
and lock layers so they can't be altered. Assigning settings
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such as color, linetype, or lineweight to layers helps you
comply with industry standards. You can also use layers
to organize drawing objects for plotting. Assigning a plot
style to a layer makes all the objects drawn on that layer
plot in a similar manner.

Establish Drafting Standards

Manual drafting requires meticulous accuracy in drawing
linetypes, lineweights, text, dimensions, and more.
Standards must be established in the beginning and
applied consistently. With CAD, you can ensure conformity
to industry or company standards by creating styles that
you can apply consistently. You can create styles for text,
dimensions, and linetypes. A text style, for example,
establishes font and format characteristics such as height,
width, and slant. You can save styles, layers, layouts, title
block and border information, and some command settings
in drawing template files. Using drawing templates helps
you quickly start new drawings that conform to standards.

Draw Efficiently

With manual drafting, you use drawing tools that include
pencils, scales, compasses, parallel rules, templates, and
erasers. Repetitive drawing and editing tasks must be done
manually. In CAD, you can choose from a variety of drawing
tools that create lines, circles, spline curves, and more.
You can easily move, copy, offset, rotate, and mirror
objects. You can also copy objects between open drawings.

Draw Accurately

With manual drafting, you must draw objects carefully to
ensure correct size and alignment. Objects drawn to scale
must be manually verified and dimensioned. With CAD,
you can use several methods to obtain exact dimensions.
The simplest method is to locate points by snapping to an
interval on a rectangular grid. Another method is to specify
exact coordinates. Coordinates specify a drawing location
by indicating a point along an X and Y axis or a distance and
angle from another point. With object snaps, you can snap
to locations on existing objects, such as an endpoint of an
arc, the midpoint of a line, or the center point of a circle.
With polar tracking, you can snap to previously set angles
and specify distances along those angles.

View Your Drawing

With manual drafting, the size and resolution of your
drawing is fixed. With CAD, the size and resolution of your
drawing can be changed as needed. To do detailed work,
you can increase display size by zooming in. You can
zoom out to display more of the drawing. To move to
another section of a drawing, you pan the drawing without
changing magnification. You can zoom and pan to create
the best working conditions. This can be invaluable when
working on large and detailed drawings, such as this health
spa plan.

Create Dimensions and Text

With manual drafting, if you resize any part of the drawing,
you must erase and then redraw the dimensions. Changing
text can often involve relettering the whole drawing. With
CAD, you create associative dimensions and text on the

layout in paper space. Associative dimensions are tied to
the underlying model. Changes to the model automatically
update the dimension values. Standard types of dimensions
include linear, radial, ordinate, angular, baseline, and
more. You can easily revise the content, font, size,
spacing, and rotation of text in dimensions and notes.

Modify Your Drawing

Revisions are a part of any drawing project. Whether you
work on paper or with CAD, you will need to modify your
drawing in some way. On paper, you must erase and
redraw to make revisions to your drawing manually. CAD
eliminates tedious manual editing by providing a variety of
editing tools. If you need to copy all or part of an object, you
don't have to redraw it. If you need to remove an object, you
can erase it with a few clicks of the mouse. And if you make
an error, you can quickly undo your actions. Once you draw
an object, you never need to redraw it. You can modify
existing objects by mirroring, rotating, scaling, stretching,
trimming, and more. You can also change object properties,
such as linetype, lineweight, color, and layer, at any time.

Drawing Office Management

With computer aided drafting, the size of the drawing office
became considerably small. It increases the capacity of
storing and preserving of the drawing without damage for a
long time in less cost. Locating of drawing is easy task as
comparing to conventional method of drawing office
management

Starting Auto CAD

After you have installed Auto CAD, an AutoCAD icon is
displayed on the desktop. You can start AutoCAD by
double - licking on it. You can also start AutoCAD using the
start menu. To do so, choose the start button at the bottom
left corner of screen (default position); a menu will be
displayed (Fig 1). From this menu, choose programs>
Auto desk> AutoCAD - English > AutoCAD- English.

CG & M : TDM (Dies & Moulds) (NSQF - Revised 2022) - R .Theory for Ex. 1.6.81

Fig 1

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



260

When you start AutoCAD, the welcome window will be
displayed. In this window, various links are available
providing information on enhancements, new features,
products and services, subscription, and so on. The
information available in this window is in form of text and
videos. You can click on a  link to find information contained
in that link. For example, in the learn area, you can find
information about new features and enhancements of
AutoCAD. You can close the welcome widow (Fig 2) by
closing the close button from it.

toolsbars, model and layout tabs, and status bar. A title bar
that has Auto CAD symbol and the current drawing name
is displayed on top of the screen

Drawing area

The drawing area covers the major portion of the screen. In
this area, you can draw the objects and use the commands.
to draw the objects, you need to define the coordinate
points, which can be selected by using your pointing
device. The position of the pointing device is represented
on the screen by the cursor. The window also has the
standard windows buttons such as close, minimize, scroll
bar, and so on, on the top right corner. These buttons have
the same functions as for any other standard window.

Command window

The command window at the bottom of the drawing area
has the command prompt where you can enter the
comments. It also displays the subsequent prompt
sequences and the messages. You can change the size
of the window by placing the cursor on the top edge (double
line bar known as the grab bar) and then dragging. This way
you can increase its size to see all the previous comments
you have used. By default, the command window displays
only three lines. You can also press the F2 key to display
AutoCAD text window, which displays the previous
comments and prompts.

Fig 2

Auto CAD screen components (Fig 3)

Various components of the initial Auto CAD screen are
drawing area, command window, menu bar, several

View cube

View cube is available on the top right corner of the drawing
area and is used to switch between the standard and
isometric views or roll the current view. The view cube and
its options are discussed in later chapter.

Status bar (Fig 4)

The status bar is displayed at the bottom of the screed and
is called application status Bar. It contains some useful
information and buttons that make it easy to change the
status of some AutoCAD functions. You can toggle between
the on and off states of most of these functions by choosing
them.

Fig 2

Fig 3
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Drawing coordinates

The information about the coordinate is displayed on the
left - corner of the status bar. You can select this coordinate
button to toggle between the on and off states. The
COORDS system variable controls the type of display of
the coordinates. If the value of the COORDS variable is set
to 0, the coordinate display is static, that is, the coordinate
values displayed in the status bar change only when you
specify a point. If value of the COORDS variable is set to 1
or 2, the coordinate display is dynamic. When the variable
is set to 1, AutoCAD constantly displays the absolute
coordinates of the graphics cursor with respect to the UCS
origin. The polar coordinates (length < angle) are displayed
if you are in an AutoCAD command and the COORDS
variable is set to 2. By default, the COORDS variable is set
to 1. You can also click on the drawing coordinates area to
change the coordinate status from on to off and vice versa.

Infer constraints

If this button is chosen then some of the geometric
constraints will be automatically applied to sketch when it
is drawn. You can use CTRL + SHIFT+ I as a shortcut key
to toggle this button.

Snap mode

If the snap mode button is chosen, the snap mode is on.
So, you can  move the cursor in fixed increments. The F9
key acts as a toggle key to turn the snap off or on.

Grind display

In AutoCAD, the grid lines are used as reference lines to
draw objects. If the grid display button is chosen, the grid
display is on and the grid lines are displayed on the screen.
The F7 function key can be used to turn the grid display on
or off.

Ortho mode

If the ortho mode button is chosen, you can draw lines at
right angles only. You can use the F8 function key to turn
ortho on or off.

Polar tracking

If you turn the polar tracking on, the movement of the cursor
is restricted along a path based on the angles set as the
polar angle. Choose the polar tracking button to turn the
polar tracking on. you can also use the F10 function key to
turn on this option. Note that turning the polar tracking on,
automatically turns off the ortho mode.

Object snap

When the object snap button is chosen, you can use the
running object snaps to snap on to a point. You can also
use the F3 function key to turn the object snap on or off. The
status of OSNAP (off or on) does not prevent you from using
the immediate mode object snaps.

Object snap tracking

When you choose this button, the inferencing lines will be
displayed. Inferencing lines are dashed lines that are
displayed automatically when you select a sketching tool
and track a particular key point on the screen. Choosing
this button turns the object snap tracking on or off. You can
also use the F11 function key to turn the object snap
tracking on or off.

Allow/disallow dynamic UCS

Choosing this button allows or disallows the use of dynamic
UCS. Allowing the dynamic UCS ensures that the XY plane
of the UCS got dynamically aligned with the selected face
of the model. You can also use the F6 function key to turn
the dynamic UCS button on or off.

Dynamic input

The dynamic input button is used to turn the dynamic input
on or off. Turning it on facilitates the heads-up design
approach because all commands, prompts, and dimensional
inputs will now be displayed in the drawing area and you do
not need to look at the command prompt all the time. This
saves the design time and also increase the efficiency of
the use iff the dynamic input mode is turned on, you will be
allowed to enter the commands through the pointer inputs
boxes, and the numerical values through the dimensional
input boxes. You will also be allowed to select the
command options through the dynamic prompt options in
the graphics window. To turn the dynamic input on or off,
use the F12 key.

Show/ Hide line weight

Choosing this button in the status bar allows you to turn on
or off the display of line weight in the drawing. If this button
is not chosen, the display of line weight will be turned off.

Show/ Hide transparency

This button is available in the status bar and is choosen to
turn on or off the transparency set for a drawing. You can
set the transparency in the properties panel or in the layer
in which the sketch is drawn.

Fig 4
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Quick properties

If you select a sketched entity when this button is chosen
in the status bar, the properties of the selected entity will
be displayed in a panel. You can use CTRL + SHIFT + P
as shown as a shortcut key to toggle this button.

Selection cycling

When this button is chosen, you can cycle through the
objects to be selected, if they are overlapping or close to
other entities. On selecting an entity when this button is
chosen, the Selection list box with a list of the entities that
can be selected will be displayed. You can use
CTRL + W as a shortcut key to toggle this button.

Invoking tools in AutoCAD

On starting AutoCAD, when you are in the drawing area,
you need to invoke AutoCAD  tools to perform an operation.
For example, to draw a line, first you need to invoke line tool
and then define the start point and the endpoint of the line.
Similarly, if you want to erase objects, you must invoke the
erase tool and then select the objects for erasing. AutoCAD
has provided the following methods to invoke the commands.

1 Key board

2 Ribbon

3 Application menu

4 Tool palettes

5 Menu bar

6 Shortcut menu tool bar

Key board

You can invoke any AutoCAD command from the keyboard
by typing the command name and then pressing the Enter
key. As you type the first letter of command, AutoCAD

displays all available commands starting with the letter
typed. If the Dynamic input is on and the cursor is in the
drawing area, by default, the command will be entered
through the pointer input box. The pointer input box is a
small box displayed on the right of the cursor, as shown in
Fig 5. However, if the cursor is currently placed on any
toolbar or menu bar, or if the dynamic input if turned off, the
command will be entered through the command prompt.
Before you enter a command, the command prompt is
displayed as the last line in the command window area. If
it is not displayed, you must cancel the existing command
by pressing the ESC (Escape) key.

The following example shows how to invoke the line
command using the keyboard (Fig 5).

Fig 5

Ribbon

In AutoCAD, you can also invoke a tool from the Ribbon.
The tools for creating, modifying and annotating the 2D and
3D designs are available in the panels instead of being
spread out in the entire drawing area in different tool bars
and menus (Fig 6).

Fig 6

When you start the AutoCAD session for the first time, by
default the ribbon is displayed horizontally below the quick
access toolbar. The ribbon consists of various tabs. The
tabs have different panels, which in turn, have tools
arranged in rows. Some of the tools have small black down
arrow. This indicates that the tools having similar functions
are grouped together. To choose a tool, click on the down
arrow; a drop- down will be displayed. Choose the required
too from the drop- down displayed. Note that if you choose
a tool from the drop- down, the corresponding command
will be invoked and the tool that you have chosen will be
displayed in the panel. For example, to draw a circle using
the 2- point option, click on the down arrow next to the
center, radius tool in the draw panel of the home tab; a
flyout will be displayed. Choose the 2-point tool from the
flyout and then draw the circle. You will notice that the 2-
point tool is displayed in place of the center, radius tool. In
this textbook, the tool selection sequence will be written

as, choose the 2-point tool from home> draw> circle drop
-down. Choose the down arrow to expand the panel. You
will notice that a push pin is available at the left end of the
panel. Click on the push pin to keep the panel in the
expanded state. Also, some of the panels have an inclined
arrow at the lower- right corner. When you left click on
inclined arrow, a dialog box is displayed. You can define
the setting of the corresponding panel in the dialog box.

You can reorder the panels in the tab. To do so, press and
hold the left mouse button on the panel to be moved and
drag it to the required position. To undock the ribbon, right-
click on the blank space in the ribbon and choose the
undock option. You can move, resize, anchor, and auto -
hide the ribbon using the shortcut menu that will be
displayed when you right - click on the heading strip. To
anchor the floating ribbon to the left or right of the drawing
area in the vertical position, right- click on the heading strip

CG & M : TDM (Dies & Moulds) (NSQF - Revised 2022) - R .Theory for Ex. 1.6.81

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



263

of the floating ribbon; the shortcut menu is displayed.
Choose the corresponding option from this shortcut menu.
The auto - hide option will be hide the ribbon into the
heading strip and will display it only when you move the
cursor over this strip.

You can customize the display of tabs and panels in the
ribbon. To customize the ribbon, right-click on any one of
the tools in it; a shortcut menu will be displayed. On moving
the cursor over one of the options, a flyout will be displayed
with a tick mark before all options and the corresponding
tab or panel will be displayed in the ribbon. Select/ clear
appropriate option to display / hide a particular tab or panel.

Application menu

The application menu is available at top - left of the
AutoCAD window. It contains some of the tools that are
available in the standard toolbar. Click the down arrow on
the application menu to display the tools, as shown in
Fig 7. You can search for tools or commands by using the
search field on the top of the application menu. To search
a tool or command, enter its complete or partial name in the
search field; the list of related tools and commands will be
displayed. If you click on a tool from the list, the corresponding
command will get activated.

By default, the recent document button is chosen in the
application menu. Therefore, the recently opened drawings
will be listed. If you have opened multiple drawing files,
choose the open documents button; the documents that
are opened will be listed in the application menu. To set the
preferences of the file, choose the option button available
at the bottom right of the application menu. To exit
AutoCAD, choose the exit button next to the options
button.

Menu bar

You can also select commands from the menu bar. Menu
bar is not displayed by default. To display the menu bar,
click on the down arrow in the quick access toolbar, a flyout
is displayed. Select the show menu bar options from it; the
menu bar will be displayed. As you move the cursor over the
menu bar, different tabs are highlighted. You can choose
the desired item by left - clicking on it; the corresponding
menu is displayed directly under the title. For example, to
draw an ellipse using the center option.

Tool bar

Toolbars are not displayed by default. To display a toolbar,
choose the view tab in the Ribbon and click on Toolbars in
the User interface panel; a flyout will be displayed. Select
the required toolbar. Alternatively, display the menu bar
and then choose Tools > toolbars> AutoCAD from it; a list
of toolbars will be displayed. Select the required toolbar.
(Fig 8) shows the draw toolbar invoked.

Shortcut Menu

AutoCAD has provided shortcut menus as an easy and
convenient way of invoking the recently used tools. These
shortcut menus are context-sensitive, which means that
the tools present in them are dependent on the place/
object for which they are displayed at the cursor location.
You can right - click anywhere in the drawing area to
display the general shortcut menu. It generally contains an
option to select the previously invoked tool again, apart
from the common tools for windows, refer to Fig 9.

Fig 7

Fig 8
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Starting a new drawing (Fig 10)

Fig 9

Fig 10

You can open a new drawing using the new tool in the quick
access toolbar. When you invoke the new tool, by default
AutoCAD will display the select template dialog box, as
shown in Fig 11. This dialog box displays a list of default
templates available in AutoCAD. The default selected
template is acad.dwt, which starts the 2D drawing
environment. You can select the acad3D. dwl template to
start the 3D modeling environment. Alternatively, you can
select any other template to start new drawing that will use
the settings of the selected template. You can also open
any drawing without using any template either in metric or
imperial system. To do so, choose the down arrow on the
right of the open button and select the open with no
template - metric option or the open with no template -
imperial option from the flyout.

You can also open a drawing using the use a wizard and
start from scratch options from the create new drawing
dialog box. By default, this dialog box is not invoked. To
invoke the create new drawing dialog box, enter startup in
the command window and then enter 1 as the new value for
this system variable. After setting 1 as the new   value for
the system variable, whenever you invoke the new tool, the
create new drawing dialog box will be displayed, as shown
in Fig 12. The options in this dialog box are discussed next.

Open a drawing: By default, this option is not available.
This option will be available when you start a new session
of AutoCAD. This option is discussed later in this chapter.

Start from scratch

When you choose the start from scratch button, AutoCAD
provides you with options to start a new drawing that
contains the default AutoCAD setup for imperial (Acad.
Dwl) or metric drawings (Acadiso.dwl). If you select the
imperial default setting, the limits are 12X9, text height is
0.20, and dimensions and line types scale factors are 1.

Use a template

When you choose the use a template button in the create
new drawing dialog box, AutoCAD displays a list of
templates (Fig 13). The default template file is acad. Dwl or
acadiso. Dwl, depending on the installation. You can
directly start a new file in the 2D skating environment by
selecting the acad.dwl or acadiso.dwl template. If you use
a template file, the new drawing will have the same settings
as specified in the temple file.

Use a wizard

The use a wizard option allows you to set the initial drawing
settings before actually starting a new drawing. When you
choose the use a wizard button, AutoCAD provides you
with the option for using the quick setup or advanced setup
(Fig 14). In the quick setup, you can specify the units and
the limits of the work area. In the advanced setup, you can
set the units, limits, and the different types of settings for
a drawing.

Fig 11

Fig 12
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Fig 13

Fig 14

Advance setup

This option allows you to preselect the parameters of a new
drawing such as the units of linear and angular
measurements, type and direction of angular
measurements, approximate area desired for the drawing,
precision for displaying the units after decimal, and so on.
When you select the Advanced Setup wizard option from
the Create New Drawing dialog box and choose the OK
button, the Advanced Setup wizard is displayed. In the
wizard, the Units page is displayed by default, as shown in
Fig 15.

This page is used to set the units for measurement in the
current drawing. You can select the required unit of
measurement by selecting the respective radio button.
You will notice that the preview image is modified accordingly.
The different units of measurement you can choose from
are decimal, engineering, architectural, fractional, and
scientific. You can also set the precision for the
measurement units by selecting it from the precision drop-
down list.

Fig 15

selecting any one of these radio buttons as required. The
preview of the selected angular unit is displayed on the right
of the radio buttons (Fig 16).

This page is used to set the units for angular measurement
and its precision. The units for angle measurement are
decimal degrees, deg/min/sec, grads, radians, and
surveyor. The units for angle measurement can be set by

Fig 16

The next page is the angle measure page, as shown in
Fig 17. This page is used to select the direction of the
baseline from which the angles will be measured. You can
also set your own direction by selecting the other radio
button and then entering the value in its edit box.

Fig 17

Choose next to display the angle direction page (Fig 18) to
set the orientation for the angle measurement. By default,
the angles are positive, if measured in a counter clock wise
direction.

This is because the counter-clockwise radio button is
selected. If you selected the clockwise radio button, the
angles will be considered positive when measured in the
clockwise direction.

Fig 18

To set the limits of the drawing, choose the next button; the
area page will be displayed, as shown in Fig 19. You can
enter the width and length of the drawing area in the edit
boxes.

Quick setup

When you select the quick setup option and choose the ok
button, the quick setup wizard is displayed. This wizard
has two pages; units and area. The units page is opened
by default, as shown in Fig 20. The only difference is that
you cannot set the precision for the units in this wizard.
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Fig 19

Fig 20

Choose next to display the area page, as shown in Fig 21.
The area page of the quick setup is similar to that of the
advanced setup wizard. In this page, you can set the
drawing limits.

Fig 21

Tip: when you open an AutoCAD session, a drawing opens
automatically. But you can open a new drawing using
options such as start from scratch and use a wizard before
entering into AutoCAD environment using the startup
dialog box. As mentioned earlier, the display of the startup
dialog box is turned off by default. Refer to the section of
starting a new drawing to know how to turn on the display
of this dialog box.

Saving your work (Fig 22)

You must save your work before you exit the drawing editor
or turn off your system. Also, it is recommended that you
save your drawings in regular intervals, so that in the event
of a power failure on an editing error, all works saved before
the problem started will be retained.

AutoCAD has provided the Qsave, save as, and save
commands that allow you to save your work. These
commands allow you to save your drawing by writing it to
a permanent storage device, such as a hard drive or in any
removable drive.

When you choose save as from the application menu or
choose the save as tool from the quick access tool bar, the
save drawing as dialog box is displayed. Even if the drawing
has been saved with a file name, this tool gives you an
option to save it with a different file name. in addition to
saving the drawing, it sets the name of the current drawing
to the file name you specify, which is displayed in the title
bar. This tool is used when you want to save a previously
saved drawing with different file name. you can also use this
tool when you make certain changes to a template and
want to save the changed template drawing but leave the
original template unchanged.

File name edit box

To save your work, enter the name of the drawing in the file
name edit box typing the file name or selecting it from the
drop- down list. If you select the file name, it automatically
appears in the file name edit box. If you have already
assigned a name to the drawing, the current drawing name
is taken as the default name. if the drawing is unnamed, the
default name drawing / is displayed in the file name edit
box.

Closing a drawing

You can close the current drawing file without quitting
AutoCAD by choosing close> current drawing from the
application menu or by entering close at the command
prompt. If multiple drawing files are opened, choose close>
all drawings from the application menu. If you have not
saved the drawing after making the last changes to it and
you invoke the close command. AutoCAD displays a
dialog box that allows you to save the drawing before
closing. This box gives you an option to discard the current
drawing or the changes make to it. It also gives you an
option to cancel the command. After closing the drawing,
you are still in AutoCAD from where you can open a new
or an already saved drawing file. You can also the close
button (X) of the drawing area to close th drawing.

Opening an existing drawing using the drag and drop
method

You can also open an existing drawing in AutoCAD by
dragging it from the window explorer and dropping it into
AutoCAD. If you drop the selected drawing in the drawing
area, the drawing will be inserted as a block and as a result
you cannot modify it. But, if you drag the drawing from the
window explorer and drop ir any where other that the
drawing area, AutoCAD opens the selected drawing.

Fig 22
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Quitting Auto CAD

 You can exit the Auto CAD program by using the EXIT or
QUIT commands. Even if you have an active commands,
you can choose Exit Autodesk AutoCAD from the
Application Menu to quit the AutoCAD program. In Case
the drawing has not been saved, it allows you to save the

work first through a dialog box. Note that if you choose No
in this dialog box ,all the changes made in the current list
till the last save will be lost. You can also use the Close
button (X) of the main AutoCAD window (present in the title
bar) to end the AutoCAD session.

Drawing of 2D objects
Objectives: At the end of this lesson you shall be able to
• brief how to draw lines using the line command and its options
• explain various coordinate systems used in AutoCAD
• describe the erase commands to clear the drawing area, undo, redo and oops command
• brief the two basic object selection methods
• explain how to draw circles recatangles, polygon, ellipse, point using the options of the circle command.

Draw lines in AutoCAD

The most commonly used fundamental object in a drawing
is line. In AutoCAD, a line is drawn between two points by
using the line tool. You can invoke the line tool from the
draw panel of the home tab in the ribbon. Besides this, you
can choose the line tool from the draw tab of the tool
palettes. To invoke the tool palettes, choose the tool
palettes button from the palettes panel in the view tab.
Alternatively, you can invoke the line tool from the draw
tool. However, the draw toolbar is not displayed by default.
To invoke this toolbar, choose View > User Interface >
Toolbars > AutoCAD from the Ribbon. (Fig 1)

You can also invoke the line tool by entering line or L (L is
the alias for the Line command) at the command prompt.
On invoking the line tool, you will be prompted to specify the
starting point of the line. Specify a point by clicking the left
mouse button in the drawing area or by entering its
coordinates in the dynamic input fields or the command
prompt. After specifying the first point, you will be prompted
to specify the second point. Specify the second point; a
line will be drawn. You may continue specifying points and
draw lines or terminate the line tool by pressing ENTER,
ESC, or SPACEBAR. You can also right-click to display
the shortcut menu and then choose the enter or cancel
options from it to exit the line tool. (Fig 2)

Command: Line

Specify first point: Move the cursor (mouse) and left-click
to specify the first point.

Specify next point or [Undo]: Move and left-click to specify
the second point.

Specify next point or [Undo]: Specify the third point.

Specify next point or [Close/Undo]: (Press Enter to exit the
line command).

Note: that in the command prompt the close and undo
options will be displayed while creating line using the line
tool. Both these options are discussed next.

The close option (Fig 3)

After drawing two continuous lines by using the line tool,
you will notice that the close option is displayed at the
command prompt. The close option is used to join the
current point to the start point of the first line when two or
more continuous lines are drawn. If you are specifying the
endpoint by using the mouse, then click at the start point
of the first line or enter C at the command prompt, as given
in the command prompt below.

Choose the line tool

Line specify first point: Pick the first point.

Specify next point or [Undo]: Pick the second point.

Specify next point or [Undo]: Pick the third point.

Specify next point or [Close/Undo]: Pick the fourth point.

Specify next point or [Close/Undo]: (The fifth point joint with
the first point).

You can also choose the close option from the shortcut
menu, which appears when you right-click in the drawing
area.

Fig 1
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Now, draw a horizontal line intersecting the Y axis. The
vertical distance between the origin and the intersection
point will be the Y coordinate of P. It will be denoted as P(y).
The Y coordinate specifies how far the point is to the top or
bottom from the origin along the Y axis. The intersection
point of the horizontal and vertical lines is the coordinates
of the point and is denoted as P (x, y).  The X coordinate
is positive, if measured from the right of the origin and is
negative, if measured from the left of the origin. The Y
coordinate is positive, if measured above the origin and is
negative, if measured below the origin.

The undo option

While drawing a line, if you have specified a wrong endpoint
by mistake, then you can undo the last specified point and
go back to the previous stage by using the undo option of
the line tool. You can use this option multiple times. To use
this option, type undo (or just U) at the specify next point
or [Undo] prompt. You can also right-click to display the
shortcut menu and then choose the undo option from it.

Invoking tools using dynamic INPUT/Command Prompt

In AuotCAD, if you enter any alphabet at the command
prompt or dynamic input, all tools whose names start with
the entered alphabet will be displayed in a list at the
command prompt or dynamic input. For example, if you
enter L at the command prompt or dynamic input, all the
tools whose names start with the alphabet L will be
displayed, (Fig 4). In this way, you can view all the tool
names starting with a particular alphabet and select the
required tool.

Fig 4

Coordinate systems (Fig 5)

In AuotCAD, the location of a point is specified in terms of
Cartesian coordinates. In this system, each point in a
plane is specified by a pair of numerical coordinates. To
specify a point in a plane, take two mutually perpendicular
lines as references. The horizontal line is called the X axis,
and the vertical line is called the Y axis. The X and Y axes
divide the XY plane into four parts, generally known as
quadrants. The point of intersection of these two axes is
called the origin and the plane is called XY plane. The origin
has the coordinate values of X = 0, Y = 0. The origin is taken
as the reference for locating a point on the XY plane. Now,
to locate a point, say P, draw a vertical line intersecting the
X axis. The horizontal distance between the origin and the
intersection point will be called the X coordinate of P. It will
be denoted as P (x). The X coordinate specifies how far the
point is to the left or right from the origin along the X axis.

In AuotCAD, the default origin is located at the lower left
corner of the drawing area.

AuotCAD uses the following coordinate systems to locate
a point in an XY plane.

1 Absolute coordinates

2 Relative coordinates

3 Polar coordinates

4 Direct distance entry

If you are specifying a point by entering its location at the
command prompt then you need to use any one of the
coordinate system.

Absolute coordinate system (Fig 6)

In the absolute coordinate system, points are located with
respect so the origin (0,0). For example, a point with X = 5
and Y = 3 is measured 4 units horizontally (distance along
the X axis) and 3 units vertically (distance along the Y axis)
from the origin. In AuotCAD, the absolute coordinates are
specified at the command prompt by entering X and Y
coordinates, separated by a comma. Hoever, remember
that if you are specifying the coordinates by using the
dynamic input mode, you need to add # as the prefix to the
X coordinate value. For example, enter #1,1 in the dynamic
input boxes to use the absolute coordinate system. The
following example illustrates the use of absolute coordinates
at the command prompt to draw the rectangle.

In AuotCAD the absolute coordinates are specified by
entering X and Y coordinates, separated by the comma.
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Relative coordinate system (Fig 7)

In the relative coordinate system, the displacements along
the X and Y axes (DX and DY) are measured with reference
to the previous point rather than to the origin. In AuotCAD,
the relative coordinate system is designated by the symbol
@ and it should proceed any relative entry. The following
prompt sequence illustrates the use of the relative
rectangular coordinate system to draw a rectangle with the
lower left corner at the point (1,1). The length of the
rectangle is 4 units and the width is 3 units.

Remember that if dynamic input is on, you need a input a
comma (,) after entering the first value in the dynamic input
boxes. Else, AuotCAD LT will take coordinates in relative
polar form.

Sign conention: As mentioned, in the relative rectangular
coordinate system the displacements along the X and Y
axes are measured with respect to the previous point,
Imagine horizontal line and a vertical line passing through
the previous point so that you get four quadrants. If the new
point is located in the first quadrant, the displacements DX
and DY are both positive. If the new point is located in the
third quadrant, the displacements DX and DY are both
negative. In other words, up or right are positive and down
or left are negative.

Polar coordinates (Fig 8)

In the relative polar coordinate system, a point is located
by defining both the distance of the point from the current
point and the angle that the line between the two points
makes with the positive X axis. The prompt sequence to
draw a line from a point at 1,1 to a point at a distance of 5
units from the point (1, 1), and at an angle of 30-degree to
the X axis is given next.

Command: Line

Specify first point: 1, 1

Specify next point or [Undo]: @5<30

Sign convention. By default, in the relative polar coordinate
system, the angle is measured from the horizontal axis (3
'O' clock) as the zero-degree baseline. Also, the angle is
positive if measured in a counter clock wise direction and
negative if measured in a clockwise direction. Here, it is
assumed that the default setup of the angle measurement
has not been changed.

Direct distance entry (Fig 9)

The easiest way to draw a line in AuotCAD is by using the
direct distance entry method. Before drawing a line by
using this method, ensure that the dynamic input button is
chosen in the status bar. Next, choose the line tool; you will
be prompted to specify the start point. Enter the coordinate
values in the text box and press enter; you will be prompted
to specify the next point. Now, enter the absolute length of
the line and its angle with respect to the current position of
the cursor in the corresponding text boxes. Note that you
can use the TAB key to toggle between the text boxes. If
the ortho mode is on while drawing lines using this method.
You can position the cursor only along the X or Y axis.
Therefore, position the cursor at the desired angle, type the
length at the command prompt, and then press enter.

Choose the line tool.

Line specify first point: Start point

Specify next point or [Undo]: Position the cursor and then
enter distance.

Specify next point or [Undo]: Position the cursor and then
enter distance.
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Ortho mode (F8) method (Fig 10)

Erasing objects (Fig 11&12)

Sometimes, you may need to erase the unwanted objects
from the objects drawn. You can do so by using the erase
tool. This tool is used exactly the same way as an eraser
is used in manual drafting to delete the unwanted lines. To
erase an object, choose the erase tool from the modify
panel. You can also choose the erase button from the
modify toolbar. To invoke the modify toolbar, choose view
> User Interface > Toolbars > AutoCAD > Modify from the
ribbon. On invoking the erase tool, a small box, known as
pick box, replaces the screen cursor. To erase the object,
select it by using the pick box. The selected object will be
displayed in dashed lines and the select objects prompt
will be displayed again. You can either continue selecting
the objects or press enter to terminate the object selection
process and erase the selected objects. The prompt
sequence is given next.

If you enter All at the select objects prompt, all objects in
the drawing area will be selected, even if they are outside
the display area. Now, if you press enter, all the selected
objects will be erased.

To erase the objects, you can also first select the objects
to be erased from the drawing and then choose the erase
option from this shortcut menu that is displayed on right-
clicking in the drawing area.

Cancelling and undoing a operation (Fig 13)

If you are in a command and you want to cancel or get out
of it, press the ESC (Escape) key on the keyboard.

Command: Erase

Select objects: Press ESC (Escape) to cancel the command

Similarly, sometimes you unintentionally erase some
object from the screen. When you discover such an error,
you can correct it by restoring the erased object by means
of the oops command. The oops command restores object
that have been accidentally erased by the previous erase
command. You can also use the U (Undo) command to
undo the last command.

Command: Oops (Restores erased objects)

Command: U (Undoes the last command)

Object selection methods

The usual method to select objects is by selecting them
individually. But it will be time consuming, if you have a
number of objects to select. This problem can be solved by
creating a selection set that enables you to select several
objects at a time. The selection set options can be used
with those tools that required object selection, such as
erase and move. There are many object selection methods,
such as Last, Add, Window, Crossing, and so on. Here you
will learn two methods: Window and Crossing.
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after invoking a tool, type C at the select objects prompt
and press enter; you will be prompted to select the first
corner of the window. Select the first corner and then move
the cursor to specify the opposite corner. As you move the
cursor, a green color window with dashed outline is
displayed. Specify the opposite corner of the window; the
objects that touch the window boundaries and the objects
that are enclosed by the window are selected and displayed
as dashed objects. Fig 15 shows a window drawn to select
objects by using the window crossing method. The objects
that will be selected are shown in dashed lines.

Window selection (Fig 14)

The window selection is one of the selection methods in
which an object or group of objects are selected by drawing
a window. The objects that are completely enclosed within
the window are selected and the objects that lie partially
inside the boundaries of the window are not selected. To
select the objects by using the window option after invoking
a tool, type W at the select objects prompt and press
Enter; you will be prompted to specify the first corner of the
window. Select the first corner and then move the cursor to
specify the opposite corner. As you move the cursor, a blue
color window of continuous line will be displayed. The size
of this window changes as you move the cursor. Specify
the opposite corner of the window; the objects that are
enclosed in this window are displayed as dashed objects.
Figure 13 show the window drawn to select by using the
window option. The objects that will be selected are shown
in dashed lines.

You can also invoke the window option without entering W
at the command prompt. To do so, specify a point on the
screen at the select objects prompt. This is considered as
the first corner of the window. Moving the cursor to the right
will display a blue-shaded window. After enclosing the
required objects, specify the other corner of the window.
The objects that are completely enclosed within the
window will be selected and displayed in dashed lines. The
following is the prompt sequence for automatic window
after invoking the erase tool:

Select objects: Select a blank point as the first corner of the
window

Specify opposite corner: Drag the cursor to the right to
select the other corner of the window.

Select objects: Enter

Window crossing method (Fig 15)

The window crossing selection is one of the selection
methods in which an object or group of objects that are
completely or partially enclosed by the selection window
are selected. The objects to be selected should touch the
window boundaries or completely enclosed within it. To
select the objects by using the window crossing method

You can also invoke the window crossing method without
entering C at the command prompt. To do so, specify a
point in the drawing area at the select objects prompt and
move the cursor to the left. As you move the cursor, a green
color window with dashed outline will be displayed. Specify
the opposite corner of the window; the objects touching the
window boundary and that are enclosed within this window
are selected and displayed as dashed objects. The prompt
sequence for the automatic window crossing method when
you choose the erase tool is given next.

If you do not invoke any tool and click to specify the first
corner of the window for window selection or window
crossing, the command prompt provides you with three
selection options: Fence, Wpolygon, and Cpolygon. If you
enter fence or F at the command prompt, you can select
objects by drawing a fence around them. If you enter WP
at the command prompt, you can select objects by drawing
a polygon around them. If you enter CP at the command
prompt, you can select objects by drawing a polygon
around them.

Draw a circle (Fig 16)

A circle is drawn by using the circle tool. In AutoCAD, you
can draw a circle by using six different tools. All these tools
are grouped together in the draw panel of the ribbon. To view
these tools, choose the down arrow next to the center,
radius tool in the draw panel. All tools will be listed in a drop-
down. Note that the name of the tool chosen last will be
displayed in the draw panel.
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Drawing a circle by specifying two points (Fig 19)

Ribbon; Home > Draw > Circle drop-down > 2-point
command: Circle or C > 2P you can also draw a circle by
specifying its two diametrical ends. To do so, first ensure
that the dynamic input button is chosen, and then choose
the 2-point tool from the draw panel; you will be prompted
to specify the first end of the diameter. Type the coordinates
and press enter or specify the center by using the left
mouse button. After specifying the center of the circle,
move the cursor to define its diameter. Now, you can type
the coordinates or diameter in the dimension input box.

Fig 16

Draw a circle by specifying center and radius (Fig 17)

To draw a circle of specifying its center and radius first
ensure that the dynamic input button is choosen, and then
choose the center, radius tool from the draw panel; you will
be prompted to specify the center of the circle. Type the
coordinates and press enter or specify the center by using
the left mouse button. After specifying the center of the
circle, move the cursor to define its radius; the current
radius of the circle will be displayed in the dimension input
box. This radius value will change as you move the cursor.
Type a radius value in the dimension input box or click to
define the radius; the radius; a circle of the specified radius
value will be drawn.

Drawing a circle by specifying center and diameter
(Fig 18)

To draw a circle by specifying its center and diameter, first
ensure that the dynamic input button is chosen and then
choose the center, diameter tool too from the draw panel;
you will be prompted to specify the center. Type the
coordinates and press enter or specify the center by using
the left mouse button. After specifying the center of the
circle, move the cursor to define its diameter; the current
diameter of the circle will be displayed in the dimension
input box. This diameter value will change as you move the
cursor. Type a diameter value in the dimension input box
or click to define the diameter; a circle of the specified
diameter value will be drawn.

Drawing a circle by specifying three points on a circle
(Fig 20)

To draw a circle by specifying three points on its periphery,
choose the 3-point tool from the draw panel and specify the
three points in succession. You can type the coordinates
of the points or specify them by using the left mouse button.
The prompt sequence to type the three coordinates on
choosing the 3-point tool is given below.

Specify center point for circle or [3P/2P/Ttr (tan tan
radius)]:3p

Specify first point on circle: 30, 30

Specify second point on circle: 30, 10

Specify third point on circle: 40, 20
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Drawing a circle tangent to two objects (Fig 21)

An object (line, circle, or arc) is said to be tangent to a circle
or an arc, if it touches the circumference of the circle or the
arc at only one point. To draw a circle that has specified
radius and is tangent to two objects, first ensure that the
dynamic input button is chosen, and then choose the tan,
tan, radius tool from the draw panel; you will be prompted
to specify a point on the first object to be tangent to the
circle. Move the cursor near the object to be made tangent
to the circle; a tangent symbol will be displayed. Specify
the first point; you will be prompted to specify a point on the
second object to be made tangent to the circle. Move the
cursor near the second object that is to be tangent to the
circle; a tangent symbol will be displayed. Specify the
second point; you will be prompted to specify the radius.
Type the radius value in the dimension input box and press
enter; a circle of the specified radius and tangent to two
specified objects will be drawn. In figure the dotted circle
represents the circle that is tangent to two objects. The
circle actually drawn depends on how you select the
objects to be made tangent to the new circle. The figures
show the effect of selecting different points on the objects.
If you specify too small or large radius; you may get
unexpected results or the @circle does not exit@ prompt.

Drawing arcs (Fig 22)

An arc is defined as a part of a circle. In AutoCAD LT, it can
be drawn using the Arc command. You can invoke the arc
command from the draw toolbar; AutoCAD provides eleven
different options to draw an arc. The default option for
drawing an arc is the 3-point option. Other options can be
invoked by entering the appropriate letter in the command
window or by right-clicking and choosing the appropriate
option from the fly out. The option that was used last will be
displayed in the draw panel. The various options to draw the
arcs are discussed.

Draw arcs by specifying start, center, and end (Fig 23)

You can create an arc using a start point, center, and a third
point that determines the endpoint. The distance between
the start point and the center determines the radius. The
endpoint is determined by a line from the center that
passes through the third point.

Using different options, you can specify either the start
point first or the center point first.

Fig 22

Draw arcs by specifying start, center, angle (Fig 24)

You can create an arc using a start point, center, and an
included angle.

The distance between the start point and the center
determines the radius. The other end of the arc is determined
by specifying an included angle that uses the center of the
arc as the vertex.

Using different options, you can specify either the start
point first or the center point first.

The included angle determines the endpoint of the arc. Use
the start , end, angle method when you know both
endpoints but cannot snap to a center point.

Draw arcs by specifying start, center, length (Fig 25)

You can create an arc using a start point, center, and the
length of a chord. The distance between the start point and
the center determines the radius. The other end of the arc
is determined by specifying the length of a chord between
the start point and the endpoint of the arc. Using different
options, you can specify either the start point first or the
center point first.
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Draw arcs by specifying start, end, radius (Fig 26)

You can create an arc using a start point, endpoint, and a
radius

The direction of the bulge of the arc is determined by the
order in which you specify its endpoints. You can specify
the radius either by entering it or by specifying a point at the
desired radius distance.

The continue option

With the option, you can continue drawing an arc from a
previously drawn arc or line. Continue from the draw menu
the start point and direction of the arc will be taken from the
endpoint and ending direction of the previous line or arc.
When this option is used to draw arcs, each successive arc
will be tangent to the previous one. Most often, this option
is used to draw arcs tangent to a previously drawn line.

Drawing rectangles (Fig 27)

A rectangle is drawn by choosing the rectangle tool see Fig
26, from the draw panel. In AutoCAD, you can draw
rectangles by specifying two opposite corners of the
rectangle, by specifying the area and the size of one of the
sides, or by specifying the dimensions of the rectangle. All
these methods of drawing rectangles are discussed next.

Fig 27

Drawing rectangles of specifying two opposite corners

On invoking the rectangle tool, you will be prompted to
specify the first corner of the rectangle. Enter the
coordinates of the first corner or specify the start point by
using the mouse. The first corner can be any one of the four
corners. Next, you will be prompted to specify the other
corner. Specify the diagonally opposite corner by entering
the coordinates or by using the left mouse button, as
shown in Fig 28.
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Drawing rectangles by specifying the area and one
side

To draw a rectangle by specifying its area and the length
of one of the sides , first specify the start point. Next,
invoke the shortcut menu by right-clicking and then
choose the area option. Next, specify the parameters; the
rectangle is drawn. Following is the prompt sequence to
draw a rectangle whose start point is at 3, 3 has area 15
units, and length 5 units:

Choose the rectangle tool from the draw panel.

Specify first corner point or [Chamfer/Elecvation/Fillet/
Thickness/Width]: 3, 3

specify other corner point or ]Area/Dimensions/Rotation]:
A

Enter area of rectangle in current units <100.000>:15

Calculate rectangle dimensions based on [Length/Width]
<Length>: L

Enter rectangle length <10.0000>:5

In the above case, the area and length of the rectangle
were entered. The system automatically calculates the
width of the rectangle by using the following formula:

Area of rectangle = Length x Width

Width = Area of rectangle/Length

Width = 15/5

Width = 3 units

Drawing rectangles by specifying their dimensions

You can also draw a rectangle by specifying its
dimensions. This can be done by choosing the dimensions
option from the shortcut menu at the specify other corner
point or [Area/Dimensions/Rotation] prompt and entering
the length and width of the rectangle. The prompt sequence
for drawing a rectangle at 3, 3 with a length of 5 units and
width of 3 units is given next.

Choose the rectangle tool from the draw panel.

Specify first corner point or [chamfer/Elevation/Fillet/
Thickness/Width]: 3, 3

Specify other corner point or [Area/Dimensions/Rotation]:
D

Specify length for rectangles <0.0000>:5

Specify width for rectangles <0.0000>:3

Specify other corner point or [Area/Dimensions/Rotation]:
click on the screen to specify the orientation of rectangle.

Here, you are allowed to choose any one of the four
locations for placing the rectangle. You can move the
cursor to see the four quadrants. Depending on the location
of the cursor, the corner point that is specified first holds the
position of either the lower left corner, the lower right corner,
the upper right corner, or the upper left corner. After
deciding the position, you can click to place the rectangle.

Drawing rectangle at an angle (Fig 29)

You can also draw a rectangle at an angle. This can be
done by choosing the rotate option from the shortcut menu,
at the specify other corner point or [Area/Dimensions/
Rotation] prompt and entering the rotation angle. After
entering the rotation angle, you can continue sizing the
rectangle using any one of the above discussed methods.
The prompt sequence for drawing a rectangle at an angle
of 45-degree is:

Choose the rectangle tool from the draw panel

Specify first corner point or [Chamfer/Elevation/Fillet/
Thickness/Width]: Select a point as lower left corner
location.

Specify other corner point or [Area/Dimensions/Rotation]:
R

Specify rotation angle or [Pick points] <current>: 45

Specify other corner point or [Area/Dimensions/Rotation]:
Select a diagonally opposite point

While specifying the other corner point, you can place the
rectangle in any of the four quadrants. Move the cursor in
different quadrants and then select a point in the quadrant
in which you need to draw the rectangle. Fig 29 shows a
rectangle drawn at an angle of 45 degree.

You can also set some of the parameters of a rectangle
before specifying the start point. These parameters are the
options in the command prompt and are discussed next.

Chamfer

The chamfer option is used to create a chamfer, which is
an angled corner, by specifying the chamfer distances, see
Fig 30. The chamfer is created at all four corners. You can
give two different chamfer values to create an unequal
chamfer.
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Choose the rectangle tool from the draw panel.

Specify first corner point or [Chamfer/Elevation/Fillet/
Thickness/Width]: C

Specify first chamfer distance for rectangles <0.0000>:
Enter a value, d1.

Specify second chamfer distance for rectangles <0.0000>:
Enter a value, d2.

Specify first corner point or [Chamfer /Elevation/Fillet/
Thickness/Width]: Select a point as lower left corner.

Specify other corner point or [Area/Dimensions/Rotation]:
Select a point as upper right corner.

Fillets (Fig 30)

The fillet option is used to create a filleted rectangle, see
figure. You can specify the required fillet radius. The
following is the prompt sequence for specifying the fillet:

Choose the Rectangle tool from the Draw panel

Specify first corner point or [Chamfer/Elevation/Fillet/
Thickness/Width]: F

Specify fillet radius for rectangles <0.0000>: Enter a value.

Specify first corner point or [Chamfer/Elevation/Fillet/
Thickness/Width]: Select a point as lower left corner.

Specify other corner point or [Area/Dimensions/Rotation]:
Select a point as upper right corner.

Width

The width option is used to create a rectangle whose line
segments have some specified width, as shown in Fig 31.

Specify first corner point or [Chamfer/Elevation/Fillet/
Thickness/Width]: W

Specify line width for rectangles <0.0000>: Enter a value

Drawing ellipses

Ribbon: Home > Draw > Ellipse drop-down Toolbar: Draw
> Ellipse Tool palettes: Draw > Ellipse command: Ellipse

If you cut a cone by a cutting plane at an angle and view the
cone perpendicular to the cutting plane, the shape created
is called an ellipse. An ellipse can be created by using
different tools available in the ellipse drop-down of the draw
panel, refer to Fig 32. In AutoCAD, you can create a true
ellipse, also known as a NURBS-based (Non-Uniform

rational Bezier spline) ellipse. A true ellipse has center and
quadrant points. If you select it, grips (small blue squares)
will be displayed at the center and quadrant points of the
ellipse. If you move one of the grips located on the perimeter
of the ellipse, the size of the ellipse will be change.

Drawing ellipse using the center option

To draw an ellipse by specifying its center point, endpoint
of one axis, and length of other axis, chooses the center
tool from the draw panel; you will be prompted to specify the
center of the ellipse. The center of an ellipse is defined as
the point of intersection of the major and minor axes.
Specify the center point or enter coordinates; you will be
prompted to specify the endpoint. Specify the endpoint of
the major or minor axis; you will be prompted to specify the
distance of the other axis. Specify the distance; the ellipse
will be draw.

After specifying the endpoint of one axis, you can enter R
at the specify distance to other axis or [Rotation] prompt
to specify the rotation angle around the major axis. In this
case, the first axis specified is considered as the major
axis. On specifying the rotation angle, the ellipse will be
drawn at an angle with respect to the major axis. Note that
the rotation angle should range between 0 and 89.4 -
degree. Fig 32 shows the ellipse created at different
rotation angles.
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Drawing an ellipse by specifying its axis and endpoint

To draw the ellipse by specifying one of its axes and the
endpoint of the other axis, choose the axis, end tool from
the draw panel; you will be prompted to specify the axis end
point. Specify the first endpoint of one axis of the ellipse;
you will be prompted to specify the other endpoint of the
axis. Specify the other endpoint of the axis. Now, you can
specify the distance to other axis from the center or specify
the rotation the specified axis.

Fig 33 shows and ellipse with one endpoint of the axis
located at (3, 3), the other at (6, 3), and the distance to the
other axis as 1 unit. Fig 34 shown an ellipse with one
endpoint of the axis located at (3, 3), the other at (4, 2), and
the distance to the other axis as 2 units.

Drawing regular polygons

A regular polygon is a closed geometric entity with equal
sides. The number of sides of a polygon varies from 3 to
1024. For example, a triangle is a three-sided polygon and
a pentagon is a five-sided polygon. To draw a regular 2D
polygon, choose the polygon tool from the draw panel; you
will be prompted to specify the number of sides. Type the
number of sides and press enter. Now, you can draw the
polygon by specifying the length of an edge or by specifying
the center of the polygon. Both these methods are discussed
next.

Drawing a polygon by specifying the center of polygon

After you specify the number of sides and press enter, you
will be prompted to specify the center of polygon.  Specify
the center point; you will be prompted to specify whether
the polygon to be drawn is inscribed in a circle or
circumscribed about an imaginary circle. A polygon is said
to be inscribed when it is drawn inside an imaginary circle
such that the vertices of the polygon touch the circle,
(Fig 35) whereas, a polygon is said to be circumscribed
when it is drawn outside the imaginary circle such that the
sides of the polygon are tangent to the circle, (Fig 36).

Drawing a polygon by specifying and edge

To draw a polygon by specifying the length of an edge, you
need to type E at the specify center of polygon or [Edge]
command prompt and press Enter, Next, specify the first
and second endpoints of the  edge in succession; the
polygon will be drawn in counter clockwise direction, as
shown in Fig 37.
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Placing points

A point is one of the basic drawing objects and is specified
as a dot (a period). A point is defined as a geometric object
that has no dimension and properties, except location.
However, in AutoCAD, you can control the size and
appearance (style) of a point. You will first learn to change
the point style and size and then about various methods to
place a point..

Changing the point style and point size

The point style and size can be set from the Point Style
dialog box shown in Fig 38 There are twenty combinations
of point types. Choose Format > Point Style from the Menu
Browser; the Point Style dialog box will be invoked you can
choose a point style in this dialog box, which is indicated
by highlighting that particular point style. Next, choose the
OK button. Now all the points will be drawn in the selected
style, until you change it to a new style. The type of point
drawn is stored in the PDMODE (Point Display MODE)
system variable. You can change the point style by
entering a numeric value in the PDMODE variable. Fig 39
shows the PDMODE Values for different point type areas.

Fig 38

Fig 39

Function keys
Objective: At the end of this lesson you shall be able to
• describe various functional key in AutoCAD.

Function and control keys

You can also use the function and control keys to change
the status of the coordinate display, Snap, Ortho, Osnap,
tablet, screen, isometric planes, running Object Snap,
Grid, Polar, and Object tracking. Some of the keys can be
used in drafting settings. The following is a list of function
Table 1 and control keys.

Table 1

Key Description

Fl Help

F2 Graphics Screen/AutoCAD Text Window

F3 Osnap On/Off (CTRL+F)

F4 3D Snap On/Off

F5 Isoplane top/right/left (CTRL+E)

F6 Dynamic UCS On/Off

F7 Grid On/Off (CTRL+G)

F8 Ortho On/Off (CTRL+L)

F9 Snap On/Off (CTRL+B)

F10 Polar tracking On/Off

F11 Object Snap tracking

FI2 Dynamic Input On/Off
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Help (Fl)

To display Help for a menu, open the menu, and then press
Fl. Pressing F1 or entering 'help while a command is active

displays Help for that command. Choosing the Help button
in a dialog box displays Help for that dialog box.(Fig 1)

Graphics Screen/AutoCAD Text Window (F2)

Whenever, you want to view the command inputs and its
steps, press F2 to display the text window. The Text
window is displayed in front of the AUTOCAD drawing area.
Similarly, use the TEXTSCR command to switch from the
drawing area to text window. (Fig 2)

Osnap On/Off (F3):Using object snaps is a quick way to
locate an exact position on an object without having to
know the coordinate or draw construction lines. For
example, you can use an object snap to draw a line to the
center of a circle or to the midpoint of a polyline segment.
You can specify an object snap whenever you are prompted
for a point. You can use an object snap once in the middle
of a command, or you can set running object snaps.

Fig 1

Fig 2

Fig 3
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3D Object Snap (F4)

Object snaps function the same way in 3D as they do in 2D
with the exception that they can optionally be projected.By
default, the Z-value of an object snap location is determined
by the object's 3D location. However, if you work with object
snaps on the plan or top view of a 3D model, a constant Z-
value is more useful.

If you turn on the OSNAPZ system variable, all object
snaps are projected onto the XYplane of the current UCS
or, if ELEV is set to a non-zero value, onto a plane parallel
to XY plane at the specified elevation.

Note: When you create or modify objects, make sure that
you know whether OSNAPZ is turned on or off. There is no
visual reminder, and you can get unexpected results.

Isoplane top/right/left (F5) (Fig 4)

The isometric plane affects the cursor movement keys only
when Snap mode is on and the snap style is Isometric. If
the snap style is Isometric, Ortho mode uses the appropriate
axis pair even if Snap mode is off. The current isometric
plane also determines the orientation of isometric circles
drawn by ELLIPSE. You can cycle through the isometric
planes by pressing F5.

Isometric drawings simulate a 3D object from a particular
viewpoint by aligning along three major axes. By setting the
Isometric Snap/Grid, you can easily align objects along
one of three isometric planes; however, although the
isometric drawing appears to be 3D, it is actually a 2D
representation. Therefore, you cannot expect to extract 3D
distances and areas, display objects from different

Left: Aligns snap and grid along 90- and 150-degree axes.

Top: Aligns snap and grid along 30- and 150-degree axes.

Right: Aligns snap and grid along 30- and 90-degree axes

Choosing one of the three isometric planes causes Ortho
and the crosshairs to be aligned along the corresponding
isometric axes. For example, when Ortho is on, the points
you specify align along the simulated plane you are
drawing on. Therefore, you can draw the top plane, switch
to she left plane to draw another side, and switch to the right
plane to complete the drawing. (Fig 5)

viewpoints, or remove hidden lines automatically. If the
snap angle is 0, the axes of the isometric planes are 30
degrees, 90 degrees, and 150 degrees. Once you set the
snap style to Isometric, you can work on any of three
planes, each with an associated pair of axes:

Dynamic UCS On/Off (F6)

With the dynamic UCS turned on, you can temporarily and
automatically align the XYplane of the UCS with a plane on
a 3D solid while creating objects.During a command, you
can align the UCS dynamically by moving your cursor over
a planar face of a 3D solid rather than using the UCS
command. After you finish the command, the UCS returns
to its previous location and orientation.

Grid (F7)

The grid is a rectangular pattern of dots that extends over
the area you specify as the grid limits. Using the grid is
similar to placing a sheet of grid paper under a drawing. The
grid helps you align objects and visualize the distances

between them. The grid is not plotted. If you zoom in or out
of your drawing, you may need to adjust grid spacing to be
more appropriate for the new magnification. You can turn
on or off the grids by pressing F7 key.

To display a grid and set grid spacing (Fig 6)

1 From the Tools menu, choose Drafting Settings.

2 In the Drafting Settings dialog box, Snap & Grid tab,
select Grid On to display the grid.

3 Under Snap Type and Style, make sure Grid Snap and
Rectangular Snap are selected.

4 For grid X Spacing, enter the horizontal grid spacing in
units.

CG & M : TDM (Dies & Moulds) (NSQF - Revised 2022) - R .Theory for Ex. 1.6.81

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



281

5 To use the same value for vertical grid spacing, press
ENTER. Otherwise, enter a new value for grid Y Spacing.

6 Choose OK.

Orthomode (F8)

You can use Ortho mode to restrict the cursor to the
horizontal or vertical axis. The orthogonal alignment depends
on the current snap angle, UCS, or isometric grid and snap
setting. Ortho works with commands that require you to
specify a second point. You can turn Ortho on and off at any
time during drawing and editing by pressing F8 key. You
can use Ortho not only to establish vertical or horizontal
alignments but also to enforce parallelism or to create
regular offsets from existing objects. By imposing orthogonal
constraints, you can draw more quickly. For example, you
can create a series of perpendicular lines by turning on
Ortho mode before you start. Because the lines are
constrained to be parallel to the horizontal and vertical
axes, you know that the lines are perpendicular.

Setting Snap (F9)

The snap is used to set increments for the cursor movement.
While moving the cursor, it is sometimes difficult to
position a point accurately. The SNAP command allows
you to set up an invisible grid, Fig 7 that allows the cursor
to move in fixed increments from one snap point to another.
The snap points are the points where the invisible snap
lines intersect.

The snap spacing is independent of the grid spacing, and
so the two can have equal or different values. You generally
set snap to an increment of the grid setting, for example,
Snap=5 and Grid=10.

Polar Tracking (F10)

Polar tracking is used to locate points on an angular
alignment path. Polar tracking can be selected by choosing
the POLAR button on the status bar, by using the function

key F10, or by selecting the Polar Tracking On (F10) check
box in the Polar Tracking tab of the Drafting Settings dialog
box (Fig 8). Polar Tracking constrains the movement of the
cursor along a path that is based on the polar angle
settings. For example, if the Increment angle list box value
is set to 15-degree in the Polar Angle Settings area, the
cursor will move along the alignment paths that are
multiples of 15-degree (0, 15, 30, 45, 60, and so on) and a
tooltip will display a distance and angle.

Object Snap Tracking (F11)

Object Snap Tracking tracks the movement of the cursor
along the alignment paths based on the Object Snap points
(running osnaps) that are selected in the Object Snap tab
of the Drafting Settings dialog box. Selecting the Object
Snap Tracking On (F11) check box in the Object Snap tab
of the Drafting Settings dialog box, choosing the OTRACK
button on the status bar, or using the function key Fl 1 sets
the object snap tracking on.The direction of the path is
determined by the motion of the cursor or the point you
select on an object. For example, if you want to draw a
circle whose center is located in the line with the center of
two existing circles (Fig 9), you can use AutoTracking.
First select Center in the Object Snap tab of the Drafting
Settings dialog box to set Center as the running osnap.
Also choose the Osnap button on the status bar to the On
position. Now, you can activate the object tracking by
choosing the OTRACK button on the status bar.

Fig 8
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Dynamic input mode (F12) (Fig 10)

As mentioned earlier, turning the Dynamic Input mode on
allows you to enter the commands through a pointer input
and the dimensions using the dimensional input. When
this mode is turned on, all the prompts are available at the

tooltip as dynamic prompts and you can select the
command options through dynamic prompt. The settings
for Dynamic Input are done through the Dynamic Input tab
of Drafting Settings dialog box. Invoke the Drafting Settings
dialog box by selecting the Drafting Settings option from
the Tools drop-down list.

Object properties
Objectives: At the end of this lesson you shall be able to
• brief the methods of applying color in AutoCAD
• describe the various line types in in AutoCAD.

Color

You can enter the color number (1 through 255) or the color
name (the names for the first seven colors). For example,
you can specify the color red by entering the ACI number
1 or the ACI name red.You can also enter bylayer or
byblock. If you enter byblock, all new objects are drawn in
the default color (white or black, depending on your
background color) until they are grouped into a block.

You can set the color of an object either by its layer or by
specifying its color explicitly, independent of its layer.

- Assigning colors by layer makes it easy to identify each
layer within your drawing.

- Assigning colors explicitly provides additional
distinctions between objects on the same layer.

- You can use a variety of color palettes when assigning
color to objects, including

- AutoCAD Color Index (ACI)

- True Color

- PANTONE ® Colors

- RALTM Classic and RAL Design color books

- DIC ® Color Guide

- Colors from imported color books.

AutoCAD Color Index (ACI) Palettes

Specifies a color from the AutoCAD Color Index. If you
hover over a color, the number of the color and its red,
green, blue value are displayed below the palette. Click a
color to select it, or enter the color number or name in the
Color box.

To set ACI Color for all new objects

1 Click Home tab > Properties panel > Object Color list.

2 From the list, choose a color, or choose Select Colors
to display the Select Color dialog box, and do one of the
following:

- On the Index Color tab, click a color, or in the Color
box, enter a color name or number.

- On the Index Color tab, click ByLayer to draw new
objects in the color assigned to the current layer.

- For creating blocks only, on the Index Color tab,
click ByBlock to draw objects that, when they are
combined into a block and inserted into the drawing,
display the current color.

Specifies color settings using the 255 AutoCAD Color
Index (ACI) colors.
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Line type

A linetype is a repeating pattern of dashes, dots, and blank
spaces displayed in a line or a curve. You assign linetypes

to objects either by layer or by specifying the linetype
explicitly, independent of layers.

All objects are created using the current linetype, which is
displayed in the Properties palette and the Home tab,
Properties panel of the ribbon when no objects are selected.

- If the current linetype is set to ByLayer, objects are
created with the linetype assigned to the current layer.

- If the current linetype is set to ByBlock, objects are
created using the Continuous linetype, a solid linetype
without embedded spaces, until the objects are
combined into a block definition. When the block is
inserted into the drawing, it displays the current linetype
for those objects.

Line weight

Lineweight is a property assigned to graphical objects,
hatches, leader lines, and dimension geometry that results
in thicker, darker lines.

Lineweights can be turned on and off in a drawing, and are
displayed differently in model space than in a paper space
layout

- In model space, a lineweight of 0 is displayed as one
pixel wide, and other lineweights use a proportional
pixel width. Lineweight display in model space does not
change with the zoom factor. For example, a lineweight

value that is represented by a width of four pixels is
always displayed using four pixels regardless of how far
you zoom in.

- In a paper space layout, lineweights are displayed
using real-world units, and lineweight display changes
with the zoom factor.
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Plotting & Export
Objectives: At the end of this lesson you shall be able to
• explain the methods of setting plotter specifications and plot drawings
• describe the method of creating layouts.

Plotting Drawings

After creating a drawing of an architectural plan or a
mechanical component, you may need to send it to the
client or have a hard copy for reference. To do so, you need
to plot the drawing. To plot the drawing, choose Plot from
the Quick Access Toolbar; the Plot-Model dialog box will
be displayed. If the dialog box is not expanded by default,
choose the More Options button at the lower right corner
of the dialog box to expand it, as shown in Fig 1.

Page Setup

Displays a list of any named and saved page setups in the
drawing. You can base the current page setup on a named
page setup saved in the drawing, or you can create a new
named page setup based on the current settings in the Plot
dialog box by clicking Add.

Printer/Plotter

Specifies a configured plotting device to use when plotting
layouts. If the selected plotter doesn't support the layout's
selected paper size, a warning is displayed and you can
select the plotter's default paper size or a custom paper
size.

Paper Size

Displays standard paper sizes that are available for the
selected plotting device. If no plotter is selected, the full
standard paper size list is displayed and available for
selection.

Plot Area

Specifies the portion of the drawing to be plotted. Under
What to Plot, you can select an area of the drawing to be
plotted.

Window

Plots any portion of the drawing that you specify. When you
select Window, the Window button becomes available.
Click the Window button to use the pointing device to
specify the two corners of the area to be plotted, or enter
coordinate values.

See Preview and you can see the drawing. Click Plot and
the drawing will be plotted.

Viewports

The options available depend on whether you are configuring
model space viewports (on the Model layout) or layout
viewports (on a named (paper space) layout).

Tabs for Model space viewports: New Viewports-Model
Space, Named Viewports-Model Space.

Tabs for layout viewports: New Viewports-Layouts, Named
Viewports-Layouts

It is important to create layout viewports on their own layer.
When you are ready to output your drawing, you can turn
off the layer and output the layout without the boundaries
of the layout viewports.

Viewports for 3D object viewing (Fig 2)

Command : VIEWPORTS Following screen appear

Fig 1

Fig 2

New Name

Specifies a name for the new model space viewport
configuration. If you do not enter a name, the viewport
configuration is applied but not saved. If a viewport
configuration is not saved, it cannot be used in a layout.
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Standard Viewports

Lists and sets the standard viewport configurations,
including CURRENT, which is the current configuration.

Preview

Displays a preview of the viewport configuration you select
and the default views assigned to each individual viewport
in the configuration.

Apply To

Applies the model space viewport configuration to the
entire display or to the current viewport.

Display: Applies the viewport configuration to the entire
Model tab display.

Current Viewport: Applies the viewport configuration to
the current viewport only.

Setup

Specifies either a 2D or a 3D setup. When you select 2D,
the new viewport configuration is initially created with the
current view in aIl.of the viewports. When you select 3D, a
set of standard orthogonal - 3D views is applied to the
viewports in the configuration.

Change View To

Replaces the view in the selected viewport with the view you
select from the list. You can choose a named view, or if you
have selected 3D setup, you can select from the list of
standard views. Use the Visual Style (not in Auto CAD LT)

Applies a visual style to the viewport. All available visual
styles are displayed.

New Viewports Tab-Layouts (viewports Dialog Box)

Lists all saved model viewport configurations in the drawing.

Current Name

Displays the name of the current viewport configuration,

New Viewports Tab-Layouts (viewports Dialog Box)

Standard Viewports

Displays a list of standard viewport configurations and
configures layout viewports.

Preview

Displays a preview of the viewport configuration you select
and the default views assigned to each individual viewport
in the configuration.

Viewport Spacing

Specifies the spacing you want to apply between the layout
viewports you are configuring.

Setup

Specifies either a 2D or a 3D setup. When you select 2D,
the new viewport configuration is initially created with the
current view in all of the viewports. When you select 3D, a
set of standard orthogonal 3D views is applied to the
viewports in the configuration.

Fig 3
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Change View To: Replaces the view in the selected
viewport with the view you select from the list. You can
choose a named view, or if you have selected 3D setup, you
can select from the list of standard views.

Named Viewports Tab-Layouts (viewports Dialog Box)
(Fig 3)

Displays any saved and named model space viewport
configurations for you to use in the current layout. You
cannot save and name a layout viewport configuration.

-VPORTS - Layout Viewports

Creates multiple viewports in layouts (paper space).

The number and arrangement of layout viewports and their
associated settings are called viewport configurations.

The following prompts are displayed.

Corner of viewport

Specifies the location of the one corner of the rectangular
viewport.

Opposite corner. Specifies the location of the opposite,
diagonal corner of the rectangular viewport.

On

Turns on a viewport, making it active and making its objects
visible.

Off

Turns off a viewport. When a viewport is off, its objects are
not displayed, and you cannot make that viewport current.

Fit

Creates one viewport that fills the available display area.
The actual size of the viewport depends on the dimensions
of the paper space view.

Shadeplot

Specifies how viewports in layouts are plotted.

As Displayed: Plots the same way it is displayed

Wireframe: Plots wireframe regardless of display

Hidden: Plots with hidden lines removed regardless of
display

Visual Styles: Plots using the specified visual style; all
visual styles in the drawing are listed as options whether in
use or not (not available in AutoCAD LT)

Render Presets: Plots using the specified render preset;
all render presets are listed as options (not available in
AutoCAD LT)

Lock

Locks the current viewport. Prevents changes from being
made to the associated view.

Object

Creates a nonrectangular layout viewport from a closed
polyline, ellipse, spline, region, or circle. The polyline you
specify must be closed and contain at least three vertices.
It can be self-intersecting, and it can contain arcs as well
as line segments.

Polygonal

Creates a nonrectangular layout viewport defined by a
series of line and arc segments.

The descriptions of the Next Point, Arc, Close, Length, and
Undo options match the descriptions of the corresponding
options in the PLINE command.

Restore

Restores a previously saved viewport configuration.

Layer (Fig 4)

Resets layer property overrides for the selected viewport to
their global layer properties.

2 Divides the current viewport in half.

3 Divides the current viewport into three viewports.

Horizontal and Vertical split the area into thirds. The other
options create one large viewport in half the available area
and two smaller ones in the other half Above, Below, Left,
and Right specify where the larger viewport is placed.

4 Divides the current viewport into four viewports of equal
size.

About Model Space Viewports

In model space, you can split the drawing area into one or
more rectangular areas called model space viewports.

Viewports are areas that display different views of your
model. In large or complex drawings, displaying different
views reduces the time needed to zoom or pan in a single
view. Errors that you might miss in one view might be visible
in another.

The Fig 4 show several model space viewport configurations.
You can save and restore viewport configurations by name
with the VPORTS command.
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When you display multiple viewports, the one that is
highlighted with a blue rectangle is called the current
viewport.

- Commands that control the view, such as panning and
zooming, apply only to the current viewport.

- Commands that create or modify an object are started
in the current viewport, but the results apply to the
model and can be visible in other viewports.

- You can start a command in one viewport and finish it
in a different viewport.

- You can make any viewport the current one by clicking
in It.

Model space viewports should not be confused with layout
viewports, which are available only in paper space and are
used to arrange views of your drawing on a sheet.

Modify Model Space Viewports (Fig 5)

You can modify the size, shape, and number of model
space viewports in a viewport configuration:

- Choose from several viewport configurations by clicking
the [+] or [-] control in the top-left corner of a viewport.

- Drag the boundaries of viewports to adjust their size.

- Press CTRL while dragging viewport boundaries to
display the green splitter bar and create new viewports.
Alternatively, you can drag the outermost splitter
controls.

- Drag a viewport boundary onto another boundary to
remove a viewport.

After you create a new viewport, you might want to
maximize and center the view by double-clicking the
mouse wheel to perform a zoom extents.

To Create a New Layout Viewport

1 Click View tab > Viewports panel > New.

2 In the Viewports dialog box, New Viewports tab, under
Standard Viewports, select Single.

3 Click to specify one corner of the new layout viewport

4 Click to specify the opposite corner.

A new layout viewport object is available and displays a
default view. To adjust the view, double-click within the
layout viewport to access model space.

To Restore a Saved Viewport Arrangement

Viewport arrangements can be saved only in model space,
but you can restore saved viewport arrangements either in
model space, as model space viewports, or in paper space,
as layout viewports.

1 Click View tab > Viewports panel > Named.

2 In the Viewports dialog box, Named Viewports tab,
select the name of the viewport configuration from the
list.

To Delete a Saved Viewport Arrangement

1 Click View tab > Viewports panel > Named.

2 In the Viewports dialog box, Named Viewports tab,
select the name of the viewport configuration you want
to delete.

3 Press the DELETE key.
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ACAD Shorcuts

Arc A

Area AA

Array AR

Break BR

Chamfer CHA

Circle C

Copy CP , CO

Ddmodify MO

Dimangular DAN, DIMANG

Dimbaseline DBA

Dimdiameter DD1 , DIMDIA

Dimcontinue DCO , DIMCONT

Dimradius DRA , DIMRAD

Dist DI

Donut DO

Dsviewer AV

Erase E

Extend EX

Fillet F

Hatch H

Layer LA

Line L

Linetype LT

List LI , LS

Ltscale LTS

Matchprop MA

Mirror MI

Move M

Offset O

Osnap OS

Pline PL

Point PO

Polygon POL

Purge PU

Rectangle REC

Regen RE

Rotate RO

Scale SC

Setvar SET

Snap SN

Solid SO

Strech S

Trim TR

Zoom Z

ACAD System Variables

APERTURE SETS OBJECT SNAP TARGET HEIGHT, IN PIXELS

AREA STORES THE LAST AREA COMPUTED BY AREA, LIST, DBLIST

AUNITS SETS UNIT FOR ANGLES

AUTOSNAP CONTROLS DISPLAY OF AUTOSNAP MARKER , AUTOSNAP MAGNET ON/OF

BLIPMODE CONTROLS WETHER MARKER BLIPS ARE VISIBLE

CECOLOR SETS COLOR OF NEW OBJECTS

CELTSCALE SETS CURRENT GLOBAL LINE TYPE SCALE FOR OBJECTS.

CELTYPE SETS LINETYPE FOR NEW OBJECTS

CELWEIGHT SETS THE LINEWEIGHT FOR NEW OBJECTS

CHAMFERA SETS THE CHAMFER DISTANCE

CHAMFERS SETS THE SECOND CHAMFER DISTANCE

CHAMFERC SETS THE CHAMFER LENGTH

CHAMFERD SETS THE CHAMFER ANGLE

CHAMMODE SETS THE INPUT METHOD BY WHICH ACAD CREATES CHAMFER

CIRCLERAD SETS THE DEFAULT CIRCLE RADIUS

CLAYER SETS THE CURRENT LAYER

COORDS CONTRLS WHEN COORDINATES ARE UPDATED ON STATUS LINE

CURSORSIZE DETERMINES THE SIZE OF CROSSHAIR AS A PERCENTAGE OF SCREEN SIZE

DIMASZ CONTROLS THE SIZE OF DIMENSION LINE AND LEADER LINE ARROW HEADS

DIMEXE SPECIFY HOW FAR TO EXTEND EXTENSION LINE BEYOND DIMENSION LINE
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DIMEXO SPECIFY HOW FAR EXTENSION LINES ARE OFFSET FROM ORGIN POINT

DIMGAP SETS THE DISTANCE AROUND DIMENSION TEXT FOR DIMENSION LINE

DIMTIH CONTROL POSITION OF TEXT INSIDE EXTENSION LINE

DIMTSZ SPECIFY THE SIZE OF OBLIQUE STROKE DRAWN INSTEAD OF ARROW HEAD

DISTANCE STORES DISTANCE COMPUTED BY DIST

DONUTID SETS THE DEFAULT INSIDE DIAMETER FOR DONUT

DONUTOD SETS THE DEFAULT OUTSIDE DIAMETER FOR DONUT

EDGEMODE CONRTOLS HOW TRIM AND EXTEND DETERMINE CUTTING/BOUNDARY EDGE

FILEDIA SUPRESSES DISPLAY OF FILE DIALOGUE BOXES

FILLETRAD STORES THE CURRENT FILLET RADIUS

GRIDMODE SPECIFY WHETHER THE GRID MODE IS ON OR OF

GRIDUNIT SPECIFY GRID SPACING FOR CURRENT VIEW PORT

HIGHLIGHT CONTROLS OBJECT LIGHTING

HPANG SPECIFY HATCH PATTERN ANGLE

HPDOUBLE SPECIFY HATCH PATTERN DOUBLING FOR USER DEFINED PATTERNS

HPNAME SETS A DEFAULT HATCH PATTERN NAME

HPSCALE SPECIFY THE HATCH PATTERN SCALE FACTOR

HPSPACE SPECIFY THE HATCH PATTERN LINE SPACING FOR USER DEFINED PATTERN

LASTANGLE STORES THE END ANGLE OF THE LAST ARC ENTERED

LASTPOINT STORES THE COORDINATE OF THE LAST POINT ENTERED

LIMCHECK CONTROLS CREATION OF OBJECTS BEYOND DRAWING LIMITS

LIMMAX STORES THE UPPER RIGHT DRAWING LIMIT FOR CURRENT DRAWING SPACE

LIMMIN STORES THE LOWER LEFT DRAWING LIMIT FOR CURRENT DRAWING SPACE

LTSCALE STORES THE GLOBAL LINETYPE SCALE FACTOR

LUNITS SETS LINEAR UNITS

LUPREC SETS NUMBER OF DECIMALS FOR LINEAR UNITS

MIRRTEXT CONTROLS HOW MIRROR REFLECTS TEXT

OFFSETDIST SETS THE DEFAULT OFFSET DISTANCE

ORTHOMODE CONSTRAINS CURSOR MOVEMENT TO THE PERPENDICULAR

OSMODE SETS RUNNING OBJECT SNAPMODE USING BIT-CODES

PDMODE CONTROLS HOW POINT OBJECTS ARE DISPLAYED

PDSIZE SETS TEH DISPLAY SIZE FOR POINT OBJECTS

PLINEWID STORES THE DEFAULT POLYLINE WIDTH

POLYSIDES SETS THE DEFAULT NUMBER OF SIDES FOR POLYGON

QTEXTMODE CONTROL HOW TEXT IS DISPLAYED

REGENMODE CONTROLS AUOMATIC REGENERATION OF DRAWING

SAVENAME SAVES FILE NAME

SNAPANG SETS SNAP AND GRID ROTATION ANGLE FOR THE CURRENT VIEW PORT

SNAPBASE SETS THE SNAP AND GRID ORGIN POINT FOR THE CURRENT VIEW PORT

SNAPMODE TURNS SNAPMODE ON AND OF

SNAPUNIT SETS SPANSPACING FOR CURRENT VIEW PORT

TEXTSIZE SETS DEFAULT TEXT HEIGHT FOR NEW TEXT OBJECTS WITH CURRENT STYLE

TRACEWID SETS DEFAULT TRACE WIDTH

TRIMMODE CONTROLS WHETHER ACAD TRIMS SELECTED EDGES FOR CHAMFER/FILLETS

UNITMODE CONTROLS UNIT FORMAT FOR UNITS
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CG & M Related Theory for Exercise 1.6.82-83
Tool & Die Maker (Dies & Moulds) - AutoCAD & Pro - E

Introduction to creo
Objectives: At the end of this lesson you shall be able to
• list the hardware requirements to install creo software
• Install Creo software
• launch Creo and interface the main components;
• set up a Working Directory, file names and conventions;
• brief the  File menu, Manage File options, and different file types;
• open a Creo object and manage files;
• brief  what  is a Session is and how to Manage Session.

Introduction

CreoTM Parametric is one of the most powerful Computer-
Aided Design (CAD), Computer-Aided Analysis and
Computer-Aided Manufacture(CAM) software packages
available in the world today. It is the flagship of a family of
other software products, developed by PTC Corporation,
for engineering design and product development, also
including CreoTMDirect, CreoTM Simulate, CreoTM Layout
and others. The main applications are in mechanical,
product design, aerospace, construction,shipbuilding and
other industries.

CreoTM Parametric (or Creo) was previously known as
Pro/EngineerTM and WildfireTM. The core of the software
contains a variety of tools for the creation, validation and
communication of complex three-dimensional (3D) objects
as parts and assemblies. In addition, there are integrated
applications that associate directly with the 3D model
geometry and support the development of engineering
drawings, mould design, NC machine simulation, sheet
metal design, piping and wiring, harness design, structural
strength, thermal and CFD analyses, kinematic and
dynamic analyses, feasibility and optimisation studies,
and others.

Creo Installation

To install the software following hardware is required

Hardware requirements

The minimum computer system requirements are listed
below:

- Operating system: Windows 7 or Windows 10 64-bit
editions;

- Processor: Core i5 or higher;

- RAM: More than 4Gb;

- Monitor: Minimum resolution — 1280 × 1024 pixels
with 32-bit   colour;

- Hard or solid state disk memory available: More than
10Gb;

- Dedicated Graphics card: 1Gb minimum;

- Microsoft compatible 3 button (2 button and a wheel)
mouse;

- Internet connection.

Creo installation software package has an automated
SETUP.EXE executable file that guides the installation
process of all main applications and defaults.

Run SETUP.EXE file with administrative privileges to start
the installation process. The PTC Installation Assistant
appears as shown in Fig 1. The Introduction, Software
Agreement and Licenses are all self-explanatory sections
relevant to a specific user.

By pressing the Install icon (Fig 2) the installation starts
and in the end a shortcut Creo icon is created automatically
on the PC desktop.

Fig 1

By pressing the Customize icon, the user can access a
submenu with Options (Fig 3). Make sure that
Modelcheck and Mold Analysis are selected. These
options are needed for the Mould Design chapter.

Note: Depending on the license agreement
some of the applications are automatically
selected (ticked) and those with no license are
unavailable (dimmed) for installation. By
pressing the Install icon (Fig 2), the installation
starts and in the end a shortcut Creo icon is
created automatically on the PC desktop.

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



291

Fig 2

Getting Started and Creo Interface

Launching the software

Launch Creo by LMB (left mouse button) double-clicking
on the shortcut Creo Parametric icon in the PC desktop.
Another way to launch the software is to press on the
Windows Start icon, and then to activate Creo Parametric
from the ( Creo user interface DOC) PTC applications
list.

The initial screen after starting the software is shown in
Figure 4. It consists of File and Home ribbon menu options,
Folder Browser tab, and Favourites tab to run a Web
browser. Close the

Resource Centre window and the Web browser link http:/
/ptc.partcommunity.com/.

Fig 3
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Fig 4

The main interface at Start Up looks as shown in Figure
5. The main areas and functions of this interface are as
follows: The Folder Browser tab (Fig 5), located on the
left of the screen next to the Model Tree tab, lists the
folders on the computer or network.Browse the folders
and view their contents in the Folder Browser.

The Favourites tab is a multi-functional Web browser
embedded in Creo. It displays models and tutorials from

PTC.com and other websites. A preview window appears
in the centre of the screen after the launch.

The Folder Browser icons ( ) are located at the bottom
left corner of the main window. Click (LMB) on the icons
to either show or hide the current folder and Web
browsers.

Fig 5

The Graphics area is a large grey area where the 3D model
geometry is visible when a model is opened This is the
main area where the model geometry is developed and
displayed. The user can rotate, move and zoom the model.

Select working directory

The Working Directory is a directory or a folder in the PC
disc memory (hard drive, solid state disc memory, USB
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memory stick, network, etc.) where all models (objects)
belonging to a project are stored. The user can set any
existing folder with Read/Write permissions as a Working
Directory. It is very important to do this immediately after
starting Creo or switching to a new project. If a Working
Directory is not selected, the software will save or open
an object from the default directory (usually in C: drive).
For example, an assembly model containing several parts
will not open those models that are located outside the
Working Directory. The missing part name will appear in
red in the assembly Model Tree.

The main commands are:

New

Click on New ( ), (or File > New) to create a new model.

Open

Click on Open ( ), (or File > Open) to open a model.

New and Open commands create a new model or open
an existing model from the Working Directory. They can
be activated directly from the Home menu after Start Up .

Save

Click on Save icon ( ), (or File > Save) to save the model
in the current Working Directory, thus creating another
version of the object. Creo does not overwrite the existing

Fig 6

Rule number one is to set up a Working Directory
immediately after starting the software! This ensures that
all existing and new models (files) are opened or saved in
one place.

Click on Select Working Directory icon ( ) from the Home
menu at Start Up (Figure .5) and set up a Working
Directory. Alternatively, select File > Manage Session >
Select Working Director

File menu options

File menu options appear when selecting the File tab from
the menu bar as shown in Figure 6. Some commands
might be dimmed at Start up.

file after Save. It creates anew file version containing the
latest modifications.

Print

Print ( ) icon has a sub-menu with several commands to
print the object from the active window to a printer as
either a rendered image from the screen, a 2D drawing, a
drawing in PDF format or a tessellated model in STL Stereo
lithography format.

Close

Click on Close icon ( ) to close the active window. Note
that the object is still in the computer RAM, which is
called Session. If the current model is closed accidentally,
it can be opened back from the Session and then saved.
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Manage file

Manage File has a sub-menu with the following
commands:

Rename (File > Manage File > Rename)

This command renames the current object and its versions
in the Session (computer RAM) and/or in the Working
Directory.

Delete Old Versions (File > Manage File > Delete
Old Versions)

This command deletes all versions except the latest (with
the highest variant number) of the current object from the
Working Directory.

Delete All Versions (File > Manage File > Delete All
Versions)

THIS COMMAND DELETES ALL VERSIONS of the
current object from the Working Directory (from the
computer disc) and the Session. The software asks the
user to confirm this action. One should

be very careful when using this command.

Manage session

Session is the computer RAM allocated for all Creo-
opened models (objects). Several objects (parts,
assemblies, drawings, etc.) can be opened
simultaneously and displayed in different windows within
a single Session. Typically, the user works simultaneously
on different models, belonging to a project, and switches
from one window to another. Sometimes, a new Working
Directory needs to be set up without stopping  Creo. In
this case, all opened objects in the Session need to be
closed and removed from it to avoid memory conflicts.
This is done with the following tools from the Manage
Session menu

Erase Current (File > Manage Session > Erase Current)

This command removes an object (model) from the active
window.

Erase Not Displayed (File > Manage Session > Erase
Not Displayed)

Close

Click on Close icon (  ) to close the active window. Note
that the object is still in the computer RAM, which is
called Session. If the current model is closed accidentally,
it can be opened back from the

Session and then saved.

File names and conventions

An object name can consist of letters and or numbers
but cannot contain spaces or special symbols. The use

of underscore symbol is permitted and it can also be used
to separate some sections within the name. For example,
MY_FIRST_MODEL is a correct name. Also, the software
does not distinguish between upper and lower case letters.
These rules apply to all Creo names, including the names
of files, folders, features, parameters, etc.

File Management in Creo

In Creo, the Save command creates a new file with the
same name but with a higher variant number and does
not overwrite the previous file. After saving a model many
times, the user might notice that there are

several files with the same name in the Working Directory.
This is a specific feature that allows the user to retrieve
an older version of the same model. The question is how
to distinguish between different versions. By default, the
file extensions are hidden in the Windows File Explorer.
To reveal them, open the File Explorer, find the View tab
and tick the option File name extensions (Windows 10)
as shown in Figure .7. The file type and extension number
are now visible. For example, a Creo file
PART_MODEL.PRT.2 has the following convention:
PART_MODEL is the object name, PRT is the object type
CAD/CAM with Creo Parametric used by the software to
associate it with an application (i.e. Part mode, or
Assembly mode) and 2 is the model variant. After selecting
Save, the software creates a new file in the Working
Directory with the same name and type but a higher variant
number 3 (i.e. PART_MODEL.PRT.3). The command Open
always opens the object (file) with the highest extension
(variant) number.

The main object types are as follows:

· PRT — This object is created in Part mode. It contains
a record of the model geometry as a sequence of features
and their parameters.

· ASM — This object is created in Assembly mode. It
contains the assembly model history including the names
of parts, sub-assemblies and their relative locations. It
may contain additional data and surface

features created within the assembly. The assembly itself
does not have the actual part(s) geometry. If a part model
is missing from the Working Directory, then the assembly
is not able to open and display

the part. The part name will appear in red in the assembly
Model Tree.

· DRW — This object is created in Drawing mode. Every
drawing refers to a part or assembly model. Similar to the
assembly model, the drawing does not include the model
geometry and will not display it

if the associated model file is missing.
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Fig 7

Functions of the Mouse Buttons

The PC mouse is an essential input device in Creo 3D
modelling. Every click of a mouse button generates an
input for the software. It is important to understand and
learn the functions of each mouse button when clicking
on an icon (command) from the user interface or clicking
on a model geometry item. In the beginning, it is difficult
to remember all mouse button functions, but after some
practice it will become second nature to use the correct
button and key combinations. Usually, the software does
not react if an incorrect button is clicked or if a wrong
item selected. However, sometimes it may stop working
or crash if the user repeatedly clicks a (wrong) button.
Therefore, one should be careful and use the mouse
buttons correctly. The main mouse button functions and
combinations are explained in the following
Left Mouse Button (LMB)
The LMB is used to: click and initiate an action, such as
click on interface icon, tab, tool, pull down menu, open a
menu and other functions. For example to click on Open,
Save, Extrude, Rotate and other
icons (commands). In addition, the LMB is used to click
and select (pick) a geometry item as input for a command
sequence. For example to click on datum plane, axis,
point, edge, feature, etc.
Typically, the user performs a click and release action
with the LMB to click and select (pick) an item.

In order to make multiple selections and add (or remove)
more than one geometrical item(s), the user must press
and hold the CTRL key down (CTRL + Hold) and then
continue selecting the items with the LMB.
Middle Mouse Button or the Wheel (MMB)
This is used to accept the current selection or input. In
2D (Sketch) mode, the MMB is used to place dimensions
and also to abort (stop) the current command.MMB is
also used to rotate the model in the Graphics area and to
viewit at various angles. To rotate, place the cursor on a
point inside the
Graphics area, press and hold the MMB (MMB + Hold)
and drag the mouse slowly to rotate the model. Some
computer mice have a wheel instead of a middle button.
The wheel rotation zooms-In or zoomsOut the model.
Rotating and zooming the model are constantly used
during the modelling process.
Another purpose of the MMB (or the wheel) is to translate
the model on the screen. Press SHIFT and hold (SHIFT +
Hold) with one finger, click the MMB, and then drag to
translate the model.
Right Mouse Button (RMB)
It is used to initiate shortcut and mini menus by clicking
once or by pressing and holding for a few seconds (RMB
+ Hold)
when you open a new file in Creo the window opens as
shown in Fig 8.

Fig 8
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Familiarization of interface / windows
Objectives: At the end of this lesson you shall be able to
• familiarize the  main  window components of the Creo
• state the functions of each components in Creo windows.

Creo Modelling Interface The default, Part mode
(part modelling) interface is shown in Fig 1.

Fig 1

The main components of the interface are as follows:

Main Menu — It is located on the top of the screen.
Commands are grouped into tabs depending on their
functions, such as  File, Model, Analysis, Annotate, Tools,
View, Flexible Modelling and Applications. Each of these
tabs except File activates a specific

ribbon interface. Each ribbon contains a number of icons,
organized into groups, which activate commands or tools
with specific actions.

The commands are context dependent, and some of them
might be disabled (dimmed) if correct prerequisites are
not available or if geometrical entities not selected.

The ribbon interface is active when a new or an existing
Creo object is opened in the Graphics area. Fig 1 shows

Part mode ribbon interface with a part opened and shown
in the Graphics area. Every Creo application, i.e. part,
assembly, mould design, NC assembly, and others, has
a specific interface and commands.

· Graphics Area — This is the screen area in which the
model geometry is displayed. By using the mouse, the
user interacts with the model, selecting geometrical
entities such as plane, point, surface,

edge, etc., in order to create a new model feature or modify
existing model features.

· Ribbon — The Model ribbon (Fig 2) is a context-sensitive
menu that contains the main commands (icons and drop-
down menus). These are arranged in groups from left to
right following the modelling workflow.

Fig 2
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- Message Area - A bar at the bottom of the screen
under the Model Tree and Graphics area (Fig 1)
providing prompts and help. Every command has a
specific sequence and type of expected inputs. It is a
good practice to read the messages because the
system is telling what has been done and what is
required next. It is recommended, especially for
beginners, to read the messages during the learning
process.

- Graphics Toolbar (Fig 3) - It is a small bar under the
ribbon used to control the view of the model or sketch.

Fig 3

- Quick Access Toolbar — It is located on the top left
of the screen. It contains the following
commands: New, Open, Save, Undo, Redo,
Regenerate and Windows (shown in Fig 4).

Fig 4

- The Regenerate command icon ( ) is frequently used
in Part or Assembly mode to initiate the model
recalculation after a change of a dimension or another
parameter.

- Dashboard (Fig 5) — This is a submenu that will open
after activation of a top-level command. For example,
commands for creating Extrude, Rotate, Blend, Sweep,
or other features have their dashboards. Each
dashboard has command-specific tools and options
for creating variations of the activated feature. For
instance, the Extrude command ( ) opens a dashboard
that has options to create a protrusion (adding material)
or cut (removing material). Also, the dashboard can
switch to create a solid or surface feature.

Click (LMB) on Extrude (i.e. Model > Shapes > Extrude)
to activate the Extrude dashboard (Fig 6). If all necessary
inputs are provided into the dashboard, for example, a 2D
sketch (two concentric circles) and extrude depth
(Fig 6), then a green tick ( ) is available to save the changes

and close the Extrude command. Creo cannot continue if
the command dashboard is still open. Click (LMB) on the
OK green tick ( ) or Cancel ( ) icon on the right-hand side
of the dashboard to close and continue.

Fig 5

Fig 6
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- Model Tree (Figure 1) — It is a record of all features
and parameters following the order of their creation. In
fact, the model is a software programme containing
commands and input values that Creo executes to
create the model geometry. The Model Tree shows
the model history. It updates every time new features
are added or deleted.

- Creo Help — To access Creo Help Centre, click (LMB)
on Help ( ) icon at the top right corner of the main
screen (Figure 1).

- Use the Search tool ( ) and type into the search bar to
quickly find anything related to Creo, e.g. ‘extrude’.
The result activates the command or highlights it on
the screen in real time.

- PTC Learning Connector ( ) — It is located next to
Creo Help. It allows the user to log into the PTC

University e-Learning database and access tutorials
and videos. The user needs a Login name and
Password. Most help however can be quickly sourced
from the Creo Help Centre tab.

Working with Multiple Windows
The user can open several windows, each containing a
different object, within the same Session. However, only
one of these windows, the Active window, can be
accessed for modelling. A common practice is to switch
from one active window to another and work on several
opened models.
This can be done by accessing the Active window ( ) icon
from the Quick Access Toolbar. Click on the icon, scroll
down and select the model that is to become active, as
shown in (Fig 7). The current Active.

Fig 7

Window is marked with a black tick in front of the model
name. After the Active window (object) selection, the
system opens the model in the specific to the model
environment, i.e. Part mode, Assembly mode, etc.
System of Units and Drawing Configuration (Fig 8)
By default, the software will be installed and configured
to the ASME Inch/Pound (Imperial) system of units. In
order to reconfigure it to Metric units (mm, kg), the user
should run the configuration *.BAT file as follows:

- Go to C:\Program Files\PTC\Creo 4.0\M050 (or another
version)\ Common Files\creo_standards.

- Select CONFIGURE.BAT file and Run as administrator.
- The CMD black window (Fig 8) opens. · Select the

desired system from the list, type the corresponding
number and press ENTER. For example, for the Metric
units (mm, KG, second) select 4, 5 or 6. Select 7 for
the Metric units (mm, N, second).

- Every option corresponds to a specific engineering
drawing standard.

Fig 8
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Sketching in creo
Objectives: At the end of this lesson you shall be able to
• state what is  2D sketch
• brief  all basic tools of sketcher
• explain the methods to  modify all dimensions at once (scaling)
• brief method of sketching according to design intent.

Sketcher is the main creation tool of Creo Parametric.

The sketcher toolbar ribbon is located at the top of the
window.This section explores the many options of
sketcher.

Its basic icons are shown in Figure 1. The LMB (Left Mouse
Button) is used to select geometry or to select a location
when creating geometry.

Fig 1 Sketcher Ribbon

Entering Sketcher Directly from Creo Parametric

Select the NEW FILE icon from the ribbon at the top of
the screen. Save as >File>New. When the New file win-
dow opens, select Sketch as the type, then enter a valid
filename without the extension. Pick OK. (Fig 2).

Fig 2

Entering Sketcher from Part Mode within Creo
Parametric: This section assumes We are in part creation
mode already. and To enter sketcher mode from part mode,
select the SKETCHER icon at the top of the screen. Pick
the plane that We wish to sketch on followed by orienting
another plane toward the right, top, left, or bottom of the
screen. Pick the Sketch button.

If necessary in the upper left corner of the window, select
the SKETCH VIEW icon to orient the sketching plane
parallel to the display screen.

The sketcher ribbon is slightly different at the left and
right ends.

Sketching: Sketched entity can be designated as
geometry or construction. Sketching tools create
geometric entities by default. To create construction

entities, click Sketch >  Construction Mode.We can

convert geometric entities into construction entities or
vice versa:

- To convert geometric entities to construction entities,
select an entity then click Construction on the mini
toolbar.

Construction entities are displayed with a dashed line
style.

- To convert construction entities to geometric entities,
select an entity then click Solid on the mini toolbar.

Geometric entities are displayed with a solid line style.

Points, centerlines, and coordinate systems have separate
tools for creating datum or construction instances. We
can use the Search tool to search for a datum created
using the Point, Centerline, or Coordinate System Datum
tools.

Dynamic Constraining: As We move the pointer,
applicable constraints are offered and the geometry snaps
to these constraints. The relevant existing geometry is
highlighted. For example, a tangent constraint is offered
when We sketch a line near the circumference of a circle.
We can accept, lock, disable, or disregard the offered
constraints. Selecting Sketching Tools. (Fig 3).

Fig 1
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Fig 3

The Sketching group contains tools to create the

following entities

- Lines

- Quadrilaterals

- Circles

- Arcs

- Ellipses

- Splines

- Fillets

- Chamfers

- Text

- Offset

- Thicken

- Project

- Centerline

- Point

- Coordinate system

Using the Mouse or Keyboard in Sketcher

We can use the mouse or keyboard to perform the

following operations:

- Click an entity to see the available options on the mini

toolbar.

- Middle-click or press ESC to abort the current

operation. Middle-click or press ESC again to exit the

active tool.

- Right-click to lock an offered constraint while We are

sketching. Right-click again to disable the constraint

and right-click a third time to enable it again.

- Right-click the sketch window to access the shortcut

menu. Commands change when an entity is selected.

Points and Centerlines

We can create construction points, construction

centerlines, datum points, and datum centerlines.

Points and centerlines are represented in the graphics

window in different default colors and line styles. We can

customize these settings in the System Appearance area

of the Creo Parametric Options dialog box.

The Difference Between Construction and Datum

Entities

Construction points and centerlines are sketching aids

and cannot be referenced outside Sketcher. Datum entities

convey feature-level information outside of Sketcher. Use

datum entities to add information to sketched curve

features and sketch-based features in 2D and 3D

Sketcher.

To change a construction entity to a datum entity, click

the entity and choose Solid on the mini toolbar. To change

a datum entity to a construction entity, click the entity

then choose Construction on the mini toolbar.

Using Datum Points

We can create datum points and centerline in a sketch

and then use it when we create entities in Part or Assembly

mode. The following table provides information about the

connections between the features and the datum entities.

Feature Entity Created by a Datum Point Entity Created by a Datum
Centerline

Sketched curve Datum point Datum axis

Extrude Axis through the point and normal
to the sketch plane

Sketched pattern Pattern instance

Revolve feature Axis of rotation
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All other sketch- No geometry is created No geometry is created
based features

Other features that use No geometry is created No geometry is created
Sketcher points or
centerlines to convey
feature-level geometry

Using Datum Entities and Features

Keep in mind the following points when sketching an axis
of rotation for a revolve feature or when placing a hole
feature:

- When a sketch for a Revolve feature includes several
geometry centerlines, the first centerline We create
is automatically designated as the axis of revolution.

- To designate a datum or construction centerline as
the axis of revolution or to select a different datum or
construction centerline as the axis of rotation, select
the centerline and right-click and choose Designate
Axis of Revolution on the shortcut menu.

Coordinate Systems

We can use the coordinate system tool in Sketcher to
create three types of coordinate systems: construction,
datum, and horizontal-vertical. When horizontal-vertical
coordinate systems are available for creation, we cannot
create construction and datum coordinate systems, and
vice versa.

There are separate sketching tools for creating
construction coordinate systems and datum coordinate
systems. However, we can toggle between construction

and datum status using the shortcut menu. When We
create construction and datum coordinate systems,
construction and datum centerlines are also created along
the x- and y-axes.

Construction Coordinate Systems

Construction coordinate systems are sketching aids and
do not convey any information outside Sketcher. Use a
construction coordinate system to accomplish the
following tasks:

- Dimension a spline—Modify the spline points by
specifying the x-, y-, and z-axis coordinates with
respect to the coordinate system.

- Create a reference—Add coordinate systems to any

section to aid dimensioning.

Datum and Horizontal-Vertical Coordinate Systems

A datum coordinate system conveys feature-level
information outside of Sketcher; We can use it to add
information to sketched curve features and sketch-based
features in 2–D and 3–D Sketcher. Datum coordinate
systems create entities in Part or Assembly mode as
follows:

Type Availability Behaviour Outside Sketcher

Datum 2–D Sketcher In a sketched curve—Creates a datum coordinate
system

Sketched curves In a sketched pattern—Places pattern members

Sketched patterns In a toroidal bend—Defines the neutral plane

Toroidal bends In a wrap feature—Defines the origin

Wrap features

Horizontal-vertical 3–D Sketcher for Conveys feature information, such as graph
features that have not coordinates or the relative origin for each of the
been converted to sections used for blends.
Wildfire UI and that
require a coordinate
system, such as
Graph and Blend.

If We retrieve a section that contains a coordinate system
type unavailable in the current sketch, it is converted
automatically.

Automatic Coordinate System Conversions

When We retrieve a section from the Sketcher Palette or
from a legacy file, it may include a coordinate system

type that is unavailable in the current Sketcher
environment. Under these circumstances, the coordinate
system is automatically converted as follows:

- Horizontal-vertical—Becomes a geometry coordinate
system, in instances where geometry coordinate
systems are available. In other instances, a
construction coordinate system is substituted.
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 For Sketched Curve features, the geometry coordinate
system generates a datum coordinate system outside
Sketcher. Make sure to toggle the system
to Construction if We do not want to create the datum.

- Construction or Datum—Becomes two perpendicular
construction centerlines with a construction point at
the intersection, in instances where horizontal-vertical
coordinate systems are available.

All other coordinate systems created before Pro/
ENGINEER Wildfire 5.0, that are not needed for feature-
level information, are converted to construction coordinate
systems.

Sketch Constraints (Relations). (Fig 4)

Fig 4

Constraint Geometric entities to select Resulting Constraint

Horizontal or One or more lines or two or The lines become horizontal or vertical (as defined
Vertical more points. by the current sketch space). Points arealigned

horizontally or vertically.

Collinear Two or more lines. The items lie on the same infinite line.

Perpendicular Two lines. The two items are perpendicular to each other.

Parallel Two or more lines.

A line and a plane (or a planar The line is parallel to the selected plane.
face) in a 3D sketch. The items
are parallel to each other.

Tangent An arc, ellipse, or spline, and a The two items remain tangent.
line or arc.

Concentric Two or more arcs, or a point and an arc. The arcs share the same centerpoint.

Midpoint Two lines or a point and a line. The point remains at the midpoint of the line.

Coincident A point and a line, arc, or ellipse. The point lies on the line, arc, or ellipse.

Equal Two or more lines or two or more arcs. The line lengths or radii remain equal.

Symmetric A centerline and two points, lines, arcs, The items remain equidistant from the centerline,
or ellipses. on a line perpendicular to the
centerline.

About the Dimension Tools

Use these dimension tools to dimension Sketcher entities:

-  Normal—Creates a linear, radial, diameter, angular,

conic, or ordinate dimension. Works in Continue mode.

-  Perimeter—Dimensions the total length of a chain

or a loop of entities.

-  Baseline—Creates linear dimension entities based

on the position of the first selection. All subsequent
selections are measured relative to the first selection.

-  Reference—Creates a symbolic dimension for the

entity.

To Modify Dimension Values (Fig 5)

To modify one dimension, double-click it. To modify several

dimensions at once, use the Modify Dimensions dialog

box.

To Modify One Dimension

1 Double-click the dimension.

2 Type a new value and press ENTER. The dimension is

changed.

To Trim and Extend Entities

1 Bring the pointer over the entity that we want to trim.
The entity is highlighted.

2 Holding down the CONTROL key, drag the endpoint of
the entity that we want to trim. The entity is trimmed
or extended in the direction in which we drag it. At
every intersection, the constraint that it created is
displayed.

Fig 5
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To Trim Entities to Each Other

1 Click Sketch >  Corner.

2 Click any two entities (they do not have to intersect)
on the portion of the entity that we want to keep. The
two entities are trimmed.

To Delete a Segment

1 Click Sketch >  Delete Segment.

2 Click the segment that we want to delete. The segment
is deleted.

To Divide Entities

We can divide a section entity into two or more new
entities. If the entity is dimensioned, delete the dimension
before using the Divide command.

1 Click Sketch >  Divide.

2 Click the entity at the locations where we want to divide.
The entity is divided at the specified location.

To create a divide at an intersection, click near the
intersection. The curser automatically snaps to the
intersection and the divide is created.

About Dividing and Trimming Entities

We can divide and trim entities by using the Divide and
Trim tools or by holding down the CONTROL key and
dragging the endpoint of the entity to the desired location.

Mirroring Geometry

Use the  Mirror command to mirror Sketcher geometry

about a sketched centerline. For example, we can create
half of the section and then mirror it.

When we mirror geometry, constraints are also mirrored.

We can mirror only geometric entities. We cannot mirror
dimensions, text entities, centerlines, and reference
entities.

About Cut, Copy, and Paste Operations

We can use the cut and copy operations to remove or
duplicate, respectively, a portion of a section or the
complete section.

The sketch entities that we cut or copy are placed on the
clipboard

Click Sketch >  Cut or press CTRL+X to cut the

selected Sketcher geometry entity or entities.

Click Sketch >  Copy or press CTRL+C to copy the

selected sketch geometry entity or entities.

We can use the paste operation to place the cut or copied
entities at a required location within an active section.

Click Sketch >  Paste or press CTRL+V to paste the

copied entities into the active section.

we can use the copied or cut sketch geometry multiple
times. We can also use the cut, copy, and paste
operations to move the contents of a section across
multiple sections.

About Translating, Rotating, and Scaling a Section

We can translate, rotate, or scale an existing sketcher
geometry or an imported or pasted sketch geometry within
an active sketch. The geometry we select to translate,
rotate, or scale appears within a bounding box with the
following handles:

- The translation handle appears at the center of the
bounding box.

- The rotation handle appears at the upper right corner
of the bounding box.

- The scale handle appears at the lower right corner of
the bounding box.

We can move the translation, rotation, or scale handles
from their original locations. To move these handles, right-
click a handle and drag the handle to a new location.

Consider the following points when we translate, rotate,
or scale the sketcher geometry:

- The original position of the translation, rotation, and
scale handles appear in dimmed color when we perform
a translation, rotation, or scale operation.

- The translation, rotation, or scaling dimensions that
appear during the translation, rotation, or scaling
operations, are removed after we complete these
operations.

- Dimensions and constraints are created when we
complete the translation, rotation, or scaling operation.
These dimensions and constraints are independent of
the changes to the geometry as a result of the
translation, rotation, or scaling operation.

- We can undo or redo the translation, rotation, or scaling
operation.

- While performing a translation, rotation, or scaling
operation, we can undo or redo any of these operations
to attain an intermediate state of the geometry. After
we complete the translation operation we cannot
replay the intermediate state of the geometry.

- After we complete the translation, rotation, or scaling
operation by quitting the Rotate Resize tab, the undo
operation displays the geometry in the state before
the translation operations.

- Toaccess the Rotate Resize tab, click Sketch >

  Rotate Resize. In addition, the Rotate Resize tab

opens automatically when we perform one of the
following operations:

- Paste a copied or cut geometry.

- Import a shape from the Sketcher palette.

- Import an existing section from the file system.

We cannot scale a section if we use Paste Special to

paste a copied or cut section.
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Basic modeling
Objectives: At the end of this lesson you shall be able to
• state the  basic features in Creo
• brief  the features like extrude, extrude cut, revolve, revolve cut.

Fig 1

Creating Features

There are many kinds of features that you can create on
a part. There are solid features and surface features, and
features specific to applications. Part modeling refers to
the creation of solid features and some user-defined
features. Some features add material and some remove
material. The most basic way to add material is through
a protrusion. The most basic way to remove material is
through a cut.

Extrude (Fig 1)

Extrusion is a method of defining three-dimensional
geometry by projecting a two-dimensional section at a
specified distance normal to the sketching plane.

Use the Extrude tool as one of the basic creation
methods that allows you to create a solid or surface, and
to add or remove material.

You can create the following extrusion types with the
Extrude tool:

- Protrusion—Solid, Thickened

- Cut—Solid, Thickened

- Extruded surface

- Surface trim—Regular, Thickened

Accessing the Extrude Tool

To access the Extrude tool, click pick the  Extrude

button in the Shapes group of the ribbon

- (Preferred) Select an existing sketched datum curve
and click.  This method is referred to as object-
action.

- Click  and create a sketch to extrude. This
method is referred to as action-object.

- Select a datum plane or planar surface to use as
the sketching plane and then click .

Dash Board

The Dash board consists of the following elements:

Fig 2

Common Extrusion options

-  —Creates a solid.

- —Creates a surface.

- Depth options—Constrains the depth of the
feature. (Fig 2)

- Depth box and Reference collector—Specifies a
depth value for the extrusion that is controlled by
the depth dimension. If a depth reference is required,
the text box acts as a collector and lists the
reference summary.

- —Flips the direction of feature creation with

respect to the sketching plane.

- Options used for creating a cut

- —Creates a cut using the extruded volume.

- —Changes the side to be removed when

creating a cut.

- Options used with the Thicken Sketch option

- —Creates a feature by assigning a thickness

to the section outline.

- —Changes the side where a thickness is

added, or adds a thickness to both sides.

- Thickness box—Specifies a thickness value to
apply to the section outline.

- Options used for creating a Surface Trim

- —Trims a surface using a projected section.

- —Changes the side of the quilt to be removed,

or keeps both sides.

- Quilt collector—If both sides of the quilt are kept,
specifies the side to retain the quilt id of the original
quilt.
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Slide-up Panels

- The Extrude tool provides the following slide-up
panels:

- Placement—Use this slide-up panel to redefine the
feature section. Click Define to create or change
the section. Click Unlink to make the section
independent of the sketched datum curve.

- Options—Use this slide-up panel to do the
following:

- Redefine the depth of the feature for each side of
the sketching plane.

- Create a surface feature with capped ends by
selecting the Capped Ends option.

- Properties—Use this slide-up panel to edit the
feature name and open feature information in the
Pro/ENGINEER browser.

To create an extruded feature

1. Create the sketch profile.

2. Select the Extrude tool 

3. Select / sketch the section.

4. Specify the direction of feature creation.

5. Define depth attributes.

6. To verify the feature, click .

If you are satisfied with the geometry you created, click

Different Types of Extrude Feature

The next table shows different types of geometry that
you can create with the Extrude tool.

Extruded Solid Protrusion

Extruded Solid Protrusion with an assigned thickness
(Thickened)

Extruded Cut, created with Through Next

Extruded Surface

Extruded Surface Trim  A section is projected onto quilt
to cut out a hole in the quilt.

Surface trim with an open section A section is projected
on the quilt to create a trim line and cut the quilt.

Fig 3

Symmetrical and Asymmetrical depth options

The system creates a default extrusion using the Blind
depth option. (Fig 3)

- Side1—To specify the depth of feature on one side of
the sketching plane.

- Side2—Specify the depth to feature to the other side
of the sketching plane separately. (Fig 4)

Fig 4

Sketch Extrude side 1 Extrude side 2
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Through All—Extrudes a section to intersect with all

surfaces. Use this option to terminate a feature at the
last surface it reaches. (Fig 8)

Fig 14

Specifying the Depth Attributes

You can specify the depth of an extruded feature by
selecting one of the following depth options:

Blind—Extrudes a section from the sketching plane

by the specified depth value. (Fig 5)

Note: Specifying a negative depth value flips
the depth direction

Fig 5

Symmetric—Extrudes a section on each side of

the sketching plane by half of the specified depth
value.

 Through Until—Extrudes a section to intersect with

a selected surface or plane. For a terminating surface,
you can select the following (Fig 6)

Fig 6

- A part surface, which is not required to be planar

- A datum plane, which is not required to be parallel to
the sketching plane

- A quilt composed of one or several surfaces

- In an assembly, you can select geometry of another
component.

To Next—Extrudes a section to the next surface. Use

this option to terminate a feature at the first surface it
reaches.Note: You cannot use a datum plane as a
terminating surface. (Fig 7)

Fig 7

Fig 8

To Selected—Extrudes a section to a selected point,
curve, plane, or surface. (Fig 9, 10 & 11)

Fig 9

Fig 11

Fig 10
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To Add Taper to a  Extruded Feature (Fig 12)

You can add a taper to an extrude if the section of the
feature is a closed loop. You cannot taper an extrude if is
selected to add a thickness. The Extrude tab must be
open to perform this procedure. (Fig 13

Extruded Feature before Taper Extruded Feature after Taper

Fig 13

1 Click the Options tab.

2 Select the Add taper check box

3 Type a value for the taper angle from -89° to +89° in
the box.

To Create a Thin Extruded Feature (Fig 14)

1 Click Model Extrude. The Extrude tab opens.

2 Select a sketch to extrude, or to create a sketch, click
the Placement tab, click Define, sketch a section, and

click OK. Note :You could also select a sketch

first, or select a datum plane or planar surface first,

and then click Model  Extrude.

3 Select a depth option from the menu.

4 To flip the direction of feature creation in relation to the

sketching plane, click .

5 To add thickness to the sketch, click   or right-

click the feature and choose Thicken Sketch on the
shortcut menu.

1 Type a value for thickness in the box to the right of 

2 To change the side of the sketch where the thickness
is added, click to the right of the thickness box. You
can switch between three modes: Side 1, Side 2 or
Both sides.

3 (Optional) The section used for the extrusion is
associative with the sketched datum curve you
selected. To break this associativity and copy the
section into the extrusion, click the Placement tab,
and then click Unlink.

4 To create a double-sided feature, click the Options
tab and define the depth for the second side.

Click 

Revolve (Fig 15)

The Revolve tool creates a feature by revolving a

sketched section around a centerline. Use the Revolve
tool as one of the basic creation methods that allows you
to create a revolved geometry as a solid or surface, and
to add or remove material.

You can create different types of revolved feature with the
Revolve tool:

- Revolved protrusion—Solid, Thickened

- Revolved cut—Solid, Thickened

- Revolved surface

- Revolved surface trim—Regular, Thickened.

Fig 15

To Create a Revolved Feature

To access the Revolve tool, pick  the Revolve the

Extrude button in the Shapes group of the ribbon.

The dash board consists of the following elements:
Common Revolve options. (Fig 16)

Fig 12
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Fig 16

- —Creates a solid feature.

- —Creates a surface feature.

- Angle options—Lists options to constrain the angle
of revolution for the feature. Choose one of these

options: Variable, Symmetric, or To

Selected.

- Angle box/Reference collector—Specifies an angle
value for the revolved feature. If a reference is
required, the text box acts as a collector and lists
the reference summary.

- —Flips the direction of feature creation with

respect to the sketching plane.

- Options used for creating a cut

- —Creates a cut using the revolved feature

volume.

- —Changes the side to be removed when creating
a cut.

- Options used with the Thicken Sketch option

- —Creates a feature by assigning a thickness to
the section outline.

- —Changes the side where a thickness is added or
adds a thickness to both sides.

- Thickness box—Specifies a thickness value to
apply to the section outline.

- Options used for creating a Revolved Surface Trim

- —Trims a surface using a revolved section.

- —Changes the side of the quilt to be removed, or
keeps both sides.

- Quilt collector—If both sides of the quilt are kept,
select the side to retain the quilt id of the original
quilt.

About Sections Used for Revolved Features

Creating a revolved feature requires you to define a section
that you want to revolve and the axis of revolution. The
axis can be a linear reference or a Sketcher centerline.

Consider the following rules for defining revolved sections:

- You can use open or closed sections to create
revolved surfaces.

- Geometry must be sketched only on one side of
the axis of revolution.

Different Types of Revolved Feature

The next table shows different types of geometry that you can create with the Revolve tool.

Revolved Solid Protrusion

Revolved Protrusion with an assigned thickness
(created using a closed section)

Revolved Protrusion with an assigned thickness
(created using an open section)

Revolved Cut

Revolved Surface
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About the Angle of Revolution (Fig 17)

In a revolved feature, a section is revolved around an axis
of revolution to a specified angle. You can define the angle
of revolution by selecting one of the following angle options:

Variable—Revolves a section from the sketching

plane by the specified angle value. Type the angle value
in the box, or select one of predefined angles (90,180,270,
360).

Symmetric—Revolves a section on each side of the

sketching plane by half of the specified angle value.

To Selected—Revolves a section up to a selected

datum point, vertex,  plane, or surface.

Note: The terminating plane or surface must contain the
axis of revolution.

Tips for Changing the Angle Option Using Snapping

You can use snapping to the nearest reference to change
the angle option from Variable to ‘To Selected’. Hold down
SHIFT and drag the handle to a reference that you want
to use to terminate the feature.You can change the angle
option back to Variable by holding down SHIFT and
dragging the handle. As you drag the handle, the angle
dimension is displayed.

About a Revolved Cut

You can use the Revolve tool to remove material by
revolving a sketched section about a centerline.To create
a cut, use the same angle options as for protrusions. For
solid cuts, use closed sections. For cuts created with
Thicken Sketch, you can use both closed and open
sections.While defining a cut, you can switch between
the following feature attributes:

- Cut and protrusion by clicking Remove Material

- The side where material is removed by clicking Flip

Material Side

- Solid and thin cut by clicking  Thicken Sketch.

Fig 17

Advanced Modelling

Objectives : At the end of this lesson you shall be to

• explain the blend, sweep and shell features in creo

• explain profile, pattern and round features in creo

• state the features of chamfer, hole and draft in creo.

The Advanced modelling using Creo Parametric,
teaches you how to use advanced part modelling
techniques to improve your product designs. You will learn
various tools used in Creo parametric,

Blends

A blended feature consists of a series of at least two planar
sections that have been joined at their vertices with
transitional surfaces to form a continuous feature.

Example: Starting Points and Blend Shape

The starting points of the sections influence the shape of
the blend. Fig 1.

Swept blends

A swept blend can have two trajectories: an origin trajectory
(required) and a secondary trajectory (optional). Each
Swept Blend feature must have at least two sections, and
sections may be added between these two sections. To
define a trajectory of the swept blend, you can select a
sketched curve, a chain of datum curves, or edges. Only
one trajectory is active at a time.

Example: Creating a Swept Blend Fig.2

Completed Swept Blend

Sweeps

Create a Sweep feature by sweeping a cross-sectional
sketch along one or more trajectories. You can control the
object’s orientation, rotation, and geometry.

Material can be added or removed as the sketch sweeps
along the trajectory. You can add a thickness to the
sketch. The geometric representation of the sweep can be
solid or surface.
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Fig 2

You can merge the end of a solid sweep to a nearby solid
surface without leaving a gap. You can close each end of
a surface sweep if the sketch forms a closed loop, and the
trajectory is open. When you create cut, trim, or thin
features, use the arrows in the graphics window to indicate
the direction of the tool operation. About Constant Section
Sweeps

You create a sweep feature with a constant section by
specifying a trajectory and then sketching a section to
follow along it. Fig 3.

Fig 3

1 Trajectory     2 Section 3 Swept feature.

Shell Feature

The Shell feature hollows out the inside of the solid, leaving
a shell of a specified wall thickness.

It lets you specify a surface or surfaces that you want to
remove from the shell (Fig.4). If you do not select a surface
to remove, a “closed” shell is created (Fig.5), with the
whole inside of the part hollowed out and no access to the
hollow.

If you flip the thickness side (for example, by entering a
negative value, or by clicking  on the Shell tab), the shell
thickness is added to the outside of the part.

When defining a shell, you can also select surfaces where
you want to assign a different thickness. You can specify
independent thickness values for each such surface.

The Shell feature allows you to select the adjacent tangent
surfaces. This enables you to remove or offset
(independently or with different thickness) the surfaces
which are tangent to their neighbouring surface at one or
more boundaries.

At the tangent edge, where the separation of the shell
offset occurs, a normal capping surface is constructed to
close the gap.

Fig 4

Fig 5

Profile Rib Feature

A Profile Rib feature is a thin fin or web protrusion that
attaches to solid surfaces in your design. Typically, these
ribs are designed to strengthen parts in your design and
are often used to prevent unwanted bending. You can
create a profile rib by defining the feature cross section
between two perpendicular surfaces.

Profile Rib features are only available in Part mode, and
they are subject to normal feature operations, including
patterning, modifying, editing references, and redefining.

Designing a Profile rib feature requires you to:

- Create a dependent section by selecting a Sketch
feature from the Model Tree, or to sketch a new
independent section.

- Determine the rib material side with respect to the
sketching plane and desired rib geometry.

You can enter the Profile Rib tool and begin designing your
rib feature under the following conditions:

- Sketch Not Selected—Entering the Rib tool and then
selecting an existing sketch or creating a new sketch
for the Rib feature.

- Sketch Selected—Selecting an existing sketch for the
Rib feature and then entering the Rib tool.

In either case, after you designate a sketch for the rib, the
validity of your sketch is examined and, if valid, it is placed
in the collector. The reference collector only accepts one
valid rib sketch at a time.

There are two types of profile rib features available.
However, the type is automatically set according to the
attaching geometry.
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Straight Attaches to straight surfaces.Extrudes
either to one side or symmetrically
about the sketching plane.

Rotational Attaches to surfaces of revolution.
The angled surface of the rib is conical,
not planar.Revolves the section about the
axis of the parent, making a wedge either
to one side or symmetrically about the
sketching plane. The wedge is then
trimmed with two planes parallel to the
sketching surface. The distance between
the planes corresponds to the thickness
of the rib and attaching geometry.

The Pattern Feature

A pattern consists of multiple instances of a feature.
Select a pattern type and define dimensions, placement
points, or a fill area and shape to place the pattern
members. The result of the operation is a feature pattern.
When you pattern this feature pattern, the result is a
feature pattern pattern. You cannot pattern either a group
pattern or a feature pattern pattern.

For most pattern types, the feature or feature pattern
selected for patterning is the pattern leader. After you
pattern the selected feature or feature pattern, the pattern
leader that you selected is the pattern header while the
instances are pattern members. To copy, mirror, and
move patterns, you must select the pattern header instead
of the pattern members.

You can create a Reference Pattern of a feature that
references the geometry of any pattern member. The
feature selected for patterning does not need to be on the
pattern leader.

You can mirror a pattern, group pattern, or pattern of a
pattern. You can also apply move or rotational
transformations to a pattern, group pattern, or pattern of a
pattern.

Patterns offer the following benefits:

- Creating a pattern is a quick way to reproduce a
feature.

- A pattern is parametrically controlled. Therefore, you
can modify a pattern by changing pattern parameters,
such as the number of instances, spacing between
instances, and original feature dimensions.

- Modifying patterns is more efficient than modifying
individual features. In a pattern, when you change
dimensions of the original feature, the whole pattern is
updated.

- It may be easier or more effective to perform operations
once on the multiple features contained in a pattern,
rather than on the individual features. For example,
suppressing a pattern or adding it to a layer.

You can only pattern a single feature. To pattern several
features, create a local group and pattern this group. You
can choose Unpattern from the shortcut menu when a
group pattern or pattern pattern of the following types is
created:

- Dimension -    Table

The result is a set of groups or feature patterns.

- The line style attributes of a datum curve are not
transferred to its pattern members.• A thin feature
“remembers” the surface to which it is attached and
patterns to this surface.

The Round Feature

A round is an edge treatment feature in which a radius or
chord is added to one or more edges, an edge chain, or the
space between surfaces. Surfaces can be solid model
surfaces, or they can be zero-thickness quilts or surfaces.

To create rounds, you must define one or more round sets.
A round set is an organizational unit containing one or
more pieces of round geometry. After you specify round
placement references, default attributes, radius or chord
values, and transitions are used to create a round that best
fits the selected geometry. When you select multiple
references, the round propagates across tangent neighbors
until it encounters a break in tangency.
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Round Sets and Transitions

About Round Types
You can create the following round types:
- Constant
The round piece has a constant radius (Fig 6).

- Variable

The round piece has multiple radii (Fig 7).

- Round driven by a curve

The radius of the round is driven by the datum curve

(Fig 8).

1 Datum curve

- Full

The full round replaces the selected surface (Fig 9).
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The chamfer feature

You can create and modify chamfers. Chamfers are a type
of feature where an edge or corner is beveled. Surfaces can
be solid model surfaces or traditional Creo zero-thickness
quilts and surfaces. You can create two types of chamfers:
corner chamfers and edge chamfers.

Corner Chamfers

You create corner chamfers using the  Corner
Chamfer tool. When you create a corner chamfer, you

select a vertex defined by three edges, and then you set
length values along each chamfer direction edge.

Edge Chamfers

You create edge chamfers using the   Edge Chamfer tool.
To create edge chamfers, you define one or more chamfer
sets. A chamfer set is an organizational unit containing
one or more chamfer pieces (chamfer geometry).

Set Mode Display Transition Mode Display

Two edge references are selected for the chamfer set. All transitions for the entire edge chamfer feature
Preview geometry of the two chamfer pieces and the are displayed. The two chamfer pieces are
distance value is shown. shown for context.

The hole feature

The Hole tool enables you to add simple, custom, and
industry-standard holes to your models. You add holes by
defining a placement reference, offset references, optional
hole orientation references, and the specific characteristics
of the hole.

As you work, the system displays preview geometry of the
hole. Notice that a hole always begins at the placement
reference and extends to the specified depth. You can
directly manipulate and define the hole in the graphics
window and on the Hole tab.

You can create the following hole types:

- Simple—Consists of an extruded or revolved cut that is
not directly associated with any industry standard.
You can create the following Simple holes types:

- Predefined rectangle profile—Uses (straight) geometry
predefined by the system. By default, the system
creates one-sided Simple holes. However, you can
create two-sided Simple Straight holes by using the
Shape tab. Two-sided Simple holes are typically used
in assemblies and enable you to simultaneously format
both hole sides.

- Standard hole profile—Uses standard hole profile as
drill hole profile. You can specify the countersink,
counterbore, and tip angle for the holes.

- Sketched—Uses a sketch profile that you create in
Sketcher.

- Standard—Consists of a revolved cut based on industry-
standard fastener tables. Creo provides industry-
standard hole charts and tapped or clearance diameters

for the selected fastener. You can also create your own
hole charts. The thread notes are automatically created
for Standard holes. You can separate the hole axis
from the hole thread surface and place the thread in a
specified layer. You can create the following types of
Standard holes:

-   — Tapped hole

-   — Tapered hole

-   — Drilled hole

-   — Clearance hole

Hole Features vs Cut Features

Hole features are different from cut features in the following
ways:

- Hole features use a predefined placement scheme that
can be more desirable than the dimensioning scheme
of the cut.

- Simple Straight holes and Standard holes do not
require a sketch, unlike cut features.

The Draft Feature

The Draft feature adds a draft angle from -89.9° to +89.9°
to individual surfaces or to a series of surfaces. You can
draft only the surfaces that are formed by tabulated
cylinders or planes. To access the Draft feature, click
Model >  Draft.

You can draft either solid surfaces or quilt surfaces, but not
a combination of both. When you select surfaces to be
drafted, the first selected surface determines the type of
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additional surfaces, solid or quilt, that can be selected for
this feature.
For drafts, the system uses the following terminology:
- Draft surfaces—The surfaces of the model that are

being drafted.
- Draft hinges—Lines or curves on the draft surfaces that

the surfaces are pivoted about (also called neutral
curves). Draft hinges can be defined by selecting a
plane or quilt, in which case the draft surfaces are
pivoted about their intersection with this plane, or by
selecting individual curve chains on the draft surfaces.

- Pull direction (also called draft direction)—Direction
that is used to measure the draft angle. This is usually
the direction of mold opening. You can define it by
selecting a plane (in which case the pull direction is
normal to this plane), a straight edge, a datum axis, or
an axis of a coordinate system.

- Draft angle —The angle between the pull direction and
the resulting drafted surfaces. If the draft surfaces are
split, you can define two independent angles for each
side of the drafted surface. Draft angles must be within
the range of -89.9° to +89.9°.

Draft surfaces can be split either by the draft hinge or by
a different curve on the draft surface, such as an intersection
with a quilt, or a sketched curve. If you are splitting by a
sketch, the system extrudes it to a quilt within the draft
feature, in the direction normal to the sketching plane. If
the draft surfaces are split, you can:
- Specify two independent draft angles for each side of

the drafted surface.
- Specify a single draft angle, with the second side

drafted in the opposite direction.
- Draft only one side of the surface (either one), with the

other side remaining in the neutral position.
When the surfaces to be drafted include rounds, you can
either preserve the rounds, and they remain rounds, or you
can draft the rounds, and then they become conic.
If you propagate a draft, the system expands the selection
of surfaces to be drafted. The draft adds surfaces until a
sharp edge or a surface that cannot be drafted is reached.
The draft_tan_propagation_default configuration option
defines the default of whether to propagate a draft or not.
The   command defines whether to propagate a draft f or
the draft feature.

Assembly

Objectives : At the end of this lesson you shall be to
• describe the process of assembly in creo.

To create a subassembly or an assembly, you must first
create datum features or a base component. You can
then create or assemble additional components to the
existing component(s) and datum features.

Assembling Components

You can add components to an assembly in the following
ways:

- Assemble a component parametrically by specifying
its position relative to the base component or other
components and/or datum features in the assembly.

- Assemble components manually or automatically using
predefined component interfaces. Refer to About
Automatic Placement of Components for more
information.

- Assemble a component nonparametrically using the
Package command in the Assembly group. Use
packaging as a temporary means to include the
component in the assembly; then finalize its location
with assembly instructions.

- Create a part or subassembly directly in Assembly.

- You can use notebooks and specify declarations to
assemble components automatically. You create these
assemblies by automatically aligning datum planes
and axes of different parts in accordance with the
declarations previously made in Notebookt and Part
modes. You can specify declarations, and after a
component has a declaration, it can be automatically
assembled.

- You can include a component as a member of an
assembly without actually placing it in the assembly
window. This technique allows you to list the
component as a member of the assembly even if  the
component is not ready to be assembled (for example,
it does not have geometry). The system lists included
components in the Model Tree and BOM, but does
not display them on the screen or include them in
mass property calculations. To add constraints later,
you can redefine the placement of the component.

You can remove a component from an assembly by
deleting it or replacing it with another component. In
addition, you can also redefine the placement constraints
for assembled components.

To place a base component or feature, you must either
create three orthogonal datum planes as the first feature,
assemble an existing component (part, subassembly, or
skeleton model), or create a base component.

A component that is added into an assembly is saved in
the assembly directory.

Using Datum Planes as the First Feature: When you
create three orthogonal datum planes as the first feature
in an assembly, you can assemble a component with
respect to these planes, or create a part in Assembly as
the first component. Using datum planes as the first
feature has the following advantages:
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- You can redefine the placement constraints of the first
assembled component.

- You can pattern the first component you add, creating
a flexible design.

- You can reorder subsequent components to come
before the first one (if the components are not children
of the first component).

Assembling a Component Parametrically: Using the
Component Placement tab, you can assemble
components parametrically by establishing constraints
that define the component’s position in the assembly.
The component’s position changes according to changes
in components or assembly features to which it is
constrained.

Creating a Base Component: If you do not create three
orthogonal datum planes, the base component is the first
part, subassembly, or skeleton model placed into an

assembly. In many ways it is like the base feature of a
part. The initial assembly units are the same as the units
of the base component. When a base component is the
first object in an assembly (before any assembly features),
no placement constraints are defined. You place the
component with the Default constraint. If you replace a
base component with interchangeable components, the
replacing components will always be placed by default
as well.

When you create the first component of an assembly,
you can either create an empty component or copy from
an existing component. As with an assembled base
component, the initial assembly units are the same as
the base component, and interchange components that
replace the created base component will always be in
the default orientation.

Creo parametric drawing

Objectives : At the end of this lesson you shall be to

• list the functionally of engineering drawing modes in creo parametric

• brief the steps involved in creating a drawing

• explain the methods of adding models and opening a existing models in drawing.

About the Creo Parametric Drawing Mode: Creo

Parametric offers functionality to work with engineering

drawings in Drawing mode with the Detail module. Use

this module to perform the following operations:

- Create drawings of all Creo Parametric models.

- Export drawing files to other systems and import files

into Drawing mode.

- View and annotate models and drawings.

- Manipulate dimensions, and use layers to manage the

display of different items. Creo Parametric associates

drawings with their parent models. The model

automatically reflects any dimensional changes that

you make to a drawing. In addition, corresponding

drawings also reflect any changes that you make to a

model (such as the addition or deletion of features

and dimensional changes) in Part, Sheetmetal,

Assembly, or Manufacturing modes.

- Work with various view types. All views in the drawing

are associative. If you change a dimensional value in

one view, other drawing views are updated accordingly.

- Work with multiple sheets in the drawing.

- Add and modify different kinds of textual and symbolic

information.

- Define mapkeys for drawing operations. Execute the

mapkeys in any of the tabs irrespective of whether the

tab is active or not.

- Customize engineering drawings with sketched

geometry, create custom drawing formats, and make

multiple cosmetic changes to drawings.

- Use shortcut menus to modify an object in a drawing

from anywhere in the Model Tree, Drawing Tree, or the

graphics window. At any time when a drawing window

is active, you can interrupt your current process and

activate a drawing object for modification.

- Create 3D parametric, feature-based models from 2D

drawing data using AutobuildZ. The 2D drawing data

can be imported to Creo Parametric from any of the

supported file formats, such as DXF, DWG, and IGES.

Additionally you can use the following capabilities of

AutobuildZ:

- Clean up 2D data by moving unnecessary and

unwanted data to blanked layers.

- Associate the parts with the active drawing in session.

- Create features in the active part by selecting

geometric entities on the drawing in session.

- Map the views of the drawing to datum planes in the

parts.

- Automatically regenerate the drawing views of the

active part on a separate drawing sheet when features

are added to the active part.

Creating a Drawing: When you start a new drawing,

you specify a 3D model file in which to place drafting

views.
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1 Click File > New. The New dialog box opens.

2 Click Drawing and type a name in the File name box

or use the default. Click OK. The New Drawing dialog

box opens.

3 In the Default Model box, type the name of a model in

the working directory. If you started the new file from

an open 3D file, the 3D file name appears by default.

The selected model is set as the current drawing model.

4 Under Specify Template, do one of the following:

- To use a drawing template, click Use template and

select a template from the list.

- To create a drawing without a template but with an

existing format, click Empty with format. Under Format,

specify the format you want to use.

- Specify the drawing size or retrieve a format. To specify

the size, do one of the following:

Click Portrait or Landscape in the Orientation box and

select a standard size from the Standard Size list.

Alternatively,

Click Variable in the Orientation box to define both the

height and width dimensions. Select Inches or Millimeters

and type values in the Width and Height boxes.

To retrieve a format, select Retrieve Format and select a

name from the Name list in the Format box. You can also

type [?] or click Browse to select a name from the Open

dialog box.

5 Click OK. The new drawing opens.

- If the part that you are using to create the drawing has

simplified representations, the Open Rep dialog box

opens. Select the required representation and click

OK. The new drawing is created with the selected

representation set as the current representation of the

drawing model.

- If you are using the default template to create the

drawing of a part that has simplified representations,

the default representation is used to create the drawing.

The Open Rep dialog box opens only when you are

creating a new empty drawing.

- If a model has multiple instances defined with a Family

Table, you are prompted to choose an instance from

the Select Instance dialog box before you select the

representation using the Open Rep dialog box.

Adding Models to the Drawing: Before you can place

a view of a 3D model, you must associate the 3D model

with the drawing. This is called adding the model to the

drawing.

When you start creating a new drawing file you are

prompted in the New File dialog box for a 3D model to

reference. Once the drawing is in progress, use the

following procedure to add other models to the drawing

file:

1 Open a drawing to add a drawing model.

2 Perform one of the following operations:

- Click   Drawing Models in the Model Views group of

the Layout tab.

- Right-click and click Drawing Models on the shortcut

menu.

The DWG MODELS menu appears on the Menu Manager.

3 Click Add Model. The Open dialog box opens and lists

all the files in your current working directory.

4 Select the model to add as a drawing model to the

current drawing, and click Open.

- If the new model that you are adding to the drawing

contains part simplified representations, the Open Rep

dialog box opens. Select the required representation

and click OK.

- If the model that you are adding to the drawing has

different instances of a Family Table, you are first

prompted to select an instance from the Select

Instance dialog box, and then the simplified

representation from the Open Rep dialog box.

5 The model is added to the drawing and set as the

current drawing model. If you have selected a

representation in the Open Rep dialog box, the

selected representation is set as the current

representation of the drawing model.

Adding a model to the drawing does not place a view of

the model on the sheet, but lets the drawing reference

the model so that you can place a view. You can insert

drawing views of the newly added part as you would for

any other drawing model.

Opening a Model from a Drawing

To open a model from within Drawing mode, you can use

File > Open, or you can use the Model Tree.

1 Click File > Open. The File Open dialog box opens.

2 Navigate to and select the model you want to open,

and then click Open.

The model is retrieved into the current session in a

separate window.

Using the Model Tree

1 In the Model Tree, select the model you want to

retrieve, and then right-click to display the shortcut

menu.

2 Click Open from the shortcut menu. The model is

retrieved into the current session.
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Surface Modelling
Objectives : At the end of this lesson you shall be to
• describe the method of creativity an Extruded Surface
• explain the method of creativity a Revolved Surface
• explain method of creativity a Sweep Surface
• state the method of creativity a Blended Surface
• describe the method of creativity a Swept Blend Surface
• explain the method of creativity a Helical Sweep Surface.

Surface modeling
Surface models are a type of three-dimensional (3D) 
models with no thickness. These models are widely 
used in industries like automobile, aerospace, plastic, 
medical, and so on. Surface models should not be 
confused with thick models, that is, models having 
mass properties. Surface models do not have thickness 
whereas thick or solid models have a user-defined 
thickness. In Pro/ENGINEER, the surface modeling 
techniques and feature creation tools are the same as 
that used in solid modeling. A solid model of any shape 
that is created can also be created using the surface 
modeling techniques. The only difference between 
the solid model and the surface model will be that the 
solid model will have mass properties but the surface 
model will not. Sometimes, complex shapes are difficult 
to create using solid modeling. Such models can be 

easily created using surface modeling and then the 
surface model can be converted into the solid model. It 
becomes easy for a person to learn surface modeling if 
he is familiar with solid modeling feature creation tools.

Creating surfaces in pro/engineer wildfire 2.0
In Pro/ENGINEER Wildfire 2.0, a sketch can be toggled 
between a solid model and a surface model. The two tool 
buttons that are used to toggle between the solid feature 
and a surface feature are available on dashboards.

Creating an Extruded Surface
To create an extruded surface, choose the Extrude Tool 
button from the Base Features toolbar. The Extrude 
dashboard is displayed as shown in Fig 1.

Fig 1

 In this dashboard, the Extrude as solid button is 
selected by default. Select the Extrude as surface 
button to extrude the sketch and create a surface 
model. Attributes are sketch plane, both-side or one-
side extrusion, depth of extrusion, and so on are same 
for the surface model as solid model.

A surface model can be extruded with capped ends 
or with open ends. To create the capped end surface 
model, the sketch should be a closed loop. Otherwise, a 
surface can be created with the open sketch Fig 2&3.

To create a surface with capped ends, select the Capped 
Ends check box in the Options slide up panel.

Creating a Revolved Surface
To create a revolved surface, choose the Revolve Tool 
button from the Base Features toolbar.

The Revolve dashboard is displayed as shown in Fig 4. 
This feature creation tool works in the same way as in 
the case of solid modeling.

Fig 2 Fig 3

Fig 4

 The Revolve as solid button is selected by default; 
choose the Revolve as surface

button to create a revolve surface. You can create a 
revolved capped end surface or an open end surface. 
The Capped End check box in the Options slide-up 

panel is available only when the sketch is closed and 
the angle of revolution is less than 360-degrees. Fig 5 
shows the open end revolve surface and Fig 6 shows 
the capped end revolve surface.
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Creating a Blended Surface
To create a surface blend, choose Insert > Blend > 
Surface from the menu bar. The BLEND OPTS menu 
is displayed. The method to create a blended surface 
is the same as that to create a solid blend. To create 
a solid blend feature, refer to Chapter 7. Blended 
surfaces can be with open ends or capped ends.
Fig 9 shows the blended surface with open ends and  
Fig 10 shows the blended surface with capped ends.

Creating a Sweep Surface
To create a sweep surface feature, choose Insert > 
Sweep > Surface from the menu bar. The SWEEP 
TRAJ menu is displayed. The method to create a 
surface sweep feature is the same as that to create a 
solid sweep feature. The additional option of capping 
the ends is also available in the Sweep option.

Fig 7 and 8 show the sweep surfaces with the open and 
closed ends respectively.

Fig 5

Fig 7

Fig 13

Fig 9

Fig 6

Fig 8

Fig 14

Fig 10

Creating a Swept Blend Surface
To create a swept blend surface, choose Insert > Swept 
Blend > Surface from the menu bar.

The BLEND OPTS menu is displayed. The method to 
create a swept blend surface is the same that to create 
a solid swept blend feature. Fig 11 shows the swept 
blend with open ends and Fig 12 shows the swept blend 
with capped ends.

Fig 11 Fig 12

Creating a Helical Sweep Surface
To create a surface helical sweep, choose Insert > 
Helical Sweep > Surface from the menu bar.

The Surface dialog box and the ATTRIBUTES menu 
is displayed. The method to create a helical sweep 
surface feature is the same as that to create a solid 
helical sweep feature. Fig 13 shows the helical sweep 
surface with open ends and Fig 14 shows the helical 
sweep surface with capped ends.

Creating a Surface Using Variable Section Sweep

To create a surface by variable section sweep, choose 
Insert > Variable Section Sweep from the menu bar. The 
Variable Section Sweep dashboard is displayed. The 
procedure to create a variable section sweep feature 
or surface is the same as was discussed in Chapter 8.  
Fig 15 shows the trajectories and section that are used 
to create the variable section sweep surface. You have 
an option to keep the ends open or capped. This option 
is available in the Options slide-up panel.

Fig 15

Creating surfaces using style environment of Pro/
Engineer / CREO
Style is an environment available in Pro/ENGINEER that 
is used to draw free style curves and create surfaces 
by joining them. The surfaces created using the Style 
environment are called Super features. This is because 
these features can contain any number of curves or 
surfaces. The Style surfaces can be joined with the Pro/
ENGINEER surfaces. They can have the parent-child 
relationship among themselves and as well as with Pro/
ENGINEER features. To enter the Style environment, 
choose the Style Tool available in the Base Features 
toolbar or choose Insert > Style from the menu bar.  
Fig 16 shows the appearance of the Style environment.

Style Tools Toolbar 
Fig 17 shows the Style Tools toolbar available in the 
Style environment. The tools available in this toolbar 
are discussed next.

Select Button 
This button is used to select the surfaces, curves, 
planes, and so on in the Style environment. If you are 
in middle of a feature creation tool you can choose the 
Select button to exit that tool.
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Fig 18

Set the active datum plane Button
This button is used to select the datum plane on which the 
drawing or the editing operation needs to be performed. 
The datum plane that you select is highlighted by a 
mesh.

Create Internal Datum Plane Button
This button is chosen by selecting the black arrow on 
the right of the Set the active datum plane button. When 
you select the arrow, the flyout is displayed. Choose 
the Create Internal Datum Plane button to create an 
internal datum plane in the Style environment. When 
you choose this button the DATUM PLANE dialog box 
is displayed. This dialog box is used to create a datum 
plane. The datum planes are named as DTM1, DTM2, 
and so on. 

It should be noted that the datum planes created using 
this button are displayed in the graphics window only 
when you are in the Style environment. Once you 
exit the Style environment, the datum plane becomes 
invisible. Any feature created in the Style environment is 
displayed in the Model Tree as a Style feature.

Create Curves Button
This button is used to draw curves. When you choose 
this button, the Curve dashboard is displayed as shown 
in Fig 18.

The options in this dashboard are discussed next.

Fig 16

Fig 17

Free Radio Button
When the Curve dashboard is displayed, the Free radio 
button is selected by default. The

prompt in the Message Area reads “Click to define 
points for the curve (SHIFT to snap)”.

To create curve, click on the screen. A yellow point is 
displayed at the location where you clicked. Now, again 
click to define the second point of the curve. The two 
points are joined. When you click to define the location 
of the third point, you will notice that the curve that you 
are drawing is defined by a spline. After defining the 
points, press the middle mouse button to create the 
curve. While specifying a point if you press the SHIFT 
key then the point is snapped to the entity already 
present on the screen. 

Remember that the curve drawn using the Free option 
is created on the active datum plane. To draw a 3D 
curve you need to snap the point on the existing entity. 
You can also draw a 3D curve by choosing the Toggle 
showing all views and one view full-size button from the 
Style toolbar. When you choose this button, the display 
is turned into four windows. In Pro/ENGINEER, this 
type of display is called a 4-view display mode. The four 
views show the top, default, right-side, and front views. 
You can select a point in one window and then select 

the second point in the other window. By specifying 
points in different windows, the 3D curve can be drawn. 
To switch back to the single window display mode, 
choose the Toggle showing all views and one view full-
size button.

Planar Radio Button

This radio button when selected allows you to create 
the curve on the datum plane that is highlighted by the 
mesh. This datum plane is called the active plane. The 
active plane can be selected before invoking the Curve 
dashboard by choosing the Set the active datum plane 
button.

COS Radio Button
This radio button is used to draw curves on surfaces. 
The points that you define on a surface are constrained 
to that surface. When you click to define the location 
of the first point of the curve, the point is placed. Now, 
this surface is selected and the points placed hereafter 
should lie on the same surface. If you click outside this 
surface then the point is not placed on the surface. After 
the curve is drawn, press the middle mouse button. The 
red curve is converted to a white curve indicating that 
the curve is completed. The curve drawn on the surface 
is the child of the surface.
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Control Points Check Box
While drawing the curve, if this check box is selected, 
then while editing the curve thecontrol points are 
displayed.

Edit curves Button
This button is used to edit the curves that are created 
as style features. When you choose this button the Edit 
curve dashboard is displayed and you are prompted to 
select a curve. When you select a curve to edit, the Edit 
curve dashboard appears as shown in Fig 19.

Fig 19

The options in the Edit curve dashboard are discussed 
next.

Curve collector
When you select a curve to edit, the id of the curve is 
displayed in this collector.

Free radio button
If the curve that is selected for editing was drawn using 
the Free option, then this radio

button is selected by default.

Planar radio button
If the curve that is selected for editing was drawn using 
the Planar option, then this radio button is selected by 
default.

COS radio button
If the curve that is selected for editing was drawn using 
the COS option, then this radio  button is selected by 
default.

Proportional Update check box
If the curve that is selected for editing was drawn using 
the Proportional Update option, then the curve is edited 
proportionately with the points.

Control Points check box
If the curve that is selected for editing was drawn using 
the Control Points option, then the control points are 
displayed on the curve. Using these control points you 
can modify the shape of the curve.

By default, a curve has a natural contact with the 
adjacent surface. This is evident from the check mark 
on the left of the Natural option in the shortcut menu.  
Fig 20 shows the curve that is connected to the adjacent 
surface using the Natural option. The curve is drawn 
using the Free option. The point on the cylindrical 
surface is selected by using SHIFT+left mouse button 
and similarly another point is selected on the surface at 
the base. Fig 21 shows the curve whose contact type is 
changed to the Surface Tangent option by choosing it 
from the shortcut menu.

Creating COS’s by projecting curves onto surfaces 
Button
Using this button, a curve created in the Style environment 
can be projected onto the selected surface.

Fig 20

Fig 21

Fig 22

Fig 23

Create surfaces from boundary curves Button
This button is used to create a surface among a closed 
boundary of curves. When you choose this button the 
Boundary Surfaces dashboard is displayed and you 
are prompted to select three or four boundary curves 
to define a surface. Select the four curves as shown in 
Fig 22. After selecting the four curves, press the middle 
mouse button. The surface is created as shown in  
Fig 23.
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Connect surfaces Button
When you choose this button, the Connect surfaces 
dashboard is displayed and you are prompted to select 
the two surfaces. The Style surface can be connected 
to the Pro/ENGINEER surface. When you select the two 
surfaces shown in Fig 24 and press the middle mouse 
button, the connections are automatically applied to the 
two surfaces.
Fig 24

Fig 26

Fig 25

These connections may be of two types: curvature 
connection represented by a dashed line and the tangent 
connection represented by an arrow. If the tangent 

connection is applied then the arrow is displayed and 
if the curvature connection is applied then a dashed 
line is displayed on the surfaces. Fig 25 shows the two 
surfaces where the tangent connection is applied and 
is not applied.

After surfaces are selected, the Connect surfaces 
dashboard is displayed as shown in Fig 26. To apply the 
connection, click on any one end of the dashed line. The 
dashed line is converted to an arrow, indicating that the 
two surfaces are connected. To remove the connection, 
use SHIFT+left click on the arrow.

Trim selected quilts Button
This button is used to trim a surface. When you choose 
this button, the Trim dashboard is displayed and you 
are prompted to select the surface(s) to trim. Select the 
surface so that it turns pink in color and then press the 
middle mouse button. Now, you are prompted to select 
the curve that will be used to trim the surface. Select the 
curve and press the middle mouse button. The selected 
surface is highlighted in two portions. Select the portion 
to delete. Choose the green check mark to exit the trim 
tool. 

Fig 27 shows the surface and the curve that are selected 
for trimming. This figure also shows the surface divided 
into two portions. The portion defined by the curve is 
selected to delete. Fig 28 shows the surface after 
trimming.

Fig 27

Fig 28

SURFACE EDITING TOOLS IN Pro/ENGINEER 
WILDFIRE

The surface editing tools help in decreasing the modeling 
time. They also help in creating

complex surface models. The surface editing tools that 
you will be learning in the next section

are as follows:

1 Mirror		 2 Merge	 3 Trim 

4 Fill 		  5 Intersect 	 6 Offset 

7 Thicken 	 8 Solidify	 9 Vertex Round

Mirroring the Surfaces
The Mirror Tool is used to mirror the surface about a 
plane. This tool is available in the Edit Features toolbar 
only when a surface is selected. When you choose this 
button, the Mirror dashboard is displayed as shown in 
Fig 29.

Using the References tab you can choose the mirroring 
plane. The Copy as Dependent check box is selected 
by default in the Options tab. The makes sure that the 
Parent-child relationship is maintained between the 
mirrored and the original surface. Fig 30 shows the 
mirror plane about which the surface is mirrored as 
shown in Figure 31.

Merging the Surfaces
The Merge Tool is used to merge the two surfaces 
and make them a single surface. A surface is also 
known as a Quilt. To convert a surface to a solid, it is 
necessary that the surfaces are merged. While merging 

CG & M : TDM (Dies & Moulds) (NSQF - Revised 2022) - R.Theory for Ex  1.6.82-83

© N
IM

I 

NOT T
O B

E R
EPUBLI

SHED



322

the surfaces, this tool also trims the surfaces. This tool 
is available in the Edit Features toolbar only when the 

Fig 29

Fig 30 Fig 31

Fig 32

The following steps explain the procedure to merge the 
surfaces shown in Fig 33.
Fig 33

1	 Select the Quilts option from the Filter drop-down 
list. Select the two surfaces and when the surfaces 
turn pink in color, choose the Merge Tool; the Merge 
dashboard is displayed. In this figure, the part of the 
surfaces that will be retained after the two surfaces 
are merged is highlighted by yellow dots on it. The 
yellow arrows points to show the side of the surface 
to keep. The direction of yellow arrow can be toggled 
by using the Change side of first quilt to keep and 
the Change side of second quilt to keep buttons 
available on the Merge dashboard.

2	 Choose the Change side of first quilt to keep button 
and then choose the Change side of second quilt 
to keep button. Notice that the outer side of the 
surfaces are highlighted with yellow dots as shown 
in Fig 34.

Fig 34

3	 Choose the Preview button and then exit the 
dashboard. The resulting merged surface is shown 
in Fig 35. This merged surface is a single surface 
and now can be converted to a solid feature.

Fig 35

The Reference tab of the Merge dashboard shows 
the selected quilts. In the Options tab, you can select 
between Intersect and Join options. The Join option can 
be used when the edge of one quilt lies on the other 
quilt.

Trimming the Surfaces
As the name suggests, the Trim Tool is used to trim 
the selected surfaces using a trimming object. You 
need to select the surface that you need to trim and 
then choose the Trim Tool button from the Edit Features 
toolbar. The Trim dashboard is displayed, as shown in 
Fig 36. You are prompted to select the trimming object. 
This trimming object can be a curve, plane, edge, or a 
surface.

The part of the surface that is to be retained is highlighted 
with yellow dots. A yellow arrow points in the direction 
of the surface to be retained after trimming. You can 
choose the Flip between one side, other side, or both 
sides of trimmed surface to keep button to toggle the 
direction of yellow arrow. By default, the trimming object 
is deleted after the surfaces are trimmed. If you need 
to keep the trimming object, select the Keep trimming 
surface check box from the Options slide-up panel.

two surfaces to be merged are selected. When you 
choose the Merge Tool button, the Merge dashboard is 
displayed as shown in Fig 32.
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Fig 36

Fig 37 Fig 38

Fig 37 shows the surface selected as the trimming 
object, the trimming surface, and the yellow arrow. From 
this figure it is evident that the arrow is pointing toward 

the right; therefore the right portion of the surface will 
be retained after trimming. Fig 38 shows the surface 
obtained after trimming.

Fig 39

From the References slide-up panel choose the Define 
button to select the sketching plane and drawing the 
Fig 40 Fig 41

sketch. Fig 40 shows the sketch plane and Fig 41 shows 
the surface that is created using the Fill option.

Creating the Intersect Curves
The Intersect option is used to create a curve at the 
intersection of two surfaces. The intersect curve can 
then be used for various purposes. The Intersect option 

is available in the Edit menu only when you have 
selected a surface. When you choose this option from 
the Edit menu, the Intersect dashboard is displayed as 
shown in Fig 42.

Fig 42

When you select the second surface, the intersecting 
curve is created as shown in Fig 43.

Make sure to select the second surface while holding 
the CTRL key down. The curve created can be 
copied, moved, and so on. One of the uses of the 
intersect curve is shown in Figu 44 and 45. In Fig 44, 
the intersecting curve is copied at a distance of 150. 
To create the surface shown in Fig 56, the Boundary 
Blend Tool is used. To create the boundary blend, the 
intersecting curve is selected and then the curve edge 
of the surface is selected. Both the curves are blended 
and the tangency is increased by dragging the handles.

Creating the Offset Surfaces: A surface can be 
copied to an offset distance. To offset a surface, select 

Fig 43

the surface to offset and choose Edit > Offset from the 
menu bar. The Offset dashboard is displayed, as shown 
in Fig 46. The Offset option is available only when you 
have selected a surface to offset.

Creating the Fill Surfaces
The Fill option is used to create a planar surface by 
sketching its boundaries. When you choose this option 

from the Edit menu in the menu bar, the Fill dashboard 
is displayed as shown in Fig 39.
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Fig 46

Fig 44 Fig 45

Fig 47

Fig 48

Fig 49

In Pro/ENGINEER, there are three methods to offset a 
surface. These methods are as follows:

1	 Create the offset of the whole surface, using the 
Standard option.

2	 Sketch a section and offset the area inside the 
section with the draft, using the With Draft option.

3	 Sketch a section and offset the area inside or outside 
the section, using the Expand option.

In the Offset dashboard, first you need to specify the 
type of offset surface you need to create.

The types of offset that can be created in Pro/ENGINEER 
Wildfire 2.0 are as follows:

1	 Standard Offset Feature

2	 With Draft Feature

3	 Expand Feature

Standard Offset Feature
The Standard Offset Feature button is present at 
the lower-left corner of the Offset dashboard and is 
selected by default. You can enter the offset value in the 
dimension box.

Using this option you can offset the surface as a whole. 
From the drop-down list present in the Options slide-up 
panel, you can offset a surface normal to the surface, 
allow Pro/ENGINEER to automatically fit the surface, 
or control the direction of the offset in the x, y and 
z-axes. If you select the Control Fit option, you need to 
select a coordinate system and specify the direction to 
offset. From the Options slide-up panel you can select 
the Create side surface check box to join the offseted 
surface with the side surfaces. Figure 47 shows the 
original surface and the offset surface.

With Draft Feature
The With Draft Feature button can be selected form 
the list of buttons that appear by selecting the black 
arrow present on the right of Standard Offset Feature 
button. Using this option you can sketch the section 
and then give a draft angle to side surfaces. Choose 
the Define button from the from the References slide-up 
panel to define a sketch plane and create the sketch. 
Fig 48 shows the draft offset surface with the Straight 
radio button selected from the Options slide-up panel. 
The section that was drawn on the sketch plane was 
circular. Similarly, Fig 49 shows the draft offset surface 
with the Tangent radio button selected from the Options 
slide-up panel.

Expand Offset Feature
The Expand Offset Feature button can be selected form 
the list of buttons that appear by selecting the black 
arrow present on the right of Standard Offset Feature 
button. Using this option you can sketch the section 
and then choose to offset the inside of the sketch or 
the outside of the sketch. For this purpose you need to 
choose the Flip the material sides of sketch button from 
the dashboard. Fig 50 shows the offset surface when 
the inside of the sketch is selected to offset. The section 
that was drawn on the sketch plane was rectangular. 
Choose the Define button from the Options slide-panel 
to define the sketch plane and create the sketch. Fig 51 
shows the draft offset surface when the outside of the 
sketch is selected to offset.
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Fig 50

Fig 53

Fig 56

Fig 57

Fig 55

Fig 51

Fig 54

Giving Thickness to a Surface
To add thickness to a quilt or to a surface, select the 
quilt and choose the Thicken option from the Edit menu. 
The Thicken dashboard is displayed, as shown in  
Fig 52.

Drag the handle to set the thickness of the quilt or 
enter the thickness value in the dimension box. You 
can even remove material from the quilt by choosing 
the Removes material from inside thickened quilt button 
from the dashboard. 

Using the drop-down list present in the Options slide-
up panel, you can give thickness to the quilt normal 
to the surface, allow Pro/ENGINEER to automatically 
scale the surface along axes, or scale and fit the 
original surface with respect to the coordinate system. 
If you select the Control Fit option, you need to select 
a coordinate system and specify the direction to scale. 
Fig 53 and 54 show the surfaces after adding thickness 
by controlling the thickness using the Normal to surface 
option and the Automatic fit option respectively.

Fig 52

Converting a Surface to a Solid
You can convert a closed surface into a solid by 
choosing Edit > Solidify from the menu bar. This option 
is available only when a closed surface is selected. This 
option fills the hollow surface with material.

Creating Round at the Vertex of a Surface
The vertices of a surface or quilt can be rounded using 
the Vertex Round option. Choose Insert > Advanced > 
Vertex Round from the menu bar. The SURFACE TRIM: 
Vertex Round dialog box is displayed as shown in Fig 55. 

You are prompted to select the datum quilt to intersect. 
Select the surface; now you are prompted to select the 
corner vertex(s) to be rounded. Select the first vertex 
and then press the CTRL key to select the other vertex 
as shown in Fig 56. After selecting the vertices, press 
the middle mouse button. The Message Input Window is 
displayed. Type the radius of round and press ENTER. 
Choose the OK button from the SURFACE TRIM: Vertex 
Round dialog box. The vertices are rounded as shown 
in Fig 57.
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Creation of surface modelling
Objectives: At the end of this lesson you shall be to
•	 explain the steps in creation of surface modelling

In this lesson you will create the surface model shown in 
Fig 1. The orthographic views of the surface model are 
shown in Fig 2.

Fig 1

The following steps are required to complete this 
tutorial:
a 	 Examine the model and determine the number of 

features in it, refer to Fig 2.

b 	 Create the base feature, which is a blend surface, 
refer to Figs 3 through Fig 5.

Fig 5

c 	 Create the second feature, which is a blend feature, 
refer to Figs 6 & 7.

Fig 6

Fig 7

d 	 The third feature is a mirror feature that will be created 
by mirroring the second feature about a plane passing 
from the center, refer to Fig 8.

Fig 8

e 	 Create the fourth feature which is also a blend feature, 
refer to Figs 9 & 10.

Fig 9
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Fig 10

f  	 Next, individually the surfaces will be selected to 
merge, refer to Figs 11 & 12.

Fig 11

Fig 12

g 	 Remaining features are the fill features that will create 
surfaces on the blend features, refer to Figs 13 through 
15.

h 	 Create rounds on the edges, refer to Fig 16.

Fig 13

Fig 14

Fig 15

After understanding the procedure for creating the model, 
you are now ready to create it.

When the Pro/ENGINEER session is started, the first 
task is to set the working directory.

Since this is the first tutorial of this chapter, you need to 
create a folder named c13 if it does not exist and set it 
as the working directory.

Starting a New Object File
1 	 Start a new part file and name it as c13tut1.

The three default datum planes are displayed in the 
graphics window. The Model Tree is

also displayed in the graphics window. Close the Model 
Tree by clicking on the sash present on the right edge 
of the Model Tree.

Creating the Base Feature
You will use the menu bar present on the top of the screen 
to invoke the Blend option. The Blend option will be used 
to create the base feature.

1 	 Choose Insert > Blend > Surface from the menu bar. 
The BLEND OPTS menu is displayed.

2 	 Choose Parallel > Regular Sec > Sketch Sec > Done 
from the BLEND OPTS menu. The SURFACE dialog 
box and the ATTRIBUTES menu is displayed.

3 	 Choose Straight > Open Ends > Done from the 
ATTRIBUTES menu. You are prompted to select the 
sketch plane.

4 	 Select the RIGHT datum plane. The DIRECTION 
menu is displayed.

5 	 Choose Okay from the DIRECTION menu. The SKET 
VIEW menu is displayed.

6 	 Select the Top option and then choose the TOP datum 
plane. The References dialog box is displayed and 
you enter the Sketcher environment.

Fig 16
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7 	 Close the References dialog box and draw the arc 
and dimension it as shown in Fig 3.

8 	 After drawing the first arc, press and hold down the 
right mouse button and choose the Toggle Section 
option from the shortcut menu.

9 	 Draw the second arc and dimension it as shown in 
Fig 4.

10 	After drawing the sketch, choose the Continue with the 
current section button to exit the Sketcher environment. 
The DEPTH menu is displayed.

11 Choose Blind > Done from the DEPTH menu. The 
Message Input Window is displayed.

12 Enter a value of 150 and press ENTER.

13 	Choose OK from the SURFACE dialog box. The base 
feature is created as shown in Fig 5.

Creating the Second Feature
To create the second blend feature you need to create a 
datum plane that is at a distance of 150 from the FRONT 
datum plane that is passing through the center of the 
base feature.

1 	 Choose Insert > Blend > Surface from the menu 
bar.

2 	 Choose the Parallel > Regular Sec > Sketch Sec > 
Done from the BLEND OPTS menu.

3 	 Choose Straight > Open Ends > Done from the 
ATTRIBUTES menu. You are prompted to select the 
sketch plane.

4 	 Choose the Make Datum option to display the DATUM 
PLANE menu. Select the Offset option and then select 
the FRONT datum plane.

5	  Press the middle mouse button to confirm the selection. 
Now select the Enter Value option from the OFFSET 
menu to display the Message Input Window and enter 
150 in it.

6 	 Select the Done option from the DATUM PLANE menu 
and then select Okay from DIRECTION menu.

7 	 Set the orientation of the sketch plane by selecting the 
TOP datum plane to be at the top while sketching.

8 	 After you enter the Sketcher environment, close the 
References dialog box.

9 	 Sketch the first arc of radius 25, and then after toggling 
the sketch draw the second arc as shown in Figure 
6.

10 	Exit the Sketcher environment; the DEPTH menu is 
displayed.

11 Choose Thru Until > Done from the DEPTH menu.

12 	Select the FRONT datum plane. Choose OK from the 
SURFACE dialog box. The blend surface is extruded 
up to the selected datum plane as shown in Fig 7.

Creating the Mirror Copy of the Second Feature
The third blend feature is the same as the second blend 
feature. Therefore, a mirror copy of the second feature 
will be used to create the third feature.

1 	 Select the second feature and then choose the Mirror 
Tool button. The Mirror dashboard is displayed and 
you are prompted to select a plane to mirror about.

2 	 Select the FRONT datum plane and exit the Mirror 
dashboard by choosing the Build Feature button. The 
mirror copy of the second feature is created as shown 
in Fig 8.

Creating the Fourth Blend Feature
The fourth blend feature will be created on the top of the 
base feature. To create the blend feature, you will need 
to create a datum plane that is at a distance of 150 from 
the bottom of the base feature.

1 	 Choose Insert > Blend > Surface from the menu 
bar.

2 	 Choose Parallel > Regular Sec > Sketch Sec > Done 
from the BLEND OPTS menu.

3 	 Choose Straight > Capped Ends > Done from the  
ATTRIBUTES menu. You are prompted to select the 
sketch plane.

4	 Choose the Make Datum option to display the DATUM 
PLANE menu. Select the Offset option and create a 
datum plane at a distance of 150 from the TOP datum 
plane.

5 	 Set the orientation of the sketch plane by selecting 
the RIGHT datum plane to be at the top while 
sketching.

6	 After you enter the Sketcher environment, close the 
References dialog box.

7 	 Sketch the first circle of diameter 50, dimension it. 
Toggle the sketch and then draw the second circle of 
diameter 70 as shown in Fig 9.

8 	 Exit the Sketcher environment; the DEPTH menu is 
displayed.

9 	 Choose Thru Until > Done from the DEPTH menu.

10 Select the TOP datum plane. Choose OK from the 
SURFACE dialog box. The blend surface is extruded 
up to the selected datum plane as shown in Fig 10.

Merging the Surfaces to Create a Quilt
To create round on the edges it is necessary to create a 
common edge where the two surfaces are joining. For 
this purpose, the surfaces are merged.
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Note:  It is easier to select the two surfaces 
for merging from the Model Tree. You should 
remember that to select more than one surface 
you need to press the CTRL key. When you 
select the surfaces from the Model Tree the 
boundary of the surface is highlighted in red 
color indicating that the surface is selected. 
When you are selecting a surface directly from 
the graphics window, you need to select the 
surface thrice. The third time when you select 
the surface, it turns pink in color.
You can also select the Quilt option from the 
Filter drop-down list to select the surfaces. 
The Filter drop-down list is available in the 
status bar at the bottom right corner of the 
main window.

1 	 Select the blend surface that is at the left and then 
select the blend surface at the middle. When the 
two surfaces are highlighted, choose the Merge 
Tool. The Merge dashboard is displayed and the two 
arrows shows the portion that will be retained after 
merging.

Note: The Merge Tool button is available 
only when the two surfaces are selected for 
merging.

2 	 Choose the Change side of first quilt to keep button 
from the dashboard. The direction of yellow arrow 
changes.

3 	 Choose the Change side of second quilt to keep 
button from the dashboard. The direction of yellow 
arrow changes. The portion of the surface that is now 
highlighted will be retained after merging.

4 	 Exit the dashboard by selecting the Build Feature 
button. The model after merging the two surfaces is 
shown in Fig 11.

Using the same procedure, merge the blend surface 
at the right with the blend surface at the middle. After 
that, merge the top blend surface with the middle blend 
surface. Fig 12 shows the surface model after merging 
all the surfaces and forming a quilt.

Creating the Fill Surfaces
Four surfaces will be created to cap the ends of the blend 
surfaces. First, the left blend surface will be capped using 
the Fill option.

1 	 Choose the Fill option from the Edit menu. The Fill 
dashboard is displayed.

2 	 From the References slide-up panel choose the Define 
button. The Sketch dialog box is displayed and you 
are prompted to select the sketch plane.

3 	 Choose the Datum Plane Tool button from the Datum 
toolbar. To choose the button you need to move the 
Sketch dialog box because the dialog box overlaps 
the tool button.

4 	 Select the two vertices of the left blend surface. To 
select the second vertex hold down the CTRL key. 
Then holding down the CTRL key select the FRONT 
datum plane.

5 	 Select FRONT from the DATUM PLANE dialog box. 
The drop-down list appears in the row where you 
clicked. From the drop-down list, select the Parallel 
option. Choose the OK button from the DATUM PLANE 
dialog box. The datum plane is created and a yellow 
arrow points in the direction of viewing the sketch.

6 	 Choose the Sketch button to close the Sketch dialog 
box. Close the References dialog box and enter the 
Sketcher environment.

7 	 Choose the Create an entity from an edge button 
and select the smaller semicircular edge of the blend 
surface. Complete the sketch as shown in Fig 13.

8 	 Exit the Sketcher environment and then exit the Fill 
dashboard by choosing the Build Feature button. The 
Fill surface is created as shown in Fig 14.

Similarly, create the fill surfaces to cap the ends of the 
middle surface blend feature. Mirror the fill surface to 
create the fill surface at the right blend surface. Fig 15 
shows the surface model after capping all the ends of 
the blend surfaces.

Merging the Fill Surfaces
The fill surfaces that you have created should be merged 
with the other surfaces in order to create round on their 
edges.

1 	 Hold down the CTRL key to select the fill surface that 
is at the left and then the blend surface at the middle. 
When the two surfaces turn pink in color, choose the 
Merge Tool to display the Merge dashboard.

2 Exit the dashboard by selecting the Build Feature 
button.

Using the same procedure, merge the remaining fill 
surfaces individually with the blend surface at the middle. 
To check whether all the surfaces are merged, select 
the surface model thrice. If the whole surface model is 
highlighted in pink color then all the surfaces are merged 
and form a quilt.

Creating Rounds
When all the surfaces are merged then the edges are 
obtained at the intersection of two surfaces. These edges 
can be easily rounded. In the given surface model, note 
that there are rounds that are having two different radius 
values. Therefore, you need to create two sets to define 
two values of rounds.

1 	 Choose the Round Tool from the Engineering Features 
toolbar.

2 	 Select the edges that have a radius value of 12. 
Remember that to select more than one edge, you 
need to hold down the CTRL key.
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3 	 After creating the rounds of radii 12, select the Sets 
tab to display the slide-up panel.

4 	 Click on New set, you have added a set that is named 
Set2.

5 	 Select the two edges that are having radii of 22. 
After creating the rounds of radii 22, exit the Round 
dashboard. 

The surface model after creating the rounds is as shown 
in Fig 16.

6 	 Choose the Save the active object button from the 
File toolbar and save the model.

Manufacturing
Objectives: At the end of this lesson you shall be to
•	 state what is manufacturing module in creo
•	 list of the sub modules in manufacturing module in creo
•	 brief the method of creating the NC code for a given part in creo.

(Manufacturing process allows you set up and run NC 
machines, create assembly process sequences, create 
bills of material, and generate inspection programs for 
Coordinate Measuring Machines (CMMs).

The Manufacturing area of Help to learn about 
streamlining the NC programming process for 
production milling of prismatic parts and multisurface 
three-axis milling). Manufacturing Help shows you 
how to program and set up your NC machines, create 
process flows that cover the NC operations as well as 
other operations, and define CMM inspection programs 
that probe manufactured parts. (Fig 1)

Additive manufacturing is the process that creates 
three-dimensional objects from 3D digital models. 
Additive Manufacturing application lets you manage 
and print your models using a 3D printer. Use the 
Additive Manufacturing help to learn about creating tray 
assemblies, setting up printing options, and printing the 
models.

Manufacturing Modules consist of the following
-	 Creo NC

-	 Expert Machinist

-	 Manufacturing Process Planning

-	 Coordinate Measuring Machines (CMM)

-	 Manufacturing Verification

-	 Additive Manufacturing

Creo NC Overview
The Creo NC Help describes the logical sequence of 
tasks to progress from a design model to NC machine 

data. Creo NC creates the data necessary to drive an 
NC machine tool to machine a part. Refer to these 
topics for information on using the NC user interface, on 
configuring Creo Parametric for NC, and on performing 
manufacturing tasks.

Step on creo NC
-	 Using Creo NC

-	 Creating a Manufacturing Model

-	 Configuring Creo Parametric for Creo NC

-	 Using the Manufacturing Process

-	 Using the Process Manager

-	 Working with the Process Table

-	 Creating a Manufacturing Template

-	 Creating a Manufacturing Process

-	 Creating Operations

-	 Creating Workcells

-	 Defining Fixtures

-	 Specifying Coordinate Systems

-	 Creating NC Sequences

-	 Setting Up a Retract Surface

-	 Setting up the Machine Tool

-	 Setting Manufacturing Parameters

-	 Defining NC Sequences

-	 Working with Mill Geometries

-	 Defining a Milling NC Sequence

-	 Defining a Turning NC Sequence

-	 Defining a Hole Making NC Sequence

-	 Defining a Wire EDM NC Sequence

-	 Defining an Auxiliary NC Sequence

-	 Defining a User-Defined NC Sequence

-	 Defining a Mirror NC Sequence

-	 Using Cutter Location Data and Displaying Tool Path

Fig 1
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-	 Using Cutter Location (CL) Data

-	 Displaying a Tool Path

-	 Performing Post-Processing for Creo NC

About Creo NC
Creo NC creates the data necessary to drive an NC 
machine tool to machine a Creo part. It does this by 
providing the tools to let the manufacturing engineer 
follow a logical sequence of steps to progress from a 
design model to ASCII CL data files that can be post-
processed into NC machine data.

Licensing Requirements
Creo NC is a family of optional modules that can be 
ordered in any combination, to provide a custom fit of 
the available functionality to your company’s needs.

The Creo Complete Machining license covers the 
complete Creo NC functionality as described in this 
Help System. Other modules provide subsets of this 
functionality.

To Create a Manufacturing Model

1	 On the Creo Parametric Quick Access toolbar, click   
or click File > New. The New dialog box opens

2	 Select the Manufacturing option under Type.

3	 Select the NC Assembly option under Sub-type.

4	 Type a name for the new manufacturing model in 
the Name text box, unless you want to accept the 
default.

5	 If you do not wish to use the default template, clear 
the Use default template check box.

6	 Click OK. The New File Options dialog box appears. 
Select the template on which you want to base the 
manufacturing drawing. If you do not wish to use a 
template, select Empty from the list of templates.

In the New File Options dialog box, select the Copy 
associated drawings check box if you want to create a 
new manufacturing drawing based on the drawing that 
is a part of the selected template.

For example, the template inlbs_mfg_nc.asm contains 
a corresponding drawing inlbs_mfg_nc.drw. To create a 
manufacturing model named mfgmodel.asm using this 
template, select the template and then select the Copy 
associated drawings check box. A drawing is created 
with the same name and a different extension, that is, 
mfgmodel.drw.

7	 Click OK. The model tree of the manufacturing 
assembly is displayed in the Creo Parametric 
Navigator window. At this point, the assembly 
contains the components and features from the 
selected template. If you are not using a template, 
the assembly is empty. You have to define the 
manufacturing assembly configuration next.

About Manufacturing Process
Creo NC process consists of the following basic steps:

1	 Set up the manufacturing database. It may contain 
such items as workcells (machine tools) available, 
tooling, fixture configurations, site parameters, or 
tool tables. This step is optional. If you do not want to 
set up all your database up front, you can go directly 
into the machining process and later define any of 
the items above when you actually need them.

2	 Define an operation. An operation setup may contain 
the following elements:

-	 Operation name

-	 Work Centers (workcell or machine tool)

-	 Coordinate system for CL output

-	 Operation comments

-	 Operation parameters

-	 FROM and HOME points

You have to define a work center and a coordinate 
system before you can start creating NC sequences. 
Other setup elements are optional.

3. Create NC sequences for the specified operation. 
Each NC sequence is a series of tool motions with the 
addition of specific post-processor words that are not 
motion-related but required for the correct NC output.

The tool path is automatically generated by the system 
based on the NC sequence type (such as Volume Milling, 
Outside Turning), cut geometry, and manufacturing 
parameters. You can apply more “low level” control, if 
you like, by:

-	 Defining your own tool motions, that is, approach, 
exit, and connect motions. Tool motions include 
Automatic Cut motions.

-	 Inserting non-motion CL commands.

4	 For each completed NC sequence, you can create a 
material removal feature, either by making the system 
automatically remove material (where applicable), or 
by manually constructing a regular Creo feature on 
the workpiece (such as Slot or Hole).

Modal Settings
Most of the machining setup elements are modal, that 
is, all subsequent NC sequences will use this setting 
until you explicitly change it. Among those are:

-	 Operation setup (including the workcell and Machine 
coordinate system)

-	 Fixture setup

-	 Tool (provided the tool type is compatible with the 
NC sequence type)

-	 Manufacturing parameters of an activated site

-	 NC Sequence coordinate system (for the first NC 
sequence, the Machine Coordinate system specified 
for the operation will be implicitly used as the NC 
sequence coordinate system as well, unless you 
explicitly specify another one)
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-	 Retract surface.

Mold Design and Casting
Objectives: At the end of this lesson you shall be to
•	 brief the mold design and casting using creo parametric

Introduction
Mold Design and Casting lets you simulate the mold 
design process, design die assemblies and components, 
and prepare castings for manufacturing.

Use the Mold Design and Casting area of Help to 
learn about creating, modifying, and analyzing mold 
components or assemblies. Mold Design and Casting 
Help shows you how to quickly update mold components 
to the changes in the design model or to design die 
assemblies and components and prepare castings for 
manufacturing. You will learn how to create and modify 
design parts, cavities, mold layouts, and drawings.  
(Fig 1)

Mold Design and Casting Modules

-	 Mold Design and Casting

-	 Creo Mold Analysis (CMA)

Mold Design and Casting

Fig 1

Example: Manufacturing Process
The following flow chart gives a summary of the 
manufacturing process.
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Mold Design and Casting is an optional module for Creo 
Parametric that provides the tools to simulate the mold 
and cast design process. This module lets you create, 
modify, and analyze the mold and cast components and 
assemblies, and quickly update them to the changes in 
the design model.

Mold Design and Casting, together with Creo Parametric, 
provide tools to do the following:

Design Part Creation and Modification

-	 Create models

-	 Import and repair geometry if necessary

The import functionality can be used with the following: 
See Data Doctor Option and Interface

-	 Analyze if a design part is moldable, using Draft 
Check and Thickness Check capabilities

- 	 Automatically create parting lines and detect 
undercuts using Silhouette Curve functionality

-	 Fix problem areas by creating draft, rounds, and 
other features as needed

Cavity Creation
-	 Assemble and orient design model dynamically 

while checking draft and projected area

-	 Apply a shrinkage that corresponds to design part 
material, geometry, and molding conditions

- 	 Automatically create the workpiece stock from which 
core, cavity, and inserts will be split

- 	 Create parting geometry, including sliders, inserts, 
automatic parting lines, and automatic parting 
surfaces

-	 Automatically split the workpiece to create cores, 
cavity, and inserts as solid models

-	 Create and assemble sand cores for cast design

Mold Layout Creation
-	 Create top level mold assembly

-	 Placement and patterning of mold cavities to allow 
multi-cavity molding

-	 Online selection and automatic assembly of standard 
mold bases

-	 Modification of mold base plates to allow for 
assembly of mold cavity

-	 Online selection and automatic assembly of ejector 
pins and other Mold Catalog items

-	 Automated creation of runners

-	 Automated creation of waterlines, including 3-D 
waterline interference checks

-	 Define and simulate mold opening and check for 
interference between mold components

Drawing Creation
- 	 Create complete production drawings, including 

dimensions, tolerances, automatic bill of materials 
(BOMs) with or without balloon notes

-	 Use of drawing templates

About Mold and Cast Features
Mold and cast features exist at the assembly level. There 
are two classifications of features: regular features and 
user-defined features.

Regular features are special features added to a model 
to facilitate the molding or casting process. These 
features include silhouette curves, ejector pin holes, 
runners, waterlines, draft lines, offset areas, volumes, 
and trimming features.

User-defined features are created in part mode and used 
to create commonly used structures in the workpiece or 
die block. A user-defined feature is created once and 
used multiple times by modifying the dimensions each 
time it is copied into an assembly.

About PTC Creo Mold Analysis
Creo Mold Analysis (CMA) is an injection molding 
simulation application. You can use CMA to verify the 
part design for manufacturing to avoid the molding 
defects. Some of the most common molding issues are 
incomplete cavity filling, undesirable weld line location, 
and improper wall thickness.

You can use the unique auto-meshing function to 
prepare the model for analysis in very less time. 
Additionally, CMA provides product insights in terms of 
potential weld line, air trap locations, and the required 
clamping force.
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